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Část I

Od instalace
po profesionální úroveň



Instalace analySIS®

Výstraha: Před instalací nebo vyjmutím libovolného hardwarového modulu, případně před připojením
nebo odpojením propojovacích kabelů, vypněte počítač a odpojte jej od elektrické sítě. Přečtěte si
a dodržujte všechny výstražné pokyny, jak je vysvětleno v instalačních příručkách pro digitalizační kartu
GrabBit a kameru.

Instalace GrabBit a připojení kamery
1. Postupujte podle pokynů v instalační příručce pro GrabBit a pro kameru, abyste správně instalovali

digitalizační kartu GrabBit do Vašeho počítače a připojili kameru.

l Vložení ochranného softwarového klíče

2. Vložte ochranný softwarový klíč do paralelního portu počítače.

l Běžné softwarové klíče (licence A) mají modrou nebo bílou barvu. Představují platnou softwarovou
licenci pro použití programu analySIS® na jednom počítači. Platnost bílých softwarových klíčů je
časově neomezená, modré softwarové klíče mají platnost časově omezenou.

l Zelený softwarový klíč představuje licenci B. Pro instalaci jsou však nutné klíče licence A.
l Červený softwarový klíč představuje sí�ovou licenci. Tento klíč lze připojit do libovolného počítače

v síti. Uvědomte si, že před instalací programu analySIS® musíte instalovat ovladač pro sí�ový klíč.
Nabídka Setup obsahuje položku pro instalaci ovladače pro sí�ový klíč.

l Pokud je k paralelnímu portu připojena tiskárna, musí být softwarový klíč vložen mezi počítač
a propojovací kabel tiskárny.

Instalace programového vybavení analySIS®

3. Zapněte počítač a pokud je to nutné, spus�te operační systém.

4. Ukončete všechny spuštěné aplikace.

5. Vložte instalační kompaktní disk s programovým vybavením analySIS® do jednotky CD-ROM.

➤ Pokud není potlačena funkce automatické spouštění, automaticky se spustí program Setup.
V opačném případě musíte v programu Průzkumník manuálně spustit soubor setup.exe.

6. Pokud chcete instalovat nebo aktualizovat program analySIS®, zvolte v nabídce Setup položku
analySIS 3.1.

7. Postupujte podle pokynů na obrazovce a zadejte odpovídající údaje.

➤ Po instalaci programu analySIS® se otevře programová složka, zvolená při instalaci, s několika
zástupci programů. Zástupce vlevo patří programu analySIS®.

Instalace dokumentace ve formátu PDF
8. Jestliže chcete zkopírovat soubory s dokumentací ve formátu PDF na pevný disk počítače, všechny

nebo po částech, zvolte v nabídce Setup položku Documentation.

9. Postupujte podle pokynů na obrazovce a zvolte požadovanou dokumentaci.

➤ Do zvolené programové složky se doplní zástupce s ikonou ve tvaru knihy, který zajiš�uje vazbu na
právě instalované soubory s dokumentací.

10. Zvolením položky Quit opus�te nabídku Setup.

l Program analySIS® nebo instalovanou dokumentaci spustíte pouhým poklepáním na
odpovídajícího zástupce.
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Když vložíte instalační CD-ROM do jednotky CD-ROM,
automaticky se zobrazí nabídka Setup. Potřebujete další
dokumentaci? Je dostupná kdykoliv právě z této nabídky.

Program analySIS® nelze instalovat bez softwarového klíče.

Po instalaci programu analySIS® a libovolné požadované
dokumentace se ve zvolené programové složce v nabídce
Start systému Windows objeví čtyři zástupci. Po stisknutí
tlačítka [Ctrl] můžete zástupce uchopit a přesunout na
pracovní plochu Windows. Spuštění programu analySIS®

a odpovídající dokumentace bude pohodlnější. Poklepáním
na zástupce ReadMe zpřístupníte nejnovější informace
o programu analySIS®.

Před spuštěním programu analySIS® se přesvědčte, zda
jsou propojovací kabely počítače a kamery pevně připojeny
do odpovídajících portů. Pokud nejsou správně připojené,
zobrazí se chybové hlášení. Na obrázku je zobrazeno
ukázka chybového hlášení pro kameru F-View nebo
ColorView CCD.

analySIS® – Před spuštěním

Vítejte ve světě analySIS®!

Softwarový balík, který jste si zvolili, vytvořila
společnost Soft Imaging System. Vstoupili
jste tak do celosvětového společenství
uživatelů analySIS®. Vítejte. Rozsáhlá řada
funkcí pro pořízení a zpracování digitálních
obrázů, analýzu, archivaci v databázi
a zpracování výsledné dokumentace, to vše
je dostupné v programu analySIS®.

Myslíme si, že zjistíte, že práce s analySIS®

je ohromně uspokojivá zkušenost!

Konfigurace analySIS®

Programové vybavení analySIS® je
dostupné v mnoha různých rozšířených
verzích a konfiguracích. To znamená, že
některé funkce popsané v této úvodní
příručce nebo v jiné dokumentaci nemusí
být zahrnuty v softwarovém balíku, jenž jste
si vybrali, a naopak některé funkce, které
jsou součástí Vašeho softwarového balíku,
nemusí být v následujícím textu vysvětleny.

www.soft-imaging.net

Navštivte naši webovou stránku, která je
plná informací, zahrnujících naše stále se
rozrůstající produkty, kontakty na naši
zákaznickou a servisní linku, vše o našich
připravovaných konferencích a seminářích
a mnohem a mnohem více.

Co je nového?

Pokračuje nepřetržitý vývoj a rozšiřování
programového vybavení analySIS® od Soft
Imaging System. Verze 3.1 zahrnuje mnoho
nových funkcí. Podívejte se:

Překryvné vrstvy na živém obraze (str. 22)

Třírozměrné povrchy (str. 69)

Automatické měřítko (str. 27)

Odesílání elektronické pošty (str. 33)

Nastavení pracovní plochy (str. 16)

Navigátor (str. 10)

Magická hůlka (str. 90)

Nové analytické funkce (str. 83)

Nové funkce pro úpravu
překryvných vrstev (str. 52)

Rozšířené RGB Studio (str. 61)

O generátoru zpráv (nově integrovaného do
programu analySIS®) je pojednáno v druhé
části této příručky.
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Máte otázky? Máte potíže?
Máte nějaké otázky nebo potíže? Chceme je od Vás slyšet.
Jestliže máte nějaké otázky nebo potíže, které nedokážete sami vyřešit, dokonce ani po prostudování
odpovídající dokumentace, obra�te se na službu zákazníkům, přednostně elektronickou poštou. Naši
pracovníci ve službě zákazníkům budou nesmírně š�astní, pokud Vám pomohou.

1. Pokuste se specifikovat, kdy a přesně za jakých okolností se potíže objevily.

l Ideální by bylo, kdybyste byli schopni reprodukovat potíže nebo chybu. Tím ulehčíte naší
zákaznické službě hledání příčiny potíží a také nalezení řešení.

2. Poznamenejte si veškerá chybová hlášení, zobrazovaná na obrazovce.

l Nebo si jednoduše sejměte okno s hlášením. Vše, co musíte udělat pro sejmutí aktivního okna,
je stisknout klávesy [Alt]+[Print]. Aktivní okno se zkopíruje do schránky operačního systému
Windows. Nyní je snadné zahrnout kopii okna do elektronické pošty. Stiskněte pouze klávesy
[Ctrl]+[V].

l Elektronická pošta s velkými objemy dat může způsobit potíže při přenosu. Z tohoto důvodu není
vhodné snímat a zasílat elektronickou poštou obsah celé obrazovky. Ze stejného důvodu je také
rozumné zvolit menší barevnou hloubku sejmutého okna.

3. Pokud jste dosud nespustili program analySIS®, prosím, spus�te jej.

4. Příkazem ? > About... otevřete dialogové okno About.
➤ V dialogovém okně About je uvedena verze programového vybavení (Docu, Auto, Pro) , číslo

sestavení a sériové číslo Vaší verze analySIS® i použitý operační systém.
l Než se obrátíte na službu zákazníkům, přesvědčte se, zda máte všechny tyto informace

k dispozici.

5. Vše, co nyní potřebujete udělat, je popsat nám v elektronické poště co nejpřesněji Vaše potíže
(a pokud je to možné zaslat i sejmutá dialogová okna). Do elektronického dopisu zahrňte také
informace z dialogového okna About a potom nám jej zašlete na naši e-mailovou adresu služby
zákazníkům:

support@soft-imaging.de
l Samozřejmě nejjednodušším a nejpohodlnějším způsobem, jak se obrátit na naši službu

zákazníkům, je použít funkci pro automatické vytváření elektronické pošty přímo v programu
analySIS®. Pouze zvolte příkaz ? >About... > System Info... > Send, který Vám automaticky
vytvoří formulář pro elektronickou poštu. Vše, co potřebujete udělat, je doplnit příslušné
podrobnosti, které popisují potíže, které nastaly. Před odesláním elektronické pošty si přečtěte
stručný komentář ve formuláři s informací o odesílání elektronické pošty Vaším systémem
analySIS® do naší firmy.

l Pokud nelze odeslat elektronickou poštu z Vašeho počítače, na němž je instalován analySIS®,
zvolte příkaz ? >About... > System Info... > Send Info. Všechny systémové informace se uloží
do souboru. Potom můžete tento soubor odeslat z jiného počítače.

l Můžete nám také bezplatně zavolat nebo faxovat následující čísla:
Tel.: (+49) 2 51/7 98 00–0
Fax: (+49) 2 51/7 98 00–99
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Pokud si chcete prohlédnout další doporučení, otevřete
dialogové okno Welcome (příkazem ? > Welcome...).

Nejdůležitější informace o verzi vašeho programového
vybavení analySIS® zobrazíte zvolením příkazu ? > About.

Příkazem ? >About... > System Info... > Send
automaticky zobrazíte formulář pro zaslání elektronické
pošty naší službě zákazníkům. Do tohoto formuláře se
automaticky zahrnou všechny nezbytné systémové
informace. Vše, co potřebujete udělat, je přesně formulovat
otázku nebo popsat potíže, které nastaly, a potom klepnout
na tlačítko Send (v levém horním rohu na panelu nástrojů
okna elektronické pošty), aby se elektronická pošta
odeslala k nám.

analySIS ® – Před spuštěním

Úvodní uživatelská příručka pro Vás rozloží
problematiku... takže se seznámíte s tímto
programem, a to rychle! Dovolte nám návrh:
přečtením a následováním obsahu celé
příručky od začátku až do konce získáte
vynikající přehled o tom, jak analySIS®

pracuje a jaké jsou jeho schopnosti. Potom
budete vědět, jak jej použít co nejefektivněji
pro Vaši práci.

Levé stránky obsahují vlastní pokyny “krok
za krokem”, na pravých stránkách jsou
obrázky, vysvětlení termínů a také pomocné
informace.

Další dokumentace

Kdykoliv budete mít dotaz velmi specifické
povahy, měli byste nahlédnout do Uživatelské
příručky. Jedná se o vyčerpávající verzi
příručky pro uživatele, která je určena
k referenčním účelům. Je v ní podrobně
popsáno grafické uživatelské rozhraní (GUI)
programu analySIS® a všechny příkazy
a funkce analýzy.

Na základě své objednávky můžete obdržet
další příručky, záleží na tom, co si
objednáte: například příručku pro rozšiřující
softwarové moduly, instalační a uživatelskou
příručku pro digitalizační kartu GrabBit a pro
Vaši kameru. Veškerá dokumentace je také
dostupná v souborech formátu PDF na
instalačním CD programu analySIS®.
V nabídce Setup můžete zvolit soubory,
které se zkopírují na pevný disk Vašeho
počítače. Tyto soubory si můžete prohlížet
na obrazovce nebo vytisknout
prostřednictvím programu Acrobat Reader
od firmy Adobe (dodává se s programem
analySIS®).

Pokud chcete nejaktuálnější verze těchto
souborů PDF s dokumentací, navštivte naše
webové stránky a všechny požadované
soubory si načtěte. Soubory PDF naleznete
na adrese:

www.soft-maging.net/misc/docu.htm

Adobe a Acrobat jsou registrované
ochranné známky společnosti Adobe
Systems Incorporated. Mohou pro ně být
použita omezení související s autorskými
právy.
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Grafické uživatelské rozhraní (GUI)
Grafické uživatelské rozhraní (GUI)
programu analySIS® je plně přizpůsobitelné
Vašim specifickým požadavkům.

Panel nabídek

Příkazy programu analySIS® jsou přístupné
prostřednictvím odpovídajících nabídek
(menu). Panel nabídek programu analySIS®

můžete nastavit podle vlastních požadavků.
Pokud chcete doplnit, upravit nebo odebrat
příkazy nabídek, použijte příkaz Special >
Define > Menu Bar...

Oblast pamě�ových polí obrázků
(Image Buffers)

Každému obrázku je programem analySIS®

přiděleno jeho vlastní pamě�ové pole. Po
spuštění programu jsou všechna dostupná
pamě�ová pole obrázků prázdná. Při použití
programu se zaplňují – načtením nebo
pořízením obrázků a vykonáním různých
operací s obrázky, které mění vzhled
obrázků a jejichž výsledkem je nový
obrázek. Během libovolné práce to
znamená, že současně je přístupných
mnoho obrázků. V daný okamžik však může
být aktivní pouze jedno pamě�ové pole
obrázku.

Aktivní pamě�ové pole obrázku
l Obrázek v aktivním pamě�ovém poli bude

vždy zobrazen v obrazovém dokumentu
bez ohledu na nastavený počet
zobrazovaných obrázků.

l Aktivní pamě�ové pole obsahuje buï živý
obraz nebo pořízený obrázek. Jakékoliv
interaktivní vstupy nebo měření
(provedená Vámi) se vždy uplatní na
obrázku v aktivním pamě�ovém poli.

Panely nástrojů

Pro často používané příkazy jsou vytvořena
tlačítka, která poskytují rychlý a snadný
přístup k těmto funkcím. Chcete-li upravit
vzhled a obsah panelů nástrojů, použijte
příkaz Special > Edit Button Bars...

Správce výřezů (Viewport Manager)

Umožňuje Vám určit, jak budou obrazy
zobrazeny v obrazovém dokumentu
analySIS®. Program analySIS® 3.1 Vám
poskytuje mnoho variant, bez ohledu na
aplikaci, pro optimalizaci zobrazení obrázků
na obrazovce.

Obrazový dokument je speciální okno pro zobrazení
načtených nebo živých obrazů. Na každém monitoru lze
současně zobrazit až 25 obrázků. Aby se zobrazily,
obrazový dokument se rozdělí do několika oken, tzv. výřezů.
V každém výřezu může být zobrazen jeden obrázek.
Systémy se dvěma monitory Vám umožňují zobrazení
druhého obrazového dokumentu na duálním monitoru.

Pokud chcete změnit zobrazení obrázku v obrazovém
dokumentu, například upravit koeficient zvětšení, použijte
panel nástrojů pro práci s obrázky na monitoru Windows.
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Stavový řádek zobrazuje následující a další údaje:

l Stručný popis všech funkcí programu analySIS®.
Informace zobrazíte pouhým přesunutím kurzoru myši
na funkci nebo příkaz (zobrazí se nápověda).

l Název aktivního vstupního kanálu.
l Polohu a velikost společného rámečku.

Použití programu analySIS®

Grafické uživatelské rozhraní
Načtení a zobrazení obrázků
Uložení grafického uživatelského
rozhraní

Správce obrázků

Pole operandů je určeno pro:

l stanovení zdrojových a cílových
pamě�ových polí obrázků při použití
operací pro zpracování obrázků, které
mění původní obrázky, například inverze,
filtry...

l propojení s obrázky pro určité operace
pro zpracování obrázků.

Oblast pamě�ových polí obrázků použijte
pro:

l přehled o načtených obrázcích
l rychlý přístup k informacím o obrázku,

jako jsou velikost nebo druh obrázku
l aktivaci pamě�ového pole obrázku

Oblast pro ikony:
l je určena pro tisk, archivaci nebo

ukládání jednotlivých obrázků

Oblast pro dokument:

Pouze v této oblasti se mohou zobrazovat
dokumenty programu analySIS®. Každý
dokument se otevírá v samostatném okně.
Program analySIS® podporuje následující
druhy dokumentů:

l Obrázek
l Databáze
l Tabulka
l Text
l Schéma
l Graf
l Zpráva
l Třírozměrný povrch
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Načtení obrázků
Načtení obrázků uložených na pevném disku

1. Ve správci obrázků klepněte levým tlačítkem myši na pamě�ové pole, do kterého chcete načíst
obrázek. Aktivujte například pole č. 5.

l Zvolené pamě�ové pole se barevně zvýrazní a přiřadí se do aktivního výřezu.

2. Volbou příkazu File > Open... načtěte obrázek.

➤ Otevře se dialogové okno Open Image.

3. V seznamu Files of type zvolte položku Tagged Image Format (*.tif) . TIF je standardní formát
obrázků v programu analySIS®.

l Tento formát je výchozí při prvním otevření dialogového okna.

4. Pokud se chcete dostat ve struktuře složek (adresářů) na počítači o úroveň výš, klepněte na tlačítko
Up One Level.
➤ V poli pod panelem nástrojů se zobrazí seznam všech vnořených složek a dokumentů zvoleného

formátu.

5. Pokud chcete zobrazit obsah složky, poklepejte na ni. Zobrazí se všechny vnořené složky soubory.

l Kořenová složka programu analySIS® obsahuje složku Images, zpravidla ...\analysis\Images. Zde
můžete zvolit obrázky formátu TIF.

6. Pokud chcete zobrazit náhledy nebo soubory s obrázky, klepněte na tlačítko Preview. Zvolte soubory
s obrázky.

7. Označte obrázky, které chcete načíst.

8. Klepněte na tlačítko Open, zvolené obrázky se načtou.

➤ Dialogové okno Open Image se zavře.
➤ Obrázky se načtou do po sobě následujících pamě�ových polí. První obrázek se načte do aktivního

pamě�ového pole, například č. 5. Další obrázky se pak načtou do pamě�ových polí 6 až 9 (pokud
současně načítáte 5 obrázků).

Načtení obrázků do určených pamě�ových polí
1. Klepněte na záložku karty Gallery ve správci obrázků.

2. Pouhým klepnutím levého tlačítka myši uvnitř výřezu aktivujte obrazový dokument.

l Pokud má okno Images barevné záhlaví, je aktivní.

3. Zvolte příkaz Standard (button bar) > Open...

4. Klepněte levým tlačítkem myši na soubor s obrázkem, jenž chcete načíst.

5. Stiskněte a přidržte levé tlačítko myši a přetáhněte soubor přímo na požadované pamě�ové pole
(metoda drag&drop).

➤ V poli se zobrazí náhled načteného obrázku.

6. Opakujte předcházející krok, dokud to bude potřebné.

7. Chcete-li ukončit načítání, klepněte na tlačítko Close.
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Dialogová okna pro načítání souborů vycházejí ze
standardu MS Windows pro dialogová okna. Dialogové
okno pro načtení souborů je opatřeno funkcí Náhled.

Ve všech dialogových oknech pro načtení dokumentů je
seznam Files of type, který obsahuje formáty všech
přípustných druhů dokumentů.

Myší uchopte a přetáhněte (metoda drag&drop) obrázek do
požadovaného pamě�ového pole. Pro načtení souborů
metodou drag&drop můžete také využít aplikaci MS
Průzkumník.

Použití programu analySIS®

Grafické uživatelské rozhraní
Načtení a zobrazení obrázků

Načtení obrázků
Zobrazení více obrázků současně
Optimalizace zobrazení
Prohlížení velkých obrázků

Uložení grafického uživatelského
rozhraní

Otevření obrázků

Můžete načíst několik obrázků současně.
Po klepnutí na tlačítko Open v dialogovém
okně Open Image se načtou všechny
zvolené soubory s obrázky. První obrázek
se načte do aktivního pamě�ového pole,
ostatní obrázky do následujících
pamě�ových polí.

Jak zvolit...

l souvislou skupinu obrázků:
Klepněte levým tlačítkem myši na první
obrázek. Potom stiskněte klávesu [Shift]
a klepněte na poslední z požadovaných
obrázků.

l nesouvislou skupinu obrázků:
Klepněte levým tlačítkem myši na první
obrázek. Potom stiskněte a přidržte
klávesu [Ctrl] a postupně klepněte levým
tlačítkem myši na všechny požadované
obrázky.

l všechny obrázky ve složce:
Pouze stiskněte klávesy [Ctrl]+[A]

Příkaz Open... je kontextově závislý, tzn.
že dialogové okno Open Image se objeví
pouze v případě, že je aktivní obrazový
dokument. Pokud je aktivní textový
dokument, zobrazí se dialogové okno Open
Text atd.

Tlačítko Open se nachází na standardním
panelu nástrojů. Pokud si chcete
prohlédnout seznam všech různých
otevíracích příkazů, klepněte na šipku za
tlačítkem.
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Zobrazení více obrázků současně
Použití správce výřezů (Viewport Manager)

1. Klepněte na tlačítko Display Properties v dialogovém okně Viewport Manager.

2. V polích Viewport limit zvolte kurzorovými klávesami maximální počet obrázků, které si přejete
současně zobrazit. Dostupné jsou varianty 3 × 3, 4 × 4, 5 × 5.

Chcete-li současně zobrazit 9 obrázků, zvolte nastavení 3 × 3.

l Změna nastavení parametru Viewport limit se projeví až při příštím spuštění programu.
l Systém s jedním monitorem: Skupina Dual monitor nebude přístupná.

3. V seznamu Preffered monitor zvolte monitor, se kterým si přejete pracovat. Pokud chcete nastavit
duální monitor jako pracovní, zvolte hodnotu Dual.
l Při nastavení hodnoty 3 × 3 se prvních 9 pamě�ových polí obrázků zobrazí na duálním monitoru,

pamě�ová pole 10 až 18 na monitoru Windows.
l Systém s jedním monitorem: V tomto případě bude vždy preferován monitor Windows.

4. Klepněte na tlačítko s ikonou monitoru č.2 a nastavte počet výřezů zobrazených na duálním
monitoru.

➤ Pod tlačítkem se objeví matice zobrazující maximální počet dostupných výřezů, limitovaný
samozřejmě nově nastavenou hodnotou Viewport Limit.

➤ Systém s jedním monitorem: kroky 4–6 se neprovádějí

5. Přesuňte kurzor myši na levý horní výřez.

➤ Horní levý výřez bude aktivní (záhlaví bude barevné). V šedém poli pod rozbalenou maticí se
zobrazí údaj 1×1 images.

6. Klepnutím levého tlačítka myši potvrïte zobrazení jednoho obrázku.

➤ Nyní bude na duálním monitoru zobrazen pouze jeden obrázek.

7. Klepněte na tlačítko s ikonou monitoru č.1 a nastavte počet výřezů zobrazených na monitoru
Windows.

Zvolte nastavení 2 × 2 výřezů.

➤ Obrazový dokument na monitoru Windows se rozdělí na čtyři výřezy.

8. Klepnutím na tlačítko OK potvrïte nastavený způsob zobrazení.

9. Zvolením příkazu File > Exit ukončete program analySIS®.

10. Spus�te znovu program analySIS®, aby se aktivovalo nové nastavení výřezů.

➤ Aktivní bude pamě�ové pole obrázku 1, které bude jediným zobrazeným polem na duálním
monitoru.
Obrazový dokument na monitoru Windows bude obsahovat 4 výřezy, v kterých budou zobrazeny
obrázky načtené do pamě�ových polí 10 až 13.
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Systém duální obrazovky podporuje dva monitory. Na
monitoru Windows se zobrazuje grafické uživatelské
rozhraní. Duální monitor se používá pro zobrazení obrázků
a je podporován pouze programem analySIS®.

Pokud chcete určit počet a uspořádání výřezů v obrazovém
dokumentu, klepněte na tlačítko Arrange Viewports.

Výřezy Duální monitor Monitor Windows

Maximálně 3 × 3 4 × 4

Počet 3 × 3 1 × 3

Přiřazená
pamě�ová pole
obrázků

Výřezy Duální monitor Monitor Windows

Maximálně 3 × 3 3 × 3

Počet 1 × 1 2 × 2

Přiřazená
pamě�ová pole
obrázků

Která pamě�ová pole obrázků a jak budou přiřazena
výřezům po spuštění programu analySIS® závisí na
nastavení vlastností zobrazení. Na preferovaném monitoru
se zvýrazní sloupec šedou barvou.

Stisknutím tlačítka Toggle Navigator v okně Viewport
Manager přepnete mezi zobrazením uspořádání výřezů
a zobrazením náhledu obrázku v aktivním poli (vpravo).

Použití programu analySIS®

Grafické uživatelské rozhraní
Načtení a zobrazení obrázků

Načtení obrázků
Zobrazení více obrázků současně
Optimalizace zobrazení
Prohlížení velkých obrázků

Uložení grafického uživatelského
rozhraní

Výřez je oblast v obrazovém dokumentu,
která obsahuje jeden načtený obrázek do
programu analySIS® nebo živý obraz.
Obrazové dokumenty na monitoru Windows
i duálním monitoru mohou být rozděleny do
více výřezů. (Duálním monitorem se rozumí
druhý monitor v soupravě Dual Screen Kit).

Správce výřezů obsahuje:

l Kartu pro každý monitor (pokud
používáte dva monitory). Mezi oběma
kartami se přepíná klepnutím na
příslušnou záložku.

l Vlastní panel nástrojů pro rychlejší
nastavení vlastností výřezů.

Arrange Viewport

Umožňuje Vám definovat počet
a uspořádání výřezů na příslušném
monitoru.

Display Properties

Umožňuje Vám změnit:

l maximální počet výřezů
l výchozí vztah mezi pamě�ovými poli

obrázků a výřezy
l aktuální koeficient zvětšení pro výřezy
l provozní rozlišení duálního monitoru –

bez nutnosti opakovaného spuštění
programu

Zoom

Postupně zvětšuje nebo zmenšuje obrázek
v aktivním výřezu až do skutečné velikosti.

Display Configuration

Ukládá celé aktuální nastavení.

Toggle Navigator

Přepíná mezi zobrazením uspořádání výřezů
a zobrazením náhledu aktivního
pamě�ového pole obrázku.
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Optimalizace zobrazení obrázku
1. Současným stisknutím tlačítek [Ctrl]+[Alt]+[T] vytvořte zkušební obrázek.

2. Klepněte na tlačítko Arrange Viewports na panelu nástrojů okna Images a změňte uspořádání
výřezů na 1 × 2.

➤ Obrazový dokument se rozdělí na dva výřezy. Zkušební obrázek se umístí do levého výřezu
a změní se přiřazení pamě�ových polí obrázků. Koeficient zvětšení se nastaví na hodnotu Auto.
Zvětšení se upraví tak, aby byl ve výřezu zobrazen celý zkušební obrázek.

3. Klepněte na tlačítko Single View, v obrazovém dokumentu se zobrazí právě jeden obrázek – obrázek
z aktivního výřezu.

➤ Uspořádání výřezů a přiřazení pamě�ových polí obrázků výřezům se nezmění.
➤ Tlačítko Single View se změní na Tile View.

4. Zvolte některý z koeficientů zvětšení ze seznamu Zoom Factor nebo zadejte požadovanou hodnotu
přímo do pole, například 30 %.

➤ Zkušební obrázek se zmenší na 30 % skutečné velikosti. Výřez již nebude zcela vyplněn obrázkem.
Za okraji obrázku bude ve výřezu podkladová výplň.

5. Po klepnutí na tlačítko Zoom In se zdvojnásobí aktuální koeficient zvětšení.

➤ Velikost zkušebního obrázku bude nyní odpovídat 60 % jeho skutečné velikosti.

6. Po klepnutí na tlačítko Adjust Zoom se koeficient zvětšení nastaví tak, aby obrázek vyplnil aktuální
výřez.

l Poměr stran obrázku se nezmění. Narozdíl od automaticky nastaveného koeficientu zvětšení není
tento koeficient zvětšení závislý na velikosti okna, tzn. že po změně velikosti okna zůstane
koeficient zvětšení zachován.

7. Po klepnutí na tlačítko Adjust Window se velikost okna přizpůsobí aktuální velikosti obrázku. Tlačítko
je dostupné pouze při zobrazení jednoho obrázku.

8. Po klepnutí na tlačítko Full Screen obrázek vyplní celou obrazovku. Grafické uživatelské rozhraní
nebude na monitoru zobrazeno.

➤ Na monitoru se zobrazí celý obrázek. Pokud je koeficient zvětšení obrázku příliš velký,
odpovídajícím způsobem se upraví.

9. Klepněte na tlačítko Zoom v okně Viewport Manager.
➤ V aktivním výřezu se nyní zobrazí symbol lupa. Symbol můžete přesouvat myší. Jakmile se lupa

dotkne horního okraje výřezu, obrázek se začne posouvat směrem nahoru.
l Klepnutím levého tlačítka myši zvětšíte koeficient zvětšení o 100 %, například z 300 % na 400 %.

Pravým tlačítkem myši zmenšíte koeficient zvětšení o 100 %, například z 300 % na 200 %.
Klepnutím prostředního tlačítka myši nebo stisknutím klávesy [ESC] ukončíte režim zvětšení.

10. Klepněte na tlačítko Toggle Navigator v okně Viewport Manager, zobrazí se náhled obrázku.
Určete, kterou část obrázku chcete uvnitř náhledu zobrazit (v okně Images).

l Přesuňte kurzor myši na okraj červeného výběrového rámečku kolem náhledu. Tvar kurzoru se
změní na dvoustrannou šipku. Po stisknutí levého tlačítka myši můžete zmenšit velikost
výběrového rámečku. Poměr stran rámečku bude stejný jako u výřezu v okně Images.

l Nyní přesuňte kurzor dovnitř červeného výběrového rámečku. Tvar kurzoru se změní na
čtyřstrannou šipku. Po stisknutí levého tlačítka myši můžete rámeček přesouvat.

➤ Zvolená část obrázku se zobrazí v okně Images.
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Současným stisknutím tlačítek [Ctrl]+[Alt]+[T] vytvořte
zkušební obrázek. Zkušební obrázek je rozdělen na dvě
části v odstínech šedé, které překrývá barevná vrstva
s hodnotou aktuálního rozlišení monitoru a dalšími
informaci. Pokud chcete vytvořit barevný zkušební obrázek,
stiskněte současně tlačítka [Ctrl]+[Alt]+[Shift]+[T].

Zkušební obrázek má automaticky stejné rozměry jako
aktivní výřez a je vždy zobrazen v plné velikosti.

Záhlaví okna obsahuje číslo pamě�ového pole obrázku (2),
název obrázku (Test) a aktuální koeficient zvětšení (100 %).

Na náhledu v okně Viewport Manager se volí část obrázku,
která se zobrazí v okně Images. Požadovanou část zvolíte
nastavením velikosti a polohy výběrového rámečku.

Použití programu analySIS®

Grafické uživatelské rozhraní
Načtení a zobrazení obrázků

Načtení obrázků
Zobrazení více obrázků
Optimalizace zobrazení
Prohlížení velkých obrázků

Uložení grafického uživatelského
rozhraní

Obrazový dokument zobrazený na monitoru
Windows má vlastní panel nástrojů, který
urychluje a usnadňuje nastavení způsobu
zobrazení obrázků.

Koeficient zvětšení udává v procentech
zvětšení nebo zmenšení obrázku při
zobrazení na monitoru.

l Automatický koeficient zvětšení se
automaticky aktivuje po spuštění
programu. Přizpůsobuje se aktuální
velikosti výřezu. Pokud změníte velikost
výřezu, změní se odpovídajícím
způsobem i velikost obrázku. Koeficient
zvětšení nepřesáhne 100 %.

l Jednotlivé výřezy mohou mít odlišné
koeficienty zvětšení.

l Aktuální koeficient zvětšení se zobrazuje
v záhlaví výřezu.

l Koeficient zvětšení můžete nastavit
v rozsahu od 1 % až 6400 %.

l Při koeficientu zvětšení 100 % odpovídá
jeden obrazový bod na obrazovce přesně
jednomu bodu obrázku.

l Nastavený koeficient zvětšení se při
změně velikosti výřezu nemění, tzn. že ve
výřezu bude zobrazena pouze část
obrázku.

l Pokud je obrázek větší než výřez, objeví
se na okrajích výřezu posuvné lišty.

l Snímek můžete posouvat přímo použitím
nástroje Pan&Scroll. Klepněte na
obrázek a přidržujte stisknuté tlačítko
myši. Pokud je obrázek větší než výřez,
změní se tvar kurzoru myši. Potom
budete moci obrázek myší jednoduše
posouvat.
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Prohlížení velkých obrázků
Jak lze současně zobrazit část obrázku a celkový pohled?

1. Pokud používáte dva monitory, klepněte na záložku Windows v okně Viewport Manager.
➤ Monitor Windows bude aktivní, tzn. že další obrázek, který načtete nebo pořídíte, se zobrazí na

tomto monitoru.

2. Pokud chcete zobrazit uspořádání výřezů, klepněte na tlačítko Toggle Navigator v okně Viewport
Manager.

3. Klepněte na tlačítko Arrange Viewports na panelu nástrojů okna Images, v němž je zobrazen
obrazový dokument monitoru Windows.

l V matici výřezů zvolte uspořádání 2 × 2.

4. Uchopte a přetáhněte aktivní pamě�ové pole obrázku do každého ze čtyř výřezů.

l Klepněte levým tlačítkem myši na pamě�ové pole obrázku, a aniž byste tlačítko uvolnili, přesuňte
kurzor myši přímo do výřezu v obrazovém dokumentu nebo do schematického výřezu v okně
Viewport Manager.

5. Zvolením příkazu File > Open... načtěte obrázek.

l Vyhledejte složku ...\analysis\mages a načtěte obrázek Au-label.tif.
➤ Načtený obrázek se nyní zobrazí na monitoru Windows ve všech čtyřech výřezech.

6. Klepněte na tlačítko Adjust Zoom na panelu nástrojů okna Images.

➤ Obrázek v aktivním výřezu se zmenší tak, aby se celý vešel do výřezu. Tento obrázek můžete
později využít jako celkový pohled pro určení části obrázku, kterou chcete zobrazit podrobněji.

7. Nastavte odpovídající koeficienty zvětšení pro zbývající tři výřezy.

l Příslušný výřez aktivujete klepnutím levého tlačítka myši. Aktivní výřez má barevné záhlaví.
l Požadovaný koeficient zvětšení zvolte v seznamu Zoom Factor, například 25 %, 50 % a 100 %.
➤ Nyní jsou obrázky v jednotlivých výřezech zobrazeny s odlišnými koeficienty zvětšení.

Jak zvolit část obrázku v celkovém pohledu?
8. Aktivujte horní levý výřez s celkovým pohledem.

9. Stiskněte tlačítko [Shift] a klepněte levým tlačítkem myši na pravý spodní obrázek v okně Viewport
Manager, označí se všechny čtyři výřezy.

➤ Nyní jsou barevná záhlaví všech čtyřech výřezů v okně Viewport Manager.

10. Klepněte levým tlačítkem myši kdekoliv na celkovém pohledu v levém horním výřezu (v okně
Images).

➤ Ve zvolených výřezech se automaticky zobrazí část, označená na celkovém pohledu.

11. Stiskněte a přidržte levé tlačítko myši a posouvejte výběrovým rámečkem po celkovém pohledu.

➤ Obsah ostatních výřezů se bude patřičně měnit podle pohybu kurzoru myši a bude odpovídat
aktuální poloze výběrového rámečku.

12. Pokud chcete zrušit výběr více výřezů, pouze klepněte levým tlačítkem myši na aktivní výřez v okně
Viewport Manager.
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Pamě�ová pole obrázků mohou být přiřazena libovolnému
výřezu. Obrázek uchopte a přetáhněte jej z pamě�ového
pole do požadovaného výřezu.

Zvolené výřezy mají barevná záhlaví. Výřez, jehož záhlaví je
zobrazeno tučným písmem, je aktivní (vlevo nahoře). Stejný
obrázek je zobrazen ve 4 výřezech ve 4 různých velikostech.
Zvolte všechny výřezy v okně Viewport Manager. Stiskněte
a přidržte levé tlačítko myši a potom na celkovém náhledu
zvolte požadovanou část obrázku, kterou chcete zobrazit ve
větším rozlišení. Ostatní výřezy budou zobrazovat zvolenou
část obrázku.

Ikona složky v oblasti pamě�ových polí obrázků obsahuje
číslo pamě�ového pole obrázku. Ikona monitoru udává druh
obrázku. Pod názvem obrázku je uvedeno rozlišení.
Rozlišení 318 × 223 × 24 odpovídá obrázkům v barvách
true color s barevnou hloubkou 24 bitů a rozměry
318 × 223 obrazových bodů. Galerie obsahuje náhledy
všech obrázků, aktuálně načtených do programu
analySIS®, v pamě�ových polích obrázků (vpravo).

Použití programu analySIS®

Grafické uživatelské rozhraní
Načtení a zobrazení obrázků

Načtení obrázků
Zobrazení více obrázků
Optimalizace zobrazení
Prohlížení velkých obrázků

Uložení grafického uživatelského
rozhraní

Volba více výřezů

Zvolte na monitoru Windows více výřezů
současně.

Více výřezů můžete zvolit pro:

l Snadné prohlížení detailů velkých
obrázků současným zobrazením více
kopií obrázku s různými koeficienty
zvětšení. Nejvíce zmenšený obrázek
použijte jako celkový pohled, s jehož
pomocí můžete zvolit požadovanou část
snímku.

l Úpravy koeficientu zvětšení více obrázků
současně. Pokud nastavíte koeficient
zvětšení ve výřezu, koeficient zvětšení
všech označených výřezů se automaticky
odpovídajícím způsobem upraví.

Ikony v oblasti pamě�ových polí obrázků

Prázdné pamě�ové pole

Obrázek v odstínech šedé: zahrnuje
obrázky s 256 (hloubka 8 bitů), 2 12 = 4096
(hloubka 12 bitů) nebo 2 16 = 16777 216
(hloubka 16 bitů) odstínů šedé. Minimální
hodnota je zobrazena černě, maximální
hodnota (maximální jas) bíle.

Binární obrázky: zahrnují pouze dvě
hodnoty pro vyjádření barvy – černou
a bílou.

Obrázky v pseudobarvách: obrázky
s 256 odstíny šedé. Jednotlivým odstínům
jsou dle určitého pravidla přiřazeny
libovolné barvy zobrazitelné na monitoru.
Příslušné barvy pouze barevně rozlišují
hodnoty obrazových bodů (pixelů), proto
jsou nazývány pseudobarvami.

Obrázky v barvách true Color nebo RGB:
zahrnuje obrázky s barevnou hloubkou
24 bitů (2 24 = 1622777 216 barev).

Fourierovy obrázky: obrázky s barevnou
hloubkou 32 bitů sestavené na základě
16 bitových reálných a imaginárních čísel.
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Uložení grafického uživatelského
rozhraní (Workspace)
Uložení rozvržení grafického uživatelského rozhraní jako pracovní plochy

1. Otevřete dokumenty všech typů, které si přejete zahrnout do Vašeho grafického uživatelského
rozhraní, například obrázky, databázi, tabulku s výsledky měření, grafy a diagramy. Uzavřete všechny
ostatní dokumenty.

l Pokud chcete skrýt okna správce výřezů (Viewport Manager) a správce obrázků (Image Manager),
stiskněte kombinace kláves [Alt]+[1] a [Alt]+[2].

2. Zvolte optimální uspořádání oken podle svých představ.

l Zatrhněte předvolbu Allow tiling and cascading of image window, kterou zpřístupníte příkazem
Special > Preferences > View. Potom zvolte příkaz Window > Tile vertical.

3. Zvolte příkaz File > Workspace > Save as...

l Do pole File name v dialogovém okně Save Workspace zadejte název pro Vaši pracovní plochu,
například „analyza“.

l Zrušte zatržení předvolby Load documents (not only layuot), aby se uložilo pouze rozvržení
grafického uživatelského rozhraní bez jakýchkoliv specifických dokumentů.

l Jestliže chcete zajistit, že se pracovní plocha po uzavření nezmění, zvolte položku Do not save.
l Klepněte na tlačítko Save.

Načtení pracovní plochy
4. Zatržením předvolby Workspace, kterou zpřístupníte příkazem Special > Edit Button Bars... >

Button bars aktivujte panel nástrojů Workspace.

➤ Panel obsahuje 5 tlačítek, která zastupují 5 pracovních ploch. První dvě tlačítka jsou již přiřazena
předdefinovaným pracovním plochám nazvaným „normal“ a „report“. Třetí tlačítko je přiřazeno
pracovní ploše, kterou jste právě vytvořili („analyza“).

l Pokud chcete provést libovolné změny v přiřazení tlačítek pracovním plochám, použijte příkaz File
> Workspace > Define Menu...

5. Nyní se podívejte na možnosti použití pracovní plochy:

1. Nejprve načtěte odlišnou pracovní plochu, například předdefinovanou pracovní plochu „normal“.
K načtení plochy stačí pouhé klepnutí na první tlačítko.

2. Zavřete všechny dokumenty.

3. Nyní načtěte vlastní pracovní plochu („analyza“). Stačí pouze klepnout na třetí tlačítko na panelu
tlačítek pracovních ploch.

4. Potom načtěte obrázky, databázi, tabulku a histogram. Všechny uvedené dokumenty budou
umístěny podle Vašeho rozvržení pracovní plochy.

Vytvoření pracovních plochy pro následující den
6. Zvolte příkaz File > Workspace > Save as... Do dialogového okna zadejte název pro pracovní

plochu. Zatrhněte předvolbu Load documents. Zvolte přepínač Confirm save on close a zavřete
dialogové okno.

➤ Tato pracovní plocha se přiřadí čtvrtému tlačítku.
l Na konci pracovního dne: Uložte všechny obrázky, které si přejete uchovat. Obrázky, které

neuložíte, se bez předchozí výstrahy smažou, a budou tak zcela ztracené.
Ukončete program analySIS®. Když se zobrazí dotaz, zda chcete uložit pracovní plochu, klepněte
na tlačítko Yes. Všechny dokumenty, které jste neuložili, způsobí zobrazení podobných hlášení.
Uložte všechny dokumenty, které si přejete uchovat.
Při příštím spuštění programu analySIS® se všechny tyto dokumenty automaticky načtou.
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Obrázek znázorňuje možnost nastavení pracovní plochy
(uloženého grafického uživatelského rozhraní – GUI) pro
optimální interaktivní měření. Jedinými zobrazenými prvky
GUI jsou okno Images a tabulka aktuálních naměřených
hodnot. V okně Images je jediný výřez obrázku v plné
velikosti. Jedinými zobrazenými panely nástrojů jsou
standardní panel nástrojů a panel nástrojů Workspace.
Správci výřezů a obrázků jsou vypnutí, všechna ostatní okna
pro dokumenty jsou minimalizovaná.

Zobrazená pracovní plocha se načte po klepnutí na třetí
tlačítko na panelu nástrojů Workspace. První dvě tlačítka
jsou přiřazena předdefinovaným pracovním plochám,
nazvaným „normal“ a „report“.

Použití programu analySIS®

Grafické uživatelské rozhraní
Načtení a zobrazení obrázků
Uložení grafického uživatelského
rozhraní

Grafické uživatelské rozhraní se nazývá
pracovní plocha a můžete je uložit do
souboru. Pracovní plocha zahrnuje
rozvržení všech oken s dokumenty a panelů
nástrojů i umístění oken správce výřezů
a správce obrázků. Může také obsahovat
specifické obrázky a dokumenty, které si
přejete mít načtené.

l Nastavení rozvržení GUI
Pracovní plochu můžete definovat pro
každý odlišný druh úloh, které provádíte
v programu analySIS®, takže můžete
optimalizovat rozvržení grafického
uživatelského rozhraní pro každý druh
úloh. Odlišné pracovní plochy mohou být
definovány pro pořizování snímků,
generování zpráv a analýzu obrázků.
Odlišné pracovní plochy Vám rychle
poskytnou potřebné rozvržení obrazovky.
l Opakované načtení obrázků/

dokumentů
V pracovní ploše mohou být uloženy
cesty k aktuálně načteným obrázkům
a dokumentům. Uložením aktuálního
GUI do pracovní plochy na konci
pracovního dne si pro následující ráno
usnadníte pokračování v práci tam, kde
jste ji přerušili. Všechny obrázky,
tabulky, grafy, databáze i zprávy, které
byly načtené v okamžiku uložení
pracovní plochy, budou právě tam, kde
jste je zanechali.

Výstraha: Před ukončením programu
analySIS® se ujistěte, zda jste uložili
všechny obrázky. Neuložené obrázky
se smažou bez předcházejícího
upozornění.

Konfigurace ve vztahu k pracovní ploše

Konfigurace určuje, jaké příkazy bude
možné aktivovat z nabídek, panelů nástrojů
a klávesnice, například z uživatelského
panelu nástrojů. Konfigurace uchovává
informaci o tom, jaké funkce jsou dostupné
v grafickém uživatelském rozhraní. Pracovní
plocha však uchovává informace
o aktuálním vzhledu GUI, včetně umístění
načtených specifických dokumentů.
Informace uchovávané v konfiguraci
a pracovní ploše jsou zcela odlišné.
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Konfigurace vstupů
1. Zvolte příkaz Image > Set Input...

➤ V dialogovém okně Set Input jsou uvedeny všechny aktivní logické vstupní kanály. Existující kanály
můžete duplikovat a potom upravit, případně můžete nastavit zcela nový vstupní kanál.

2. Klepněte na tlačítko New Channel.

➤ Otevře se dialogové okno Select Device.
Toto dialogové okno má předdefinované vstupy pro čtení všech obrazových signálů pomocí
instalované digitalizační karty.

3. V seznamu Available devices zvolte zařízení, které poskytuje požadovaný výstupní signál.

l Pokud chcete zobrazit všechny vstupy, které nabízí Vaše digitalizační karta,  klepněte na symbol +
ve stromové struktuře složek.

l Pokud je například zvolena barevná CCD kamera ColorView 12, měli byste zvolit hodnotu
ColorView 12, ColorView II nebo F-/ColorView.

4. Klepněte na tlačítko OK.

➤ Nový logický vstup se doplní do seznamu dostupných vstupních kanálů.

5. Chcete-li nastavit vlastnosti vstupního kanálu, klepněte na tlačítko Configure Input.

➤ Otevře se dialogové okno Configure Input.

6. Pokud chcete změnit název vstupního kanálu, klepněte na záložku Info.

7. Jestliže potřebujete nastavit parametry pro pořizování obrázků, klepněte na záložku karty Input.
l Obsah této karty závisí na druhu digitalizační karty a kamery, kterou používáte. To znamená, že

vzhled karty Input může být podstatně odlišný od následujícího popisu.
l V poli Camera je uveden videosignál poskytovaný videokamerou. Podrobnější informace

o kameře, teplotě snímače CCD atd.  zobrazíte klepnutím na tlačítko Info...

8. Pokud chcete při snímání obrázku pořizovat pro každý kanál (červený, zelený a modrý) 8bitová data
místo 12 bitových, zatrhněte předvolbu 8 bit mode.

l Při použití tohoto režimu se živý obraz i pořízené snímky rychleji vyhodnotí. Nevýhodou je, že
některé optimalizační operace, které se týkají zobrazení obrázku na monitoru i následného
zmenšení barevné hloubky (z 3 × 12 bitů na 3 × 8 bitů – které jsou dostupné v 8bitovém i 12bitové
režimu), nelze provést.

9. V poli Exposure zadejte čas v mikrosekundách, během kterých snímač CCD bude exponovat.

l Expoziční čas můžete interaktivně měnit při sledování živého obrazu v dialogovém okně Camera
Control. Okno otevřete příkazem Image > Camera Control...

l Na kartě Input můžete aktivovat nebo vypnout rychlé pořizování živého obrazu a zaostřovací filtry –
předvolby Fast live acquisiton a Sharpen filter. Stejné parametry můžete pohodlně nastavit
v dialogovém okně Camera Control při sledování živého obrazu.
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Vlastnosti logického vstupního kanálu se definují na
několika kartách v jednom dialogovém okně. Pro každou
odlišnou konfiguraci kamery můžete vytvořit samostatný
vstupní kanál. Program analySIS® podporuje až 100 kanálů.

Přes tyto vstupní kanály lze rovněž komunikovat se skenery
a kamerami, které používají softwarové rozhraní TWAIN.

Pořizování obrázků
Konfigurace vstupů
Kalibrace vstupů
Optimalizace zobrazení
Pořizování obrázků
Zobrazení měřítka

Logický vstupní kanál

Obsahuje všechna nastavení, která souvisejí
s pořizováním obrázku. Grafické uživatelské
rozhraní logického vstupního kanálu je
v podstatě stejné pro fyzicky odlišná
zařízení jako o jsou videokamery nebo
rozhraní pro skenování. Liší se až
dostupností funkcí v dialogovém okně
Configure Input.

Obrázky a příklady, uvedené v této kapitole,
odpovídají použití barevné CCD kamery
ColorView 12.

Vstupní kanál definuje následující:

l Fyzický vstup, přes který je videokamera
připojena k digitalizační kartě;

l Druh použitého obrazového signálu;
l Kalibrační data;
l Zobrazení živého obrazu ve výřezu;
l Makro příkazy, které se vykonají buï

před nebo po pořízení obrázku;

a další nastavení.

Oříznutí

Pokud si přejete, můžete při pořizování
obrázku odstranit okrajovou oblast.
Libovolná odřezávaná okrajová oblast se
volí na kartě Format.

Ořezávání má mnoho možností využití:

l K odstranění černých okrajů obrázků
(artefaktů), pořízených některými
kamerami.

l K odstranění okrajů obrázků, u nichž
došlo při pořizování kamerou nebo
mikroskopem k distorzi nebo podobně
obtížně odstranitelnému efektu na
okrajích.

l K zajištění standardního formátu obrázků,
aby byly při tisku všechny obrázky stejné
velké.
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Kalibrace vstupů
1. Pokud chcete kalibrovat aktuální logický vstupní kanál, zvolte příkaz Image > Configure Input...

(nebo klepněte na tlačítko Configure Input v dialogovém okně Set Input).

2. Klepněte na záložku XY Calibration.

3. Klepněte na tlačítko Unit... (Jednotky...).

l V seznamu Basic unit v dialogovém okně Set Unit (Volba jednotek) zvolte položku m (metry).
l Pokud chcete zobrazovat kalibrační vzdálenost v mikrometrech, zvolte v seznamu Scale položku µ.

Klepnutím na tlačítko OK nastavení potvrïte.

4. Zvolte odpovídající poměr X/Y pro Vaši kameru.

l Pokud má Vámi používaná kamera čtvercové obrazové body (pixely) prvku CCD (snímače),
zadejte pro parametr X/Y ratio hodnotu 1. Potom zatrhněte předvolbu Fixed.

5. Nastavte na mikroskopu nejmenší možné zvětšení.

6. Zadejte hodnotu zvětšení do pole Magnification.

7. Umístěte vhodný kalibrační preparát na stolek mikroskopu a zaostřete na něj.

l Prostřední obrázek na následující stránce ukazuje kalibrační měřítko v mikroskopu při
zvětšení 20×.

8. Klepnutím na tlačítko Snapshot pořiïte obrázek kalibračního preparátu. Obrázek se načte do
aktivního pamě�ového pole.

l Ke zvolení polohy preparátu a k zaostření využijte živý obraz. Stačí pouze klepnout na tlačítko
Acquire. Jakmile budete spokojeni, ukončete režim živý obraz klepnutím na tlačítko Snapshot.

9. Zadejte do vstupního pole Calibration length délku, kterou použijete ke kalibraci.

l Na obrázku na následující straně je mezi ryskami měřítka 30 a 80 vzdálenost 500 µm.

10. Zvolte přepínač Arbitrary v oblasti Calibration.

l Pokud bude obraz referenčního měřítka přesně ve svislém nebo vodorovném směru, můžete
použít odpovídající nabídky Vertical/Horizontal pro kreslení kalibrační úsečky.

11. Nyní klepněte na tlačítko Calibrate.

➤ Na aktivním obrázku se objeví kurzor myši.
l Přesuňte kurzor myši na počáteční bod pro kalibrační délku a klepněte levým tlačítkem myši.
l Přesuňte kurzor myši na koncový bod pro kalibrační délku a potvrïte jej klepnutím levým tlačítkem

myši. Délka modré čáry musí přesně odpovídat zvolené kalibrační délce.

12. Klepnutím na tlačítko Save... otevřete seznam kalibračních dat pro různá zvětšení.

13. Pokud seznam v dialogovém okně Magnification Table obsahuje chybné kalibrační údaje, klepněte
na tlačítko Delete All.

14. Potom klepnutím na tlačítko Add přidejte do seznamu kalibrační data, která jste právě získali. Data se
doplní i do grafu.

15. Klepnutím na tlačítko OK zavřete dialogové okno.

16. Nyní nastavte mikroskop na nejbližší vyšší zvětšení.

17. Opakujte kroky 6 až 16 pro všechna zvětšení, takže poslední kalibraci byste měli provést pro největší
zvětšení.

18. Klepnutím na tlačítko OK potvrïte provedenou kalibraci vstupu.
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Poklepejte na ikonu kamery na stavovém řádku, otevře se
dialogové okno Configure Input.

Kalibrační data můžete zkontrolovat v tabulce zvětšení. Graf
znázorňuje vzájemný vztah velikosti obrazového bodu
a zvětšení. Body na grafu by měly tvořit přímku. Můžete také
nastavit zvětšení vstupního kanálu, jehož hodnota není
v tabulce zvětšení zahrnuta. V takovém případě se použije
interpolace a chybějící kalibrace se dopočítá.

Pořizování obrázků
Konfigurace vstupů
Kalibrace vstupů
Optimalizace zobrazení
Pořizování obrázků
Zobrazení měřítka

Kalibrace vstupů

Kalibrace logického vstupu se provádí pro
všechny obrázky pořízené přes tento vstup.
Pokud chcete pořizovat správně kalibrované
obrázky, musí být vstup správně kalibrován.

(Image > Configure Input... > XY
Calibration)

Kalibrace obrázků

Kalibrační data existujícího obrázku mohou
být později upravena. To je nutné například
při pořízení obrázku použitím
nekalibrovaného vstupu, například při
použití skeneru.Jakýkoliv obrázek, který
chcete kalibrovat po jeho pořízení, musí
samozřejmě obsahovat známou délku,
například měřítko vložené do obrazu.

(Image > Calibration Image...)

Nastavení zvětšení

Jestliže chcete zajistit správnou kalibraci
obrázků, musíte opětovně nastavit zvětšení
v programu analySIS®, kdykoliv změníte
nastavení mikroskopu (například
mikroskopy BX61, AX70, IX81 apod. –
změna objektivu, měniče zvětšení, zoomu
stereomikroskopu, výměna fotoprojektivů
apod.). Pokud chcete změnit zvětšení pro
aktivní logický vstup, zvolte Image > Set
Magnification...

Dálkové ovládání

Program analySIS® spolupracuje s mnoha
světelnými a elektronovými mikroskopy
prostřednictvím dálkového ovládání. Pokud
máte dálkově připojený mikroskop, program
analySIS® automaticky načte aktuálně
nastavené zvětšení mikroskopu.

(Image > Configure Input... > Magnification
> Remote > On).
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Optimalizace živého obrazu
1. Zvolte příkaz Image > Configure Input ...(nebo klepněte na tlačítko Configure Input v dialogovém

okně Set Input).

2. Klepněte na záložku Display.

3. Zatrhněte předvolbu Display warning v oblasti Over exposure.

4. Zadejte hodnotu 0,5 do pole Overflow.

➤ Nyní jakmile bude při pořizování obrázku více než 0,5 % ze všech obrazových bodů bílých, zobrazí
se varování: „Attention! Over-exposure!“ (Pozor! Přeexponováno!).

5. Zatrhněte předvolbu Activate v oblasti Automatic gain display.

➤ Obrázky budou nyní vždy zobrazeny s optimálním kontrastem bez ohledu na aktuální expoziční
podmínky.

6. Zadejte hodnotu 0,5 do pole Right overflow.

➤ 0,5 % nejjasnějších obrazových bodů se nyní zobrazí jako bílé.
l Hodnota Right overflow brání příliš jasným obrazovým bodům, aby ovlivňovaly automatické

vylepšení obrazu.
l Deaktivace funkce Right overflow zabrání u fluorescenčního obrazu zbytečné „saturaci“

nejjasnějších míst obrazu z fluorescenčního mikroskopu.
l Hodnota Left overflow brání ovlivnění obrazu ojedinělými extrémně tmavými body. Použití

hodnoty Left overflow (například 0,5 %) výrazně zlepší dosažení „černého pozadí“ vyžadovaného
například u fluorescenčního obrazu. Pro kameru ColorView 12 však nelze nastavit.

7. Po zatržení předvolby Online histogram budete moci během pořizování obrázků kontrolovat
rozložení intenzity (intenzitou se rozumí hodnota pro všechny tři barevné kanály).

➤ Histogram se při pořizování obrázku zobrazí automaticky. Můžete kontrolovat využití rozsahu
digitalizace obrazu Vaším zařízením.

➤ Kromě histogramu se zobrazí minimální, střední a maximální hodnota intenzity pro aktuální
obrázek. Procentuální hodnota se vztahuje k maximální hodnotě šedé, dostupné při použití
konkrétní kamery. Pro 12bitovou kameru je hodnota 4095, pro 8bitovou kameru 255.

8. Po zatržení předvolby Live overlay budete moci zaznamenávat informace, například interaktivně
měřit přes živý obraz.

9. Zvolte jednu ze čtyř dostupných položek v seznamu Image scaling.

l Underscan: Koeficient zvětšení (25 %, 50%, 100 %) se automaticky volí tak, aby byl ve výřezu
zobrazen celý obrázek, tzn. že část plochy výřezu nemusí být zakryta obrázkem.

l Overscan: Nejnižší koeficienty zvětšení (25 %, 50%, 100 %) se automaticky volí se tak, aby byl celý
výřez zaplněn obrázkem, tzn. že obraz nemusí být ve výřezu zobrazen celý.

l Adjust to viewport: Velikost obrázku se upraví tak, aby se přizpůsobil aktuální velikosti výřezu.
l Full size (100 %): Obrázek se zobrazí v plné velikosti – nezvětšený. Pokud je výřez menší než

obrázek, zobrazí se pouze část obrázku, která vyplní výřez.

10. Klepnutím na tlačítko OK potvrïte právě provedené nastavení.
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Histogram na obrázku znázorňuje rozložení odstínů šedé
v úzkém pásmu. Bez automatického vylepšení obrazu bude
obrázek tmavý a málo kontrastní. Automatické vylepšení
obrazu rozšíří aktuální pásmo odstínů šedé, a zlepší tak
zobrazení na monitoru. Struktury na obrázku tak budou
mnohem lépe viditelné.

Zvolená hodnota v seznamu Image scaling určuje prioritu,
podle které se upraví koeficient zvětšení pro výřez.

Pořizování obrázků
Konfigurace vstupů
Kalibrace vstupů
Optimalizace zobrazení
Pořizování obrázků
Zobrazení měřítka

Karta Display Vám poskytuje množství
způsobů, jak optimalizovat živý obraz
a zobrazení snímků na obrazovce.

Zahrnuje:

l Zobrazení výstrahy při přeexponování;
l Zobrazení s kontrastem zvýšeným

pomocí automatického nebo trvale
nastaveného vylepšení kontrastu, i když
budou podmínky pro pořízení snímku
nevyhovující (automatické vylepšení nebo
pevná stupnice);

l Kontrolu současného rozložení intenzity
(intenzitou se rozumí všechny tři barevné
kanály) během pořizování obrázku
prostřednictvím histogramu, resp.
histogramu šedých odstínů a jejich
četnosti poskytovaných Vaší černobílou
kamerou;

l Aktivaci zobrazování údajů přes živý
obraz (měření, kalibrační mřížky apod.);

l Definici měřítka pro obrázek zobrazený
ve výřezu.

Zobrazování údajů přes živý obraz

Pokud je zatržená předvolba Live overlay,
bude se překryvná vrstva (overlay)
zobrazovat přes živý obraz.

To znamená, že můžete:

l Provádět různá měření na živém obraze
i doplňovat výsledky přes živý obraz;

l Zobrazit automatické měřítko a mřížku
(grid) přes živý obraz;

l Zvýraznit a označit detaily obrázku při
pozorování živého obrazu (nebo obecněji
– zapisovat texty a vkládat obrázky do
překryvné vrstvy).

Vliv na informace o obrázku

Parametry na kartě Display neovlivňují
informace o aktuálním obrázku. Výjimka:
Pokud je aktivováno zvýšení kontrastu při
použití kamery ColorView 12, když je
obrázek konvertován z 3 × 12 bitů na
3 × 8 bitů, projeví se to na optimalizovaném
kontrastu.
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Pořizování obrázků
Určení pamě�ového pole a výřezu pro pořizování obrázku

1. Klepněte ve správci obrázků (Image Manager) na pamě�ové pole (Image Buffer), do nějž si přejete
umístit obrázek z kamery.

➤ Aktivní pamě�ové pole je barevně zvýrazněno.
➤ Výřez, který je aktuálně propojen s aktivním pamě�ovým polem, má barevné záhlaví v obrazovém

dokumentu i ve správci výřezů.

2. Pokud si přejete zobrazit obrázek z kamery v jiném výřezu, stačí uchopit pamě�ové pole obrázku
a přetáhnout je na požadovaný výřez ve správci výřezů. Potom na pamě�ové pole klepněte levým
tlačítkem myši.

Jak správně nastavit zvětšení před pořízením obrázku
3. Jestliže chcete řádně nastavit zvětšení tak, aby výsledné obrázky byly správně kalibrované, zvolte

příkaz Image > Set Magnification...
l Uvedený postup je nutné provést pouze v případě, že zvětšení se automaticky nenačítá

prostřednictvím dálkového ovládání (str. 21 – dálkové ovládání – Image > Configure Input... >
Magnification > Remote > On).

➤ Seznam Magnification zahrnuje všechna zvětšení, která jste uložili do tabulky zvětšení (Image >
Calibrate Input...> XY Calibration > Save...).

4. Klepněte v seznamu na zvětšení, které je právě nastaveno na mikroskopu, a potom klepněte na
tlačítko OK.

l Můžete také zadat zvětšení, které není uvedeno v seznamu. Program analySIS® k zjištění
správnosti kalibrace obrázku použije interpolaci a chybějící kalibraci dopočítá.

Pořízení obrázku
5. Zvolte příkaz Image > Acquisition, na obrazovce se objeví živý obraz.

➤ Pokud je zobrazen živý obraz, bliká ikona kamery na stavovém řádku a název vstupního kanálu je
zobrazen červeně.

➤ Živý obraz se zobrazí v aktuálním výřezu.
l Velikost obrazu ve výřezu závisí na hodnotě zvolené v seznamu Image scaling na kartě Display

(Image > Configure Input...).

6. Ovládacími prvky mikroskopu upravte osvětlení, polohu preparátu a zaostření.

7. Zvolte příkaz Image > Camera Control..., budete moci optimalizovat kvalitu pořizovaného obrázku
nastavením expozičního času, barvy, jasu, kontrastu a zaostření, resp. vyvážení bílé.

l Zavřete dialogové okno Set Input, protože jinak nebude příkaz Camera Control... přístupný.
l Funkce v dialogovém okně Camera Control závisí na digitalizační kartě a kameře.

8. Jestliže chcete zastavit živý obraz, zvolte příkaz Image > Snapshot.
➤ Obrázek se vloží do aktivního pamě�ového pole programu analySIS®. Nyní jej můžete upravovat,

zpracovávat a archivovat.
➤ Obrázkům se přiřazuje standardní název, který ovlivňuje nastavení parametrů Prefix for images

a Incremental number na kartě Image (Special > Preferences...).
l Snímek můžete samozřejmě pořídit i bez předchozího zobrazení živého obrazu.
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Funkce, dostupné v dialogovém okně Camera Control, se liší
v závislosti na použitém modelu kamery. Pokud používáte
ColorView 12, vypadá okno Camera Control následovně:

Exposure time
(Expoziční čas)

Definuje dobu, po kterou je snímač CCD kamery
osvětlen. Tlačítky + a – se expoziční čas nastavuje
v pseudologaritmických krocích. Po stisknutí tlačítka
Auto se expoziční čas nastaví automaticky pro živý
obraz na základě hodnot o rozložení odstínů šedé,
zjištěných z histogramu.

Color Settings
(Nastavení barev)

Otevírá dialogové okno pro nastavení kontrastu, jasu
a filtru gama posuvnými lištami. Pro červenou,
zelenou a modrou mohou být zobrazeny samostatné
posuvné lišty.

White Balance
(Vyvážení bílé)

Koriguje efekty v tónování barev v živém obraze nebo
v automaticky pořizovaném snímku. Při vyvážení bílé
se jas a kontrast všech tří barevných kanálů (červené,
zelené, modré) automaticky nastaví tak, aby se celý
obrázek nebo jeho část v rámečku zobrazily co
nejvěrohodněji barevně.

Sharpen Filter On/Off
(Zapnutí/vypnutí
zaostřovacího filtru)

Aktivuje nebo ruší použití zaostřovacího filtru, kterým
se zaostřuje nebo zjemňuje vzhled obrázku,
v závislosti na nastavení filtru.

Sharpen Filter Settings
(Histogram nastavení
zaostřovacího filtru)

Otevírá dialogové okno pro nastavení parametrů
zaostřovacího filtru posuvnými lištami. Dostupné jsou
hodnoty v rozsahu od –30 (jemný) do +30 (ostrý). Po
nastavení hodnoty 0 se filtr neuplatňuje.

Fast Acquisition
(Rychlé snímání)

Aktivuje/ruší rychlé snímání živého obrazu. Průběžná
aktualizace živého obrazu se urychlí, současně však
poklesne jeho kvalita.

Use automatick gain
display (Použití
automatického
vylepšení obrázku)

Aktivuje/ruší automatické vylepšení obrázku.
Při aktivaci se, bez ohledu na aktuální expoziční
podmínky, obrázek zobrazí na obrazovce
s optimálním kontrastem.

Histogram calculation
on full image (Výpočet
histogramu pro celý
obrázek)

K výpočtu histogramu aktuálního rozložení odstínů
šedé se využijí všechny obrazové body.

Histogram calculation
on crosshair (Výpočet
histogramu podle
záměrného kříže)

K výpočtu histogramu aktuálního rozložení odstínů
šedé se využijí pouze body v oblasti vymezené
segmenty záměrného kříže (každý segment
záměrného kříže je široký několik obrazových bodů).

Histogram calculation
on ROI. (Výpočet
histogramu podle
zvolené oblasti)

K výpočtu histogramu aktuálního rozložení odstínů
šedé se využijí pouze body ohraničené uživatelsky
nastavitelným rámečkem.

Set ROI (Nastavení
oblasti)

Vytvoří červený rámeček na obrázku. Polohu
a velikost rámečku můžete nastavit myší (zatímco je
stisknuté levé tlačítko myši). Po klepnutí pravým
tlačítkem myši rámeček zmizí.

Pořizování obrázků
Konfigurace vstupů
Kalibrace vstupů
Optimalizace zobrazení
Pořizování obrázků
Zobrazení měřítka

Režim snímání živého obrazu

Zobrazuje živý obraz v aktivním
výřezu. Tento režim je určen pro
zaostřování, nastavení osvětlení
a nastavení vhodné polohy preparátu
v mikroskopu. Uvedené příkazy se
vztahují k režimu snímání živého
obrazu, a proto jsou v něm dostupné.

Pořizování snímků

Pokud chcete pořizovat snímky přes
logický vstupní kanál a vkládat je do
aktivního pamě�ového pole, zvolte
příkaz Image > Snapshot. Uvedený
příkaz použijte také k ukončení
režimu snímání živého obrazu. Při
pořizování snímku se ukládají
doplňkové informace o snímku,
například kalibrační data a aktuální
vstupní zvětšení. Chcete-li zpřístupnit
některou z uvedených informací,
klepněte pravým tlačítkem myši na
pamě�ové pole.

Ovládání kamery

Zajiš�uje rychlý a snadný přístup
k nejdůležitějším parametrům kamery
– interaktivně během snímání
živého obrazu. Pokud provádíte
měření denzity, vyvarujte se
provádění změn v nastavení kamery
mezi jednotlivými měřeními. Mohl
by se narušit soulad mezi signály
fyzického vstupu a hodnotami
barev/odstínů šedé obrázku, tzn. že
jejich vztah by již nebyl jednoznačný.

Pokud potřebujete manuálně upravit
nastavení barev vstupního kanálu,
aktivujte histogram, který Vám
umožní si prohlédnout dynamický
rozsah obrázku.

25



Pořizování obrázků
Jak změnit název obrázku po jeho pořízení

1. Poklepejte na pamě�ové pole obrázku, jehož název chcete změnit.

➤ Otevře se dialogové okno Image Information.
l Na kartě General jsou uvedeny všechny informace o obrázku automaticky načtené při pořízení

snímku.
l Na kartě Channel data jsou všechna data o logickém vstupním kanálu, použitém při pořízení

snímku.

2. Zadejte nový název obrázku do pole Image name na kartě General.

3. Zapište libovolné poznámky k obrázku, případně jeho vyhodnocení do pole Comment.
l Po zadání kódu ${Comment} do záhlaví nebo zápatí při rozvržení stránky se budou automaticky

společně s obrázky tisknout i komentáře.
l Pokud chcete obrázek archivovat, použijte klíčová slova z vytvořeného komentáře, abyste mohli

obrázek vyhledávat v databázi obrázků programu analySIS®.

4. Klepnutím na tlačítko OK potvrïte provedené změny.

➤ V pamě�ové oblasti se automaticky zobrazí nový název obrázku.
➤ Nový název obrázku je nyní nastaven jako výchozí a bude nabízen v případě, že chcete uložit

obrázek do souboru nebo vložit jako záznam do databáze programu analySIS®.

Automatický dotaz na zvětšení při pořizování obrázku
Doplnění příkazu Image > Set Magnification... do logického vstupního kanálu.

1. Poklepejte na ikonu Input vstupního kanálu na stavovém řádku.

➤ Otevře se dialogové okno Configure Input pro aktivní logický vstupní kanál.

2. Klepněte na záložku Macro.

3. Zadejte příkaz pro požadovanou funkci do pole Preprocessing steps a doplňte na konec řádku
středník.

SetMagnification$();

4. Pokud chcete přezkoušet toto jednoduché makro, klepněte na tlačítko Execute.

l Pokud se zobrazí chybové hlášení, zkontrolujte správnost zápisu příkazu.
l Pokud se zobrazí dialogové okno Set Magnification, makro pracuje správně. Potom klepněte na

tlačítko OK.

5. Zatrhněte předvolbu Enabled.

6. Klepnutím na tlačítko OK zavřete dialogové okno Configure Input.

7. Pokud chcete zkontrolovat vstupní kanál, klepněte na tlačítko Snapshot na panelu nástrojů
Standard.

➤ Program analySIS® otevře dialogové okno Set Magnification před pořízením obrázku.
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Use fixed scaling
(Použít pevné
měřítko)

Aktivuje/ruší zvýšení kontrastu podle pevné
stupnice. Nepoužívá se průběžně aktualizovaný
histogram odstínů šedé, ale pevně zvolené
meze pro odstíny šedé.

Automatically adjust
fixed scaling
(Automaticky
nastavit pevné
měřítko)

Automaticky přepočítá meze pro odstíny šedé
používané pří zvýšení kontrastu podle pevné
stupnice.

Manually adjust
fixed scaling
(Manuálně nastavit
pevné měřítko)

Otevře dialogové okno pro manuální nastavení
mezí pro odstíny šedé používané pří zvýšení
kontrastu podle pevné stupnice.

Informace o obrázku zahrnují všechny údaje uložené
s obrázkem. Na uvedeném obrázku se název obrázku
a název souboru neshodují. Libovolné informace, které si
přejete archivovat s obrázkem, můžete doplnit do pole pro
komentáře.

Pořizování obrázků
Konfigurace vstupů
Kalibrace vstupů
Optimalizace zobrazení
Pořizování obrázků
Zobrazení měřítka

Název obrázku

Je název obrázku v pamě�ovém poli
programu analySIS®. Název obrázku se
nemusí nutně shodovat s názvem souboru
nebo názvem záznamu obrázku v databázi.

Název souboru

Je název souboru s obrázkem, který je
uložen například na pevném disku.

Název záznamu

Je název obrázku uloženého v databázi.
Název záznamu může představovat celou
sadu obrázků, které jsou připojeny ke
vkládanému obrázku jako dokumenty.

Výchozí název obrázku

Při pořizování je obrázku přiřazen výchozí
název. Pokud chcete změnit výchozí název,
zvolte příkaz Special > Preferences... >
Image > Image acquisition > Prefix for
images/Incremental number.

Makra pro vstupní kanál

Koncepce vstupního kanálu zahrnuje
definici základních příkazů pro vytváření
maker pro vstupní kanál. Klepněte na
záložku Macro v dialogovém okně
Configure Input a zadejte příkazy pro makra,
které se mají vykonat před nebo po pořízení
obrázku.

l Můžete například nastavit zvětšení před
pořízením obrázku a aktivovat následující
pamě�ové pole, jakmile pořídíte obrázek.

l Můžete například obrázek vložit přímo do
aktivní databáze, jakmile jej pořídíte.

l Můžete například vypnout světelný zdroj
mikroskopu před pořízením obrázku
a následně jej znovu zapnout, jakmile
obrázek pořídíte.
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Zde můžete zadat Váš komentář k obrázku.

Komentáře se mohou automaticky tisknout
s obrázkem. Jestliže obrázky archivujte, můžete je
vyhledávat podle jednotlivých slov komentáře.

Tyto hodnoty
vyplývají z kalibrace
a dat logického
vstupního kanálu,
použitého pro
pořízení obrázku.

Oblast pro pamě�ová
pole obrázků

Název obrázkuČíslo obrázku



Automatické měřítko
Jak zobrazit měřítko

1. Načtěte správně kalibrovaný obrázek do aktivního pamě�ového pole. Použijte například obrázek
„Demo“ z ukázkové databáze.

2. Stisknutím kombinace kláves [Shift]+[F4] zobrazte/skryjte měřítko na obrazovce.
Můžete také zvolit příkaz Image > Scale Bar > Show in Viewport.
➤ V pravém dolním rohu výřezu se zobrazí měřítko.
l Zobrazení měřítek je globální nastavení. To znamená, že měřítko bude zobrazeno buï ve všech

výřezech, nebo nebude zobrazeno v žádném výřezu.

Změna vlastností měřítka
1. Zvolte příkaz Image > Scale Bar > Properties...

2. Klepněte na záložku Display v dialogovém okně Automatic Scale Bar. Na kartě Display se
nastavuje druh a umístění měřítka.

l V oblasti Scale bar selection zvolte požadovaný druh měřítka. Kromě obvyklého vodorovného
měřítka je k dispozici svislé měřítko a pruh s paletou barev. Pruh s paletou barev ukazuje, jak si
vzájemně odpovídají hodnoty barev a odstínů šedé v obrázcích s pseudobarvami. Hodnota Z se
zobrazuje pro obrázky kalibrované kalibrací z.

l V oblasti Show scale bar zvolte umístění automatického měřítka. Měřítko se může zobrazovat ve
výřezech (Viewport), na tiskových výstupech (Printer) nebo v kopiích ve schránce (Clipboard).
Můžete zvolit také libovolnou kombinaci uvedených možností.

3. Pokud chcete nastavit vzhled měřítka, klepněte na záložku Format.

l V oblasti Scale bar styles můžete zvolit jedno ze tří odlišných měřítek. Měřítka mohou mít bílý,
žlutý nebo průhledný rámeček. Pokud zvolíte průhledný rámeček, nastavte libovolnou barvu pro
popis měřítka.

l Pokud si přejete obrázky s automatickým měřítkem exportovat přes schránku do jiných aplikačních
programů, například MS Word, zatrhněte předvolbu Adjust to printer frame. Velikost měřítka se
upraví podle aktuálních tiskových rozměrů. Samozřejmě musí být známá a správně zadaná tisková
oblast.

l Do pole Clipboard/Burn image zadejte velikost písma pro tiskové výstupy, kopírování do schránky
nebo vkládání údajů.

l V poli Font size zvolte požadovanou velikost písma pro popis všech měřítek. Program analySIS®

použije zvolenou velikost písma při tisku obrázků a při jejich kopírování do schránky. Velikost
písma nastavená v poli Font size neovlivní zobrazení měřítek na obrazovce.

4. Klepnutím na tlačítko OK potvrïte nastavené hodnoty.

l Všechna nastavení, která souvisejí s měřítky, jsou globální, to znamená, že se projeví na všech
načtených obrázcích.
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V zobrazené ukázce je obrazový dokument rozdělen do čtyř
výřezů. Ve všech čtyřech výřezech je zobrazen stejný
obrázek, ovšem s odlišnými koeficienty zvětšení.

Na obrázku jsou zobrazena vodorovná a svislá měřítka
i pruh s paletou barev. Pruhy s paletou barev ukazují, jak si
vzájemně odpovídají hodnoty barev a odstínů šedé
v obrázcích s pseudobarvami (vlevo). U obrázků,
kalibrovaných kalibrací z, udávají pruhy s paletou barev, jak
si odpovídají odstíny šedé a hodnoty z (vpravo). Zobrazená
ukázka obsahuje mapu výšek, generovanou například
modulem Stereo.

Pořizování obrázků
Konfigurace vstupů
Kalibrace vstupů
Optimalizace zobrazení
Pořizování obrázků
Zobrazení měřítka

Automatické měřítko

Ve výřezech se zobrazuje měřítko, které při
práci s programem analySIS® průběžně
ukazuje kalibraci obrázků, bez ohledu na
nastavení výřezu.

Měřítka a kalibrace obrázku

Program analySIS® vypočítává délku
měřítka na základě kalibrace aktuálního
obrázku. Vždy se přesvědčte, zda jsou
obrázky správně kalibrované.

l Obrázky pořízené prostřednictvím
programu analySIS® budou automaticky
kalibrovány, pokud je kalibrován použitý
vstupní kanál.

l Při práci s obrázky importovanými z jiné
aplikace zvolte před zobrazením měřítka
příkaz Image > Calibrate > Image...

Výstraha: Automatické měřítko nepřekrývá
obrázek, jedná se o vlastnost výřezu.
Měřítko je propojeno se souřadnicovým
systémem výřezu a zobrazuje se trvale na
stejném místě. Velikost a umístění měřítka
a velikost písma zůstávají zachované i když
posunete obrázek ve výřezu nebo změníte
koeficient zvětšení. Kalibrační délka bude
vždy nastavena tak, aby se přizpůsobila
aktuálnímu koeficientu zvětšení ve výřezu.
Můžete také zvolit automatické nastavení
jednotek tak, abyste se vyvarovali zobrazení
příliš velkých nebo příliš malých číselných
hodnot.
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Uložení obrázků
1. Zvolte pamě�ové pole s obrázkem, který si přejete uložit.

2. Zvolte příkaz File > Save.

l Obrázky můžete také uložit pouhým uchopením a přetažením na ikonu pro ukládání ve správci
obrázků.

➤ Zobrazí se dialogové okno Save Image As.

3. Zadejte cestu ke složce, do které si přejete uložit obrázek. Do pole File name zadejte název, pod
kterým chcete obrázek uložit. Program analySIS® automaticky nabídne pro uložení do souboru
aktuální název obrázku.

4. Zvolte požadovaný formát obrázku v seznamu Files of type. Všeobecně je nejvhodnější formát TIF
(TIFF).

l Formát TIF je jediný formát, u kterého se ukládá nejenom vlastní obrázek, ale také všechny
doplňkové atributy, jako jsou překryvné objekty a vrstvy, kalibrace obrázku, údaje o vstupním
kanálu a komentáře k obrázku.

l Příkazem File > Arange Image File Formats... můžete uspořádat formáty obrázků podle
požadovaného kritéria, tzn. nejčastěji používané formáty přesuňte na začátek seznamu. Formáty
obrázků, které nepoužíváte, můžete skrýt.

5. Klepnutím na tlačítko Options... v dialogovém okně Save Image As zpřístupněte obecné parametry,
které se vztahují k ukládání obrázků.

➤ Otevře se dialogové okno Preferences s kartami, včetně karty Save.

6. V oblasti TIFF compression zvolte přepínač No compression.

l Komprimace obrázku zpravidla způsobí artefakty, proto byste měli komprimovat pouze obrázky,
které jste již analyzovali nebo přeměřili.

7. Určete, jakým způsobem se s obrázkem uloží překryvná vrstva.

❑ Zrušte zatržení předvolby Burn overlay into images on save. Překryvná vrstva se uloží společně
s obrázkem, ale zachová se jako samostatný objekt. To znamená, že obrázek i překryvná vrstva
mohou být nadále zobrazovány a po načtení do programu analySIS® také upravovány odděleně.
Při tomto procesu se neztratí žádná data obrázku.

✔ Zatrhněte předvolbu Burn overlay into images on save, pokud plánujete exportovat obrázek do
jiné aplikace, například MS Word. Jedná se o jediný způsob, jak zajistit, aby jiná aplikace načetla
překryvnou vrstvu.

8. Klepnutím na tlačítko OK potvrïte nastavené hodnoty.

➤ Vrátíte se do dialogového okna Save Image As.
➤ V poli Compression se zobrazí použitá komprimační metoda.

9. Klepněte na tlačítko Save.
➤ Obrázek se uloží do zvolené složky.

Odstranění obrázku z pamě�ového pole (ve správci obrázků)
10. Pokud chcete odstranit obrázek z pamě�ového pole, zvolte příkaz Image > Delete Image.

➤ Obrázek se odstraní z pamě�ového pole programu analySIS®. Pro obrázek, který jste právě uložili,
není tento příkaz účinný.

l Obrázek můžete odstranit také pouhým uchopením a přetažením na ikonu ve tvaru odpadkového
koše v dolní části správce obrázků nebo stisknutím klávesy [Delete].
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Komprimace Velikost souboru

Žádná 4 097 KB

JPEG, kvalita 75 % 504 KB

JPEG, kvalita 50 % 327 KB

JPEG, kvalita 25 % 219 KB

Komprimace JPEG značně zmenšuje velikost souboru.

Nekomprimovaný obrázek s koeficientem zvětšení 50 %
(vlevo nahoře) a 400 % (vlevo dole)

Komprimovaný obrázek formátu JPEG (kvalita 5 %)
s koeficientem zvětšení 50 % (vpravo nahoře) a 400 %
(vpravo dole)

Při velkém zvětšení (vpravo dole) jsou zřetelně viditelné
artefakty způsobené příliš velkou komprimací JPEG.

Program analySIS® podporuje mnoho formátů obrázků od
nejběžnějších po specializované, používané odpovídajícími
systémy pro vytváření obrázků.

Pro snadný a rychlý přístup k základním operacím, jako jsou
mazání, ukládání, tisk a vkládání do databáze použijte
oblast s ikonami ve správci obrázků.

Ukládání/Tisk/Odesílání
elektronickou poštou
Ukládání obrázků
Tisk obrázků
Odesílání elektronickou poštou

Ukládání obrázků

Program analySIS® Vám nabízí následující
možnosti pro ukládání:

l ukládání komprimovaných obrázků
l vkládání překryvné vrstvy do obrázku při

ukládání
l ukládání 16bitových obrázků s barevnou

hloubkou 8 bitů

Databáze obrázků

Pokud potřebujete uložit mnoho obrázků,
je velmi vhodné vytvořit databázi obrázků.
Databáze odstraňuje nutnost správy
souborů s obrázky a také nabízí rozsáhlou
sadu nástrojů pro vyhledávání, takže
nalezení potřebných obrázků Vám
nezpůsobí vůbec žádné potíže.

Komprimace obrázku

Program analySIS® podporuje rozsáhlou
sadu komprimačních metod, které zmenšují
velikost souborů s obrázky. To je velmi
důležité například při odesílání obrázků
elektronickou poštou.

Packed bits

Tato komprimační metoda nahrazuje
posloupnost stejných bajtů jedním bajtem
a údajem o počtu jeho opakování. Tato
metoda nezpůsobí artefakty v obrázku,
ovšem lze ji použít pouze pro obrázky, které
neobsahují příliš struktur.

JPEG
(Joint Photographics Experts Group)

Tato komprimační metoda poskytuje
vynikající výsledky pro obrázky v odstínech
šedé nebo barvách true color. Formát JPEG
však způsobuje artefakty; s rostoucím
stupněm komprimace narůstá počet
artefaktů.

Formáty souborů s obrázky

Aby bylo možné obrázky číst, upravovat
a ukládat, musí být v určitých formátech.
Některé z mnoha formátů pro obrázky se
staly standardem.

Formát obrázku ovlivňuje například typ,
šířku a výšku obrázku, příponu souboru,
polohu LUT a hodnoty obrazových bodů.
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Tisk obrázků
Nastavení tisku více obrázků na jednu stranu

1. Zvolte příkaz File > Define Page Layout...

2. Pokud chcete zvolit umístění záhlaví a zápatí, klepněte na záložku Single Image.

l V oblasti Border nastavte okraje v centimetrech. Podívejte se na obrázek na následující stránce,
abyste viděli, jaká jsou v této oblasti vstupní pole.

l Záhlaví i zápatí mohou obsahovat více řádků textu. Pokud je text příliš dlouhý, nevytiskne se celý,
tzn. že se ořízne.

l Pokud chcete zachovat na výstupech poměr stran původního obrázku, zatrhněte předvolbu Fixed
image ratio.

3. Jestliže chcete nastavit pro celou stránku společné záhlaví a zápatí (první vlevo, pokračující zleva
doprava), klepněte na první záložku Header/Footer.

l Zadejte požadovaný text do polí Header a Footer, například strana ${Page}, datum ${Today}.
Na stránku se vytiskne číslo stránky a aktuální datum.

4. Pokud chcete nastavit odlišené záhlaví a zápatí pro každý obrázek, klepněte na druhou záložku
Header/Footer.

l Pokud chcete pod každým obrázkem automaticky tisknout název, zadejte do pole Footer text
${Name}.

l Jestliže chcete pod každým obrázkem vytisknout měřítko, zatrhněte předvolbu Print scalebar.
l Pokud chcete tisknout i záhlaví a zápatí nastavené v kroku 3, zatrhněte předvolbu Print page

header/footer.

5. Po klepnutí na záložku Multiple Images můžete zvolit umístění obrázků na stránce.

l V oblasti Image titles zvolte umístění obrázků pro tiskový výstup.
Do pole Horizontal zadejte počet obrázků na stránce ve vodorovném směru, do pole Vertical počet
obrázků na stránce ve svislém směru.

l Zvolte vzdálenost mezi obrázky a v oblasti Border vzdálenost záhlaví a zápatí. Okraje stránky se
upraví podle nastavení na kartě Single Image.

6. Klepněte na tlačítko Print..., zobrazí se dialogové okno Print Image. Jakmile zvolíte rozvržení stránky,
můžete zvolit příkaz File > Print...

7. Zvolte položku Multiple Images v seznamu Page Layout v dialogovém okně Print Image.

l Seznam obsahuje také položku Single Image, abyste mohli tisknout obrázky po jednom na
stránku.

8. V oblasti Print images zvolte přepínač All Images, vytisknou se všechny aktuálně načtené obrázky.

l Pokud jste zvolili přepínač Range of images, musíte do pole pod přepínačem zadat odpovídající
čísla pamě�ových polí, například při zápisu 4-7, 3 se vytisknou obrázky z pamě�ových polí 4, 5, 6,
7, 3.

9. Klepnutím na tlačítko OK spus�te tisk.

➤ Počet vytištěných stránek se bude automaticky odpovídat počtu zvolených obrázků.
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Můžete definovat své vlastní standardní rozvržení stránky
pro: tisk jednoho nebo více obrázků, tisk obrázků
z databáze analySIS® a také tisk textů, tabulek, schémat
a grafů.

Kódy proměnných v záhlaví/zápatí

${Name} Název obrázku nebo dokumentu

${Comment} Komentář k obrázku

${Buf} Číslo pamě�ového pole obrázku

${Page} Číslo stránky

${Copy} Číslo kopie

${PrintMag} Zvětšení obrázku na papíru

${Date} Datum vytvoření obrázku

${Time} Čas vytvoření obrázku

${Now} Čas tisku

Ukládání/Tisk/Odesílání
elektronickou poštou
Ukládání obrázků
Tisk obrázků
Odesílání elektronickou poštou

Rozvržení pro tisk

Při použití programu analySIS® můžete
nastavit odlišné rozvržení pro tisk pro různé
druhy dokumentů. Rozvržení pro tisk
obsahují rozvržení stránek pro:

l jednotlivé obrázky
l více obrázků
l obrázky z databáze
l ostatní dokumenty programu analySIS®,

například tabulky nebo grafy

Rozvržení stránky se skládá z definice
záhlaví/zápatí, rozmístění a zvětšení
obrázků.

Kódy proměnných v záhlaví/zápatí

Použitím předdefinovaných kódů
proměnných v záhlaví a zápatí můžete
automaticky vkládat určité informace nebo
údaje o dokumentu. Kódy proměnných vždy
začínají symbolem $ a jsou umístěny ve
složených závorkách. Pokud chcete
vytisknout s obrázkem i jeho název, měli
byste zadat následující řetězec: ${Name}.

Kontextově závislá nastavení tisku

Příkaz File > Print... je kontextově závislý,
tzn. že je závislý na druhu aktivního
dokumentu. Pokud je aktivním dokumentem
obrázek, otevře se dialogové okno Print
Image. Pro jiné druhy dokumentů se
otevřou příslušná dialogová okna.

Po klepnutí na tlačítko Print Directly na
standardním panelu nástrojů se vytiskne
aktuální dokument, aniž by se zobrazilo
nějaké dialogové okno. Při přímém tisku se
použije aktuální rozvržení stránky.

Pro zkušební tisky je určen režim Draft.
Místo obrázků se vytisknou šedé obdélníky
a rovněž rozměry záhlaví a zápatí budou
znázorněny obdélníky. Obrázky se
nevytisknou, protože tisk grafiky je časově
náročný. Použití režimu Draft je nejrychlejší
a nejsnazší způsob, jak zkontrolovat
rozvržení stránky, například pokud si chcete
ověřit, zda jsou obrázky přesně rozmístěné
jako na formuláři.
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Okraj – dolní

Zápatí při tisku jednoho
obrázku

Zápatí při tisku více obrázků

Záhlaví + zápatí
při tisku více
obrázků

Záhlaví při tisku více obrázků

Okraj – horníZáhlaví při tisku
jednoho obrázku

Vzdálenost

Okraj – pravýOkraj – levý

Netisková oblast na papíru

Oblast pro zápatí

Tisková oblast

Oblast pro záhlaví



Jak odeslat elektronickou poštu...
1. Otevřete všechny dokumenty a obrázky, které si přejete odeslat elektronickou poštou.

l Pokud plánujete odesílat elektronickou poštou obrázky a dokumenty z databáze programu
analySIS®, otevřete databázi a zvolte požadované záznamy.

2. Klepněte na standardním panelu nástrojů na tlačítko Send email, nebo zvolte příkaz File > Send
email.
➤ Dialogové okno obsahuje seznam všech obrázků a dokumentů, které jsou právě načtené nebo

otevřené v programu analySIS®.
l Při výchozím nastavení jsou všechny tyto soubory zvolené.

3. Pokud chcete zrušit označení u všech souborů, klepněte na tlačítko Unselect All. Požadované
dokumenty označíte klepnutím na odpovídající předvolbu v seznamu dokumentů.

l Pokud je příloha pro elektronickou poštu příliš velká, zobrazí se výstražné hlášení.

4. Pokud chcete odeslat záznam z databáze včetně libovolných připojených dokumentů (obrázků,
tabulek, grafů apod.), zatrhněte předvolbu Add attached database documents.

l Předvolba je dostupná pouze v případě, že je otevřená databáze a v seznamu dokumentů je
zatržena předvolba pro databázi.

l Elektronickou poštou nelze odeslat celou databázi obrázků programu analySIS®.

5. Jestliže chcete nastavit formát pro všechny obrázky, tabulky, schémata a grafy, klepněte na tlačítko
Preferences...

➤ Otevře se dialogové okno Send email Preferences.

6. Klepněte na záložku karty Image v dialogovém okně Send email Preferences, budete moci zvolit
formát souboru s obrázkem. Formát souboru se vždy nastavuje pro všechny odpovídající dokumenty
určitého typu, nikoli pro jednotlivé dokumenty.

l Pokud příjemce elektronické pošty nepoužije k otevření obrázků program analySIS®, zatrhněte
předvolby Burn overlay into sent images a Send 16-bit images as 8-bit images.

l Při odesílání elektronickou poštou používejte komprimované obrázky, které jsou menší. Jestliže
osoba, které zasíláte obrázky, nepoužije k otevření obrázků program analySIS®, použijte formát
JPEG.

7. Před odesláním zprávy, vytvořené v programu analySIS®, elektronickou poštou klepněte na záložku
karty Report v dialogovém okně Send email Preferences, zmenší se rozlišení obrázků ve zprávách.

l Pokud budete posílat zprávu vytvořenou v programu analySIS®, zkonvertuje se do souboru RTF.

8. Klepnutím na tlačítko OK zavřete dialogové okno Send email Preferences.

9. Zvolením přepínače Custom v dialogovém okně Send email aktivujte právě zvolené nastavení
formátu.

10. Klepněte na tlačítko Send...
➤ Všechny zvolené soubory s obrázky a dokumenty se doplní jako příloha nového dokumentu

elektronické pošty.
l Uvědomte si, že pokud je otevřen dokument elektronické pošty, jsou všechny ostatní funkce

programu analySIS® nedostupné.
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Obrázek nad tímto textem obsahuje seznam všech typů
dokumentů, které mohou být odeslány elektronickou
poštou z programu analySIS®, a jejich příslušné standardní
formáty.

Všechny zvolené dokumenty se doplní jako příloha
elektronické pošty.

Karta Image

Tuto kartu použijte k nastavení formátu souboru pro
všechny obrázky, které budete odesílat elektronickou
poštou. Rozhodněte se, zda a v jaké míře budou obrázky
komprimovány. Můžete určit, zade se 16bitové obrázky
automaticky zkonvertují na 8bitové a zda se překryvná
vrstva spojí s obrázkem před jeho odesláním.

Karta Report

Kartu použijte k nastavení způsobu exportu obrázků ve
zprávách (reports), zkonvertovaných do formátu RTF. Tímto
způsobem můžete omezit nebo zmenšit velikost soboru
se zprávou.

Ukládání/Tisk/Odesílání
elektronickou poštou
Ukládání obrázků
Tisk obrázků
Odesílání elektronickou poštou

Je vyžadováno splnění následujících
podmínek:

Příkaz Send email je dostupný pouze
v případě, že:

l dokumenty jsou načtené (například
obrázek a zpráva)

l máte instalovaného klienta elektronické
pošty podporujícího MAPI a soubor
MAPI.DLL

Odeslání pracovní plochy elektronickou
poštou

Pokud chcete odeslat soubor
Worksapce.wos společně s dalšími
dokumenty elektronickou poštou, zatrhněte
předvolbu Add a workspace for the selected
documents v dialogovém okně Send email.
Příjemce tak může otevřít pracovní plochu
se všemi obrázky a dokumenty a zobrazit je
v původním rozmístění. Příjemce však musí
uložit všechny přílohy do samostatné
složky.

Pokud chcete otevřít pracovní plochy se
všemi dalšími dokumenty, zvolte příkaz File
> Workspace > Open...

Velikost dokumentů elektronické pošty

Pokud chcete v případě, že velikost přílohy
elektronické pošty přesáhne určitou mez
(kterou můžete sami nastavit), zobrazit
výstražné hlášení, zvolte následujícím
příkazem File > Send email...> Preferences
> General kartu General.

Výstraha: Navzdory skutečnosti, že výchozí
nastavení je maximálně 5 MB, by Vaše
dokumenty elektronické pošty zpravidla
neměly přesahovat 1 MB.

Jak snížit velikost dokumentů
elektronické pošty
l Vynechejte některé dokumenty
l Zkomprimujte obrázky. Chcete-li provést

komprimaci, zpřístupněte karty Image
a Report v dialogovém okně Send email
Preferences.
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Příprava databáze
1. Zvolte příkaz Database > New...

➤ Otevře se dialogové okno New Database.

2. Do pole Database name zadejte název pro databázi, například My_new.

3. V poli Database files v oblasti Storage locations zvolte cestu pro uložení souborů databáze.
Při seznamování s programem použijte nabízenou cestu.

➤ Program analySIS® nabídne cestu, kterou zjistí na kartě Database (příkaz Special >
Preferences...> Database). Cesta nyní obsahuje vnořenou složku pojmenovanou podle
databáze.

l V zobrazeném příkladu by za normálních okolností měla cesta být C:\Archive\My_new.
l Program analySIS® vyžaduje při otevírání databáze volný přístup k souborům databáze. Z tohoto

důvodu uchovávejte soubory databáze na lokálním pevném disku nebo trvale přístupném sí�ovém
disku.

l Pokud databázi používá více uživatelů, zvolte pevný disk serveru, například N:\Archive. K nalezení
požadované cesty můžete využít tlačítko Browse... za vstupním polem.

4. V poli External files zvolte cestu pro všechny externí soubory. Při seznamování s programem
použijte nabízenou cestu.

➤ Nabízená cesta odpovídá nastavení na kartě Database a je doplněna zvoleným názvem pro
databázi.

l Pokud zvolíte jiné než nabízené cesty, zkontrolujte, zda ve zvolených složkách není uložena žádná
databáze nebo externí soubory jiné databáze. Pro zjednodušení zadejte cestu k nové a prázdné
složce.

l Pokud nastavujete lokální databázi pro omezený počet obrázků, uložte obrázky a dokumenty na
lokální pevný disk.

l Pokud nastavujete lokální databázi pro x obrázků, uložte zpočátku obrázky a dokumenty také na
lokální pevný disk. Protože se bude databáze rozrůstat, budete potřebovat uložit soubory (které
zabírají velké množství paměti) na disk CD. Pokyny pro přemístění souborů na disk CD naleznete
v Uživatelské příručce.

l Pokud nastavujete sí�ovou databázi pro x obrázků, zvolte pevný disk serveru s odpovídající
kapacitou, například N:\Archive.

l K nalezení požadované cesty použijte tlačítko Browse... za vstupním polem.

5. Klepnutím na tlačítko OK potvrïte zvolený název databáze a nastavené cesty.

➤ Pokud některá z požadovaných složek neexistuje, budete dotázáni, zda si ji přejete vytvořit.
Klepněte na tlačítko Yes.

➤ Otevře se dialogové okno Create Volume Label.

6. Klepnutím na tlačítko OK potvrïte nabízené označení svazku.

➤ Program analySIS® Vám doporučí použít standardní název svazku, například My_new Volume #1.
Systém bude moci podle tohoto názvu vyhledávat složky se soubory s obrázky a dokumenty.

l Pokud použijete pro uložení obrázků a dokumentů přenosná pamě�ová média, zkontrolujte, zda
označení prvního z nich odpovídá označení svazku.

➤ Program analySIS® otevře databázový dokument My_new.mdb a zobrazí hlášení Empty
database.
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V zobrazeném dialogovém okně se nastavuje cesta pro
soubory databáze a externí soubory.

Doporučené pamě�ové
médium pro soubory
databáze

Doporučené pamě�ové
médium pro soubory
s obrázky a dokumenty

Pro omezený počet obrázků v lokální databázi:

Lokální pevný disk C: Lokální pevný disk C:

Pro x obrázků a dokumentů v lokální databázi:

Lokální pevný disk C: Lokální pevný disk C: včetně
možnosti uložení na CD
podle potřeby

Pro omezený počet nebo x obrázků a dokumentů v sí�ové
databázi:

Sí�ový disk N: Sí�ový disk N:

Soubory
databáze

Co obsahují...

*. mbd Obsahuje databázové tabulky pro
správu databáze

*.tnb Obsahuje náhledy

*.mtb Obsahuje databázová pole včetně
jejich obsahu

*. ldb Dočasné soubory včetně
zpřístupněných dat

Soubory
s obrázky
a dokumenty

Co obsahují...

*.tif, *.sfs, *.sfd, *.
xls, *.doc

Jedná se o ukázku souborů
s obrázky a dokumenty

Po přípravě databáze se zobrazí prázdný dokument,
do kterého můžete vkládat záznamy.

Archivace obrázků
Příprava databáze
Vkládání obrázků
Práce s databázovými dokumenty
Export obrázků
Vyhledávání v databázi
Zálohování databáze

Databáze Vám umožňuje strukturovaně
ukládat všechny obrázky, grafy
a dokumenty, jako jsou tabulky, schémata
a texty. Tím Vám kdykoliv poskytuje rychlý
a snadný přístup k velkému množství dat.

Soubory databáze/Externí soubory

Databáze se skládá z:

l souborů databáze
l externích souborů, jako jsou obrázky

nebo dokumenty

Soubory databáze musí být vždy přístupné
a uložené na pevném disku. Externí soubory
mohou být uložené na pevném disku nebo
na přenosných pamě�ových médiích.

Výchozí velikost složek pro soubory
s obrázky a dokumenty je 600 MB. Tento
horní limit můžete změnit, například .při
pořizování záložních kopií na pamě�ová
média s nízkou kapacitou (příkaz Database
> Settings... > Storage capacity in MB).
Soubory databáze nelze manuálně přemístit
ani mazat.

Označení svazků

Všechny složky s obrázky a dokumenty
(i všechna přenosná pamě�ová média) mají
samostatný soubor archive.vol. Tento
soubor obsahuje jedinečné označení
svazku pro každou složku s obrázky
a dokumenty. Označení svazků je nezbytné
pro kontrolu, že soubory databáze
odpovídají souborům s obrázky
a dokumenty.

Práce v síti

Můžete nastavit databázi v prostředí sítě tak,
aby k ní mohlo současně přistupovat více
uživatelů z různých terminálů. Přesvědčte
se, zda jste použili pevný disk serveru
s dostatečnou kapacitou. Libovolní
uživatelé, kteří si přejí otevřít databázi ve
Windows, musí mít práva ke čtení a ukládání
na pevný disk.
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Vytvoření databázových polí
1. Zvolte příkaz Database > Define Fields.

➤ Zobrazí se stejnojmenné dialogové okno.
➤ Seznam Field obsahuje předdefinovaná databázová pole.

2. Klepněte na tlačítko New.

➤ Automaticky se vytvoří nové databázové pole. Poli bude přiřazen název UserField + pořadové
číslo.

➤ Nově vytvořené pole se objeví v poli Current field a bude aktivní.

3. Zadejte požadovaný název databázového pole, například User.

➤ V seznam Data type bude zvolena hodnota Text, kterou neměňte.
➤ Pole Default bude prázdné. Pokud budou všichni uživatelé vkládat do databáze přibližně stejný

počet obrázků, ponechejte pole prázdné. Při vkládání obrázků Vám bude doporučen naposledy
použitý text.

4. Zatrhněte předvolbu Required.

l Při vkládání obrázků do databáze nesmí zůstat pole User prázdné, musí obsahovat text.
Databázové pole s povinným vyplněním obsahu je v režimu vkládání obrázků do databáze
označeno vykřičníkem před názvem pole.

5. Klepněte na tlačítko Edit...

➤ Otevře se dialogové okno Edit Picklist pro vytváření seznamů.
➤ V horní části dialogového okna se objeví databázové pole User.

6. Zadejte vlastní jméno uživatele, například Biff, do pole Value.

7. Klepněte na tlačítko Add.

➤ Text zapsaný v poli Value bude nyní zahrnut do seznamu Picklist.

8. Opakujte dva předcházející kroky pro kterékoliv další uživatele.

l Pečlivě zkontrolujte zvolený text. Případně překlep bude velmi obtížné později opravit.
l Pokud je to nutné, zvolený text opravte:

Jestliže text obsahuje chybný znak (například Baff), zvolte jej v seznamu Picklist.
Zadejte do vstupního pole Value správný text (například Biff).
Klepněte na tlačítko Change.

9. Klepnutím na tlačítko OK potvrïte obsah seznamu Picklist.

➤ Vrátíte se do dialogového okna Define Fields.
➤ Nyní bude oblast Picklist dostupná.

10. Zatrhněte předvolbu Restrict input on picklist entries.

➤ Při vložení nového obrázku přijme pole User pouze názvy, které jsou uvedené v seznamu Picklist.
Jiné názvy odmítne.

11. Jestliže chcete vytvořit další databázové pole, například Project, Comment nebo Instrument podle
údajů v tabulce na následující stránce, opakujte uvedené kroky, počínaje krokem 2.

12. Klepnutím na tlačítko OK potvrïte vytvořená pole.

➤ Budete dotázáni, zda si nyní přejete uspořádat pole. Nyní pole neuspořádávejte, klepněte na
tlačítko No.
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Předefinovaná
databázová pole

Určení/jednotky/přípustné hodnoty

Modification Date Datum poslední změny záznamu,
například 10.3.00

Modification Time Čas poslední změny záznamu, například
12:09

Image File Size Velikost souboru s obrázkem v bajtech

Image Comment Lze jej měnit v pamě�ovém poli před
vložením příkazem Image Information

Image Name Odpovídá pamě�ovému poli obrázku

Image Path Úplná cesta k obrázku

Image Type například Palette, RGB, Mono, Binary

Bits per Pixel Barevná hloubka obrázku, například 8,
16, 24

Width Délková jednotka: kalibrační jednotka

File name Název, pod kterým je obrázek uložen

ID Jedinečné pořadové identifikační číslo
záznamu

Record Name Název záznamu v databázi

Volume Label Odkazuje se na složku nebo přenosné
pamě�ové médium, například My_New
Volume #1

Document Files Size Souhrn velikostí všech dokumentů
připojených k obrázku (v bajtech).

Insertion Date Datum vložení do databáze, například
30.5.1998

Insertion Time Čas do databáze, například 13:05

Creation Time Datum pořízení, například 10.3.1997

Cration Time Čas pořízení, například 20:10

Height Délková jednotka: kalibrační jednotka

Calibration Unit Jednotka pro výšku a šířku, například
mm

Channel Logický vstup

Magnification Při pořízování, například 100

X-Resolution Šířka v obrazových bodech, například
1024

Y-Resolution Výška v obrazových bodech, například
768

Ukázka uživatelsky
nastavených polí

User Project Comment Instrument

Typ dat Text Long Memo Text

Požadovaný vstup ano ano ne ano

Seznam dostupných
hodnot

Biff Les 340698 žádný LM SEM

Nerozbalovat seznam
dostupných hodnot při
vstupu

neaktivní

Rozšířené použití ano neaktivní ano

Omezení vstupu na
položky v seznamu
dostupných hodnot

ano neaktivní

Výchozí LM

Archivace obrázků
Příprava databáze
Vkládání obrázků
Práce s databázovými dokumenty
Export obrázků
Vyhledávání v databázi
Zálohování databáze

Databázová pole

Určují vnitřní strukturu databáze. Obsahují
libovolné informace, které si přejete uložit
s obrázkem Údaje v databázových polích
jsou propojené s odpovídajícím obrázkem
a pomáhají Vám zjednodušit přemístění
libovolných obrázků.

Předdefinovaná pole

Jsou vytvořena programem analySIS®

a automaticky se ukládají s každým
obrázkem. Obsahují charakteristické
vlastnosti obrázku a data dodávaná
systémem při vložení do databáze. Nelze
je upravovat ani mazat. Výjimkou je pole
Record Name, jehož obsah můžete měnit
při vkládání obrázku nebo při úpravě
záznamu, jestliže jste již nezměnili nastavení
v dialogovém okně Settings (příkaz
Database > Settings).

Uživatelská pole

Vytvářejí se podle potřeby, například User,
Project, Comment nebo Instrument. Můžete
definovat typ dat pro každé databázové
pole zvláš�. Pro vkládání obrázku musí také
určit, zda:

l pole vyžaduje zadání hodnoty (volba
Required)

l je nabízen seznam dostupných hodnot
(Picklist)

l musíte volit hodnotu ze seznamu
dostupných hodnot

l se nová hodnota doplní do seznamu
dostupných hodnot

l se nabídne nejčastěji používaná hodnota

Úprava záznamů

Klepněte na tlačítko Edit records nebo
zvolte příkaz Database > Edit Record...,
zobrazí se dialogové okno, v kterém můžete
měnit název záznamu a hodnoty
v uživatelem vytvořených polích.
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Vkládání obrázků
Vkládání obrázků z oblasti pamě�ových polí obrázků

1. Otevřete databázi. V seznamu dříve načtených databází v dolní části nabídky zvolte název
požadované databáze (My_New).

2. Zvolte obrázky, které si přejete vložit z pamě�ových polí do databáze.

l Pokud chcete zvolit souvislou skupinu pamě�ových polí, stiskněte klávesu [Shift] a klepněte na
první a poslední požadovaný obrázek.

l Jestliže chcete zvolit nesouvislou skupinu pamě�ových polí, stiskněte klávesu [Ctrl] a postupně
klepněte na všechny požadované obrázky.

3. Jestliže chcete vložit obrázky do databáze, uchopte je a přetáhněte z oblasti pamě�ových polí na
ikonu databáze pod touto oblastí nebo do okna databáze.

4. Pokud vkládáte více obrázků, zobrazí se dialogové okno Insert Image.

➤ Předvolby zvolených obrázků budou zatržené. Nyní můžete výběr obrázků upravit.
l Klepněte na přepínač Always v oblasti Prompt for data input.
l Klepnutím na tlačítko OK potvrïte výběr obrázků.

5. Pro každý vkládaný obrázek se zobrazí dialogové okno Insert Image.

➤ V poli Record Name bude nabízen současný název obrázku (stejný jako v pamě�ovém poli),
pokud jste nezvolili automatické pojmenovávání záznamů v dialogovém okně Settings (příkaz
Database > Settings).

➤ V poli Instrument se zobrazí výchozí hodnota LM.
➤ V polích User, Project a Comment budou nabízeny naposledy použité hodnoty, dokud nezvolíte

jinou variantu.
l Pokud je to potřebné, upravte hodnoty pro každý obrázek zvláš�.
l Zadejte klíčová slova do pole Comment, aby bylo možné libovolný obrázek vyhledat, například

informaci o preparátu nebo použité metodě měření.
l Klepněte na tlačítko Insert.
➤ V okně databáze se zobrazí náhledy vložených obrázků.

Vkládání obrázků z jiné databáze
1. Otevřete zdrojovou i cílovou databázi.

2. Ve zdrojové databázi zvolte obrázky, které si přejete kopírovat.

3. Uchopte a přetáhněte obrázky z okna zdrojové databáze do okna cílové databáze.

➤ Jestliže databáze nemají stejnou strukturu, uživatelská pole se nezkopírují a zobrazí se výstražné
hlášení, které o této skutečnosti informuje. Po klepnutí na tlačítko Yes můžete pokračovat.

l Poznámka: Pokud byste chtěli vytvořit novou databázi se stejnou strukturou, jakou má existující
databáze, použijte pole Copy structure from database file (příkaz Database > New...).

4. Proveïte všechny potřebné změny v dialogových oknech Insert Image/Insert Images a Confirm
Destination a potom klepněte na tlačítko Insert, resp. OK.

➤ Obrázky a připojené dokumenty se zkopírují do cílové databáze.
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V dolní části nabídky Database jsou uvedeny databáze,
které jste naposledy otevřeli.

Pokud chcete vložit obrázek do databáze, uchopte jej
v pamě�ovém poli a přetáhněte na ikonu databáze nebo
do okna databáze.

Zadejte hodnotu do pole Record Name a údaje do
uživatelem definovaných polí v dialogovém okně Insert
Image. Jestliže musíte do příslušného pole zadat vstupní
údaje, zobrazí se před ním symbol vykřičník.

Při vkládání více obrázků můžete zvolit libovolný obrázek
v oblasti pamě�ových polí obrázků.

Archivace obrázků
Příprava databáze
Vkládání obrázků
Práce s databázovými dokumenty
Export obrázků
Vyhledávání v databázi
Zálohování databáze

Otevření databáze

Otevřete databázi použitím příkazu
Database > Open... nebo klepnutím
na příslušný soubor v dolní části nabídky
Database.

Otevření s přidělením výhradních práv

Pokud chcete otevřít databázi s přidělením
výhradních práv, zvolte v nabídce položku,
která otevře databázi, a zatrhněte předvolbu
Exclusive v dialogovém okně Open
Database (příkaz Database > Open... >
Exclusive).

Pokud chcete upravit strukturu databáze,
musíte databázi otevřít s přidělením
výhradních práv. Jedná se například o:

l vytvoření nebo smazání polí
l vytvoření databáze
l vytvoření hesla
l úpravu cest k obrázku a dokumentu
l úpravu standardního formátu obrázku

Formát souboru s obrázkem

a komprimace obrázku (pro uložení obrázků
v databázi) se nastavují po použití příkazu
Database > Settings... Výchozím formátem
je formát TIFF bez komprimace.
U jakéhokoliv obrázku, který později vložíte,
můžete formát změnit. Uvědomte si, že tato
nastavení jsou vlastnostmi databáze,
a proto při použití sí�ové databáze ovlivňují
všechny uživatele.

Náhledy

V databázovém dokumentu se obrázky
zobrazí ve formě náhledů. Náhledy mají
menší nároky na pamě� a ukládají se
společně se soubory databáze. Poskytují
tak rychlý a jednoduchý přístup k obrázkům
a také odstranění vizuálního překrývání
(obrázku) při prohlížení stránek
databázového dokumentu použitím
posuvné lišty. Velikost náhledů budoucích
obrázků se nastavuje příkazem Database >
Settings.... Výchozí nastavení jsou malé
náhledy.
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Vkládání obrázků
Vkládání obrázků z pevného disku

1. Zvolte příkaz Database > Insert Image File...

➤ Otevře se dialogové okno Insert Image File.

2. Do pole Look in zadejte složku, v které se nacházejí soubory s požadovanými obrázky.

3. Klepněte na tlačítko Preview.

4. Postupně klepněte na všechny požadované soubory s obrázky. Po klepnutí levým tlačítkem myši
se obrázky zobrazí v poli Preview.

l Tímto způsobem můžete zkontrolovat obrázky, které zařadíte do databáze.

5. Stiskněte tlačítko [Ctrl] a postupně klepněte na všechny požadované soubory s obrázky.

➤ Názvy souborů se doplní do pole File name.

6. Klepněte na tlačítko Insert.

➤ Otevře se dialogové okno Enter Prompt Mode.

7. V oblasti Prompt for data input klepněte na přepínač Always.

8. Klepnutím na tlačítko OK potvrïte zvolenou hodnotu.

➤ Dialogové okno Insert Image se postupně otevře pro každý soubor s obrázkem.

Připojení dokumentů programu analySIS® k obrázku
1. Vložte obrázek, ke kterému si přejete připojit dokumenty do databáze, nebo zvolte vložený obrázek

v okně databáze.

l Užitečné pokyny: je vhodné zvolit, jaký druh dokumentu si přejete k obrázku připojit, například
„documents: sheet“ nebo „documents: MIA“.
Ačkoliv nemůžete vyhledávat konkrétní dokumenty, můžete nyní požadované dokumenty zjistit
použitím klíčových slov v poli Comment.

2. Zvolte příkaz Database > Insert Documents...

➤ Otevře se dialogové okno Insert Documents.
➤ Okno obsahuje přehled všech dokumentů (seřazený podle jejich názvu), obrázků (seřazený podle

čísel pamě�ových polí) a názvů obrázků načtených v programu analySIS®. Předvolby u názvů
dokumentů budou zatržené.

3. U dokumentů a obrázků, které si nepřejete vkládat, zrušte zatržení předvoleb.

4. Klepnutím na tlačítko OK potvrïte výběr dokumentů.

➤ Otevře se druhé okno Insert Documents.

5. Do pole Field name zadejte odpovídající název dokumentu, včetně správné přípony.

➤ Dokumenty se uloží ve formátu podle tabulky na následující straně.

6. Klepněte na tlačítko Insert.

➤ Dokument se uloží a zobrazí se další dialogové okno Insert Documents. Okno se zobrazí tolikrát,
kolikrát to bude nutné pro uložení všech dokumentů.

➤ Připojený dokument je signalizován žlutou sponkou na papír, připevněnou k náhledu.

42



Obrázek s připojenými dokumenty je označen žlutou
sponkou na papír.

Current
document

Předběžný název souboru (dokumentu)

Type Typ dokumentu, například obrázek, graf,
tabulka, schéma nebo text

Selection index Například hodnota 1/4 znamená, že
pracujete s prvním ze čtyř dokumentů

Record name Název obrázku, ke kterému jste připojili
dokumenty

Record ID Identifikační číslo záznamu obrázku,
ke kterému jste připojili dokumenty

File name Název souboru s dokumentem

V druhém dialogovém okně Insert Documents se zobrazí
různé druhy informací. V poli File name můžete změnit
název souboru s dokumentem.

Druh
dokumentu

Standardní
název souboru

Standardní formát

Obrázek Název
pamě�ového
pole obrázku

Formát TIF

Tabulka Aktuální název
dokumentu

Formát tabulky zvolený
na kartě Special >
Preferences... > Save.
Výchozí nastavení je
*.sfs, standardní formát
tabulek SIS.

Text Aktuální název
dokumentu

Formát TXT

Schéma Aktuální název
dokumentu

*.sfd (standardní formát
schémat SIS)

Dokumenty programu analySIS® se ukládají
standardizovaným způsobem v existujících formátech.
Pokud chcete uložit dokument v odlišném formátu, zadejte
do pole File name i příponu, například Balls.bmp nebo
Tab.xls.

Archivace obrázků
Příprava databáze
Vkládání obrázků
Práce s databázovými dokumenty
Export obrázků
Vyhledávání v databázi
Zálohování databáze

Mezi dokumenty patří:
l obrázky a grafy v programu analySIS®

l texty, tabulky a schémata v programu
analySIS®

l soubory vytvořené jinými uživatelskými
programy, například soubory z programů
CorelDraw, MS Excel, Origin nebo MS
Word.

Připojené dokumenty

K obrázkům v databázi lze připojit
dokumenty. Tato funkce je vhodná pro:

l tabulky, schémata, grafy a obrázky
programu analySIS®, použité pro
vyhodnocení obrázku

l série měření s mnoha obrázky, například
obrázky získanými pro modul MIA nebo
EFI; získané obrázky můžete připojit
k výslednému obrázku, čímž uchováte
zřetelně strukturovaný vizuální
databázový dokument

l vysvětlující texty, použité publikace nebo
korespondence, například ve Wordu

Připojení souborů s dokumenty

Soubory s dokumenty můžete připojit
k obrázku následujícími způsoby (například
text z Wordu nebo tabulku z Excelu
uloženou na pevném disku):

l Zvolte obrázek v databázi.
l Zvolte příkaz Database > Insert

Document File...
l V poli Look in zvolte odpovídající složku

a v ní soubor vytvořený ve Wordu nebo
Excelu.

l Klepněte na tlačítko Insert.

Smazání souborů s dokumenty

Pokud chcete smazat připojené soubory
s dokumenty, zvolte příkaz Database >
Open Document File (nebo poklepejte na
žlutou sponku na papír), označte soubory,
které chcete smazat, a stiskněte klávesu
[Delete].
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Práce s databázovými dokumenty
Uspořádání databázových polí

1. Otevřete databázi s přidělením výhradních práv.

l Zvolte příkaz Database > Open... Označte požadovaný soubor mdb a zatrhněte předvolbu
Exclusive v dialogovém okně Open Database.

2. Zvolte příkaz Database > Arrange Fields...
➤ Otevře se stejnojmenné dialogové okno, které obsahuje karty pro šest nastavitelných způsobů

zobrazení databáze. Každá karta obsahuje seznam Available a Current.

3. Klepněte na záložku karty Form View.

4. Přesuňte požadovaná pole do seznamu Current.

l Zvolte požadované položky v seznamu Available (například User) a přemístěte je do seznamu
Current klepnutím na tlačítko Add >.

5. Změňte pořadí položek.

➤ Zvolte některou z položek v seznamu Available a tlačítky Move Item Up a Move Item Down ji
přesuňte na požadované místo.

6. Klepněte na záložku karty Info Windows.

7. Tlačítky Add > a Remove < přemístěte požadované položky do seznamu Current.
l V okně Info může být zobrazeno maximálně sedm polí. Z tohoto důvodu je povoleno umístit do

seznamu Current pouze sedm položek.
l V seznamu musí být alespoň jedna položka.

8. Klepněte na záložku karty Table View a zvolte, která pole a v jakém pořadí chcete zobrazit v tabulce
databáze.

9. Pokud chcete aktuální nastavení polí uložit jako výchozí, klepněte na tlačítko Set Default.

l Výchozí nastavení můžete kdykoliv načíst pouhým klepnutím na tlačítko Get Default.

10. Klepnutím na tlačítko OK potvrïte provedené nastavení.

Otevření okna Info
1. Klepněte pravým tlačítkem myši na název záznamu požadovaného obrázku.

➤ Otevře se dialogové okno Info. V závislosti na Vašem výběru se zobrazí až sedm polí.

2. Klepněte na tlačítko Keep Visible (tlačítko s připínáčkem) v okně Info, okno se „přichytí“
k databázovému dokumentu.

➤ Tlačítko s připínáčkem bude stisknuté.
l Nyní můžete klepnout na libovolný náhled (postupně) a prohlédnout si zvolená pole v okně Info.

3. Klepnutím na tlačítko × v prevém horním roku zavřete okno Info.
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Zobrazení obrázků formou náhledů (Gallery View)
poskytuje nejzřetelnější přehled obrázků v databázi.
K procházení mezi databázovými dokumenty využijte
posuvnou lištu nebo tlačítka s modrými šipkami.

Při zobrazení ve tvaru formuláře (Form View) můžete
procházet jednotlivé karty Fields a zjiš�ovat hodnoty
odpovídajících databázových polí pro zvolené obrázky.

Okno Info zobrazuje sedm zvolených databázových polí.
Stačí pouze klepnout pravým tlačítkem na název záznamu
požadovaného obrázku.

Archivace obrázků
Příprava databáze
Vkládání obrázků
Práce s databázovými dokumenty

Zobrazení údajů
Načtení obrázků

Export obrázků
Vyhledávání v databázi
Zálohování databáze

Databázový dokument

Každá databáze programu analySIS® je
zobrazena ve vlastním databázovém okně
(databázový dokument). Okno obsahuje
všechny údaje databáze. Údaje mohou být
zobrazeny třemi způsoby:

Formou náhledů (Gallery view)

Jeden náhled s příslušnými databázovými
poli (Form view)

V tabulce databáze (Table view)

Panel nástrojů pro práci s databází
poskytuje rychlý přístup k často používaným
databázovým polím.

Stavový řádek databáze obsahuje
následující informace: aktuální pořadí
obrázku, celkový počet obrázků, číslo
a celkovou velikost zvolených záznamů,
naposledy použití filtr pro vyhledání
obrázků.

V kontextově závislé nabídce databáze jsou
obsaženy příkazy pro vyhledávání, vkládání
a načítání obrázků a dokumentů i příkaz
Define Context Menu... pro nastavení
kontextově závislé nabídky podle Vašich
požadavků.

Tato nabídka se otevírá klepnutím pravého
tlačítka myši na databázovém dokumentu.
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Aktuální pořadí
obrázku/Celkový
počet obrázků

Stavový řádek databáze

Název záznamu

Náhled

Zvolený obrázek

Panel nástrojů pro práci
s databází

Databázový dokument

Počet zvolených
obrázků

Aktuální filtr pro
vyhledávání



Práce s databázovými dokumenty
Načtení obrázků a dokumentů z databáze

1. V oblasti pamě�ových polí zvolte požadované pamě�ové pole obrázku.

2. V databázovém dokumentu poklepejte na obrázek, který si přejete načíst.

➤ Obrázek se načte do pamě�ového pole a zobrazí v obrazovém dokumentu.
l Obrázek můžete také uchopit a přetáhnout na pamě�ové pole.
l Tímto způsobem můžete jednoduše načíst obrázky bez připojených dokumentů.

3. Pokud si přejete načíst i všechny dokumenty připojené k obrázku, zvolte příkaz Database > Load
with Documents.

➤ Připojené dokumenty se postupně načtou do po sobě následujících pamě�ových polí obrázků.
Pokud je některé z pamě�ových polí chráněno programem AnalySIS® proti přepsání, načítání se
přeruší.

➤ Dokumenty programu analySIS® se otevřou v programu analySIS®. Jedná se například o tabulky
s příponou *.sfs.

➤ Ostatní dokumenty se načtou do odpovídajících aplikací, například textové soubory s příponou
*.doc do Wordu a tabulky s příponou *.xls do Excelu.

Export obrázků a dokumentů z databáze
1. Zvolte databázový záznam obrázku (s nebo bez připojených dokumentů), který si přejete exportovat.

2. Zvolte příkaz Database > Export Images...

➤ Otevře se dialogové okno Export Images.
➤ V okně zjistíte, kolik souborů jste zvolili a jaká je jejich celková velikost.

3. Do pole Destination path zadejte cílovou cestu pro soubory s obrázky a dokumenty.

l Můžete pouze klepnout na tlačítko ... a požadovanou cílovou složku interaktivně vyhledat
v dialogovém okně Select export path.

4. Pokud chcete exportovat všechny připojené dokumenty s obrázky, zatrhněte předvolbu Export with
attached documents.

5. Klepnutím na tlačítko OK potvrïte zvolené údaje.

➤ Pro názvy souborů exportovaných obrázků se využijí názvy příslušných záznamů. Současně se
doplní i odpovídající přípony (například tif, bmp, jpg, wmf).

➤ Exportované připojené dokumenty se zkopírují do speciálního vnořeného pořadače, vytvořeného
pro každý obrázek zvláš� a pojmenovaného rovněž podle názvu záznamu. Potom bude snadné
zjistit, které exportované dokumenty patří k jakým obrázkům.
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Pokud chcete načíst obrázek do programu analySIS®

uchopením a přetažením, přetáhnete jej z databázového
dokumentu do pamě�ového pole. Načtení připojených
dokumentů zajistíte příkazem Database > Load with
Documents.

Generátor zpráv Vám umožňuje rozvrhnout šablony zpráv
přesně podle Vašich potřeb a požadavků. Šablony zpráv
mohou být následně použity pro rychlé a snadné vytvoření
zpráv, takže dokumentace výsledků Vaší práce se vytvoří
jednotným a profesionálním způsobem. Pokud je to nutné,
můžete hotové zprávy exportovat jako soubory formátu RTF
například do MS Wordu.

Užitečné pokyny: Neváhejte příliš dlouho s rozhodnutím,
jaké uživatelské pole budete potřebovat pro Vaši úlohu.
Efektivně definovaná pole velmi zjednodušují vyhledávání
obrázků. I generování zpráv je jednodušší, protože
databázová pole mohou být včleněna do šablon zpráv.

Archivace obrázků
Příprava databáze
Vkládání obrázků
Práce s databázovými dokumenty

Zobrazení údajů
Načtení obrázků

Export obrázků
Vyhledávání v databázi
Zálohování databáze

Pokud je Vaše databáze uložena na
přenosném pamě�ovém médiu (disku CD,
magnetooptickém disku, disketě apod.):

l pokud nemá pamě�ové médium při
vkládání obrázků dostatečně velkou
volnou kapacitu, budete vyzvání k vložení
nového pamě�ového média.

l při načítání obrázků Vám bude
připomenuto, jaké pamě�ové médium
s požadovanými obrázky je použito.

Vkládání obrázků do zpráv

Generátor zpráv programu analySIS®

je určen pro vytváření profesionálních,
vícestránkových zpráv (příkaz File > Report
> New. Nabízené možnosti pro návrh
rozvržení zpráv jsou nejvyšší kvality.
Vkládání obrázků z databáze, připojených
dokumentů z programu analySIS®

a databázových polí je zcela jednoduché.

Rychlý tisk obrázků

Pokud chcete obrázky rychle vytisknout,
s méně přizpůsobitelným druhem rozvržení,
zvolte standardní tiskový příkaz (File >
Print... > Page layout: Database).

Export obrázků

Obrázky z databáze a připojené dokumenty
můžete kdykoliv zkopírovat na pamě�ové
médium jako soubory (příkaz Database >
Export Images...). Tyto soubory mohou být
upraveny v jiných aplikačních programech
a ve stejných programech potom i vytištěny.
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Vyhledávání obrázků
1. Zvolte příkaz Database > Arrange Fields...

a V dialogovém okně zvolte záložku karty Query by Example.

b Zvolte pole pro vyhledání obrázků, například Record name, Image Name, Image Typ, Channel,
Insertion Date, Insertion Time, Creation Date, Magnification, User, Project, Instrument
a Comment.

c Sestavte dotaz podle standardu Query by example (Dotaz příkladem).

2. Klepněte na tlačítko Query.

➤ Otevře se dialogové okno Query by Example se zvolenými databázovými poli.

3. Podle potřeby sestavte dotaz z jednoho nebo více polí, například: Zadejte text Herman do pole User
a hodnotu 1000 do pole Magnification.

➤ Pokud zvolíte více polí, automaticky se mezi ně doplní operátor AND. Vyhledají se pouze obrázky,
které splňují všechna kritéria.

l Vyhledají se všechny obrázky s koeficientem zvětšení 1000 vložené uživatelem Hermanem.
l V horní tabulce na následující stránce jsou uvedeny příklady. Musíte použít přesně stejný způsob

zápisu.

4. Klepněte na tlačítko Search.

➤ Vyhledané obrázky se zobrazí v databázovém dokumentu.
➤ Ve stavovém řádku databáze se v poli Rec zobrazí aktuální pořadí obrázku a počet vyhledaných

obrázků. Například údaj 1/5 znamená, že bylo vyhledáno pět obrázků, přičemž zobrazen je první
z nich. V poli Filter jsou uvedena vyhledávací kritéria, například [User]=Sheila.

5. Klepněte znovu na tlačítko Query.

6. Klepněte na tlačítko Clear v dialogovém okně Query by Example.

➤ Všechny položky v dialogovém okně se smažou.

7. Pokud chcete znovu vidět všechny obrázky v databázi, klepněte znovu na tlačítko Search.

➤ Všechny obrázky v databázi se znovu zobrazí.

8. Pokud chcete použít složitější vyhledávací filtr, zvolte příkaz Database > Query by Free Filter...
➤ Otevře se dialogové okno se stejným názvem.

a Zvolte databázová pole, operátory (>, >= apod.) a spojky v seznamech Field, Compare
a AND/OR.

b Do pole Compare with zadejte, co chcete vyhledat.

c Do jednoho pole můžete zadat dvě položky s logickým operátorem AND jako spojkou. Můžete
například vyhledat obrázky vložené v určitém časovém období, například Insertion Time >=
15:00 AND <= 20:00.

d Dvě položky můžete také spojit logickým operátorem OR, takže se vyhledají obrázky, které
splňují alespoň jedno z uvedených kritérií. Například User=Ziggy OR Project = 450998. Příklady
jsou uvedeny ve spodní tabulce na následující straně.
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Query by example (Dotaz příkladem)

Vyhledávání všech
obrázků...

Pole Hodnota

... od uživatele Percyho User Percy

...začínající písmeny Gold Record Name like Gold*

...vytvořené po 16.4.90 Creation Date >16.4.1990

...vložené 31.5.98 před
6:30 odpoledne

Insertion Date 31.5.1998

Insertion Time <18:30

... pořízené přes jiný kanál
než SlowScan

Channel SlowScan

... se zvětšením větším než
200

Magnifiation >=200

... s komentářem
obsahujícím termín P2000

Comment like *P2000*

Při vytváření dotazu příkladem můžete (a musíte) použít pro
vyhledávání jistých kombinací znaků v slovech nebo celých
slov v poli Comment slovo like a symbol * (hvězdička).
Zkontrolujte správnost zápisu.

Vyhledávání pomocí filtru

Vyhledávání Pole Op. S Op. S

... všechny obrázky
z roku 1997

Creation Date >= 1.1.1997 > 1.1.1998

... všechny obrázky
RGB nebo
v odstínech šedé

Image Type = RGB

OR

Image Type = Mono

... všechny obrázky,
jejichž název začíná
na A

Image Name >= A < B

... všechny obrázky
vložené 20.5.1998
mezi 3 a 8 hodinou
odpoledne

Insertion Date = 20.5.1998

AND

Insert Time >= 15:00 < 20:00

Vyhledávání pomocí filtru Vám dovoluje sestavit vyhledávací
kritéria ze specifických prvků za účelem nalezení
požadovaných obrázků – zvolte databázové pole v seznamu
Field, operátory v seznamu Compare a operátory
v seznamu AND/OR. Do pole Compare with zadejte pojmy
pro vyhledávání.

Poznámka: Uvědomte si, že při vkládání hodnot do polí
musíte používat datum a čas ve tvaru podle nastavení
v okně Místní nastavení operačního systému.

Archivace obrázků
Příprava databáze
Vkládání obrázků
Práce s databázovými dokumenty
Export obrázků
Vyhledávání v databázi
Zálohování databáze

Dotaz pro vyhledání v databázi

Program analySIS® nabízí tři způsoby
vyhledávání obrázků v databázi:

l Dotaz příkladem
Používá se, pokud vyhledáváte obrázky
podle obsahu polí – při použití více polí
jsou jednotlivá pole spojena logickým
operátorem AND.

l Vyhledávání pomocí filtru
Používá se pro vyhledávání podle více
kritérií – kritéria se spojují operátory AND
a OR do složitějších vyhledávacích
výrazů.

l Vyhledávání podle SQL
Obsahuje kritéria formulovaná v SQL,
standardizovaném jazyce pro správu
databáze.

Vyhledávání

Úplně prvním klepnutím na tlačítko Query se
zobrazí dialogové okno Query by Example.
Při pozdějším vyhledávání se otevře
dialogové okno pro předcházející
vyhledávání. Všechny údaje zvolené při
předcházejícím vyhledávání se zachovají.

Uložení filtrů pro vyhledávání

Vytvoření filtry pro vyhledávání můžete uložit
v dialogovém okně Query by Free Filter
nebo Query by SQL a samozřejmě je
později znovu načíst.

Zobrazení všech záznamů

Pokud chcete zrušit filtr pro vyhledávání
a zobrazit znovu všechny záznamy v okně
databáze, vytvořte „prázdný dotaz“. Před
provedením této operace odstraňte všechny
hodnoty z formuláře pro vytvoření dotazu.

49



Zálohování databáze
Ochrana databáze heslem

1. Otevřete databázi s přidělením výhradních práv.

l Zatrhněte předvolbu Exclusive v dialogovém okně Open Database.
➤ Zpřístupní se příkaz Database > Change Password...

2. Zvolte příkaz Database > Change Password...
➤ Zobrazí se výstražné hlášení, které informuje, že pokud zapomenete heslo, databáze se

nenávratně znepřístupní.
➤ Otevře se dialogové okno Change Database Password.

3. Zadejte heslo do pole New password.
l Heslo se může skládat až z 14 znaků.
l Velká a malá písmena se uloží tak, jak jsou.

4. Zadejte znovu heslo do pole Retype password.

➤ Zpřístupní se tlačítko OK.

5. Klepnutím na tlačítko OK potvrïte heslo.

l Nyní musíte k otevření databáze použít správné heslo.

Nastavení zálohy databáze
1. Zavřete databázi.

2. Spus�te program Průzkumník.

l Pokud chcete uložit zálohu na disk CD, spus�te místo programu Průzkumník programové vybavení
vypalovací jednotky.

3. Vyhledejte složku, která obsahuje databázové soubory.

l Jedná se například o My_New.mdb, My_New.mtb, My_New_1.tnd atd. ve složce
C:Z\Archive\My_New.

4. Zkopírujte uvedené soubory na pamě�ové médium.

l Můžete použít jiný (sí�ový) pevný disk nebo přenosné pamě�ové médium (například disk CD).

5. Přesvědčte se, zda má pamě�ové médium, použité pro zálohování, dostatečně velkou volnou
kapacitu pro uložení všech složek se soubory obrázků anebo dokumentů.

l Názvy složek se soubory obrázků a dokumentů obvykle obsahují databázový kód ID vytvořený
počítačem a ukončení. Například _Vol1, _Vol2, _Vol3 atd.

l Maximální velikost složek pro soubory s obrázky a dokumenty můžete nastavit v dialogovém okně,
které otevřete příkazem Database > Settings... > Storage capacity in MB. Při použití disku CD je
rozumné nastavit 600 MB.

l Pokud jsou obrázky a dokumenty z databáze již uloženy na přenosných pamě�ových médiích, je
vhodné je při zálohování kopírovat metodou 1:1 na stejný druh pamě�ového média.

6. Při použití přenosných pamě�ových médií (například disku CD) se ujistěte, zda jsou řádně označené,
a uschovejte je na místě, na které budou mít přístup pouze autorizované osoby a kde nehrozí
poškození médií.
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Výstraha!!!
Musíte pravidelně

zálohovat Vaši
databázi!

Ujistěte se, že jste si
poznamenali heslo

pro přístup k databázi!

Pokud chcete zabezpečit databázi heslem, zvolte příkaz
Database > Change Password. Můžete zvolit heslo
složené až ze 14 libovolných znaků. Z důvodu ověření
musíte zadat heslo dvakrát po sobě – místo každého
zadaného znaku se zobrazí symbol hvězdička.

Tento příkaz je dostupný pouze při otevření databáze
s přidělením výhradních práv

Pokud chcete omezit maximální počet záznamů, které lze
současně smazat, otevře dialogové okno Settings příkazem
Database > Settings.

Informace o dalších prostředcích ochrany proti
neautorizovanému přístupu k Vašim datům i vybavení proti
případné ztrátě dat naleznete v Uživatelské příručce.

Archivace obrázků
Příprava databáze
Vkládání obrázků
Práce s databázovými dokumenty
Export obrázků
Vyhledávání v databázi
Zálohování databáze

Ukládání

Jednotlivé obrázky i celou databázi můžete
velmi snadno smazat. Neexistuje žádné
pamě�ové médium, které Vám poskytne
100 % ochranu dat. Z tohoto důvodu má
nejvyšší důležitost ochrana Vaší databáze
proti neautorizovanému přístupu, proti ztrátě
dat neúmyslným smazáním nebo
poškozením pamě�ového média:

l Chraňte Vaši databázi heslem
l Pravidelně databázi zálohujte.

Mazání obrázku
l Zvolte požadovaný obrázek, resp.

obrázky, v databázovém dokumentu.
l Klepnutím na zobrazené tlačítko na

panelu nástrojů Database smažte
obrázek, resp. obrázky, z databáze.

l Provedenou operaci mazání nelze zrušit.

Mazání databáze

Mazat můžete pouze databázi otevřenou
s přidělením výhradních práv.

l Otevřete databázi s přidělením
výhradních práv.

l Zvolte příkaz Database > Delete...
l Zobrazí se dvě výstrahy s informací,

že databázi ztratíte.
l Smazanou databázi nelze obnovit.

Obnova databáze

Pokud máte potíže s otevřením databáze,
například po jejím havarijním uzavření,
pokuste se ji obnovit:

l Všichni ostatní uživatelé musí databázi
zavřít.

l Nyní se pokuste otevřít databázi ještě
jednou.

l Pokud není databáze funkční, zvolte
příkaz Database > Repair...

l Jestliže je Vaše databáze poškozená,
budete muset použít záložní kopii.
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Úprava překryvných vrstev (overlay)
1. Klepněte na tlačítko Overlay Button Bar na standardním panelu nástrojů, zobrazí se panel nástrojů

s tlačítky pro překryvné vrstvy.

➤ Tlačítko Overlay Button Bar bude stisknuté, dokud bude zobrazen panel nástrojů s tlačítky pro
překryvné vrstvy

Vkládání a formátování textů
2. Pokud chcete vložit textový objekt, klepněte na tlačítko Text.

➤ Na vrstvě se zobrazí rámeček.

3. Prostřednictvím myši upravte polohu a velikost textového objektu. Jestliže chcete přenést textový
objekt do překryvné vrstvy, klepněte na něj pravým tlačítkem myši.

➤ Program analySIS® otevře dialogové okno Object Properties.

4. Na kartě Text zadejte místo nabízeného textu <New text> svůj vlastní text.

l Text v objektu v překryvné vrstvě můžete kdykoliv změnit po stisknutí tlačítka Object Properties.

5. Pokud chcete nastavit velikost textového objektu podle délky textu, zatrhněte předvolbu Autosize
bound.

6. Zatrhněte předvolbu Zoom with image. Velikost textu se vždy nastaví podle stupně zvětšení obrázku
na obrazovce.

7. Na kartě Font zvolte písmo, jeho velikost, styl a barvu.

8. Na kartě Colors and Lines nastavte barvu pozadí a rámečku textového objektu.

9. Klepnutím na tlačítko OK zavřete dialogové okno.

➤ Text v překryvné vrstvě se náležité upraví. Šířka textového pole se upraví podle délky textu.
Výběrové značky budou mít šedou barvu. Šedá barva signalizuje, že objekt v překryvné vrstvě má
automatický rámeček, tzn. že velikost rámečku nelze interaktivně měnit.

➤ Nově vložené textové objekty zůstanou zvýrazněné uvnitř obrázku.

Vložení a úprava vzhledu šipek
10. Klepněte na tlačítko Arrow.

11. Klepnutím levého tlačítka myši se nastavuje počáteční a koncový bod šipky v obrazovém dokumentu.

➤ Všechny libovolné aktuální výběry se zruší.
Program analySIS® vloží šipku do překryvné vrstvy, šipka bude zvýrazněná.
Výchozí vzhled šipky po vložení závisí na nastavení v programu analySIS®.

12. Pokud chcete změnit vzhled šipky, klepněte na tlačítko Object Properties. Zvolte barvu, druh čáry,
šířku a styl šipky.

13. Klepnutím na tlačítko Apply přidělte šipce zvolené vlastnosti.

14. Jakmile budete spokojeni se vzhledem šipky, zavřete dialogové okno klepnutím na tlačítko Close.
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Obrázek můžete doplnit překryvnými vrstvami, aniž by se
přepsala data obrázku, protože překryvná vrstva je pouze
umístěna přes obrázek a je průhledná. Program analySIS®

využívá vícenásobné vrstvy pro různé druhy údajů. Datová
vrstva je vyhrazena pro údaje automaticky generované
měřicími operacemi programu analySIS®. Pokud chcete
k obrázku doplnit komentář, použijte vrstvu pro komentáře.

Zobrazenému obrázku jsou přiřazené 4 překryvné objekty:
tři textové objekty různých formátů a vpravo bitmapový
objekt. Všechny překryvné objekty jsou ve vrstvě pro
komentáře. Dynamické měřítko není překryvný objekt.

Grafická data mohou být ukládána/zpracovávána různými
metodami: bitmapy se skládají z jednotlivých bodů,
vektorová grafika z matematicky popsaných křivek. Čáry
jsou popsány jejich počátečními a koncovými body.

Na obrázku jsou znázorněny čáry v bitmapové a vektorové
grafice (velmi zvětšené). Údaje doplňované programem
analySIS® jsou ve vektorové grafice, obrázky jsou tvořeny
z jednotlivých bodů.

Zpracování obrázků
Úprava překryvných objektů
Nastavení kontrastu/barev obrázku
Filtrování obrázků

Překryvné objekty obsahují komentáře,
zvýrazňující (například šipky) nebo grafické
prvky (například logo společnosti). Mnoho
funkcí programu analySIS® také doplňuje
do překryvné vrstvy své výsledky.
V programu analySIS® jsou překryvné vrstvy
umístěny přes obrázky, a připomínají tak
průhledné fólie pro zpětný projektor. Data
obrázku pod překryvnými vrstvami zůstanou
nedotčená. Pokud uložíte obrázek
s překryvnými vrstvami v programu
analySIS® ve formátu TIF, obrázek
a překryvné vrstvy zůstanou oddělené.

Překryvné vrstvy

Překryvné objekty mohou být uspořádány
v různých překryvných vrstvách. Tyto vrstvy
fungují stejně, jako kdybyste umístili několik
průhledných fólií přes obrázek. Každá
průhledná fólie, resp. překryvná vrstva,
může obsahovat objekty.

l Vrstva pro komentáře obsahuje všechny
objekty vložené tlačítky z panelu nástrojů
pro překryvné vrstvy.

l Datová vrstva obsahuje všechny údaje,
které program analySIS® zapisuje jako
překryvné pro: interaktivní měření,
automatické zjištění částic nebo výpočet
histogramu. Při standardním nastavení je
tato vrstva zablokovaná, tzn. že v datové
vrstvě nemůžete zvolit, přesunout nebo
smazat objekty.

Spojení překryvné vrstvy s obrázkem

Překryvné objekty se mohou spojit
s obrázkem, čímž přepíší data obrázku.
Spojení překryvných objektů s obrázkem
je nutné například při exportu obrázku
s překryvnými vrstvami do jiné aplikace,
jako je například MS Word. Jedná se
o jediný způsob, jak ostatním aplikačním
programům zpřístupnit údaje z překryvných
vrstev.
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Úprava překryvných objektů
Načtení libovolné bitmapy do překryvné vrstvy

15. Klepněte na tlačítko Load Object.

➤ Otevře se standardní dialogové okno pro načtení souboru. Seznam Files of type Vám nabízí výběr
z mnoha formátů souborů s obrázky: BMP, ICO, EMF společně s OVL, což je formát pro soubory
s překryvnými objekty, používaný programem analySIS®.

16. V seznamu Files of type zvolte položku Windows bitmap (*.BMP). Vyhledejte požadovaný soubor
s bitmapou a klepněte na tlačítko Open. Může se například jednat o logo Vaší společnosti nebo
porovnávací obrázek.
Vnořená složka Overlay v kořenové složce programu analySIS®obsahuje ukázky všech
podporovaných typů souborů.

➤ V překryvné vrstvě se zobrazí rámeček velikosti bitmapy. Polohu rámečku můžete upravit podle
svých představ, Po klepnutí pravým tlačítkem myši můžete překryvný objekt přesunout.

17. Pokud chcete bitmapu orámovat nebo změnit některou z jejích barev, klepněte na tlačítko Object
Properties.

18. V barevné paletě Keying zvolte barvu, která se vyskytuje v bitmapě, a potom zvolte hodnotu
Transparent v paletě Background.

19. Klepnutím na tlačítko OK zavřete dialogové okno.

➤ Zvolená barva se již nezobrazí. V místech, kde byla použita zvolená barva, bude bitmapa
průhledná. Původní obrázek bude prosvítat.

Uložení a načtení překryvných objektů
20. Klepněte na tlačítko Select All.

➤ Všechny překryvné objekty budou obklopeny výběrovými značkami.

21. Jestliže chcete zvolené překryvné objekty uložit do souboru, klepněte na tlačítko Save Objects na
panelu nástrojů pro překryvné vrstvy.

➤ Všechny překryvné vrstvy, obsahující texty, šipky a bitmapy, se uloží do souboru OVL.

Úprava existujících překryvných objektů
22. Jestliže chcete změnit vlastnosti existujících překryvných objektů, klepněte na tlačítko Edit Overlay.

➤ Kurzor myši se přesune na obrázek.

23. Poklepejte na překryvný objekt, který chcete upravit.

➤ Po poklepání na objekt se otevře dialogové okno Object Properties.
➤ Kolem zvoleného překryvného objektu se zobrazí výběrové značky.

24. Upravte překryvný objekt podle svých požadavků a potom klepnutím na tlačítko OK zavřete
dialogové okno.

l Nabídka funkcí, nabízená v dialogovém okně Object Properties, závisí na zvoleném objektu.
l Překryvné objekty můžete upravovat pouze po jednom, například funkce Object Properties je

dostupná pouze v případě, že je právě zvolen jeden překryvný objekt.
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Panel nástrojů pro překryvné vrstvy

Overlay button
bar

Zobrazuje/ruší panel nástrojů pro překryvné vrstvy.
Všechny funkce pro překryvné vrstvy jsou dostupné
pouze těmito tlačítky. Panel obsahuje rozsáhlou řadu
nástrojů pro úpravu překryvných objektů podle Vašich
představ.

Edit Overlay Přepíná do režimu úprav překryvných objektů. Režim
se používá pro výběr, přesun a úpravu překryvných
objektů. Tlačítko je dostupné pouze v případě, že je
použit alespoň jeden překryvný objekt.

Select All Označuje všechny překryvné objekty aktivního
obrázku. Tlačítko je dostupné pouze v případě, že
není zvolen žádný překryvný objekt.

Select None Ruší všechny aktuální výběry. Tlačítko je dostupné
pouze v případě, že je zvolen některý překryvný
objekt.

Object
Properties

Slouží k nastavení vlastností objektů. Dostupnost
jednotlivých vlastností závisí na druhu zvoleného
překryvného objektu.

Layer Otevírá multifunkční podnabídku pro práci
s překryvnými vrstvami.

Překryvné vrstvy se mohou nebo nemusí zobrazovat.
Překryvné vrstvy s automaticky vytvořenými daty
z měření mohou být chráněny proti náhodným
úpravám.

Burn Overlay Zapíše překryvné objekty aktivního obrázku nevratně
přímo do obrázku, všechna data obrázku pod
překryvnými objekty se přepíší.

Delete Layer Maže všechny objekty aktuálně zobrazené překryvné
vrstvy.

Load Objects Načítá bitmapy, ikony, metasoubory nebo kompletní
překryvné objekty z existujícího souboru do překryvné
vrstvy aktivního obrázku.

Save Objects Ukládá všechny zvolené překryvné objekty do
souboru OVL.

Cut Objects
Copy Objects
Paste Objects

Kopíruje zvolené překryvné objekty z jednoho
obrázku do druhého nebo stejného obrázku.

Uvědomte si, že překryvné objekty nelze kopírovat
s využitím schránky Windows.

Bring to Front
Send to Back
Bring Forward,
Send Backward

Uspořádává překryvné objekty v požadovaném
pořadí – před, za apod. Vzájemně uspořádat lze
pouze překryvné objekty jedné vrstvy.

Text Pro vkládání textových objektů.

Rectangle
Elipse Line
Arrow Polyline
Polygon

Pro vkládání různých grafických objektů do překryvné
vrstvy.

Highlighter Slouží k barevnému zvýraznění libovolné pravoúhlé
oblasti na obrázku. Segment zvýrazněného obrázku
vypadá jako barevná průhledná fólie, umístěná přes
oblast obrázku.

Zpracování obrázků
Úprava překryvných objektů
Nastavení kontrastu/barev obrázku
Filtrování obrázků

Poznámky:

1. Režim úpravy objektu

Při většině operací musí být zvolen
překryvný objekt. Překryvné objekty můžete
zvolit pouze v případě, že se kurzor myši
nachází na obrazovém dokumentu. Jestliže
chcete zjistit informace o režimu úpravy
překryvných objektů, klepněte na tlačítko
s bílou šipkou na panelu nástrojů překryvné
vrstvy.

2. Výběr v překryvné vrstvě

Výběr se zpravidla odstraní, pouze pokud jej
explicitně zrušíte.

Jestliže chcete zrušit všechny výběry,
klepněte například na tlačítko s červeným
symbolem ×.

3. Velikost písma

Můžete zvolit jednu ze dvou dostupných
variant pro velikost písma v překryvných
objektech (Text Properties > Text > Zoom
with Image). Nastavené hodnoty se také
berou v úvahu při tisku:

Váš text může měnit velikost společně
s obrázkem na obrazovce, takže zajistíte,
aby velikost písma odpovídala velikosti
zobrazení obrázku. Pokud zobrazíte
obrázek ve výřezu s menším koeficientem
zvětšení, velikost písma se odpovídajícím
způsobem změní.

Při zvětšení menším než 100 % můžete text
zobrazovat v konstantní velikosti.

4. Zablokování překryvné vrstvy

Při výchozím nastavení je datová vrstva
zablokovaná. To znamená, že objekty
v datové vrstvě nelze volit ani upravovat.

5. Schránka pro překryvné objekty

Pokud chcete kopírovat překryvný objekt,
používejte tlačítka na panelu nástrojů pro
překryvné vrstvy. Nemůžete použít schránku
z Windows. Místo kombinace kláves
[Ctrl]+[C] a [Ctrl]+[ V] použijte tlačítka na
panelu nástrojů.
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Zvýšení kontrastu obrázku
Zvýšení kontrastu...

1. Načtěte obrázek do pamě�ového pole 1.

l Jako příklad pro zvýšení kontrastu je vhodný obrázek Fiber z demonstrační databáze.

2. Klepněte na tlačítko Image (button bar) > Arrange Viewports. Zvolte uspořádání výřezů 1 × 4.
Potom můžete porovnat původní obrázek s obrázkem zobrazujícím vliv různých úprav kontrastu.
Zvětšete okno obrázku na celou obrazovku.

3. Nastavte pamě�ové pole obrázku 2 jako cílové pamě�ové pole. To provedete uchopením
a přetažením pamě�ového pole na zástupce složky Dest v rámečku s operandy.
Zvolte příkaz Oper > Intensity > Maximize Contrast.
➤ Výsledný obrázek se zapíše do cílového pamě�ového pole.
l U obrázků v odstínech šedé příkaz převádí aktuální úrovně šedé na jejich maximální rozsah.

Kontrast se zvýší pouze v případech, kdy obrázek nemá žádné černé a bílé body.

4. Aktivujte pamě�ové pole obrázku 1. Nastavte pamě�ové pole 3 jako cílové pamě�ové pole. Zvolte
příkaz Oper > Intensity > Optimize Contrast.
l Příkaz vyjme 3 % nejtmavších a nejsvětlejších obrazových bodů z histogramu a nastaví je jako

černé, resp. bílé. Histogram se potom upraví tak, aby pokryl maximální rozsah odstínů šedé.

5. Aktivujte pamě�ové pole obrázku 1. Nastavte pamě�ové pole 4 jako cílové pamě�ové pole. Zvolte
příkaz Oper > Intensity > Equalize Contrast.
l Příkaz přiřazuje nové úrovně šedé obrazovým bodům tak, aby se všechny úrovně šedé

zobrazovaly téměř stejně často, tzn. že libovolný odstín šedé, který se zobrazuje častěji, se rozptýlí
mezi více úrovní šedé. Tímto způsobem se vytváří struktura viditelná v oblasti obrázku s podobným
jasem.

Subjektivní nastavení kontrastu
1. Načtěte obrázek a nastavte cílové pamě�ové pole. Klepněte na tlačítko Image (button bar) > Single

View, zobrazí se všechna nastavení kontrastu v optimální velikosti v původním obrázku.

2. Zvolte příkaz Oper > Intensity > Modify Gray Values.

➤ V dialogovém okně Modify Gray Values se zobrazí histogram obrázku (červený) a převodní
funkce (modrá). Výchozí je lineární přenosová funkce. Obrázek se nezmění.

l Libovolná úprava kontrastu se ihned projeví na obrázku.

3. Nastavte kontrast a intenzitu, například posuvnou lištou Contrast. Uvidíte, jak se obrázek mění
a kontrast se zvyšuje.

4. Nyní načtěte jednu z přenosových funkcí ze seznamu Function.

l Například hodnoty Square Root a Logarithm zvyšují kontrast v temných oblastech obrázku
a snižují kontrast se světlých oblastech. Hodnoty Square a Exponential mají opačný účinek.

5. Pokud chcete nastavit vlastní přenosovou funkci, nakreslete ji od ruky. Křivka se kreslí přesouváním
kurzoru myši na souřadnicovém grafu po stisknutí a přidržení levého tlačítka myši.

6. Jakmile obrázek optimalizujete podle svých představ, klepněte na tlačítko Change.

➤ Výsledek se zapíše do cílového pamě�ového pole.
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Původní obrázek a výsledky různých způsobů nastavení
kontrastu: maximalizovaný kontrast znamená, že současné
úrovně šedé se upraví tak, aby pokryly celý rozsah úrovní
šedé. U optimalizovaného kontrastu se 3 % nejtmavších
a nejsvětlejších obrazových bodů nastaví jako černé, resp.
bílé, a výsledný histogram se upraví tak, aby pokryl
maximální rozsah úrovní šedé. Vyrovnávaný kontrast
znamená, že současné úrovně šedé se rovnoměrně rozptýlí
tak, aby pokryly celý rozsah odstínů šedé.

V dialogovém okně je zobrazen histogram původního
obrázku. Původní obrázek obsahuje pouze některé
z dostupných úrovní šedé. V obrázku jsou pouze úrovně
šedé v rozsahu 100–230.

Přenosová funkce zobrazuje „maximální roztažení“
a odpovídá příkazu Maximize Contrast. Funkce upraví
existující úrovně šedé tak, aby pokryly maximální rozsah
(0–255).

Zpracování obrázků
Úprava překryvných objektů
Nastavení kontrastu/barev obrázku

Zvýšení kontrastu obrázku
Nastavení barev obrázku

Filtrování obrázků

Co to je kontrast?

Obrázky v odstínech šedé mohou
obsahovat maximálně 256 různých úrovní
jasu (256 úrovní odpovídá 8 bitům).
V mnoha obrázcích se však jas obrazových
bodů liší pouze v malém rozsahu, takže
aktuální rozsah úrovní šedé je menší než
celý rozsah dostupných úrovní (0–255).
Struktury v takových obrázcích jsou
vzhledem k minimálnímu kontrastu těžko
rozlišitelné. Pokud chcete optimalizovat
obrázek pro prohlížení, upravte úrovně šedé
tak, aby pokryly maximální rozsah, tedy
zvyšte kontrast.

Jaké jsou metody nastavení kontrastu?

Jednotlivé metody nastavení kontrastu mění
aktuální úrovně šedé na nové
prostřednictvím odpovídající funkce: tzn. že
nové úrovně šedé jsou obrazovým bodům
přiřazeny jednotlivě, na základě původních
úrovní. Úprava kontrastu je narozdíl od filtrů
lokální operace s obrázkem. Filtry využívají
k výpočtu nové úrovně šedé příslušného
bodu i úrovně šedé okolních bodů.

Úpravou kontrastu můžete zlepšit kvalitu
málo kontrastních obrázků. Kontrast lze
zvýšit v jednotlivých rozsazích úrovní jasu,
aby struktury, které byly v původních
obrázku nejasné, byly viditelné. Struktury
v obrázku mohou být podle potřeby
zvýrazněny nebo potlačeny.

Co to je histogram?

Histogram je graf s osami x a y, který
ukazuje vztah mezi počtem obrazových
bodů a 256 úrovněmi šedé. Zobrazuje
zastoupení a rozložení úrovní šedé
v obrázku. Vrcholky grafu odpovídají
odstínům, které se v obrázku vyskytují
nejčastěji. Histogram nabízí další způsob
kontroly výsledku po úpravě kontrastu
(kromě pouhého pohledu na obrázek
a následného posouzení).
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Nastavení barev obrázku
Nastavení barev (RGB)
Nabídka Oper obsahuje podnabídku Adjust Colors s příkazy pro úpravu pseudobarev a jejich intenzity
v obrázku. Následující podrobné pokyny popisují na příkladu nastavení barev RGB funkci těchto příkazů.

1. Pokud chcete nastavit červenou, zelenou a modrou složku aktivního obrázku, zvolte příkaz Oper >
Adjust Colors > Define RGB Adjustment...

l V dialogovém okně Define RGB Adjustment se nachází posuvná lišta a pole pro zadání hodnot
pro všechny tři barevné složky (červenou, zelenou, modrou). Posuvné lišty slouží pro rychlé, avšak
méně přesné nastavení hodnot barev. Po nastavení přibližné hodnoty využijte vstupní pole pro
doladění optimální hodnoty. Požadovanou hodnotu můžete zadat přímo nebo ji zvolit tlačítky se
šipkami.

l Výchozí nastavení: po otevření dialogového okna se naposledy nastavené hodnoty barev zobrazí
jako výchozí.

2. Pokud chcete sledovat, jak se úpravy barev projeví na obrázku, zatrhněte předvolbu Preview.
Po klepnutí na tlačítko Window zvolte pravoúhlou oblast v obrázku, která se zobrazí v náhledu.

l Náhledové okno je důležité pouze během nastavování barev. Po potvrzení nového nastavení barev
se upraví barvy celého obrázku. Pokud jste zvolili pouze určitou oblast obrázku, upraví se barvy
pouze v této oblasti.

l Při prvním spuštění programu analySIS® bude jako výchozí oblast pro zobrazení náhledu zvolen
celý obrázek.

3. Nastavení hodnot barev:

l Pokud chcete omezit barvu v obrázku, přesuňte jezdce příslušné posuvné lišty vlevo.
l Chcete-li zvýšit zastoupení barvy v obrázku, posuňte jezdce posuvné lišty vpravo.
l Hodnota 0 znamená, že zůstala zachována původní hodnota barevné složky.

4. Pokud chcete obnovit vzhled obrázku na stav před provedením jakýchkoliv změn, klepněte na tlačítko
Reset. Všechny hodnoty se nastaví na 0.

5. Pokud chcete uložit aktuální sadu hodnot, klepněte na tlačítko File... Uloženou sadu hodnot můžete
kdykoliv načíst a použít pro nastavení barev libovolného obrázku.

6. Chcete-li upravit barvy obrázku podle aktuální sady hodnot, klepněte na tlačítko Execute.

➤ Dialogové okno se zavře a obrázek aktuálně zastoupený náhledem se vloží do cílového
pamě�ového pole.

l Výstraha: Pokud jste příkazem Image > Set Frame zvolili určitou oblast obrázku, provedou se
úpravy barev pouze v oblasti ohraničené výběrovým rámečkem.

l Pokud chcete použít stejné hodnoty pro úpravu barev jiného obrázku, stačí zvolit příkaz Adjust
Colors > Execute RGB Adjustment, kdykoliv to bude potřebné.
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Následující tabulka obsahuje přehled nastavitelných
parametrů. Rozsah dostupných hodnot je definován nejnižší
a nejvyšší hodnotou. Střední hodnota znamená, že původní
obrázek zůstane zachován.

Oper >Adjust Colors

Příkaz Parametr Rozsah hodnot

Intensity
Adjustment
(Nastavení
intenzity)

Gamma 0,1 1 10

Brightness
(Jas)

-1000 0 1000

Contrast
(Kontrast)

-1000 0 1000

HSI
Adjustment
(Nastavení
HSI)

Intensity (Jas) -1000 0 1000

Hue
(Barva)

-360 0 360

Saturation
(Sytost)

-1000 0 1000

RGB
Adjustment
(Nastavení
RGB)

Red (Červená) -255 0 255

Green (Zelená) -255 0 255

Blue (Modrá) -255 0 255

Nastavení intenzity: V uvedených obrázcích jsou

nastaveny parametry gama, jas a kontrast.

Levý obrázek: gama > 1 znamená, že obrázek je jasnější
a kontrast v tmavých oblastech se zvýší.

Obrázek uprostřed: jas +200 znamená zvýšení intenzity.
Hodnoty barev zůstanou zachovány.

Obrázek vpravo: kontrast +1000 znamená vyšší sytost
barev. Hodnoty barev se nezmění.

Nastavení HSI:

Obrázek vlevo: intenzita +200 způsobí zvýšení jasu.

Obrázek uprostřed: střední hodnota, přibližně ±200,
způsobí maximální změnu barev. Maximální hodnota ±360
zachová původní hodnoty. Kladná i záporná hodnota
způsobí stejnou změnu barev.

Obrázek vpravo: sytost +1000 je maximální sytost.

Zpracování obrázků
Úprava překryvných objektů
Nastavení kontrastu/barev obrázku

Zvýšení kontrastu obrázku
Nastavení barev obrázku

Filtrování obrázků

RGB: je zkratka pro red (červená), green
(zelená), blue (modrá). Tento barevný
model používá pro popis barev aditivní
(součtové) barvy, jako například
u obrazovky monitoru. Obrázky RGB jsou
také označovány jako obrázky true color
a mohou obsahovat až 16 777 216
(=256 × 256 × 256) odlišných barev
vytvářených aditivním mícháním tří
primárních barev. Pokud jsou všechny
barevné složky nulové, obrázek bude mít
černou barvu. Smícháním 100 % složek
všech tří primárních barev vznikne bílá.

HSI: je zkratka pro hue (barva), saturation
(sytost) a intensity (jas). HSI (barva, sytost,
jas) je další model pro popis barev. Hodnoty
HSI se vytváří z hodnot RGB souřadnicovou
transformací. Model HSI je snáze
pochopitelný než model RGB, protože jeho
parametry jsou blíže vlastnímu intuitivnímu
popisu barev.

Korekce hodnoty gama zvyšuje nebo
snižuje selektivně kontrast v závislosti na
hodnotách intenzity:

I(R) = I(O) 1/γ

kde I(R) je intenzita výsledného obrázku;
I(O) je intenzita původního obrázku.

l Hodnota gama γ < 1 ztmavuje celý
obrázek. Zvýší se kontrast světlých
oblastí v obrázku.

l Hodnota gama γ > 1 zesvětluje celý
obrázek. Zvýší se kontrast tmavých
oblastí v obrázku.

l Hodnota gama γ = 0 nezpůsobí žádné
změny obrázku.

59

Gama 1,5 Jas +200 Kontrast +1000

Intenzita +200 Odstín +200 Sytost +1000



Filtrování obrázků v odstínech šedé
Potlačení šumu

1. Načtěte obrázek nebo aktivní pamě�ové pole obrázku. Nastavte cílové pamě�ové pole.

l Vhodným ukázkovým obrázkem je ZrO2 v demonstrační databázi.

2. Pokud chcete odstranit náhodný šum v obraze, zvolte příkaz Oper > Filter > Mean.

➤ Po použití filtru se výsledný obrázek vloží do cílového pamě�ového pole.

3. Aktivujte původní obrázek. Nastavte jiné cílové pamě�ové pole obrázku.

4. Zvolte příkaz Oper > Define Filter > NxN..., abyste mohli nastavit úroveň zprůměrování obrázku.

➤ Otevře se dialogové okno Defie NxN.

5. Klepněte na tlačítko Window.

➤ Na obrázku se zobrazí kurzor myši společně s červeným rámečkem. Po stisknutí levého tlačítka
můžete zvolit oblast na obrázku, která se použije pro náhled. Klepnutím pravého tlačítka myši
zvolenou oblast potvrïte.

l Všechny změny v nastavení parametrů se ihned projeví na náhledu.

6. Do pole Iterations zadejte počet provedení průměrování. Čím vyšší hodnotu zvolíte, tím větší
průměrování se provede. Začněte s hodnotou 1.

7. Do pole Size zadejte velikost okolní oblasti v obrazových bodech, která se použije pro průměrování:
například hodnota 3 odpovídá oblasti o velikosti 3 × 3.

l S rostoucí hodnotou bude obrázek více vyhlazený. Vyhladí se také artefakty, ovšem nikoli aktuální
okraje.

8. Pokračujte v nastavení obou parametrů, dokud nedosáhnete optimální výsledky. Potom klepněte na
tlačítko Execute.

Zaostření obrázku
9. Pokud chcete zvýšit kontrast obrázku, zvolte příkaz Oper > Filter > Sharpen I.

l Po potlačení šumu nebo artefaktů průměrovacím filtrem můžete znovu zaostřit vyhlazené hrany.

Zvýraznění detailů v obrázku
1. Načtěte obrázek. Nastavte cílové pamě�ové pole obrázku.

l Můžete například použít obrázek Search Image z demonstrační databáze.

2. Zvolte příkaz Oper > Define Filter > DCE Filter...
l Filtr DCE zvyšuje malé lokální rozdíly v jasu. Detaily v obrázku se tak zvýrazní a všeobecnější prvky

ve strukturách se odsunou do pozadí.

3. Po klepnutí na náhled v dialogovém okně Define DCE můžete pozorovat vliv nastavených hodnot na
obrázek.

4. Upravte nastavení šířky pásma a míru zvýraznění – parametry Bandwidth a Enhancement. Při menší
šířce pásma se zvýrazní menší lokální rozdíly. Při větší hodnotě parametru Enhancement s tyto rozdíly
zvýrazní více. Parametry upravujte, dokud nenaleznete optimální nastavení.

5. Pokud chcete potlačit artefakty způsobené použitím filtru DCE (v oblastech se stejným jasem),
zatrhněte předvolbu Quality.

6. Nyní klepněte na tlačítko Execute.
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Statistický šum můžete potlačit použitím různých filtrů:
zprůměrování (vpravo nahoře), NxN – 1 iterace, velikost 5
(vlevo dole), dolní propust (vpravo dole). Po použití filtru
bude v obrázcích patrná základní struktura.

Impulzní (bodový) šum (například „Hot Pixels“) a jednotlivé
chybné obrazové body snímače CCD můžete odstranit
filtrem medián. Hrany zůstanou ostré.

Použitím filtru DCE se obrázek zaostří. Lehce
přehlédnutelné detaily v obrázku tak budou snáze viditelné.

Zpracování obrázků
Úprava překryvných objektů
Nastavení kontrastu/barev obrázku
Filtrování obrázků

Filtrování obrázků v odstínech
šedé

Filtrování obrázků RGB

Co jsou to filtry?

Filtry jsou funkce ovlivněné okolními body.
Jas obrazového bodu ve výsledném
obrázku se vypočte na základě jasu
původního obrazového bodu i jasu okolních
bodů v původním obrázku.

Jak filtry pracují?

Nejjednodušší filtr je průměrovací filtr.
Hodnoty 3 × 3 obrazových bodů, které
obklopují středový bod se sečtou a vydělí 9
(počet obrazových bodů), čímž se získá
hodnotu jasu (šedi) středního bodu ve
výsledném obrázku. Tento filtr redukuje
statistický šum, který se náhodně objeví
v obrázku, koeficientem 3.

Jaké druhy filtrů jsou dostupné?

Průměrovací filtr je konvoluční filtr: tento
druh filtru je definován maticí, jejíž velikost
závisí na počtu uvažovaných okolních bodů,
například 5 × 5. Numerické hodnoty matice
jsou váhové koeficienty, které se násobí
odpovídajícím sousedním obrazovým
bodem. Průměrovací filtr například používá
matici 3 × 3 hodnot 1.

Další třída filtrů jsou filtry, které uspořádávají
pořadí bodů. Příkladem je například filtr
medián. Provádí setřídění všech okolních
obrazových bodů podle jasu. Původní
obrazový bod je pak nahrazen prostředním
obrazovým bodem tohoto uspořádání.
Tento filtr se používá pro odstranění
impulzního (bodového) šumu a jednotlivých
chybových obrazových bodů snímačů CCD.

Jaký filtr a pro jaké účely použít?
l Korekce statistického šumu: NxN, Mean,

Sigma, Lowpass, Rank
l Korekce impulzního šumu a chybných

obrazových bodů: Median, Rank
l Zvýšení kontrastu, zvýraznění detailů

obrázku: Sharpen I, Sharpen II, DCE
l Zvýraznění hran: Laplace, Sobel, Roberts

a další
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Filtrování obrázků RGB
Použití více filtrů RGB Studio
Přejete si zlepšit vzhled obrázků. Abyste jej zlepšili, potřebujete provést korekci hodnoty gama, zaostřit
obrázky a zvýšit jejich kontrast.

1. Aktivujte pamě�ové pole původního obrázku.

l Pouze klepněte levým tlačítkem myši na pamě�ové pole, v kterém se nachází obrázek.

2. Nastavte cílové pamě�ové pole obrázku.

➤ Program analySIS® nabídne cílové pamě�ové pole. Pokud chcete zvolit pole jiné, uchopte
požadované pamě�ové pole, stiskněte levé tlačítko myši a přesuňte pole ze správce obrázků do
rámečku s operandy.

3. Zvolte příkaz Oper > RGB Studio > Apply Filters...
➤ Okno obrazového dokumentu se minimalizuje. Objeví se samostatné okno s náhledem obrázku

z aktivního pamě�ového pole.
➤ Otevře se dialogové okno Apply Filters.

4. Zvolte filtr Gamma v seznamu Filter List.

➤ V oblasti Parameter se zobrazí pole Value.
l Tlačítky se šipkami u pole Value zvolte požadovanou konstantu γ. Přípustný rozsah hodnot je 0,1

až 100,0.
l Jakékoliv úpravy konstanty γ se ihned projeví na obrázku a zobrazí se v náhledovém okně.

Nastavení upravujte, dokud nedosáhnete uspokojivé výsledky.

5. Pokud chcete obrázek zaostřit, zvolte v seznamu Filter List filtr Sharpen.

➤ V oblasti Parameter se zobrazí pole Value.

6. Tlačítky se šipkami u pole Value zvolte požadovanou hodnotu ostření.

l Rozsah hodnot je –1000 až 1000 promile.
➤ Jakékoliv úpravy ostření se ihned projeví na obrázku a zobrazí se v náhledovém okně. Nastavení

upravujte, dokud nedosáhnete uspokojivé výsledky.

7. Jestliže chcete zvýšit kontrast, zvolte v seznamu Filter List filtr Stretch Intensity.

8. Klepněte na tlačítko Execute.

➤ Filtr se aplikuje na obrázek a výsledek se zobrazí v náhledovém okně.
l Pokud chcete zrušit použití filtru Stretch Intensity, klepněte na tlačítko Back – pokud je kontrast

stále nedostatečný nebo dokonce snad příliš velký. Potom použijte filtr Contrast nebo
Histocontrast. Při použití těchto filtrů nastavte kontrast sami.

9. Použijte další filtry, dokud neupravíte obrázek podle svých představ.

10. Klepnutím na tlačítko OK vložte výsledný obrázek do cílového pamě�ového pole.

➤ Náhledové okno a dialogové okno se zavřou.
➤ Okno obrazového dokumentu se opět zobrazí v původní velikosti a výsledný obrázek se zobrazí

v aktivním výřezu.
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Při použití RGB Studia se obrázek upravuje v samostatném
náhledovém okně. Všechny operace aplikované na obrázek
se v tomto okně ihned projeví. Během nastavení filtrů nejsou
zobrazeny překryvné vrstvy ani automatické měřítko.

Filtr Funkce

Gamma Upravuje hodnotu intenzity obrazových
bodů funkcí gama. Lze tak opravit
nelinearitu způsobenou fotoaparátem nebo
monitorem.

Hue Upravuje hodnotu odstínu obrazového
bodu.

Saturation Upravuje hodnotu sytosti obrazového
bodu.

Intensity Upravuje hodnotu intenzity obrazového
bodu.

Contrast Zvyšuje nebo snižuje kontrast obrázku.

Histocontrast Zvyšuje nebo snižuje kontrast obrázku.
Kontrast obrázku se nastavuje určením
průměrného jasu prostřednictvím
histogramu.

Sharpen Zaostřuje nebo rozostřuje obrázek.

Remove
Noise

Nahrazuje střední barvu každého bodu
barvou okolních bodů.

Average Nahrazuje barvu každého bodu průměrnou
barvou okolních bodů.

Solarize Imituje efekt klasického kinofilmu, který byl
shodou okolností krátce vystaven světlu.

Oilify Dodává obrázku vzhled olejových skvrn.

Posterize Upravuje obrázek tak, aby vypadal jako
plakát.

Mosaic Dodává obrázku vzhled mozaiky.

Emboss Zobrazuje reliéf objektů. Tmavé objekty
vypadají jako vystouplé, světlé objekty jako
zatlačené.

Noisify Dodává do obrázku náhodné obrazové
body, tzv. šum. Hodnoty šumu mohou být
přidány do všech barevných kanálů
(červený, zelený, modrý), nebo pouze do
jednoho.

Histoequalize Linearizuje počet obrazových bodů pro
jednotlivé úrovně intenzity. Zvýrazňuje
detaily v tmavých oblastech obrázku.

Stretch
Intensity

Zvyšuje kontrast obrázku.

Invert Invertujte barevné hodnoty obrazových
bodů. Výsledkem je obrázek, který vypadá
jako negativ fotografie.

Zpracování obrázků
Úprava překryvných objektů
Nastavení kontrastu/barev obrázku
Filtrování obrázků

Filtrování obrázků v odstínech šedé
Filtrování obrázků RGB

RGB-Studio se skládá ze skupiny příkazů
speciálně vyvinutých pro úpravy obrázků
RGB. Příkazy RGB Studia jsou umístěny
v nabídce Oper.

Používejte RGB Studio k:

l Filtrování barevných obrázků, použitím
například funkcí Gamma, Hue, Saturation,
Intensity, Contrast, Sharpen, Average,
Remove Noise, Oilify, Posterize, Mosaic
a mnoha dalších.

l Konverzi barev obrázku na 8bitové
obrázky použitím odlišných barevných
palet.

l Úpravě barevných palet.
l Otáčení nebo ořezávání barevných

obrázků.
l Překrývání barev obrázku nebo doplnění

vodoznaku.
l Rozložení barevných obrázků na barevné

složky použitím různých barevných
modelů.

l Obarvení barevných obrázků použitím
jedné barvy.

l Sestavení obrázků v odstínech šedé jako
barevných složek jednoho z barevných
modelů do obrázků true-type.

l Definice překryvných objektů libovolného
tvaru a barvy.

l Ořezávání, vyplnění nebo kopírování
oblasti obrázku libovolného tvaru.

Použití více filtrů: Při práci v RGB Studiu
můžete postupně použít vícenásobné
operace, aniž byste museli pokaždé volit
příkaz RGB Studio > Apply Filter... Každá
operace se projeví na obrázku upraveném
předcházejícími operacemi a potom se
umístí do zásobníku. Zásobník obsahuje
přehled všech operací souvisejících
s použitím filtrů v pořadí, v jakém byly
prováděny. Zpracování v zásobníku lze
odvolat, tzn. že jednu nebo více operací
s obrázky můžete kdykoliv postupně zrušit,
pokud nejste spokojeni s výsledky, a tudíž si
přejete použít jiné filtry.
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Měření vzdáleností
1. Před měřením zobrazte požadovaný obrázek tak, aby byl v obrazovém dokumentu zobrazen sám

a v seznamu Zoom Factor zvolte hodnotu 100 %.

l Hodnota 100 % parametru Zoom Factor znamená, že poměr mezi body obrázku a body na
monitoru je přesně 1:1. Zaručíte tak optimální přesnost měření.

2. Nezvětšujte obrazový dokument přes celou obrazovku.

l Pokud je obrazový dokument maximalizován, klepněte na tlačítko Restore Down. Přesuňte
dokument co nejvýše, abyste uvolnili prostor v dolní třetině pracovní plochy pro tabulku.

Měření konstantní vzdálenosti
3. Otevřete nabídku Measure.

l Všechny příkazy v první skupině nabídky jsou příkazy pro interaktivní měřicí funkce. Jako vzor pro
vysvětlení měřicích funkcí bude použit příkaz Arbitrary Distance.

4. Pokud chcete měřit konstantní vzdálenost v obrázku, zvolte příkaz Measure > Arbitrary Distance.

➤ Program analySIS® otevře tabulku výsledků měření. Název aktivního sloupce v tabulce a jednotek
pro měřené hodnoty se vloží automaticky a správně. Jednotka pro měření vychází z aktuální
kalibrace obrázku.

l Program analySIS® obvykle vytvoří novou tabulku pro každé nové měření. Pokud si přejete,
můžete však soustředit výsledky odlišných měření do jedné tabulky.

➤ Kurzor myši se přesune na obrázek v aktivním pamě�ovém poli.

5. Přesuňte kurzor myši na počáteční bod vzdálenosti, kterou si přejete změřit, a klepněte levým
tlačítkem myši.

➤ V překryvné vrstvě se zobrazí dvě červené rovnoběžné čáry v koncových bodech měřené úsečky,
kolmé k měřené vzdálenosti (úsečce). Použijte vztažné čáry k označení vzdálenosti, kterou si
přejete změřit.

➤ Měřená vzdálenost je zastoupena modrou čárou (úsečkou), která začíná ve Vámi zvoleném
počátečním bodu. Posunutím kurzoru myši posuňte nebo protáhněte čáru (úsečku) požadovaným
směrem.

6. Přesuňte kurzor myši na místo, kde si přejete vytvořit koncový bod měřené vzdálenosti. Potom
klepněte levým tlačítkem myši.

➤ Nastavená vzdálenost se zobrazí v překryvné vrstvě obrázku.
➤ Zjištěná délka se doplní do tabulky s výsledky měření.

7. Opakováním kroků 5 a 6 změřte všechny potřebné vzdálenosti.

Zrušení jednotlivých měření/Vynechání řádků v tabulce
8. Pokud chcete odstranit výsledek jednoho měření z obrázku a překryvné vrstvy, stiskněte klávesu

[Shift] a klepněte pravým tlačítkem myši.

l Každým dalším klepnutím pravého tlačítka myši odstraníte předcházející měření.
l Jednotlivá měření mohou být smazána, pouze pokud měření stále ještě probíhá.

9. Jestliže chcete vynechat řádek v tabulce, stiskněte klávesu [Ctrl] a klepněte pravým tlačítkem myši.

Ukončení měření
10. Chcete-li ukončit měření, stačí pouze klepnout pravým tlačítkem myši. Klepnutím na tlačítko Yes

potvrïte prováděnou operaci.
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Přesvědčte se, zda jste nechali dostatek místa pro tabulku
výsledků měření, aby ji při měření nezakryl obrazový
dokument.

Řádky v tabulce můžete přeskakovat, tzn. vynechávat
během interaktivního měření. Na obrázku je uvedena
ukázka k vynechání řádků. V tabulce jsou soustředěny
naměřené vzdálenosti ve dvou odlišných směrech. Měření
provedená ve stejné části mají shodné číslo a jsou zapsána
do stejného řádku v tabulce. Vytvořit takovou tabulku je
jednoduché – vše, co potřebujete udělat, je provést sérii
měření ve stejném pořadí. Pokud nelze příslušné měření
v daný okamžik provést, vynechejte řádek.

Ovládání myší při interaktivním měření

Nastavení krajních bodů
měřené vzdálenosti

Levé tlačítko

Zrušení jednoho měření [Shift ] + pravé tlačítko

Vynechání čísla a řádku
v tabulce

[Ctrl] + pravé tlačítko

Ukončení jednotlivých měření
nebo ukončení celého měření

Pravé tlačítko 1×/2×

Měření obrázků
Měření vzdálenosti a plochy
Úprava překryvných vrstev s výsledky
měření
Fázová analýza

Interaktivní měření

Nabídka Measure poskytuje řadu měřicích
funkcí. Jednotlivé příkazy mají následující
význam:

l Touch Count je určen pro interaktivní
zjištění počtu částic.

l Horizontal/Vertical Arbitrary Distance
měří libovolné druhy vzdáleností.

l Polygon Length měří délky
polygonálních čar.

l Circle měří plochu a obvod kruhové
oblasti.

l Pixel Value určuje úrovně šedé nebo
barvy jednotlivých bodů.

Výsledky měření

Všechny interaktivní měřicí funkce vytvářejí
tabulku výsledků. Naměřené číselné
hodnoty jsou také zobrazeny barevně
v datové překryvné vrstvě obrázku.

Soustředění naměřených hodnot

Pokud si to přejete, můžete soustředit
výsledky vícenásobných měření do jedné
tabulky.

l Zvolte v tabulce sloupec, do kterého si
přejete doplnit data. Stačí pouze klepnout
na hlavičku požadovaného sloupce.

l Nyní proveïte interaktivní měření.
l Pokud si přejet vložit výsledky měření

do sloupce, v kterém jsou již vloženy
výsledky měření, program analySIS® vloží
nové hodnoty, pouze pokud odpovídají
jednotky. Pokud se pokusíte vložit do
sloupce s hodnotami vyjadřujícími délku
hodnoty udávající plochu oblasti, mělo by
se zobrazit chybové hlášení.

Dokumentové okno je překryté?

Pokud je obrazový dokument nebo tabulka
výsledků měření překrytá jiným okem, stačí
zobrazit přehled všech otevřených
dokumentových oken z dolního okraje
nabídky Window. Potom klepněte na
dokument, který si přejete zobrazit přes
ostatní dokumenty.
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Úprava překryvných vrstev
s výsledky měření

1. Pokud není zobrazen panel nástrojů Overlay, klepněte na tlačítko Overlay Button Bar na
standardním panelu nástrojů.

l Po ukončení měření již nebudou hodnoty v datové překryvné vrstvě a v tabulce výsledků měření
propojené. Jakékoliv změny provedené v tabulce se již automaticky neprojeví v překryvné vrstvě
a naopak. Pokud si později přejete upravit překryvný objekt, budete muset používat tlačítka
z panelu nástrojů Overlay.

Volba překryvné vrstvy
2. Po klepnutí na tlačítko Overlay > Layer zvolte, zda se kromě datové překryvné vrstvy zobrazí i vrstva

s komentářem.

l Příkazy Burn Overlay a Delete Layers se vztahují k aktuálně zobrazeným překryvným vrstvám.

3. Klepněte na tlačítko Overlay > Layer a odstraňte předvolbu Lock Data Layer. Zrušíte tak ochranu
datové vrstvy před neúmyslnými změnami.

Úprava jednoho překryvného objektu
4. Klepnutím na tlačítko Overlay > Edit Overlay aktivujte režim úpravy objektu.

➤ Kurzor myši se přesune na obrázek.

5. Poklepejte na požadovaný překryvný objekt.

➤ Otevře se dialogové okno Object Properties. Jeho vzhled se liší v závislosti na tom, zda se jedná
o textový nebo grafický objekt.

6. Proveïte požadované úpravy: například změnu velikosti písma nebo barvy objektu.

l Při úpravě textového objektu můžete zatrhnout nebo zrušit zatržení předvolby Zoom with image,
která ovlivňuje změnu velikosti písma při změně velikosti zobrazení obrázku.

7. Klepnutím na tlačítko OK zavřete dialogové okno.

8. Pokud si přejete, poklepejte na jiný překryvný objekt, nebo klepnutím pravého tlačítka myši ukončete
režim úpravy objektu.

Spojení překryvných vrstev s obrázkem
9. Pokud chcete aktuálně zobrazené překryvné vrstvy trvale sloučit s obrázkem, klepněte na tlačítko

Overlay > Burn Overlay.

➤ Data obrázku pod překryvnými objekty se nenávratně ztratí.
l Spojení překryvných vrstev s obrázkem je nezbytné, pokud si přejete exportovat obrázek

a překryvná data do jiného aplikačního programu a v něm pokračovat ve zpracování obrázku.

Smazání překryvných vrstev
10. Jestliže chcete smazat aktuálně zobrazené překryvné objekty z překryvných vrstev, klepněte na

tlačítko Overlay > Delete Layers.
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Pokud chcete naměřené hodnoty statisticky zpracovat,
zvolte příkaz Measure > Statistics.

Základní vlastnosti měřicích funkcí se nastavují na kartě
Measure. Pokud chcete kartu zobrazit, zvolte příkaz
Special > Preferences...

Jestliže chcete určit, zda se ve výřezu zobrazí kromě
obrázku i překryvné vrstvy, použijte tlačítko Layer na panelu
nástrojů Overlay.

Měření obrázků
Měření vzdálenosti a plochy
Úprava překryvných vrstev
s výsledky měření
Fázová analýza

Datová překryvná vrstva

Obrázek je vždy doplněn dvěma
překryvnými vrstvami, datovou
a komentářovou. Překryvné vrstvy jsou
umístěny na obrázku podobně jako dvě
průhledné fólie. Všechny hodnoty
související s interaktivním měřením
(například naměřené délky, počty měření,
souřadnice) se zobrazují v datové překryvné
vrstvě.

Karta Measure

Na této kartě můžete určit, zda:

1. se bude v překryvné vrstvě zobrazovat
index (číslo měření), čímž se usnadní
zjištění odpovídajících hodnot v tabulce;

2. se výsledky měření zobrazí v překryvné
vrstvě přímo;

3. se bude velikost popisků měnit společně
s obrázky i pro koeficient zvětšení menší
než 100 % (při tisku velkých obrázků ve
zmenšené podobě je vhodné předvolbu
nezatrhávat, aby byly popisky čitelné);

4. se jednotlivá měření budou zobrazovat
odlišnými barvami;

5. budou kruhy definovány poloměrem
a středem nebo třemi body;

6. budou polygonální obrázky kresleny bod
po bodu nebo souvisle.

Úprava překryvných vrstev

Pokud jste ukončili měření a přejete si
odstranit všechny údaje související
s měřením z překryvné vrstvy, sloučit
překryvnou vrstvu s obrázkem nebo upravit
či odstranit zobrazené údaje, použijte
tlačítka na panelu nástrojů Overlay. Pokud
chcete zobrazit panel nástrojů Overlay,
klepněte na tlačítko Overlay Button Bar na
standardním panelu nástrojů.
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Analýza fází
1. Pořiïte si obrázek s objektem obsahujícím více fází, který si přejete analyzovat, nebo prostě načtěte

existující obrázek.

l V uvedeném příkladu se analýza fází provede na obrázku v odstínech šedé, ale zrovna tak ji lze
použít pro barevné obrázky. Dialogové okno pro nastavení prahových úrovní bude jen trochu
odlišené.

2. Pokud chcete nastavit rozsah úrovní šedé pro jednotlivé fáze, zvolte příkaz Image > Set
Thresholds...

3. Pokud chcete prahové úrovně automaticky vypočítat z histogramu obrázku, zvolte kartu Auto
Settings.

4. Klepněte na tlačítko Set ROI, abyste mohli zvolit pravoúhlou oblast obrázku, která se použije pro
výpočet prahových úrovní.

l Přesvědčte se, že ve zvolené oblasti jsou zastoupeny všechny důležité obrazové informace.
Histogram v dialogovém okně zobrazí rozložení úrovní šedé pouze ve zvolené oblasti.

5. Zvolte položku None v oblasti Background, aby se uvažovaly všechny rozsahy úrovní šedé ve
zvolené oblasti.

l Pokud definujete pozadí, horní nebo dolní rozsahy úrovní šedé nebudou brány v úvahu.

6. Zvolte položku Fixed v oblasti Histogram limits. Do pole Lower limit zadejte hodnotu 0 a do pole
Upper limit hodnotu 255 (pro 8bitovou hloubku odstínů šedé).

➤ Toto nastavení znamená, že při výpočtu prahových úrovní bude brán v úvahu celý histogram.

7. Do pole Phases zadejte počet existujících fází úrovní šedé. V uvedeném příkladu jsou zobrazeny čtyři
fáze.

➤ Na základě histogramu se automaticky vypočtou vhodné prahové úrovně. Barevný proužek pod
histogramem ukazuje rozsah úrovní šedé každé fáze.

8. Pokud chcete použít automaticky nastavené prahové úrovně, zpřístupněte kartu Manual a klepněte
na tlačítko Auto.

9. Klepnutím na tlačítko OK potvrïte nastavené prahové úrovně.

10. Zvolte příkaz Measure > Phase Analysis.

➤ Program analySIS® vytvoří tabulku výsledků měření, která bude obsahovat hodnoty pro celkovou
měřenou plochu a proporcionální plochy (v %) pro všechny fáze.

11. Pokud chcete vytvořit obrázek v pseudobarvách, vycházející z definovaných fází úrovní šedé, zvolte
příkaz Measure > Phase Color Coding.

➤ Obrázek v pseudobarvách se vloží do cílového pamě�ového pole.
➤ Barvy jednotlivých fází budou odpovídat barvám záhlaví v tabulce výsledků měření.

12. Nyní načtěte další obrázek, který chcete analyzovat.

13. Zvolte příkaz Measure > Phase Analysis.

➤ Aktuálně nastavené prahové úrovně zůstanou platné. Fázová analýza se provede na základě
těchto prahových úrovní.

➤ Naměřené hodnoty se doplní do existující tabulky.
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Každá fáze úrovní šedé se zobrazí odlišnou barvou
v obrázku v pseudobarvách.

Pro obrázky v odstínech šedé se mohou fáze vypočítat
automaticky.

Výsledky analýzy fází se objeví v tabulce, která obsahuje
proporcionální plochy pro každou fázi (v %).

Měření obrázků
Měření vzdálenosti a plochy
Úprava překryvných vrstev s výsledky
měření
Fázová analýza

Fázová analýza je kvantitativní vyhodnocení
oblasti vzhledem k jednotlivým fázím úrovní
šedé nebo barevným fázím. Nezbytným
předpokladem je nastavení několika
rozsahů odstínů šedé nebo barev a jejich
přiřazení jednotlivým fázím. viz Set Tresholds

Zobrazení v pseudobarvách

je reprezentace obrázků v odstínech šedé
použitím barev, které nesouvisejí se
skutečnou barvou objektů. Zobrazení
v pseudobarvách znamená, že každé úrovni
šedé nebo rozsahu úrovní šedé je přiřazena
určitá uživatelem zvolená barva.

Pokud je v pamě�ovém poli obrázku v ikoně
monitoru barevná paleta, obrázek je
zobrazen v pseudobarvách.

Pořadí je důležité

Běžně nejprve začnete provedením fázové
analýzy (Measure > Phase Analysis)
a potom přiřazením barev (Measure >
Phase Color Coding). Pokud provedete
přiřazení barev před fázovou analýzou,
budete muset znovu aktivovat pamě�ové
pole s původním obrázkem (následující
přiřazení barev). Jinak bude příkaz Phase
Analysis buï nepřístupný (protože přiřazení
barev obrázku v odstínech šedé způsobí
vytvoření obrázku v pseudobarvách) nebo
výsledek fázové analýzy nebudete moci
použít (protože přiřazení barev barevnému
obrázku způsobí vytvoření nového
barevného obrázku, pro který nebude
možné použít nastavené prahové úrovně).

Barevný prostor RGB a HSI

Při nastavení prahových úrovní pro barevné
obrázky (v dialogovém okně pro nastavení
prahových úrovní) můžete nastavit fáze buï
pro barvený prostor RGB (červená/zelená/
modrá) nebo HSI (barva/sytost/jas). Vhodné
fáze je často snazší určit v prostoru HSI.
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Vytváření modelů
Vytváření modelů

1. Načtěte obrázek mapy výšek povrchu objektu do pamě�ového pole. Do jiného pamě�ového pole
načtěte obrázek struktury, pokud je dostupný.

l V demonstrační databázi je obrázek nazvaný Skorodite. Jedná se o obrázek struktury. K obrázku
Skorodite je připojen obrázek EFI Map, což je obrázek mapy výšek.

2. Aktivujte obrázek s mapou výšek. Zvolte příkaz Oper > 3D-Surface > Create.

l Otevře se okno pro trojrozměrné zobrazení a v něm se zobrazí třírozměrný model. Vždy lze
zobrazit pouze jeden model.

3. Uchopte a přetáhněte odpovídající obrázek struktury na model.

l Pokud si přejete, aby obrázek struktury zmizel, zvolte položku Surface (na panelu nástrojů) >
Modify 3D-Surface...> Encoding > Height coded.

l Jestliže chcete zvětšit okno pro trojrozměrné zobrazení, stiskněte současně klávesy [Alt]+[1]
a [Alt]+[2]. Odstraníte tak správce výřezů a správce obrázků.

Pohyb modelu
l Navigátor 3D není zobrazen, zvolte proto příkaz Windows > 3D Navigation.

4. Chcete-li provést transformaci, klepněte levým tlačítkem myši na některé z tlačítek pro navigátor 3D
a tlačítko přidržte.

l Pokud chcete pohyb urychlit, klepněte blíže vnějšího okraje navigačního tlačítka.
l Pokud se Vám zdá pohyb příliš pomalý, klepněte na tlačítko Fast positioning (panel 3D nástrojů

u horního okraje okna pro trojrozměrné zobrazení).
➤ Během pohybu model zmizí a zobrazí se pomůcka pro nastavení vizuální polohy.
l Pohyb modelu můžete zajistit stisknutím:

[Ctrl]+některá kurzorová šipka Otáčení nebo naklánění příslušným směrem

[Shift]+některá kurzorová šipka Pohyb příslušným směrem

[Shift]+[PageDown] nebo [PageUp] Zmenšení nebo zvětšení

[Shift]+[Home] Obnovení výchozí polohy

l Pokud není model vidět, protože se nachází mimo okno pro trojrozměrné zobrazení, poklepejte na
střed navigátoru 3D.

Prezentace modelu
5. Stiskněte tlačítko Hide Bottom Grid (panel 3D nástrojů u horního okraje okna pro trojrozměrné

zobrazení), zobrazí se souřadnicová sí�.

6. Klepněte na tlačítko Rendering Settings (panel 3D nástrojů). Zvolte záložku karty Animation.

l Klepnutím na tlačítko Start spus�te animaci modelu. Pokud chcete animaci zastavit, klepněte na
tlačítko Stop.

l Směr otáčení a stupeň animace se nastavuje v polích Increment X, Y a Z.

7. Zobrazte kartu Options.

l Nastavte šířku (Width) a výšku (Height) výsledného obrázku.
Zavřete dialogové okno Rendering Settings.

8. Aktivujte libovolné prázdné pamě�ové pole a zkopírujte do něj zobrazený třírozměrný obraz (tak, jak je
právě zobrazen). Klepněte pravým tlačítkem myši na třírozměrný obraz a potom zvolte příkaz Copy to
Image Buffer.
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Obrázek mapy výšek (vlevo) a obrázek struktury (vpravo)
preparátu z dřeně.

Třírozměrný povrch vytvořený na základě mapy výšek.

Obrázek třírozměrného modelu: strukturovaný použitím
hodnot intenzity v mapě výšek (vpravo); včetně obrázku
textury (vpravo).

Vytváření třírozměrných povrchů
Vytváření modelů
Úprava modelů
Vybarvení modelů
Měření modelů

Co je to obrázek mapy výšek?

Konfokální laserové mikroskopy, scanning
probe mikroskopy a stereografy poskytují
mapy výšek povrchu objektů. Naměřené
výšky jsou zakódovány do obrázku
různými odstíny šedé. Použitím zmíněné
metody se výška nahradí úměrnou
intenzitou obrazového bodu. Mapa výšek se
používá pro vytvoření třírozměrného
znázornění povrchu objektů.

Co je to obrázek struktury?

Barevný obrázek nebo obrázek v odstínech
šedé, tzv. textury objektu, můžete umístit
přes mapu výšek. Barevná informace se
zkombinuje s informací o výšce a vytvoří se
model, který vypadá velmi realisticky.

Třírozměrné povrchy v obrázcích EFI

Modul Extended Focal Imaging (EFI) Vám
umožňuje vypočítat obrázky EFI použitím
série obrázků (povrchu) v různých úrovních
zaostření. Všechny oblasti obrázku EFI
budou zřetelně zaostřené. Navíc můžete
také vytvořit obrázek mapy výšek. Mapa
výšek musí být průměrována použitím
vyhlazovacího filtru, například aktivací
příkazu Oper > Filter > NxN. Třírozměrný
model povrchu se pak vytvoří na základě
mapy výšek. Obrázky EFI použijte jako
texturu pro takto vytvořený třírozměrný
model.

Obrázky mapy výšek kalibrované
Z kalibrací

Hodnoty Z se používají místo hodnot
intenzity jako informace o výšce u obrázků
kalibrovaných Z kalibrací. Pokud chcete
kalibrovat mapu výšek, použijte některý
z následujících příkazů: Image > Calibrate
Image > Z Calibration nebo Image > Define
Z calibration. Kalibrovaný obrázek mapy
výšek je vyžadován:

l pro vytvoření modelu ve skutečném
měřítku;

l jestliže výška není v poměru s intenzitou
barevných bodů;

l pokud chcete umožnit měření délek nebo
vzdáleností.
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Úprava modelů
Nastavení výšky

1. Zobrazte souřadnicovou sí�, abyste viděli dílky stupnice jednotlivých os. Klepněte na tlačítko Hide
Bottom Grid (na panelu 3D nástrojů) tak, aby nebylo stisknuté.

2. Klepněte na tlačítko Modify 3D-Surface... na panelu nástrojů Surface u dolního okraje okna pro
trojrozměrné zobrazení.

3. Do pole Height zadejte procentuální hodnotu maximálního jasu nebo výšky obrazového bodu mapy
výšek ve vztahu k maximální délce nebo šířce.

l Výchozí hodnota je 55 %. Po zvolení hodnoty 0 % bude model tvořit rovinu. Pro hodnotu 100 %
bude výška modelu odpovídat délce nebo šířce. Nižší procentuální hodnoty způsobí plošší, jemně
zešikmené modely, vyšší procentuální hodnoty příkřeji zešikmené modely.

l Pokud chcete zobrazovat délku, šířku a výšku, zatrhněte předvolbu Display data.

Nastavení rozlišení
4. Hodnoty zadané do pole Step width určují, zda se pro zobrazení modelu použije například každý

desátý obrazový bod mapy výšek (pokud zvolíte hodnotu 10).

l Výchozí nastavení je 10. V mnoha případech to je vlastně vhodný kompromis.
l Pokud model obsahuje příliš mnoho vyčnívajících vrcholků v primární struktuře, které ruší celkový

dojem modelu, nastavte vyšší hodnotu.
Před vytvořením modelu použijte vyhlazovací filtr (například Oper > Filter > NxN), abyste snížili
vysoký kontrast přechodů a vyvarovali se ostrých hran modelu.

l Jestliže je model nepřirozeně hrubý nebo na něm nejsou zřejmé významné detaily povrchu, zvolte
nižší hodnotu Step width.
S nižší hodnotou se zpomalí pohyb modelu, protože musí být vypočteno více hodnot pro
zobrazení modelu.

5. Zatrhněte předvolbu Display as grid.

➤ Souvislý povrch modelu zmizí a nahradí se sítí, představující strukturu povrchu. Výška uzlů sítě se
vypočte na základě odpovídajících hodnot intenzity v mapě výšek. Libovolné mezilehlé výškové
hodnoty modelu se vypočítají interpolací.

l Pozorujte, jak se velikost pole sítě zvětšuje nebo zmenšuje shodně s rostoucí nebo klesající
hodnotou parametru Step width.

➤ Nyní zrušte zatržení předvolby Display as grid.

Vytváření modelu z části obrázku
6. Pokud chcete vytvořit model z pravoúhlé oblasti mapy výšek, klepněte na tlačítko ROI...

➤ Aktivuje se obrazový dokument, který obsahuje mapu výšek. Požadovanou část obrázku označte
červeným rámečkem.

l Jedná se o způsob vyříznutí určité části struktury povrchu nebo odříznutí tmavých nebo světlých
okrajů obrázku.

7. Zavřete dialogové okno Modify 3D-Surface.
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Při práci s obrázkem s kalibrovanou osou Z můžete určit
výšku povrchu modelu prostřednictvím zviditelněných dat –
délky, šířky a výšky (obrázek vlevo). Pokud není obrázek
mapy výšek kalibrovaný, musíte obrázek posuzovat pouze
podle jeho vzhledu.

Parametr Step width určuje jak podrobně je zobrazen
povrch modelu a jak je vyhlazen. Příliš mnoho informací
může rušit zobrazení povrchu modelu (horní obrázky: šířka
kroku 5; dolní obrázky: šířka kroku 20).

Pokud chcete zobrazit požadované části mapy výšek jako
model, použijte funkci ROI nebo masky.

Vytváření třírozměrných povrchů
Vytváření modelů
Úprava modelů
Vybarvení modelů
Měření modelů

Výška

Relativní výšku povrchu modelu můžete
nastavit podle svých představ. U obrázků
kalibrovaných Z kalibrací je výška ve
správném měřítku. Modely vytvořené
na základě map výšek, které nebyly
kalibrované Z kalibrací, budou hodnoty
výšky definovány na základě hodnot jasu
(odstínu šedé).

Rozlišení

Úroveň zobrazených detailů a stupeň
vyhlazení povrchu modelu závisí na počtu
bodů mapy výšek použitých k výpočtu
modelu. Tímto způsobem se definuje
parametr Step width.

Omezení zobrazené oblasti modelu
l Požadovanou část struktury obrázku

můžete oříznout použitím výběrového
rámečku v mapě výšek (Modify
3D-Surface > ROI). Tímto způsobem
vytvoříte model z části obrázku.

l Globálně nastavené výběrové rámečky
(Image > Set frame) se zde nepoužívají.

l Mapa výšek vytvořená například
stereografem má rámeček, jehož šedá
barva je stálá. Pokud chcete obrázek
automaticky oříznout podle rámečku,
klepněte postupně na tlačítka Modify
3D-Surface a Auto-ROI .

l Pokud si přejete vypočítat model,
založený na jedné nebo více oblastech
libovolného tvaru (ROI) obrázku,
potřebujete nastavit masku. Jakmile máte
masku připravenu, stiskněte a přidržte
tlačítko [Ctrl], uchopte obrázek s maskou
a přesuňte jej do okna pro trojrozměrné
zobrazení. Maska se aktivuje/ruší
předvolbou Use mask, přístupnou po
klepnutí na tlačítko Modify 3D-Surface.
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Vybarvení modelů
Doplnění struktury do modelu

1. Klepněte na tlačítko Modify 3D-Surface... na panelu nástrojů Surface u dolního okraje okna pro
trojrozměrné zobrazení.

2. V seznamu Encoding zvolte způsob vybarvení modelu:

✔ Pokud chcete třírozměrný model zobrazit v jedné barvě, zatrhněte předvolbu Single color. Potom
klepněte na tlačítko Colors... a zvolte požadovanou barvu. Poklepejte na pole Field a nastavte
barvu popředí. V poli Back zvolte barvu pozadí modelu.

✔ Jestliže chcete model vybarvit použitím obrázku textury, zatrhněte předvolbu Texture. Pokud jste
dosud nenačetli žádnou texturu, klepnutím na tlačítko OK zavřete dialogové okno a potom uchopte
a přetáhněte texturu na okno pro trojrozměrné zobrazení.

✔ Chcete-li model strukturovat ve vztahu k jeho výšce nad dolní souřadnicovou sítí, zatrhněte
předvolbu Height coded. To znamená, že výšce 0 je přidělena úroveň šedé 0, maximální výšce je
přidělena úroveň šedé 255. Z uvedených údajů vyplývá, že prohlubně v modelu budou tmavé
a vrcholky světlé.

✔ Pokud chcete obrázek vybarvit použitím intenzity z mapy výšek, zatrhněte předvolbu Texture from
height.

Vybarvení modelu podle palety
3. V seznamu LUT můžete určit, zda si přejete model doplňkově vybarvený pomocí tzv. LUT (Lookup

Table) nebo nikoli. Výchozí nastavení je No lookup table. LUT je funkce (tabulka) určující způsob
přiřazení šedi (pseudobarvy), kterou uvidíte na monitoru počítače, reálným odstínům šedé objektu.

✔ Pokud chcete na modelu zobrazit spojnice výšek, zatrhněte předvolbu Height lines. Klepněte
na tlačítko LUT... a nastavte vzdálenost, tlouš�ku a barvu spojnice výšek i barvu povrchu.

✔ Chcete-li zvolit LUT pro model, zatrhněte předvolbu From file. Můžete načíst požadovaný soubor
LUT po stisknutí tlačítka LUT... Složka \Lut v instalační složce programu analySIS® obsahuje
mnoho předdefinovaných souborů.
LUT přiřazuje barvu každé z výškových hodnot Z.

➤ Barvy poskytované zvoleným LUT jsou průhledné. To znamená, že jestliže má model například
jednolitou barvu, po použití barev LUT se barva modelu smísí.

l Pokud chcete, aby se model vybarvoval pouze barvami zvoleného LUT, zrušte zatržení předvolby
Modulate LUT. Zrušíte tak přiřazení barev.

Osvětlení modelu
4. Pokud chcete model osvětlit zdrojem umělého osvětlení, zatrhněte předvolbu Enable light.

5. Zavřete dialogové okno Modify 3D-Surface.

6. Klepněte na tlačítko Rendering Settings... (panel 3D nástrojů) u horního okraje okna pro
trojrozměrné zobrazení. Klepněte na záložku karty Light.
l V poli Intensity zvolte intenzitu světelného zdroje.

Odrazivost objektu se nastavuje v poli Shadowing. S rostoucí hodnotou se model bude zdát
reálnější. V poli Color zvolte barvu světelného zdroje.

l Zatrhněte předvolbu Show position arrow. Zmenšete vzdálenost v poli Distance, dokud se
nezobrazí polohovací šipka. Zrušte zatržení předvolby Position with navigation window. Zvolte
polohu Fixed in space. Zvolením hodnot v polích Distance, Rotation X a Rotation Y můžete
posunout světelný zdroj vzhledem k modelu. Navigátor 3D naopak slouží k posuvu modelu
vzhledem ke světelnému zdroji.

Výběr barvy pozadí
7. Zvolte kartu Options. Poklepejte na pole Background a zvolte požadovanou barvu. Klepněte na

tlačítko OK.
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Oblast tvarovaná jako pyramida (nahoře) je výsledkem
Vickersova testu drsnosti materiálu. Povrch je zobrazen
včetně struktury (nahoře vlevo) a v jedné barvě (vpravo
nahoře).

Vybarvení povrchu bylo nyní překódováno podle výšky
(nahoře vlevo). Na modelu jsou zobrazeny doplňkové
spojnice výšek podél souřadnicové sítě a kalibrační data.
Pro povrch můžete zvolit LUT. V uvedeném příkladu se
jedná o obrázek Thermal (vpravo nahoře).

Zdroj umělého osvětlení způsobil, že povrch modelu vypadá
reálněji (vlevo). Můžete použít šipky indikující polohu
světelného zdroje a potom osvětlit model z různých úhlů
(vpravo).

Vytváření třírozměrných povrchů
Vytváření modelů
Úprava modelů
Vybarvení modelů
Měření modelů

Vybarvení třírozměrných modelů

Barvy i odstíny šedé modelu můžete určit
různými způsoby:

l Kódování
Pro vybarvení modelu můžete použít:
informace o výšce, texturu, hodnoty
intenzity z mapy výšek nebo zobrazení
v jedné barvě.

l Osvětlení modelu
Zapněte umělé osvětlení! Můžete zapnout
zdroj umělého osvětlení. Můžete určit
polohu světelného zdroje, jas, barvu
a stupeň stínování.

l LUT
Pro model můžete podle svých
požadavků zvolit libovolnou paletu. Paleta
způsobí, že se model vybarví podle výšky
obrazových bodů. V modelu také můžete
zobrazit spojnici výšek.

Výsledná barva libovolného bodu v modelu
se skládá ze tří hodnot (nahoře).

Uložení/otevření třírozměrných modelů

Třírozměrný povrch se skládá z řady
souborů. Hlavní je soubor s rozvržením,
který má příponu W3D. Libovolná změna
modelu se automaticky uloží do zvolených
souborů. Každému novému modelu (Oper
> 3D-Surface > Create) je standardně
přiřazen následující výchozí název:
Surface3D.w3d. Všechny soubory se
ukládají do složky pro program analySIS®

...\3D Objects\Surface 3D\. Pokud si přejete
model zachovat a zakázat jeho přepsání,
zvolte příkaz File > Save as... a uložte
soubor formátu *.W3D pod jiným názvem
v samostatná složce. Všechny ostatní
soubory modelu se automaticky zkopírují do
této složky. Po provedení uvedených kroků
můžete pokračovat v práci s kopií
třírozměrného objektu.

Pokud chcete otevřít existující model, zvolte
příkaz File > Open...a potom zvolte
v seznamu podporovaných formátů
Workspace (*.w3d).
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Měření modelů
Jak měřit délku (nebo vzdálenost, výšku a polohu)

1. Zvětšete okno pro třírozměrné zobrazení i vlastní model tak, abyste mohli zvolit měřicí body tak
přesně, jak jen to bude možné. Nechejte volné místo u dolního okraje grafického uživatelského
rozhraní (GUI), abyste během měření viděli tabulku výsledků měření.

2. Pokud chcete vymezit a změřit polygonální délku, zvolte příkaz Measure > 3D-Measurements >
Polygon Length.

➤ Program analySIS® vytvoří novou tabulku nazvanou 3D-Polygon Length. Kurzor myši se přesune
do okna pro třírozměrné zobrazení. Body a čáry související s předchozími měřeními zmizí.

3. Levým tlačítkem myši zvolte polygonální body, podle kterých se bude měřit.

➤ Ve stavovém řádku se zobrazují souřadnice naposledy zvoleného bodu.
➤ Spojením zvolených bodů se vytvoří přímky (procházející třírozměrným prostorem). Pokud chcete

změřit vzdálenosti podél povrchu modelu, musíte zvolit mnoho bodů vzájemně málo vzdálených.
➤ Nesprávně zvolené body můžete postupně (po jednom) smazat. Stiskněte klávesu [Shift]

a klepněte levým tlačítkem myši.
l Pokud potřebujete posunout povrch modelu během určování polygonální délky, můžete použít

následující klávesy:

[Shift]+některá kurzorová šipka Pohyb příslušným směrem

[Shift]+[PageDown] nebo [PageUp] Zmenšení nebo zvětšení

[Ctrl]+některá kurzorová šipka Otáčení nebo naklánění příslušným směrem

4. Pokud chcete ukončit vymezování měřené délky, klepněte pravým tlačítkem myši.

l Určete tolik délek (na modelu), kolik požadujete. Barvy použité pro zobrazení bodů a čar se budou
cyklicky měnit. Odpovídající hodnoty v tabulce výsledků měření budou mít stejnou barvu.

5. Po ukončení měření pouze klepněte pravým tlačítkem myši. Potom vše potvrïte klepnutím na tlačítko
Yes.

Jak shromažïovat výsledky měření?
6. Naměřené délky pro různé modely můžete shromažïovat v jedné tabulce. Nejprve načtěte nebo

vytvořte jiný model. Potom zpřístupněte tabulku výsledků měření a zvolte příkaz pro provedení
měření.

➤ Výsledky měření, které nyní provedete, se doplní do aktivní tabulky. V okně pro třírozměrné
zobrazení se objeví pouze výsledky aktuálního měření.

Uložení, zobrazení/skrytí výsledků měření
7. Výsledky měření se neukládají s modelem, při uzavření modelu se smažou. Pokud chcete uložit

výsledky měření, musíte uložit tabulku, která tyto výsledky obsahuje.

l Chcete-li, aby se výsledky měření odstranily z okna pro třírozměrné zobrazení, zvolte příkaz
Measure > 3D-Measurements > Hide Measurement Results.

l Dočasně skryté výsledky měření můžete kdykoliv opět zobrazit u modelu, na kterém byly
naměřeny. Pouze načtěte model nebo aktivujte okno pro třírozměrné zobrazení. Potom
načtěte/aktivujte tabulku výsledků měření a zvolte příkaz Measure > 3D-Measurements > Show
Measurement Results.
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Jaké jsou rozdíly mezi měřením na obrázcích
a měřením v okně pro třírozměrné zobrazení

Měření na obrázku Měření v okně pro
třírozměrné zobrazení

Výchozí nastavení

Můžete určit různá výchozí
nastavení, například barvy
výsledků měření na kartě
Special > Preferences >
Measure.

Karta Special >
Preferences > Measure
se nevztahuje k měření
v třírozměrném prostoru.

Ukládání výsledků měření

Body a čáry jsou součástí
překryvné vrstvy a mohou
být uloženy společně
s obrázkem.

Body a čáry nejsou
součástí třírozměrného
modelu, a proto se neuloží
s modelem, ale s tabulkou.
Body a čáry můžete
kdykoliv skrýt nebo opět
zobrazit. Trojrozměrné
náhledy zahrnují body
a čáry a lze je archivovat
kopírováním dílčích
trojrozměrných oblastí do
pamě�ového pole obrázku
analySIS® a následným
uložením obrázku.

Naměřené hodnoty a číslování

Naměřené hodnoty nebo
čísla měření mohou být
zapsána do překryvné vrstvy.

V okně pro trojrozměrné
zobrazení budou buï
naměřené hodnoty nebo
čísla měření.

Shromažïování výsledků měření

Libovolná doplňková měření
se vždy připojí do aktivní
tabulky s výsledky měření.

Můžete zvolit čáru, po
jejímž změření se
naměřená hodnota doplní
do tabulky výsledků
měření. Požadovanou čáru
zvolíte klepnutím.

Můžete zvolit prázdný
sloupec pro nová měření

Měření nelze vložit do
prázdného sloupce
existující tabulky s výsledky
měření.

Tři vzdálenosti měřené na pyramidovém povrchu,
vytvořeném měřením tvrdosti.

Vytváření třírozměrných povrchů
Vytváření modelů
Úprava modelů
Barvení modelů
Měření modelů

Měření třírozměrných modelů

Interaktivní příkazy pro měření v okně pro
třírozměrné zobrazení jsou umístěny
v Measure > 3D-Measurements.

Interaktivní měřicí funkce

Můžete měřit různé geometrické parametry
povrchů modelů:

l absolutní polohu (x, y, z)
l vzdálenost (x1-x2, y1-y2, z1-z2)
l výšku (z1-z2)
l polygonální délku
l polygonální obvod ([Shift] + polygonální

délka)
l plochu

Jestliže chcete provést měření, aktivujte
okno pro třírozměrné zobrazení a potom
zvolte požadovaný příkaz. Určete
interaktivně všechny body pro měření na
povrchu modelu.

Výsledky měření
l Výsledky se zapíší do tabulky výsledků

měření.
l V oblasti zobrazení se zobrazí značky

bodů a propojovací čáry, aby
znázorňovaly měření vzdálenosti, výšky,
polohy nebo polygonální délky.

l Barvy pro zobrazení vzdáleností, výšek,
poloh a polygonálních délek se (série
měření) v tabulce výsledků měření
i v oblasti zobrazení cyklicky střídají.

Mazání výsledků měření

Nesprávně zvolené body můžete z okna pro
třírozměrné zobrazení a z tabulky výsledků
měření postupně smazat. Stiskněte klávesu
[Shift] a klepněte levým tlačítkem myši.

Aby byly naměřené výsledky reálné, musí
být výška obrázku kalibrována pro X, Y a Z.
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Příprava obrázku
Korekce odchylek

1. Načtěte obrázek, který si přejete upravit, do aktivního pamě�ového pole.

l Obrázek Scale v demonstrační databázi, je například nerovnoměrně osvětlen. Můžete jej upravit
použitím funkce Shading Correction.

2. Zvolte příkaz Oper > Define Shading Correction...

3. Klepnutím na tlačítko Window zvolte část obrázku, která se zobrazí v náhledu.

l Levým tlačítkem myši nastavte velikost a polohu náhledového okna. Klepnutím pravého tlačítka
myši nastavení potvrïte.

➤ Předvolba Preview bude zatržena. Náhled pak bude průběžně ukazovat, jak se změny příslušného
parametru projevují na zvolené části obrázku.

4. Zvolte položku Multiplicative v oblasti Assumed deterioration.

5. Zvolte položku Source 1 v oblasti Source for shading image, aby se korekce vypočítala na základě
dat původního obrázku.

6. Zvolte položku NxN average filter ve skupině Preparation of shading image.

7. Nastavte parametry filtru v oblasti NxN average filter, například zvolte počet iterací 3 a velikost
matice filtru 50.

8. Klepnutím na tlačítko Execute proveïte korekci nehomogenity obrázku.

➤ Upravený obrázek se uloží do cílového pamě�ového pole.
➤ Nastavené parametry můžete použít pro další korekce, stačí pouze zvolit příkaz Oper > Shading

Correction.

Automatické oddělování částic
1. Nastavte koeficient zvětšení obrázku ve výřezu na 100 %.

2. Zvolte příkaz Oper > Define Filter, Separator...

3. Zvolte položku Step v oblasti Boundary shape.

l Oddělovač částic můžete použít pro vyznačení světlých nebo tmavých linií. V takovém případě
zvolte položku Dark nebo Bright.

4. Nastavte jezdci posuvných lišt Smooth a Fine/Coarse hodnoty 1.

5. Aktivujte náhled, abyste mohli sledovat, jak se nastavené hodnoty projeví na obrázku.

6. Posouvejte postupně jezdce posuvné lišty Fine/Coarse směrem nahoru, dokud nenaleznete
optimální nastavení.

➤ Pokud obrázek obsahuje příliš šumu, zvětšete hodnotu Smooth.

7. Zvolením položky Burn black ve skupině Result umožněte vytváření černých oddělovacích čar
na původním obrázku v odstínech šedé.

8. Klepnutím na tlačítko Execute oddělte částice na obrázku.

➤ V cílovém pamě�ovém poli se zobrazí původní obrázek v odstínech šedé s částicemi ohraničenými
černou barvou (úroveň šedé 0).

➤ Vytvořená oddělovací čára má šířku jeden obrazový bod.
l Uvědomte si, prosím, že rozsah odstínů šedé pro definici složek nesmí obsahovat úroveň šedé 0.
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Levý horní obrázek ukazuje kulovitou strukturu polystyrénu.
Kulovitá struktura i pozadí obrázku postupně zleva doprava
tmavnou. Z tohoto důvodu není možné nastavit prahové
úrovně pro oddělení částic. Po provedení korekce tónování
(obrázek vpravo nahoře) bude osvětlení obrázku
rovnoměrné, a budete tedy moci prahové úrovně nastavit.

Oddělovač vytváří oddělovací čáru mezi fázemi odstínů
šedé. Artefakty se mohou objevovat na okrajích a také
v okolí děr v částicích.

Výchozím obrázkem pro typickou separaci částic je binární
obrázek s bílými částicemi na černém pozadí. Použitím filtru
Erosion odstraníte okraje částic, pokud nejsou všechny
částice odděleny.

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Určení detekční oblasti
Nastavení detekce
Měření částic
Interaktivní úprava detekce
Třídění částic

Shading Correction

Korekce Shading Correction je určena pro
vyrovnání nehomogenního pozadí obrázku.
Tento druh interference se vystkytuje
například při nehomogenním osvětlení při
pořizování obrázku. Korekci tónování je
někdy nutné provést před detekcí částic pro
zajištění dostatečné korelace odstínů šedé
a struktur na obrázku.

Oddělování částic

Před detekcí částic musí být odděleny
okolní částice tak, aby každá byla
zpracována samostatně a nikoliv více částic
jako jedna. Program analySIS® nabízí
několik možností:

l Oper > Morphological Filter >
Separate Particles
Morfologický filtr je určen pro vytváření
oddělovacích čar. Filtr lze použít na
binární obrázky s bílými částicemi na
černém pozadí. Jakékoliv díry v částicích
způsobí artefakty.

l Oper > Filter > Separator (Oddělovač)
Separátor se používá přímo na obrázky
v odstínech šedé. Ohraničuje částice
nebo oblasti se stejným odstínem šedé.
Výsledný obrázek můžete po oddělení
částic interaktivně upravit. Použitím
tohoto filtru můžete čáry také vyznačovat
(kreslit).

l Kombinování více filtrů
Původní obrázek pro typické oddělování
částic je binární obrázek s bílými
částicemi na černém pozadí. Filtrem
odstraňte hranice částic, dokud nebudou
všechny částice odděleny. Potom získáte
skeletovou strukturu pozadí obrázku
vypočtenou pro offset korekci. Logickou
operací AND mezi výsledným obrázkem
(skeletovou strukturou) a původním
obrázkem se vytvoří hranice mezi
částicemi.
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Nastavení prahových úrovní
Nastavení prahových úrovní (Thresholds)

1. Načtěte do aktivního pamě�ového pole obrázek, který si přejet analyzovat.

l Následující popis detekce částic je založen na práci s osmibitovým obrázkem v odstínech šedé.

2. Zvolte příkaz Image > Set Thresholds...

➤ Nyní se otevře dialogové okno Set Thresholds.
➤ Při analýze obrázku v barvách true color se otevře dialogové okno Set Color Thresholds.

Dialogová okna pro obrázky v odstínech šedé a obrázky v barvách true color se podstatně liší.

3. Zvolte kartu Manual.
l Proužek pod grafem ukazuje počet nastavených rozsahů úrovní šedé, resp. fází. Každá fáze má

svou vlastní pseudobarvu.

4. Smažte všechny nastavené fáze kromě jedné.

➤ Zvolte položku v seznamu Phase a klepněte na tlačítko Delete. Jakmile zůstane nastavená pouze
jedna fáze, tlačítko Delete se znepřístupní.

5. V oblasti Diagram zvolte položku Histogram.

➤ Graf bude nyní ukazovat rozložení jednotlivých odstínů šedé v ohraničené části obrázku.
l Dvě svislé čáry představují aktuální prahové úrovně. Čára vlevo je modrá, čára vpravo červená.

6. Klepněte na přepínač Current v oblasti Preview.

➤ Aktivní fáze se v obrázku zobrazí barevně, takže uvidíte efekt Vašeho nastavení projeví prahů.

7. Nastavte rozsah úrovní šedé pro první fázi přímo v grafu. Rozsah zvolte tak, aby se všechny částice
zobrazily barevně.

➤ Přesuňte kurzor myši na jednu z čar prahových úrovní. Tvar kurzoru se změní na dvoustrannou
šipku. Stiskněte levé tlačítko myši a posunutím čáry nastavte požadovanou prahovou úroveň. Body
ze zvoleného rozsahu úrovní šedé se v obraze vyplní odpovídající barvou fáze.

8. Klepněte na tlačítko New, doplní se druhá fáze. Pokud chcete současně detekovat tmavé a světlé
částice, budete muset nastavit několik fází.

➤ Do seznamu Phase se doplní další položka. Standardně přiřazený název můžete nahradit
libovolným požadovaným názvem.

➤ Nová fáze se automaticky vybarví dosud nepoužitou barvou. Pokud chcete, můžete přiřazenou
barvu změnit zvolením požadované barvy v seznamu Color.

➤ Nově zvolená fáze bude aktivní – graf bude nyní zobrazovat prahové úrovně pro novou fázi.

9. Zvolte rozsah úrovní šedé pro druhou fázi.

10. Klepnutím na tlačítko OK potvrïte nově nastavené prahové úrovně.
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Pokud chcete zajistit rychlý přístup ke všem funkcím
nabídky Analysis, použijte panel nástrojů Analysis.

Na horním obrázku jsou zobrazeny odříznuté konce
uhlíkových vláken. Úroveň šedé vláken závisí na úhlu řezu.

V uvedeném příkladu obsahuje histogram (na dolním
obrázku) tři vrcholy v úrovních šedé, které zjevně odpovídají
strukturám na obrázku. Tmavé pozadí obrázku má úroveň
šedé kolem 85. Mezi úrovněmi šedé částic a jejich tvarem je
vzájemný vztah. Světlejší částice mají úroveň šedé kolem
153, tmavší kolem 130.

Rozsahy úrovní šedé se nastavují v histogramu. Pokud
nastavíte prahové úrovně, zobrazí se v obrázku rozsahy
odstínů šedé odlišných fází barevně.

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Oddělování částic
Určení detekční oblasti
Nastavení detekce
Detekce částic
Třídění částic

Částice je souvislá skupina bodů ve
zvoleném rozsahu úrovní šedé. Před každou
detekcí částic proto musíte nastavit vhodný
rozsah úrovní šedé (prahy).

Úspěšná detekce odstínů šedé vyžaduje
průkaznou korelaci mezi úrovněmi šedé
a strukturami na obrázku.

Panel nástrojů Analysis

Nejrychlejší způsob přístupu k funkcím pro
analýzu obrázku je použití panelu nástrojů
Analysis. Pokud jej chcete zobrazit (stejně
jako jiný panel nástrojů), zvolte příkaz
Special > Edit Button Bars.... Potom pouze
zatrhněte předvolbu pro panel nástrojů
Analysis.

Nastavení prahových úrovní

Před zahájením automatické detekce částic
nastavte rozsah úrovní šedé/barevných
hodnot, kterými odlišíte částice od pozadí
obrázku. Nastavení rozsahu odpovídá
nastavení prahových úrovní. Prahové úrovně
zahrnují nejnižší a nejvyšší úroveň
šedé/hodnotu barvy. K dispozici máte dva
způsoby nastavení prahových úrovní:

l Nastavte prahové úrovně interaktivně
v histogramu (karta Manual).

l Můžete také zajistit automatický výpočet
prahových úrovní (karta Auto). Prahové
úrovně se pro každý nový obrázek
vypočtou znovu.

Histogram: zobrazuje vztah mezi počtem
bodů a odpovídající úrovní šedé.
V histogramu se také nastavuje rozsah
úrovní šedé pro detekci částic.
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Určení detekční oblasti
Vytvoření výběrového rámečku

1. Zvolte příkaz Image > Set Frame.

➤ Aktuální výběrový rámeček v překryvné vrstvě obrázku je definován červeným obdélníkem.
➤ Kurzor myši je umístěn v pravém dolním rohu rámečku.

2. Stiskněte levé tlačítko myši a posouvejte pravý dolní roh rámečku, dokud nebude mít rámeček
požadovanou velikost.

3. Přesuňte rámeček do požadované polohy.

4. Klepnutím pravým tlačítkem potvrïte nastavení rámečku.

➤ Dokud je rámeček aktivní, tlačítko Enable Frame na standardním panelu nástrojů zůstane
stisknuté. Stisknutím tlačítka se aktivuje nebo ruší zobrazení výběrového rámečku.

➤ Velikost a poloha aktivního výběrového rámečku se zobrazí na stavovém řádku.

Nastavení ROI (Oblasti zájmu)
1. Zvolte příkaz Analysis > Define ROIs...

2. Pokud chcete smazat předcházející nastavení ROI, klepněte na tlačítko Delete All.

3. V oblasti Tools zvolte metodu, kterou si přejete nastavit ROI. Klepněte na tlačítko Freehand polygon,
abyste mohli od ruky nakreslit obrys požadovaného segmentu obrázku

➤ Kurzor myši se přesune na obrázek. Stiskněte levé tlačítko myši a nakreslete ROI, například vnitřek
jádra buňky.

4. Klepnutím pravého tlačítka myší se vra�te do dialogového okna.

➤ Polygonální obrazec pro definici ROI se automaticky zavře.
➤ Nová ROI se očísluje a zařadí do seznamu ROI.

5. Zadejte do pole Label název pro ROI (například Jadro). Potom klepněte na tlačítko se šipkou
u tohoto pole.
Zvolte příkaz Change Selected ROI Label, který Vám umožní změnit název zvoleného ROI.

➤ Libovolný nový název ROI se po přiřazení automaticky doplní do seznamu Label.
l Názvy z tohoto seznamu využijte později pro další podobné ROI, například další jádra buněk. Před

nastavením nové ROI zvolte požadovaný název ze seznamu Label.

6. Chcete-li nastavit další ROI pro tento obrázek, opakujte poslední dva kroky.

7. Klepněte na tlačítko Save..., nově nastavená ROI se uloží pro pozdější použití pro podobné obrázky.

8. Klepnutím na tlačítko Close zavřete dialogové okno.

9. Jestliže chcete nastavené ROI zobrazit v překryvné vrstvě, zvolte příkaz Analysis > Draw ROIs >
Into Overlay.

l Poznámka: Pokud nyní provedete další doplňkové změny do nové ROI, na překryvná vrstvě se
automaticky neprojeví.
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Kreslení mnohoúhelníku Kreslení interpolačního
mnohoúhelníku

Kreslení mnohoúhelníku
od ruky

Kreslení elipsy;
[Shift]+kreslení kruhu

Kreslení čtyřúhelníku Kreslení čtyřúhelníku
v libovolné orientaci

Kombinování dvou ROI
do jedné virtuální

ROI vycházející
z detekovaných částic

Aktivace zvolené ROI Mazání zvolené ROI

Dialogové okno Define ROIs poskytuje nástroje pro
nastavení a správu ROI.

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Určení detekční oblasti
Nastavení detekce
Měření částic
Interaktivní úprava detekce
Třídění částic

Program analySIS® poskytuje různé
možnosti pro omezení analýzy na určitou
oblast obrázku. Můžete vytvořit buï
výběrový rámeček, masku nebo ROI.
V dialogovém okně Define Detection
zvolte, jaký druh detekční oblasti chcete
použít.

Výběrový rámeček omezuje zpracování
obrázku a použití analytických funkcí na
pravoúhlou oblast v obrázku. Výběrový
rámeček je globální, a je proto platný pro
všechny načtené obrázky a řadu funkcí pro
analýzu obrázku.

ROI (Region of Interest – Oblast zájmu) je
oblast libovolného tvaru v obrázku. Oblasti
ROI jsou platné pouze pro analýzu částic.
Musíte je vytvářet pro každý obrázek zvláš�.
ROI se používají pouze v souvislosti
s analýzou částic, ovšem lze je
přetransformovat do masek a ty pak použít
pro další funkce pro analýzu obrázků.
Jestliže chcete převést ROI na masku,
zvolte příkaz Analysis > Draw ROIs > Into
Mask.

Maska je binární obrázek, kterým může být
překryt původní obrázek za účelem použití
operací souvisejících s analýzou obrázku.
Masku musíte načíst do pamě�ového pole
masky obrázku. Operace se provede pouze
s těmi částmi obrázku, které jsou překryty
bílou plochou masky.

Aktivace masky

l Analýza obrázku: Pokud chcete použít
masku pro operace související s analýzou
obrázku, musí být aktivována. Klepněte
pravým tlačítkem myši na operand maska
v seznamu operandů v okně správce
obrázků. V kontextové nabídce, která se
zobrazí, zvolte položku Enable Mask.

l Detekce: Při analýze částice nemusí být
maska aktivní. Vše, co potřebujete udělat,
je zvolit položku Mask v dialogovém okně
Define Detection.
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Nastavení detekce
Nastavení detekce

1. Zvolte příkaz Analysis > Define Detection...

➤ Otevře se dialogové okno Define Detection se třemi kartami pro nastavení parametru detekce
třídění částic.

2. Jestliže chcete nastavit parametry pro detekci částic, zvolte záložku karty Detection.

3. Do pole Minimum ve skupině Particle filter zadejte minimální počet obrazových bodů, které musí
obsahovat detekované částice.
Pokud například zadáte do tohoto pole hodnotu 10, budou se detekovat pouze částice složené
z 10 obrazových bodů nebo více.

l Jedná se o způsob vyloučení částic složených z velmi malého počtu bodů. Detekce takových
částic může být dosti bezvýznamná. Zadejte například hodnotu 3, aby se vyloučily šumové částice.

4. Zrušením zatržení předvolby Use ranges zajistěte detekci všech částic, které budou nalezeny mezi
zvolenými prahovými úrovněmi.

l Poznámka: Pokud bude předvolba Use ranges zatržená, použijí se pro aktuální analýzu filtry, které
byly použity pro předcházející analýzu.

l Pole Total count ukazuje počet částic, které byly detekovány během naposledy provedené
detekce.

5. Pokud mají částice inkluze (díry apod.), které mají být brány v úvahu pro výpočet parametrů částice,
zrušte zatržení předvolby Fill holes. Zrušení zatržení této předvolby je nutné pro správné rozpoznání
děr v částicích a jejich analýzu.

l Předvolba Fill holes ovlivňuje například výpočet plochy částic. Pokud se díry nerozpoznají, tz. že
předvolba Fill holes je zatržena, plocha děr se přičte k ploše částic.

l Parametry Hole Count a Hole Area (v dialogovém okně Define Measurement) se odkazují na díry
v částicích. Uvedené parametry budou funkční pouze při zrušení zatržení předvolby Fill Holes.

6. V oblasti Search area určete oblast obrázku, která se použije pro vyhledávání. Zvolte položku Frame,
oblast na obrázku bude definována pravoúhlým výběrovým rámečkem. Pokud výběrový rámeček
nevytvoříte, detekce se provede pro celý obrázek.

7. V oblasti Border Particles určete způsob, jakým budou zpracovány částice, které neleží celou
plochou v oblasti ohraničené výběrovým rámečkem.

8. Ve skupině Connectivity zvolte způsob odlišení dotýkajících se částic.

l Pokud je oddělovací čára mezi dvěma částicemi široká pouze jeden obrazový bod, zvolte položku
Adjacent borders (4). Jinak budou samostatné částice detekovány jako jedna částice.

9. Klepnutím na tlačítko Execute proveïte detekci částic.

➤ Všechny detekované částice se zobrazí barevně v překryvné vrstvě. Na kartě Classification určete
způsob zobrazení částic.

➤ Použije se naposledy nastavená klasifikace.

10. Klepnutím na tlačítko OK zavřete dialogové okno.
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Detekované částice se zobrazí barevně v překryvné vrstvě.
Pro obrázek se použije naposledy nastavený způsob třídění.
Libovolné částice, které nelze třídit, se zobrazí vyšrafované.

Okrajové částice mohou být při detekci zpracovány různými
způsoby. Všechny čtyři možnosti pro zpracování okrajových
částic jsou dostupné pouze při detekci v oblastech
ohraničených výběrovými rámečky.

Položka Include 50 % není dostupná pro detekci při použití
ROI.

Při detekci částic s využitím masky se okrajové částice vždy
oříznou.

Vlevo: Parametr Pixel connectivity definuje, které body jsou
posuzovány jako část částice.

Vpravo: Díry v částicích můžete také analyzovat. Aktivujte
rozpoznání děr při detekci částic, přičemž můžete použít
parametry děr, jako jsou „počet děr“ a „plocha děr“.

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Určení detekční oblasti
Nastavení detekce
Měření částic
Interaktivní úprava detekce
Třídění částic

Vyřazení částic

Možná Vás při detekci částic zajímají pouze
velké a jasné částice nebo pouze částice,
které mají alespoň jednu díru. Filtry pro
částice Vám umožňují použít parametry pro
vyřazení určitých částic. Můžete nastavit filtr
pro každý parametr. Libovolné částice, které
jsou mimo nastavený interval hodnot,
nebudou zahrnuty do výpočtu údajů
uvedených v tabulce výsledků.

Okrajové částice jsou částice, které se
nenacházejí celou plochou v detekční
oblasti. K dispozici máte čtyři způsoby
zpracování částic.

l Truncate: Částice se oříznou podle
okraje oblasti (výběrového rámečku, ROI,
masky).

l Include: Při procesu detekce se budou
jako celé uvažovat i částice, které jsou
rozříznuty výběrový rámečkem nebo ROI.

l Include 50%: Při detekci budou
uvažovány pouze částice, které jsou
v kontaktu s horním nebo levým okrajem
výběrového rámečku nebo leží v něm.

l Exclude: Částice, které se dotýkají
výběrového rámečku nebo ROI nebudou
detekovány.

Přilehlé částice

l Adjacent borders (4): Dva obrazové
body patří do jedné částice, pokud se
dotýkají jednou ze čtyř stran.

l Include diagonals (8): Dva obrazové
body patří do jedné částice, pokud se
dotýkají jednou ze čtyř stran nebo rohy.

Díry jsou souvislé rozsahy úrovní šedé
v částicích, odlišné od šedi reprezentující
detekovanou částici. Díry jsou buï
detekovány nebo ignorovány. Způsob
zpracování děr ovlivňuje plochu částic.
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Měření částic
Detekce částic

1. Pokud chcete provést detekci, zvolte příkaz Analysis > Detect.

l Pokud jste již provedli detekci z dialogového okna Define Detection, nemusíte volit příkaz Detect
z nabídky.

Volba měřených parametrů
2. Zvolte příkaz Analysis > Define Measurement...

3. Zvolte kartu Particle a určete parametry částice, které si přejete zahrnout do tabulky výsledků měření.

4. V ovládacím stromu na levé straně dialogového okna klepněte na nejvyšší složku nazvanou All,
všechny parametry v seznamu Measurements se seřadí podle abecedy.

5. Zvolte požadované parametry zatržením předvolby před parametrem. Potom se zobrazí seznam
Selected Measurements. Všechny parametry v seznamu se postupně zahrnou do tabulky výsledků
měření.
Například označte předvolby Phase, Area a Orientation.

➤ Zvolené parametry se zobrazí v seznamu Selected Measurements a pro každou částici v tabulce
výsledků měření.
Do tabulky výsledků měření musíte zahrnout parametry ID Particle a ID Class, abyste si mohli
snadno ověřit vztah mezi částicemi a parametry částic.

Nastavení filtrů částic
6. Zvolte v seznamu Selected Measuremenst parametr, například Phase, pro který chcete nastavit filtr.

➤ Oblast Filter Range bude aktivní. Hodnoty v této skupině vždy odpovídají aktivnímu parametru
v seznamu zvolených měření.

7. Zadejte minimální hodnotu parametru (v kalibračních jednotkách obrázku) do pole Min, například 2.

8. Pokud chcete použít filtr částic pro aktuální detekci, klepněte na tlačítko Apply.

➤ Výsledek použití filtru se zobrazí v překryvné vrstvě. Všechny částice, které patří do Fáze 1,
nebudou dále uvažovány.

➤ Omezení pro filtr se projeví u odpovídajících parametrů v seznamu Selected Measurement.
➤ V dialogovém okně Define detection bude zatržena předvolba Use ranges.
l Pokud použitím zvoleného filtru pro částice nedosáhnete požadovaných výsledků, zvolte jiný filtr

a použijte jej.

9. Klepnutím na tlačítko No ranges v oblasti Filter Range zrušte použití filtru částic pro aktivní parametr
měření.

10. Nyní můžete nastavit filtr částic pro měření dalších parametrů, aniž byste museli opustit dialogové
okno. Jednotlivá kritéria filtrů se spojují logickým operátorem AND, a dále tak omezují počet
vyhledaných částic.

11. Klepnutím na tlačítko OK ukončete nastavování měřených parametrů.
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Dialogové okno obsahuje tři karty s mnoha měřenými
parametry částic, tříd a ROI.

Částice původního obrázku se liší orientací, průměrnou
úrovní šedé a počtem děr. Částice mohou být vyřazeny
z detekce prostřednictvím mnoha těchto parametrů.
Všechny částice umístěné a analyzované detekcí jsou
vyšrafované:

Částice s jednou dírou mohou být detekovány v obrázku
Hole Count (Rozsah filtru – Min.: 1, Max.: 1).

Pouze částice orientované na výšku budou detekovány
v obrázku Orientation (Rozsah filtru – Min.: 85, Max.: 95).

Pouze černé částice budou detekovány v obrázku Mean
Gray Value (Rozsah filtru – Min.: 0, Max.: 1).

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Určení detekční oblasti
Nastavení detekce
Měření částic
Interaktivní úprava detekce
Třídění částic

Dialogové okno Define Measurements
obsahuje tři karty pro nastavení měření
částic, tříd a ROI.

Vlastnosti dialogového okna

l Velikost dialogového okna si můžete
upravit podle Vašich požadavků:
stiskněte levé tlačítko myši a přesuňte
okraj nebo roh dialogového okna
požadovaným směrem.

l Můžete také měnit velikost tří oken (1–3)
v dialogovém okně Define
Measurements. Například posunutím
oddělovače mezi ovládacím stromem
a měřenými parametry na pravé straně
(musí být stisknuté levé tlačítko myši)
získáte více místa pro práci s ovládacím
stromem.

Struktura parametru pro měření
l Všechny parametry pro měření jsou

v ovládacím stromu uspořádány podle
druhu; například parametr Convex Area
je ve stejné skupině s dalšími parametry,
které souvisejí s plochou.
Jestliže chcete například zpřístupnit
pouze parametry související s denzitou
(optickými vlastnostmi), klepněte
v ovládacím stromu na položku Density.

l Pořadí, v kterém jsou jednotlivé
parametry uspořádány, můžete změnit.
Pouze klepněte na záhlaví jednoho ze
dvou sloupců, parametry se abecedně
uspořádají podle názvu.

Popis parametrů částic

V dialogovém okně jsou dostupné popisy
všech parametrů k obrázkům a textům.
Pokud chcete zobrazit popis parametrů,
pouze klepněte levým tlačítkem myši na
parametr. Zvolte například parametr
Bisector Outer Max.
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Měření částic
Jak zobrazit výsledky měření částic?

1. Zvolte příkaz Analysis > Particle Results.

➤ Vytvoří se tabulka, která bude obsahovat všechny částice detekované na základě zvolených
parametrů měření. Pořadí parametrů v tabulce odpovídá pořadí v dialogovém okně Define
Measurements.

➤ Naměřené hodnoty se obvykle zobrazí v barvě podle aktuálního třídění. Všechny naměřené
hodnoty pro příslušnou třídu se zobrazí v barvě přiřazené příslušné třídě.
Pokud chcete potlačit barevné odlišení, stačí zrušit zatržení předvolby Analysis > Define
Detection > Results > Use colors in sheets.

Zjištění částic s konkrétními hodnotami
1. Zvolte sloupec v tabulce výsledků a klepněte pravým tlačítkem myši.

2. V místní nabídce zvolte položku Sort Descending, výsledky měření se uspořádají podle numerické
hodnoty.

3. Poklepáním na číslo prvního řádku v tabulce určete částici v obrázku, pro kterou byla naměřena
největší hodnota.

➤ Částice začne v překryvné vrstvě blikat.

4. Zvolte příkaz Analysis > Particle > Sheet Link.

➤ Kurzor myši se přesune na obrazový dokument.

5. Postupně klepněte levým tlačítkem myši na různé částice.

➤ Zvýrazní se řádky v tabulce výsledků pro tyto částice.

6. Klepnutím pravým tlačítkem myši ukončete propojení mezi částicemi a tabulkou.

Jak lze postupně zjiš�ovat výsledky?
1. Zvolte příkaz Analysis > Single Result.

➤ Kurzor myši se přesune na obrazový dokument.
➤ V překryvné vrstvě obrázku se zobrazí detekované částice.

2. Klepněte levým tlačítkem myši na částice, které si přejete měřit.

➤ Do tabulky výsledků měření se doplní parametry, které jste zvolili v dialogovém okně Define
Measurements.
Pokud je tabulka výsledků měření částic již aktivní, program analySIS® doplní do tabulky výsledek
pro jednu částici. Pokud tomu tak není, otevře se nová tabulka.

3. Klepnutím pravým tlačítkem myši ukončete měření.

Zobrazení výsledků měření
1. Zvolte příkaz Analysis > Define Measurements..., abyste mohli do seznamu měřených parametrů

doplnit parametr Feret Max.

2. Stiskněte klávesu [Shift] a zvolte příkaz Analysis > Single Result.

3. Klepněte levým tlačítkem myši na částice, které Vás zajímají.

➤ Program analySIS® zobrazí v překryvné vrstvě zvolené měřené parametry. Zobrazí se obrys částice
a tečny související s výpočtem parametru Feret Max.
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Parametr
částic

Typ Popis

ID Particle Identifikační
číslo

Specifické identifikační
číslo částice

Area Plocha Plocha částice
v jednotkách podle
aktuální kalibrace
obrázku. Plocha se
vypočítá vynásobením
počtu obrazových bodů
kalibračním faktorem os X
a Y.

Perimeter Obvod Součet vzdáleností mezi
obrazovými body podél
uzavřeného okraje
částice.

Diameter Outer
Max

Vzdálenost Maximální poloměr
částice, měřený ze středu
částice od jednoho okraje
k druhému.

Feret Max Vzdálenost Maximální vzdálenost
rovnoběžných tečen
protilehlých okrajů
částice.

Shape Factor Tvar Parametr udává, jak je
částice zakulacená.
Hodnota 1 je přiřazena
kruhovým částicím.
Všechny ostatní tvarové
koeficienty jsou menší
než 1.

ECD
(Equivalent
Circle
Diameter)

Vzdálenost Hodnota udává poloměr
kruhu, který má stejnou
plochu jako částice.

Phase Name Identifikační
číslo

Název rozsahu odstínů
šedé nebo rozsahu barev,
vytvořených v okně Set
Thresholds nebo Set
Color Thresholds.

Hole Count Vlastnost Počet děr v částici.

Parametry částic jsou kvantitativní a lze je použít pro každou
detekovanou částici. Tabulka obsahuje několik z přibližně
100 dostupných parametrů.

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Určení detekční oblasti
Nastavení detekce
Měření částic
Interaktivní úprava detekce
Třídění částic

Fáze pro detekci částic

Detekované částice jsou částice, které
odpovídají zvolenému rozsahu úrovní šedé,
resp. barevnému rozsahu. V úvahu budou
brány všechny fáze definované
prostřednictvím prahových úrovní. Z tohoto
důvodu byste měli při nastavování
prahových úrovní odstranit všechny fáze,
které nebudete potřebovat pro detekci.

Propojení mezi částicemi a tabulkou

Tabulka výsledků měření a obrázek
s detekovanými částicemi zůstanou
propojené, dokud neprovedete další detekci
částic.

l Pokud chcete zjistit částice v obrázku
podle konkrétních hodnot, poklepejte
na řádku s výsledky, které Vás zajímají.

l Jestliže chcete zjistit naměřené hodnoty
pro příslušnou částici v obrázku, zvolte
příkaz Analysis > Particle-Sheet Link.

Globální nastavení

Zvolte příkaz Special > Preferences...,
budete moci nastavit rozsáhlou sadu
vlastností programu. Analýzy částic se týkají
následující nastavení:

l Tabulky výsledků měření: Pokud chcete
nastavit písmo, velikost písma, počet
desetinných míst pro tabulky výsledků
měření, zpřístupněte oblast Sheet na
kartě View.

l Překryvné vrstvy: Jestliže chcete
nastavit velikost písma pro parametry
částic v překryvné vrstvě, zpřístupněte
oblast Overlay na kartě View.
Tlouš�ka pera udává, jak budou částice
zobrazeny v překryvné vrstvě, pokud
stiskněte tlačítko [Shift] a zvolíte příkaz
Single Result.
Na kartě Measure zadejte počet
desetinných míst pro parametry částic,
které se zobrazí v překryvné vrstvě.
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Interaktivní úprava detekce
Postupné doplnění částic

1. Jestliže chcete doplnit částici do seznamu detekovaných částic, zvolte příkaz Analysis > Append
Particles...
➤ Všechny částice, které již byly detekovány, se z referenčních důvodů zobrazí v překryvné vrstvě

jako obrysy. Bez ohledu na třídění, budou mít tyto částice zelenou barvu.
➤ Všechny ostatní překryvné objekty se odstraní.

2. Pokud chcete ignorovat všechny díry v částicích, zatrhněte předvolbu Fill holes v dialogovém okně
Append Particles.

➤ Pokud chcete zobrazit částice v překryvné vrstvě “vyplněné”, zrušte zatržení předvolby Outline.

3. Zvolte jednu ze sedmi metod zakreslení částic do překryvné vrstvy obrázku.

➤ Klepněte například na tlačítko Magic Wand, aby se obrysy částic automaticky vypočítaly na
základě úrovní šedé nebo barev obrázku.

➤ Kurzor myši se přesune na obrazový dokument.

4. Klepněte na reprezentativní úroveň šedé nebo reprezentativní barevnou hodnotu částice.

➤ Zvolený referenční bod se zobrazí v překryvné vrstvě jako modrý bod
➤ Všechny body tvořící částici změní barvu na červenou. Za obrazové body tvořící částici jsou

považovány body v okolí modrého referenčního bodu, jejichž úroveň šedé nebo barevná hodnota
je v nastaveném tolerančním rozsahu. Pokud má například referenční bod hodnotu šedé 75
a tolerance je 50, potom všechny úrovně šedé od 25 do 125 budou v tolerančním rozsahu.

5. Pokud chcete změnit referenční bod, pouze klepněte levým tlačítkem myši kdekoliv jinde na obrázku.

6. Jestliže chcete zvětšit hodnotu tolerance, stačí stisknout levé tlačítko myši a posunout myší doprava.
Pokud potřebujete zmenšit hodnotu tolerance, stiskněte levé tlačítko myši a posuňte myší doleva.
Aktuální tolerance se zobrazí ve stavovém řádku.

7. Jestliže chcete připojit částici do seznamu měřených částic, klepněte pravým tlačítkem myši.

8. Pokud potřebujete přidat více částic, použijte kouzelnou hůlku.

9. Klepněte dvakrát pravým tlačítkem myši, vrátíte se do dialogového okna Append Particles.

10. Můžete zvolit další metodu doplnění částic.
Pokud chcete postupně smazat doplněné částice, stačí pouze klepnout na tlačítko Undo. Částice
můžete odstraňovat, pouze dokud je dialogové okno otevřeno.

11. Zavřete dialogové okno klepnutím na tlačítko OK, kterým potvrdíte doplněné částice.

➤ Manuálně doplněné částice jsou nyní považovány za součást aktuální detekce. V zobrazených
výsledcích měření nebudou žádné rozdíly mezi částicemi detekovanými automaticky a částicemi,
které jste doplnili interaktivně.

12. Pokud chcete vytvořit novou tabulku výsledků měření, která by zahrnovala i doplněné částice, zvolte
příkaz Analysis > Particle Results.
Jestliže jste smazali nějaké částice, jejich data nebudou do tabulky zahrnuta.
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Hodnoty v aktuální tabulce výsledků jsou propojeny
s částicemi v překryvné vrstvě. V překryvné vrstvě jsou
zobrazeny částice zvolených rozsahů hodnot.

– zvolena je částice číslo 25

– plocha částice je přibližně 95 µm2

– průměrná úroveň šedi částice je 152

– částice patří do fáze Bright

1. Automatické nastavení prahových úrovní má vliv na to,
že se dvě částice se dotýkají (viz bílý kroužek na obrázku
zcela vlevo) a jsou detekovány jako jedna částice.

2. Příkaz Analysis > Delete Particles eliminuje nesprávně
detekované částice.

3. Použijte příkaz Analysis > Append Particles, kterým
doplníte obě částice samostatně. Kouzelnou hůlkou
nastavíte prahové úrovně pro každou z částic zvláš�.

4. Částice 100 a 101 byly rozpoznány jako samostatné
částice. Protože mají odlišný tvar, budou zařazeny do
odlišných tříd, a proto se zobrazí odlišnou barvou

Při použití barevné hůlky můžete použít tři tlačítka pro určení
barevného prostoru pro obrázky v barvách true color.
Uvedené obrázky demonstrují, jak zvolený barevný prostor
ovlivní detekci prostřednictvím kouzelné hůlky. Pro všechny
tři varianty byl zvolen stejný referenční bod i stejná
tolerance.

V barevném modelu RGB se tolerance se přičte/odečte od
příslušných hodnot R (červené), G (zelené) a B (modré).

V barevné modelu HSI se tolerance se přičte/odečte od
příslušných hodnot H (barvy), S (sytosti) a I (jasu).

V barevném modelu nazvaném Color se tolerance se
přičte/odečte od hodnoty H původního obrázku.

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Určení detekční oblasti
Nastavení detekce
Měření částic
Interaktivní úprava detekce
Třídění částic

Interaktivní úprava detekce

Pokud byly některé částice nesprávně
detekovány nebo nebyly detekovány vůbec,
použijte příkaz Analysis > Delete Particles
a Append Particles...

l Uvědomte si, prosím, že provedením
další detekce (po interaktivní úpravě
detekce) se potlačí částice, které jste
doplnili manuálně, a získáte tedy stejné
výsledky jako před interaktivní úpravou
detekce. Z tohoto důvodu byste po
interaktivní úpravě detekce neměli znovu
používat příkaz Analysis > Detect.
Můžete však vytvořit tabulku výsledků
anebo zvolit nové měřené parametry či
odstranit parametry, které pro další
detekci nevyžadujete.

l Uvědomte si, prosím, že všechny filtry
částic jsou nastavené tak, aby se použily
i při interaktivním doplňování částic.

Kouzelná hůlka (tlačítko Magic Wand) je
určena pro nastavení odlišných prahových
úrovní na různých místech obrázku, tedy
umožňuje Vám detekovat částice, které by
jinak byly zahrnuty v rozmezí prahových
úrovní pro celý obrázek. Musíte zvolit
referenční bod s reprezentativní úrovní šedé
nebo reprezentativní barevnou hodnotou
struktury, která Vás zajímá. Prahové úrovně
se nastaví na základě zvolené tolerance.

Odvození ROI (Oblasti zájmu) z částic:
Postup vysvětluje, jak nastavíte ROI
prostřednictvím kouzelné hůlky. Před
provedením detekce zvolte požadovanou
oblast na obrázku. Abyste tuto částici
zahrnuli do detekce jako ROI, odvoïte ROI
z nastavené částice v dialogovém okně
Define ROIs. Potom nastavte prahové
úrovně pro aktuální detekci částic ve
zvolené oblasti ROI.
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Třídění částic
Určení třídicího schématu

1. Jestliže chcete nastavit schéma pro třídění podle vlastních požadavků, zvolte příkaz Measure >
Define Classification...

➤ Otevře se dialogové okno Define Classification.

2. Zatržením předvolby Show sample objects umožníte odhad velikosti částic, nezbytný pro jejich
třídění.

➤ Aktuální překryvná vrstva se odstraní a program analySIS® zobrazí ukázku objektů pro referenční
účely.

3. Do pole New Classification zadejte název pro třídění.

4. Klepnutím na tlačítko New vytvořte nové třídicí schéma.

5. Po klepnutí na tlačítko Unit... zvolte vhodné jednotky pro třídění. Volba jednotek závisí na třídicích
kritériích. Pokud chcete například třídit částice podle plochy, měli byste jako jednotku zvolit µm2.

6. Klepněte na tlačítko Compute... a nastavte číslo a rozsah hodnot pro každou třídu. Rozsah hodnot
udává minimální a maximální hodnotu pro zvolený parametr částic.

7. Pokud si přejete upravit rozdělení tříd interaktivně, otevřete dialogové okno Define Classification:

l Pokud chcete změnit barvy přiřazené jednotlivým třídám, zvolte číslo řádku příslušné třídy
a vyberte některou ze 16 barev dostupných v barevné paletě Set color.

l Jestliže chcete změnit název tříd, klepněte levým tlačítkem myši na pole Name a zadejte do něj
název třídy

l Potřebujete-li interaktivně změnit rozdělení tříd, poklepejte na některou číselnou hodnotu a zadejte
novou.

8. Klepnutím na tlačítko OK zavřete dialogové okno.

Roztřídění částic
1. Pokud chcete roztřídit detekované částice do tříd, zvolte příkaz Analysis > Classify...

2. V seznamu Criterium v oblasti Classify zvolte parametr částic, který chcete použít pro třídění,
například Area. Volba parametru, který se použije pro třídění, závisí zcela na Vás.

3. V seznamu Class zvolte třídicí schéma, které si přejete použít. V seznamu jsou uvedena všechna
třídicí schémata, která můžete použít pro zvolené jednotky.

4. Klepnutím na tlačítko Execute proveïte třídění částic v obrázku.

➤ Částice v překryvné vrstvě se rozdělí do tříd a zobrazí se v barvách, přiřazených jednotlivým třídám.
Částice, které nelze zařadit do žádné třídy, zůstanou vyšrafované.

5. Pokud tříděním nedosáhnete požadovaných výsledků, můžete před vytvořením tabulky s výsledky
zkusit jiné třídicí schéma.

6. Klepnutím na tlačítko OK zavřete dialogové okno. Současně se vytvoří tabulka výsledků.
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Pro stejný obrázek jsou použita dvě odlišná kritéria třídění:

Na levém obrázku jsou částice roztříděny podle tvaru, na
pravém obrázku jsou stejné částice roztříděny podle
velikosti.

Uhlíková vlákna jsou roztříděna do dvou fází v odstínech
šedé. Při třídění do fází se vytvoří tabulka výsledků, která
bude obsahovat následující údaje:

– Třída 1 (tmavá fáze) obsahuje 101 částic.

– Průměrná úroveň šedé částic je 122,32.

– Celková plocha částic zařazených do třídy 1 je 1,44 µm2.

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Určení detekční oblasti
Nastavení detekce
Měření částic
Interaktivní úprava detekce
Třídění částic

Třídicí schéma se skládá z názvu, jednotky
a rozdělení tříd. Částice se třídí
prostřednictvím třídicího schématu podle
určitých parametrů. Částice lze například
třídit podle velikosti až do deseti tříd. Můžete
také zjistit průměrnou úroveň šedé všech
částic zařazených do příslušné fáze.

Automatické vytvoření třídicího
schématu: Jestliže jste již provedli detekci
částic v obrázku, můžete automaticky
vytvořit vhodné třídicí schéma.
V dialogovém okně Compute Classification
pouze zvolte kritérium a počet tříd a potom
klepněte na tlačítko Auto.

Automatické třídění
l Pokud načtete nebo pořídíte nový

obrázek, program analySIS® pro něj
použije naposledy použité třídicí schéma.
Pokud si přejete použít jiné schéma,
musíte je zvolit.

l Jakmile provedete detekci částic
v obrázku, program analySIS® si
“vzpomene” na třídicí schéma, které
naposledy použil pro tento obrázek.
Pokud příště provedete další detekci pro
příslušný obrázek, program analySIS®

pro něj použije stejné „zapamatované“
třídicí schéma. Totéž platí pro obrázky
vytvořené úpravami z původních obrázků.

Bez třídění: Pokud si nepřejete třídit částice
do tříd, zvolte v seznamu položku No
classification. Třídicím parametrům pak
budou vyhovovat všechny detekované
částice.
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Třídění částic
Výběr parametrů tříd

1. Zvolte příkaz Analysis > Define Measurements...

2. Pokud chcete určit parametry, které budou uvedeny v tabulce výsledků, zpřístupněte kartu Classes.

3. Zvolte požadovaný parametr: například ID Class nebo Particle Count.

➤ Zvolené parametry se přesunou do seznamu Selected Measurements a doplní se do tabulky
výsledků pro každou třídu.

l Je vhodné zahrnout do tabulky výsledků parametr ID Class, abyste poznali, ke které třídě uvedené
výsledky patří.

l V dolní části dialogového okna jsou textovou a grafickou formou uvedeny zvolené parametry.

4. Klepnutím na tlačítko OK zavřete dialogové okno.

Vytvoření tabulky s výsledky pro třídy
5. Zvolte příkaz Analysis > Class Results.

➤ Vytvoří se tabulka výsledků měření pro jednotlivé třídy. Všem částicím, které nemohly být zařazeny
do některé z tříd, bude přiřazena třída 0 a budou rovněž zahrnuty do tabulky.

Filtrování výsledků pro třídy
6. Klepněte na tlačítko Define Measurements na panelů nástrojů Analysis.

7. Zpřístupněte kartu Classes v dialogovém okně Define Measurements.

8. V seznamu Selected Measurements zvolte položku ID Class.
Do pole Min v oblasti Filter Range zadejte hodnotu 1.
Klepněte na tlačítko Apply.

9. Klepnutím na tlačítko OK zavřete dialogové okno Define Measurements.

10. Klepněte na tlačítko Class Results na panelu nástrojů Analysis, zobrazí se nová tabulka výsledků,
která nebude obsahovat třídu 0.

Změna způsobu zobrazení naměřených výsledků
1. Pokud chcete změnit způsob zobrazení detekovaných částic, zvolte příkaz Analysis > Classify...

2. V oblasti Particle outline zvolte položku Outline, částice patřící do příslušné třídy se zobrazí pouze
jako barevný obrys (narozdíl od částic s jednolitou barevnou výplní). Vyšrafované částice budou mít
bílý obrys.

3. V oblasti Measurement label nastavte požadovaný způsob označení částic, například ID Particles,
pro který se v překryvné vrstvě zobrazí pořadová čísla (indexy) částic. Pokud chcete zrušit označení
částic, zvolte hodnotu None.

4. Klepněte na tlačítko Execute, upravený způsob zobrazení se projeví na obrázku.
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Parametr
částic

Typ Popis

Particle Count Vlastnosti Počet částic v příslušné
třídě

Area Fraction Plocha Plocha všech částic třídy
procentuálně vyjádřená
vzhledem k celkové
měřené ploše (ohraničené
rámečkem nebo zvolené
jako ROI)

Area Class Plocha Součet ploch všech částic
příslušné třídy

Area Mean Plocha Průměrná plocha částic
příslušné třídy

Particle Density Hustota Počet částic příslušné
třídy na plochu, pokud
se jedná o ROI

Maximum/
Minimum Class

Identifikační
číslo

Horní/dolní limit pro
zařazení do třídy; může
být použito k zahrnutí
třídicího schématu do
tabulky s výsledky

Parametry tříd jsou statické veličiny, které se vztahují ke
všem částicím třídy. Uvedená tabulka obsahuje několik
parametrů tříd z přibližně 100 dostupných.

Detekované částice mohou být zobrazeny v překryvné
vrstvě několika různými způsoby. Na obrázku vlevo je
částice zobrazena jednolitou barvou, uvedené číslo je
identifikační číslo částice. Na obrázku vpravo je zvýrazněn
obrys částice a vlastní částice je zobrazena podle
skutečnosti. Pokud chcete změnit způsob zobrazení částic,
otevřete dialogové okno Classification (příkaz Define
Detection > Classification).

Detekce částic
Příprava obrázku
Nastavení prahových úrovní
Určení detekční oblasti
Nastavení detekce
Měření částic
Interaktivní úprava detekce
Třídění částic

Pokud chcete změnit zobrazení částic,
zpřístupněte kartu Classification příkazem
Define Detection > Classification. Jestliže
zvolíte jako třídicí kritérium No classification,
data částic se zobrazí bez třídění.

Special > Preferences: globální nastavení
pro zobrazení překryvné vrstvy při
interaktivním měření, které se netýká
automatické detekce částic. Existují však
výjimky:

l Desetinná místa: na kartě Measure
zvolte počet desetinných míst pro
zobrazení výsledků měření částic
v překryvné vrstvě

l Velikost písma: velikost písma pro
označení částic se nastavuje ve oblasti
Overlay na kartě View.

l Tabulka: parametry v oblasti Sheet také
ovlivňují zobrazení výsledků měření
částic.

Úprava zobrazení překryvné vrstvy:
všechny výsledky analýzy částic, které jsou
zobrazeny v překryvné vrstvě můžete
upravovat podobně jako jiné překryvné
objekty. Pouze zrušte blokování datové
vrstvy příkazem Overlay > Layer > Lock
data Layer a potom můžete začít upravovat.

Nastavení detekce, výsledky: Dialogové
okno Define Detection obsahuje tři karty pro
všeobecná nastavení, která ovlivňují i
zobrazení výsledků:

l Výsledky se pro každé ROI se mohou
počítat samostatně (včetně samostatných
tabulek). Toto nastavení ovlivní počet
parametrů tříd.

l Hodnoty v tabulce výsledků mohou být
zobrazeny v barvách odpovídajících tříd.

l Všechny koeficienty větší než 1 můžete
nastavit na hodnotu 1.
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Úvod k této části příručky

1. Účel této dokumentace
Účelem této části příručky je seznámit Vás co nejrychlejším způsobem s použitím Generátoru zpráv.
Věnujte trochu svého času a projděte si postupně pokyny uvedené v této příručce na Vašem počítači
v programu analySIS. Budete ihned schopni vytvářet své vlastní zprávy a šablony zpráv.

2. Předdefinované šablony zpráv
V postupných pokynech jsou použity předdefinované šablony zpráv, které si můžete instalovat společně
s programem analySIS. Na základě těchto šablon si můžete velmi rychle vytvořit své vlastní šablony
zpráv.

3. Struktura této části příručky
Struktura této části příručky vychází z posloupnosti kroků vyžadovaných programovým vybavením
Generátoru zpráv (v dalším textu příručky je uváděno jako Generátor zpráv). Každá dvojice stránek
pojednává o stejném tématu a je strukturována stejným způsobem:

Levé stránky

Levé stránky obsahují podrobné pokyny „krok za krokem“. Každá sada pokynů začíná uvedením
řešeného úkolu, a pokud je to nezbytné, vysvětlením požadavků. Pokyny byly sestaveny tak,
abyste k provedení jednotlivých úkolů museli sledovat pouze hlavní body. Pokyny v odrážkách
není nutné vykonat.

V textu naleznete dva druhy odrážek. Odrážky označené šipkou Vás informují, jak bude systém
reagovat na Vámi vykonané kroky. Ostatní odrážky obsahují podrobnosti ke krokům, které budete
provádět, varování nebo doporučení a nejsou označeny žádným symbolem.

Pravé stránky

Pravé stránky obsahují obrázky anebo doplňkové informace. V šedém sloupci je vysvětlena
použitá terminologie a základní operace. Jedná se o termíny použité na levých stránkách, k nimž
je nutné podat vysvětlení nebo ke kterým mohou vzniknout dotazy.

4. Práce s postupnými pokyny
Pokud se chcete seznámit s Generátorem zpráv a být schopni jej používat, nemusíte číst každý řádek
postupných pokynů. Pro začátek stačí přečíst pouze hlavní body. Jakékoliv doplňkové informace, které
jsou uvedeny v odrážkách nebo na pravých stránkách, jsou Vám k dispozici pouze pro případ, že je
budete potřebovat.
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1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků

vytvoření nové zprávy
vložení obrázků
nastavení velikosti obrázků pro tisk
doplnění stránek/procházení zprávou
vložení textu/tisk zprávy
uložení zprávy/export

použití obrázků z databáze
vložení obrázků
popis šablony SoftTecTemplate
nastavení objektů typu záznam

Svou první zprávu vytvoříte v Kapitole 1, k tomu použijete
předdefinované šablony zpráv. Naučíte se, jak pracovat
s obrázky i grafickým uživatelským rozhraním Generátoru
zpráv. Popisované kroky odpovídají běžnému postupu,
který vykonáte při práci s Generátorem zpráv.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS
vložení grafických objektů
úprava šablon stránek

Zvětšené výřezy obrázků, vysvětlující texty, grafy, tabulky
nebo grafické objekty vložíte do zprávy v Kapitole 2. Zprávy
vytvářené tímto způsobem, mohou být v určitém rozsahu
generovány automaticky.

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon

vytvoření/uložení nových šablon
úprava šablon stránek
doplnění nových šablon stránek
doplnění nových textových proměnných

vytvoření nových šablon objektů
šablony pro objekty typu záznam
šablony pro objekty typu pole

vytvoření nových šablon
nastavení vlastností stránky
návrh šablon

V Kapitole 3 můžete upravit předdefinované šablony tak,
aby vyhovovaly Vašim požadavkům. Vytváření vlastních
šablon je důležitou podmínkou pro použití Generátoru
zpráv na profesionální bázi: věnujte tedy čas vytvoření
šablony, která bude skutečně optimalizovaná pro Vaše
potřeby.

Co přesně dělá Generátor zpráv?

Automatické generování zpráv

Použijte Generátor zpráv pro vytvoření
vícestránkových zpráv opravdu automaticky
i s obrázky z databáze programu analySIS
nebo ze správce obrázků. Zvolte obrázky
v databázi obrázků a jednoduchým
příkazem je všechny vložte do zprávy.

Úplný přístup k datům obsaženým
v databázi

Společně s vlastními obrázky můžete
z databáze získat všechny doplňkové
informace k obrázkům (obsažené v polích
databáze programu analySIS) a automaticky
je zahrnout do zprávy.

Práce s obrázky

Generátor zpráv je vybaven prostředky pro
optimální způsob práce s obrázky, které
umožňují zvětšování obrázků v měřítku,
vkládání zvětšených detailů, volbu
příslušných částí obrázků atd.

Texty, tabulky, grafy

Do zprávy můžete vložit všechny libovolné
dokumenty, které jste vytvořili v programu
analySIS. Prostřednictvím Generátoru
zpráv můžete například vytisknout na jednu
stránku obrázky společně s tabulkami
výsledků odpovídajících měření a grafy.

Přizpůsobitelné rozvržení stránky

Generátor zpráv Vám poskytuje tak
přizpůsobitelné rozvržení stránek, jak si jen
dokážete představit. Nastavíte si vlastní
šablonu stránek přesně podle svých
požadavků.

Šablony stránek vytvoříte pouze jednou.
Tyto šablony jsou základem pro vytváření
Vašich zpráv a zajistí jednotný vzhled Vašich
dokumentů.

Slučitelnost s MS Word

Prostřednictvím funkce RTF Report můžete
exportovat zprávy do aplikace MS Word při
zachování vzhledu a všech vlastností zpráv.
Můžete tak komunikovat se svými
spolupracovníky, kteří nemají přístup
k programu analySIS.
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Vytvoření nové zprávy
1. Zvolte příkaz Report > New... v nabídce File.

➤ Dialogové okno New Report Vám nabídne šablony, které se mohou stát základem pro Vaše
zprávy.

➤ Předdefinované šablony programu analySIS naleznete na kartě General. Pokud nabídka File
neobsahuje položku Report, zvolte položku Add-In Manager... Potom zvolte položku Special
a zatrhněte předvolbu Report Generator v seznamu Available add-ins. Potom ukončete a znovu
spus�te program analySIS.

2. Na kartě General zvolte šablonu zprávy pojmenovanou SISTemplate.

3. V oblasti Create New zvolte položku Report.

Pokud zvolíte položku Template, měla by se vytvořit šablona zprávy vycházející ze šablony
SISTemplate.

4. Klepnutím na tlačítko OK vytvořte zprávu.

➤ První stránka nové zprávy se objeví jako samostatný dokument. Vzhled první stránky závisí na
zvolené šabloně zprávy .

➤ Program analySIS zobrazí panely nástrojů pro vytvoření a úpravu zpráv. Tyto panely nástrojů jsou
kontextově závislé, tzn. že jakmile aktivujete jiný dokument programu analySIS, panely nástrojů pro
práci se zprávami zmizí.

Popis první stránky šablony SISTemplate

Typ objektu Funkce Poznámky

1 Obrázek

O
bj

ek
ty

na
po

za
dí

Logo společnosti I po vložení do zprávy se uchová vazba na
původní soubor s obrázkem. To znamená, že
obrázek samotný se nebude s každou zprávou
ukládat znovu.

2 Čáry Rámeček

3 Text Standardní text, který se
vytiskne na každé
stránce zprávy

Text ve tvaru – page 1 of 1 – je složen ze dvou
textových objektů a dvou automatických textů.

4 Automatický
text

Datum
Číslo aktuální stránky
Celkový počet stránek

Formát data závisí na nastavení ve Windows

5 Obrázek

S
tá

lá
po

lo
ha Kód pole s obrázkem Vyšrafovaná oblast označuje maximální tiskový

prostor vyhrazený pro obrázek.

6 Text Kód pole pro text
k obrázku

Šablona také zahrnuje texty, které se budou
změněny až později ve zprávě. Tím se zajistí
specifické formátování a umístění textu.

První stránka zahrnuje všechny prvky typické pro šablony zpráv. Tyto prvky se vytisknou na všech stranách
zprávy, vycházející z této šablony. Rozvržení stránky zprávy obsahuje logo, rámeček, zvolené písmo,
umístění obrázků a komentářů/textů k obrázkům.
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První stránka zprávy vychází ze šablony SISTemplate.
Stránka zahrnuje objekty na pozadí, automatické texty
a kódy polí. Jednotlivé prvky šablony jsou vysvětleny
v tabulce na předcházející stránce (levé).

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků

vytvoření nové zprávy
vložení obrázků
nastavení velikosti obrázků pro tisk
doplnění stránek/procházení zprávou
vložení textu/tisk zprávy
uložení zprávy/export

použití obrázků z databáze

Zprávy a šablony zpráv: Zprávy se
používají pro dokumentování výsledků
standardizovanou formou. Zpravidla se
skládají z mnoha stránek s podobnou
strukturou. Pro snazší vytváření zpráv se
používají šablony zpráv. Šablona zprávy
definuje všechna rozvržení stránek
a všechny šablony objektů, které mohou
být použity v tomto druhu zprávy.

Podrobnější informace o šablonách zpráv
naleznete na stránce 139.

Objekty ve zprávách: Stránka zprávy
obvykle obsahuje různé druhy objektů.
Může se jednat textové objekty, objekty typu
obrázek, právě tak jako o grafické objekty.
Objekt se také může skládat z několika
dílčích objektů. Odlišné objekty mají odlišné
vlastnosti:

l Objekty na pozadí jsou definovány na
stránce šablony a objeví se na každé
stránce zprávy, která vychází z této
šablony stránky. Mezi běžné objekty na
pozadí patří logo společnosti, adresa
nebo rámeček (str. 141).

l Automatické texty jsou texty definované
na šabloně stránky, které se automaticky
aktualizují pro každou novou stránku
zprávy. Mezi běžné automatické texty
patří datum vytvoření a číslo stránky
(str. 151).

l Některé objekty slouží jako kódy polí.
Kódy polí, například velikost a umístění,
využijte k nastavení vlastností obrázků
a textů, které si přejete vložit do zprávy
později.

Okno zprávy: nikdy nemůžete načíst
a upravovat více než jednu zprávu (nebo
šablonu zprávy) současně. Zpráva se načte
do vlastního samostatného okna. Stránky
zprávy lze zobrazovat a upravovat po jedné.
Okno zprávy má vlastní samostatný panel
nástrojů a stavový řádek. Při umístění
objektů pomáhají pravítka na okraji okna
(str. 43) a souřadnicová mřížka.
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Vložení obrázků ze správce obrázků do zprávy
1. Načtěte do správce obrázků obrázky, které chcete vložit do zprávy.

Načtěte, například, následující obrázky z demonstrační databáze programu analySIS: Scale, Fiber,
Spheres, Large Image.

2. Stisknutím klávesy [F8] otevřete dialogové okno Preferences a zvolte kartu Report.

3. V oblasti Image proveïte dvě zásadní rozhodnutí, která se týkají zpracování obrázků ve zprávě.

Create image copies: Rozhodněte, zda se obrázky uloží společně se zprávou, nebo zda je raději
vložíte jako odkaz na existující soubor s obrázkem.

Use thumbnails instead of full images: Zvolte, zda se zobrazí obrázky ve vysokém rozlišení nebo
pouze jejich náhledy. Nastavení ovlivní pouze zobrazení na monitoru, nikoli kvalitu tiskového
výstupu.

4. Klepnutím na tlačítko OK zavřete dialogové okno.

5. Uchopte obrázek Scale a metodou drag&drop jej přesuňte ze správce obrázků na objekt typu
obrázek ve zprávě.

➤ Obrázek Scale se vloží do zprávy a zobrazí se v okně zprávy.
➤ Zvětšení pro zobrazení a délka měřítka se vypočtou na základě kalibračních dat obrázku.

Pokud chcete vložit obrázek ze správce obrázků do zprávy, uchopte obrázek ve správci obrázků a přesuňte
jej na objekt typu obrázek ve zprávě. Po vložení obrázku do objektu typu obrázek podle šablony
SISTemplate se obrázek zobrazí v okně zprávy společně se koeficientem zvětšení a aktualizovaným
měřítkem.
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Nabídka Special, položka Preferences..., karta Report,
oblast Images

✔ Create image copies ❑ Create image copies

Které
obrázky
budou
ovlivněny?

Toto nastavení můžete kdykoliv změnit pro obrázky, které
budete vkládat. Již vložené obrázky změna nastavení neovlivní.

Nejedná se
o globální
nastavení

Nastavená hodnota se ukládá společně se zprávou. Pokud
upravujete existující zprávu, zkontrolujte ještě před vložením
obrázků nastavený způsob vkládání obrázků.

Vysvětlení Předvolbu zatrhněte, pokud
chcete, aby se každý vložený
obrázek ukládal společně se
zprávou. Nezáleží na tom, zda
byl obrázek již uložen do
souboru do jiné složky nebo
nikoli.

Zrušte zatržení předvolby,
jestliže chcete se zprávou
ukládat pouze cestu
k obrázku. Tento způsob
zajiš�uje, že neuložíte stejná
data vícekrát.

Kam se
soubory
ukládají?

Pokud vložíte obrázek do
zprávy, program analySIS jej
uloží pod standardním názvem
do určité složky, která se
automaticky vytvoří při
ukládání zprávy (str. 137).

Připojené soubory s obrázky
mohou být uloženy v libovolné
složce na libovolné jednotce.
Při vytváření a úpravě zpráv
v programu analySIS se vždy
musíte přesvědčit, zda jsou
soubory s obrázky dostupné.

Možná
chybová
hlášení

Pokud se pokusíte vložit do
zprávy obrázek ze správce
obrázků, aniž by byl uložen,
zobrazí se chybové hlášení.
Obrázek pak můžete buï
uložit nebo jej vložit jako kopii.
Pokud smažete, přejmenujete
nebo přesunete obrázek
připojený do zprávy, zobrazí
se při načítání zprávy chybové
hlášení. Obrázek, který se již
nenachází ve složce, z které
byl připojen, se ve zprávě
nahradí náhledem.

Formát
obrázku

Obrázky se vždy ukládají ve
formátu TIFF, takže všechny
doplňkové informace
vyžadované samotným
obrázkem, se uloží také. Jedná
se o kalibrační data, překryvné
vrstvy obrázku, název
a komentář obrázku.

Do zprávy můžete vkládat
odkaz na obrázky libovolného
formátu podporovaného
programem analySIS.
Uvědomte si však, že kalibrační
data a překryvné vrstvy
obrázku se ukládají pouze
s obrázky formátu TIFF.

Mazání
nebo
výměna
obrázků
ve zprávě

Při mazání obrázků se aktuální
soubor s obrázkem vymaže,
jakmile zavřete zprávu.

Odstraněním obrázků ze
zprávy neovlivníte soubory
s obrázky. Jediné, co smažete,
budou soubory náhledů,
umístěné ve složce pro zprávu.

✔ Use thumbnails instead of
full images

❑ Use thumbnails instead of
full images

Co se
stane...

Po zatržení předvolby se
obrázky ve zprávě nahradí pro
zobrazení na monitoru za
náhledy.

Jestliže chcete obrázky
zobrazit na monitoru ve
vysokém rozlišení, zrušte
zatržení předvolby.

Náhledy +
překryvné
vrstvy:

Všimněte si, prosím, že program analySIS zpravidla
nezobrazuje překryvné vrstvy pro náhledy. Překryvné vrstvy
obrázku zůstanou zachovány a objeví se na tiskovém výstupu.
Překryvné vrstvy se automaticky sloučí s obrázkem při exportu
do souboru formátu RTF.

Pouze
zobrazení
na monitoru

Způsob zobrazení obrázků na obrazovce neovlivňuje kvalitu
tisku. Program analySIS automaticky nahradí všechny náhledy
obrázky ve vysokém rozlišení.

Globální
nastavení

Toto nastavení je globální, tzn. že zvolený režim zobrazení
zůstane platný pro všechny zprávy, dokud nastavení explicitně
nezměníte.

Použití Nastavení použijte při
procházení zprávou. Zkrátíte
čas potřebný pro sestavení
každé stránky.

Nastavení použijte, jestliže
potřebujete rozpoznat detaily
v obrázku, například pokud
píšete komentáře k obrázku.

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků

vytvoření nové zprávy
vložení obrázků
nastavení velikosti obrázků pro tisk
doplnění stránek/procházení zprávou
vložení textu/tisk zprávy
uložení zprávy/export

použití obrázků z databáze

Objekt typu obrázek: Obrázek nemůžete
vložit přímo do zprávy. Nejprve musíte
vytvořit objekt typu obrázek, abyste mohli
nastavit velikost, umístění i vlastnosti
obrázku. Po vložení zůstane objekt typu
obrázek prázdný. Prázdný objekt typu
obrázek jako takový rozpoznáte podle
vyšrafování oblasti pro obrázek.

Vložení objektu typu obrázek: Pokud
chcete vložit objekt typu obrázek do zprávy,
klepněte na tlačítko Image na panelu
nástrojů Report Objects.

Vložení obrázků

l Do objektu typu obrázek: použijte myš
a metodu drag&drop. Uchopte obrázky
ve správci obrázků nebo přímo v databázi
obrázků programu analySIS a přetáhněte
je na existující objekt typu obrázek.
Vložený obrázek převezme vlastnosti
objektu.

l Do objektu typu záznam (str. 115):
Objekty typu záznam obsahují také
objekty typu obrázek, ovšem jsou
definované speciálně pouze pro obrázky
z databází programu analySIS, proto
můžete do objektu typu záznam vložit
pouze obrázky z databáze. Vložení
obrázků přímo za správce obrázků není
možné.

Podrobnější informace o vlastnostech
obrázků naleznete na stránce 145.

Metoda drag&drop: Pokud chcete zvolit
obrázek, klepněte levým tlačítkem myši na
pamě�ové pole obrázku ve správci obrázků.
Držte levé tlačítko myši stisknuté a přesuňte
kurzor myši na objekt typu obrázek v okně
zprávy. Po uvolnění levého tlačítka myši se
obrázek přiřadí do zprávy.

Otevření demonstrační databáze:
Databáze s ukázkami je součástí standardní
instalace programu analySIS a nachází se
ve složce Archive\Demobase na jednotce,
na níž je instalován program analySIS.
Zvolte položku Open v nabídce Database.
V dialogovém okně vyhledejte soubor
DemoBase.mdb a klepněte na tlačítko
Open.
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Nastavení velikosti obrázků pro tisk
1. Pokud chcete obrázek zobrazit s odlišným koeficientem zvětšení, klepnutím levým tlačítkem myši

označte objekt typu obrázek.

➤ Objekt typu obrázek bude nyní v dialogovém okně Report ohraničen šedými čtverečky
(tzv. výběrové značky).

2. Pokud chcete změnit některou z vlastností objektu typu obrázek, zejména velikost pro tisk, klepněte
na tlačítko Properties na panelu nástrojů Report Objects.

3. Klepněte na záložku karty Image Properties. Na této kartě jsou umístěny vlastnosti, zejména pro
objekty typu obrázek. Ve zprávě můžete kdykoliv změnit vlastnosti jednotlivých obrázků, které byly
navrženy v šabloně zprávy .

✔ Used fixed magnification: Můžete určit libovolné zvětšení obrázku, které Vám vyhovuje.Program
analySIS potom vypočte velikost obrázku pro tisk, založenou na kalibračních datech obrázku.
Velikost obrázku pro tisk = absolutní velikost obrázku × zvětšení.
Příklad: Pokud máte k dispozici obrázek dlouhý 600 µm a zvětšení 200 : 1 nebo snad 500 : 1, bude
mít výsledný obrázek 12 cm, v druhém případě 30 cm. Pokud je výsledná velikost obrázku pro tisk
větší než objekt typu obrázek, program analySIS zobrazí pouze část obrázku, která vyplní plochu
vymezenou pro objekt typu obrázek.
Výchozí nastavení je optimalizované zvětšení aktuálního obrázku. Pokud je objekt typu obrázek
prázdný, nenačte se žádné zvětšení, pole zůstane prázdné a Vy budete muset určit hodnotu
interaktivně.

✔ Use image magnification: Program analySIS načítá hodnotu zvětšení obrázku z informací
o obrázku. Pro výpočet velikosti pro tisk jsou však použita kalibrační data X/Y: dva obrázky
s odlišnými kalibračními daty a stejným zvětšením se ve zprávě zobrazí odlišně.
Příklad: Pro obrázek se zvětšením M=100 a absolutní šířkou 600 µm se vypočte šířka obrázku
pro tisk 6 cm. Absolutní šířku vypočte program analySIS na základě počtu obrazových bodů
a kalibračních dat. Pokud je výsledná velikost obrázku pro tisk větší než objekt typu obrázek,
program analySIS zobrazí pouze část obrázku, která vyplní objekt typu obrázek.

✔ Fit image into frame: program analySIS vypočítává nejvhodnější zvětšení na základě kalibračních
dat pro velikost objektu typu obrázek. Poměr stran obrázku zůstane beze změn za všech okolností.
Přípustná jsou všechna zvětšení vyjádřená celým číslem.

✔ Use optimized magnifications: Program analySIS používá pouze hodnoty zvětšení 1, 2 a 5
a jejich desetinásobky (10, 20, 50, 100, 200, 500, 1000 atd.)
Příklad: Obrázek vyplní přesně rámeček objektu typu obrázek při zvětšení 183. Obrázek se tedy
zobrazí v nejbližším možném menším rozlišení, v tomto případě to je 100 : 1.

5. Do pole Scale zadejte konstantní zvětšení 500 a potvrïte jej stisknutím tlačítka OK. Pokud je
požadované zvětšení již uvedeno v seznamu, můžete je v seznamu vyhledat.

➤ Velikost objektu typu obrázek ovlivňuje maximální velikost obrázku k tisku. Jestliže je obrázek větší
než objekt typu obrázek, zobrazí se pouze dolní levá část obrázku.

6. Pokud chcete posunout obrázek společně s rámečkem, klepněte na tlačítko Move Image na panelu
nástrojů Report Objects.

Všimněte si, prosím, že obrázek lze posouvat pouze v případě, že je větší než objekt typu obrázek.
Po přesunutí na objekt typu obrázek se změní tvar kurzoru myši. Obrázek aktivujete klepnutím
levým tlačítkem myši. Přidržte levé tlačítko myši stisknuté a přesuňte kurzor myši na rámeček.
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Na uvedených obrázcích je zobrazena stupnice ve třech
odlišných zvětšeních, která jsou k dispozici. Zobrazené
objekty typu obrázek jsou ve všech případech stejně velké.
Velikost rámečků indikuje velikost objektů. Dvě odlišná
předdefinovaná zvětšení (200× a 300× ukazují odlišné části
obrázku.

Velikost obrázku pro tisk ve zprávě závisí na vlastnostech
zvoleného objektu typu obrázek a kalibraci obrázku.
Tabulka obsahuje všeobecně platí informace:

Velikost pro tisk = zvětšení pro tisk × velikost obrázku

Termín Definice

Zvětšení
obrázku je...

... zvětšení mikroskopu při pořizování obrázku. Toto
zvětšení zadáte před pořízením obrázku příkazem Set
magnification... v nabídce Image. Program analySIS načte
zvětšení obrázku z informací o obrázku.

Zvětšení pro
tisk je...

...absolutní zvětšení, v kterém se obrázek vytiskne na
papír. Program analySIS určuje zvětšení pro tisk z velikosti
pro tisk a absolutní velikosti obrázku.

Velikost pro
tisk je...

...velikost obrázku, v jaké se vytiskne na papír. Pokud
nepoužijete automatické označování, bude velikost
obrázku odpovídat přesně velikosti objektu typu obrázek.
Pokud chcete zobrazit zvětšení nebo měřítko, bude
velikost obrázku pro tisk menší než velikost objektu typu
obrázek.

Velikost
obrázku je...

... aktuální velikost obrázku. Ta je určena kalibrací
obrázku. Obrázek, který je široký 500 obrazových bodů a
je kalibrován na 0,5 µm/obrazový bod, má absolutní šířku
500 × 0,5 µm = 250 µm. Program analySIS určuje
absolutní velikost obrázku z informací o obrázku.

Velikost
rámečku je...

...velikost objektu typu obrázek. Velikost rámečku určíte
buï myší nebo v dialogovém okně Report Object
Properties (na kartě Position and Size). Jestliže chcete
nakreslit rámeček stejné velikosti jakou má objekt typu
obrázek, zatrhněte předvolbu Frame na kartě Image
Properties.

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků
vytvoření nové zprávy

vložení obrázků
nastavení velikosti obrázků pro tisk
doplnění stránek/procházení zprávou
vložení textu/tisk zprávy
uložení zprávy/export

použití obrázků z databáze

Výběr objektů

Všeobecně platí, že objekty musíte nejprve
zvolit a teprve potom je můžete upravovat.
Pokud chcete objekt zvolit, klepněte na něj
levým tlačítkem myši. Zvolený objekt
poznáte podle výběrových značek.

Výběr několika objektů
l Pokud stisknete a přidržíte tlačítko [Shift],

můžete zvolit několik objektů. Všechny
objekty, které zvolíte, budou označeny
výběrovými značkami: naposledy zvolený
objekt má šedé výběrové značky, ostatní
objekty bílé.

l Stiskněte a přidržte levé tlačítko myši
a vytvořte rámeček, který ohraničí
všechny objekty, které si přejete zvolit.

Výběrový rámeček
Každý objekt má vlastní výběrový rámeček.
Jedná se o pravoúhlou oblast, která
obklopuje celý objekt. Pokud objekt zvolíte,
zobrazí se barevné čtverečky označující
výběrový rámeček.
Pokud chcete změnit vlastnosti objektu,
poklepejte na něj.

NEBO...
l Zvolte objekt a potom klepněte pravým

tlačítkem myši. Zobrazí se místní nabídka,
v které zvolte příkaz Properties. NEBO...

l Zvolte objekt a potom klepněte na tlačítko
Properties na panelu nástrojů Report
Objects.

Velikost obrázku pro tisk
Program analySIS nabízí různé možností
nastavení velikosti obrázku, v jaké bude
vytištěn ve zprávě. Použijte následující
všeobecná pravidla:
l Velikost objektu typu obrázek udává

maximální velikost obrázku pro tisk.
l Rozlišení a měřítko (délkové) jsou určeny

na základě kalibračních dat obrázku.

VÝSTRAHA: Automatické označování je
správné pouze v případě, že obrázky jsou
správně kalibrované.

Více informací o obrázcích naleznete
na str. 49.
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Doplnění stránek do zprávy
1. Pokud chcete doplnit do zprávy stránku, klepněte na tlačítko Add Page na panelu nástrojů Report.

➤ Otevře se dialogové okno Add Page, v němž můžete určit, kam chcete stránku do zprávy vložit.

2. Jestliže chcete vložit novou stránku přímo před aktuální stránku zprávy, zvolte položku Insert page
v dialogovém okně Add Page. Tuto položku zvolte v případě, že chcete vložit stránku do zprávy,
která je jinak hotová.
Pokud chcete doplnit do zprávy poslední stránku bez ohledu na to, která stránka zprávy je aktivní,
zvolte položku Append page.

3. Zvolenou položku potvrïte klepnutím na tlačítko OK.

➤ Otevře se dialogové okno Select Page Template. V okně naleznete seznam všech šablon stránek,
které jsou definovány v aktuální šabloně zprávy. V závislosti na šabloně zprávy budete mít
k dispozici velmi odlišná rozvržení stránky.

4. Jestliže chcete doplnit stránku s vyhrazeným místem pro dva obrázky, zvolte položku 2ImagePage
a potom ji potvrïte klepnutím na tlačítko OK.

➤ Nyní uvidíte nově vloženou stránku v okně Report. Kromě počtu obrázků mají nová i předcházející
stránka stejné rozvržení. Program analySIS zajistí správné číslování stránek v pravém dolním rohu
stránky. Narozdíl od první stránky má nová stránka předefinované dva objekty typu obrázek.

➤ Na stavovém řádku je uvedeno číslo aktuální stránky a celkový počet stránek zprávy.
➤ Nyní budou dostupná tlačítka pro stránkování dopředu a dozadu.

5. Vložte obrázky Zr02 a Fiber ze správce obrázků do zprávy.

6. Klepněte znovu na tlačítko Add Page a v dialogovém okně Select Page Template zvolte položku
MIA page.

➤ Do zprávy bude přidána další stránka (MIA page).

Popis stránky MIA: Stránka MIA má zvláštní rozvržení, navržené speciálně pro extrémně velké
obrázky. Obrazy MIA jsou vytvořeny z jednotlivých vzájemně se překrývajících obrazů tak, aby
výsledný obraz pokryl plochu nebo objekt, který nelze zachytit jedním snímkem kamery (resp.
jiného snímacího zařízení) – viz modlu MIA. Objekt typu obrázek je otočen o 90°, takže obrázky MIA
mohou být vloženy do zprávy v optimální rozlišení.

Vytvoření obrázku MIA: Načtěte postupně následující obrázky z demonstrační databáze do
pamě�ových polí obrázků: WoodA1, WoodB1, WoodC1, WoodA2, WoodB2 a WoodC2. Aktivujte
pamě�ové pole s obrázkem WoodA1 a zvolte položku Multiple Image Alignment > Arrange
Multiple Images... v nabídce Image.

Zkontrolujte, resp. upravte, rozmístění dílčích snímků v náhledu 3 × 2 a proveïte sesazení
obrázků.

➤ Uložte výsledný obrázek vložením do demo databáze.
➤ Přetáhněte výsledný obrázek do objektu typu obrázek ve zprávě. Obrázek se otočí o 90° a zabere

právě celou stránku.
➤ Zpráva se nyní skládá ze tří stránek a celkem čtyř obrázků.

Procházení zprávou
7. Nahraïte obrázky ve vysokém rozlišení náhledy, abyste urychlili procházení stránkami zprávy.

➤ Stisknutím klávesy [F8] otevřete dialogové okno Preferences a zvolte kartu Report. Zatrhněte
předvolbu Use Thumbnails.

8. Klepnutím na tlačítko First Page na panelu nástrojů Report se přesuňte zpět na první stránku zprávy.
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Panel nástrojů Report

Panel nástrojů Report je součástí okna Report.
Nezapomeňte, prosím, že funkce těchto tlačítek nejsou
dostupné prostřednictvím příkazů v nabídce. Z tohoto
důvodu by měl být panel nástrojů trvale zobrazen. Pokud si
přejete doplnit na panel tlačítka pro další často používané
funkce, zvolte položku Edit Button Bars... v nabídce
Special.

Stránka MIA může vypadat jako na uvedeném obrázku.
Obrázek je otočený, aby mohl být zobrazen v optimální
velikosti. Výřez obrázku ukazuje další informace o obrázku.

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků
vytvoření nové zprávy

vložení obrázků
nastavení velikosti obrázků pro tisk
doplnění stránek/procházení
zprávou
vložení textu/tisk zprávy
uložení zprávy/export

použití obrázků z databáze

Zobrazení a skrytí panelu nástrojů
l Použijte příkaz Edit Button Bars...

v nabídce Special.
l Klepněte pravým tlačítkem myši na okno

zprávy. Všechny panely nástrojů, které
jsou součástí Generátoru zpráv, jsou
uvedeny pod příkazem Button Bars.

Procházení zprávou: V okně zprávy lze
zobrazit pouze jednu stránku zprávy.
Tlačítky na levé straně panelu nástrojů
Report můžete procházet zprávou dopředu
nebo dozadu.

POZNÁMKA: Při procházení zprávou
se aktuální stránka automaticky uloží.

First/Last Page: Tlačítka slouží k přechodu
přímo na první nebo poslední stránku zprávy.

Previous/Next Page: Tlačítka umožňují
přechod na předcházející nebo následující
stránku.

Go to: Pokud chcete rychle zobrazit
konkrétní stránku, zadejte do pole její číslo
a stiskněte klávesu [Enter].

Tlačítko Add Page doplní novou stránku
na libovolné zvolené místo ve zprávě. Po
klepnutí na tlačítko zvolte, kam chcete
stránku vložit. Buï ji můžete doplnit na
konec zprávy nebo vložit před aktuální
stránku.

Musíte určit šablonu pro každou stránku.
Šablona určuje vzhled stránky.

Nově vložená stránka se stane aktivní, bez
ohledu na to, jaká stránka byla zobrazena
před vložením nové stránky.

Tlačítko Delete Page odstraní stránku,
která je právě zobrazena v okně zprávy.
Odstranění stránky musíte potvrdit.
Společně se stránkou se smažou i všechny
obrázky a náhledy na stránce, včetně
odpovídajících souborů ve zvláštních
složkách, vytvořených programem
analySIS. Pokud je zachována vazba mezi
obrázky ve zprávě a původními soubory
s obrázky, příslušné soubory se
samozřejmě nesmažou.

107



Vložení textu do obrázků
1. Zvětšete zobrazení stránky zprávy tak, aby byl text čitelný. V seznamu Set Zoom na panelu nástrojů

okna zprávy vyhledejte odpovídající koeficient zvětšení, například 100 %, nebo jej přímo zadejte.

➤ Na šabloně SISTemplate označuje standardní text „Please enter your comment on the image here“
textový objekt pro vložení komentáře k obrázku.

2. Pokud chcete zadat komentář pro první obrázek, přepněte program do režimu vkládání textu.
Klepněte dvakrát po sobě na různá místa v textovém objektu.

➤ Standardní text se nyní barevně zvýrazní.

VÝSTRAHA: Text může mít v režimu vkládání textu poněkud odlišný formát než v aktuální zprávě!

3. Nyní zadejte komentář k obrázku.

➤ Pokud zadáte vlastní komentář, standardní text se automaticky smaže.
Můžete zadat více textu, než kolik se vejde do textového objektu. V takovém případě program
analySIS posune celý text nahoru (v režimu vkládání textu). Jakmile ukončíte režim vkládání textu,
bude viditelná pouze horní část textu. Text, který zůstane vně textového pole, se odřízne. Zůstane
sice zachován, ale nebude prostě zobrazen na monitoru. Pokud budete zprávu exportovat do
formátu RTF, v programu MS Word uvidíte celý text.

4. Pokud chcete ukončit režim vkládání textu, pouze klepněte na libovolné místo ve zprávě mimo
textové pole.

5. Doplňte komentáře ke všem ostatním obrázkům ve zprávě.

5.1 K procházení zprávou dopředu a dozadu použijte tlačítka na levé straně panelu nástrojů
Report.

5.2 Pokud chcete urychlit procházení zprávou, měli byste nastavit zobrazení obrázků v nízkém
rozlišení (nabídka Special, položka Preferences..., karta Report a předvolba Use thumbnails
instead of full images) a jako koeficient zvětšení zvolit hodnotu Auto, která zajistí, že v okně
zprávy se zobrazí celá stránka.

5.3 Před zadáním komentáře k obrázku nastavte původní rozlišení obrázku a koeficient zvětšení.

➤ Gratulujeme! Nyní jste vytvořili první úplnou zprávu!

Tisk zprávy
1. Jestliže chcete vytisknout ukončenou zprávu, zvolte příkaz Print... v nabídce File.

➤ Dialogové okno Print je kontextově závislé. To zjednodušeně znamená, že nabízené funkce
v dialogovém okně závisí na druhu aktivního dokumentu. Před tiskem zprávy musíte toto dialogové
okno otevřít.
Tlačítko Print Directly na standardním panelu nástrojů zajistí tisk aktuální stránky zprávy. Obrázky
se vždy vytisknou ve vysokém rozlišení.

2. V dialogovém okně Print zvolte v oblasti Images položku Full image.

✔ Full image: Všechny obrázky ve zprávě se vytisknou v plném rozlišení. Pokud je to nezbytné,
program analySIS nahradí libovolný náhled aktuálním obrázkem. Tento tiskový režim je nastaven
jako výchozí.

✔ Thumbnail: Program analySIS bude tisknout náhledy. Tuto funkci můžete použít pro urychlení
zkušebních tisků.

3. Jestliže chcete vytisknout celou zprávu, zvolte v oblasti Print Range položku All. Po klepnutí na
tlačítko OK se zahájí tisk.
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Výňatek ze zprávy obsahující obrázek ZrO2 s celým
textovým objektem.

Text vlevo: Po aktivaci režimu vkládání textu je kurzor myši
umístěn uvnitř textu. Nyní můžete zadat text.

Text vpravo: V režimu rozvržení můžete pouze upravovat
textový objekt, nikoli vlastní text. Můžete změnit velikost
textového objektu přesouváním výběrových značek.
Víceřádkový text automaticky vyplní upravenou plochu
textového objektu.

Ovládání myší v režimu vkládání textu

Vkládání textu ... klepněte na libovolné místo, na které
chcete vložit text.

Výběr textu Stiskněte a přidržte levé tlačítko myši
a posunutím myši nahoru nebo dolů
zvolte text před nebo za kurzorem myši.

Obrázek ukazuje dva textové objekty (pravoúhlé oblasti
s šedým pozadím) se stejným textem:

Text vlevo: Text je vzhledem k velikosti objektu příliš
dlouhý. Dolní část textu není viditelná, protože textový
objekt je příliš malý.

Textový objekt potřebujete odpovídajícím způsobem zvětšit.

Text vpravo: Celý text se vešel do textového objektu.

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků
vytvoření nové zprávy

vložení obrázků
nastavení velikosti obrázků pro tisk
doplnění stránek/procházení zprávou
vložení textu/tisk zprávy
uložení zprávy/export

použití obrázků z databáze

Textové objekty: Do zprávy v programu
analySIS nemůžete zadat text přímo. Před
vložením textu pro něj musíte vyhradit místo.
Oblast vyhrazená pro text se definuje
textovým objektem. Formátování textu závisí
na vlastnostech textového objektu. Pokud
například použijete odlišnou velikost písma
ve zprávě, musíte nastavit samostatný
textový objekt pro každý odlišný formát
textu.

Aktivace režimu vkládání textu: Po zvolení
objektu klepnutím levým tlačítkem myši,
klepněte do objektu levým tlačítkem myši
znovu. Program analySIS aktivuje režim
vkládání textu. Text můžete zadávat pouze
v režimu vkládání textu.

POZNÁMKA: Pokud místo dvou
samostatných klepnutí myší poklepete
(bez pohybu myši), režim vkládání textu
se neaktivuje, otevře se okno pro nastavení
vlastností textu.

Ukončení režimu vkládání textu: Po zadání
požadovaného textu ukončíte režim
vkládání klepnutím levého tlačítka myši
kdekoliv mimo textový objekt.

Nyní můžete zvolit celý textový objekt jako
obvykle, tedy klepnutím levým tlačítkem
myši. Pokud chcete formátovat text,
klepněte na tlačítko Properties.

Text: V režimu vkládání textu můžete zadat
libovolný počet řádků textu. Jakmile počet
řádků přesáhne délku textového objektu,
program analySIS posune celý text směrem
nahoru. Viditelné zůstanou pouze řádky,
které vyplní textový objekt. Když ukončíte
režim vkládání textu, zobrazí se příslušný
počet úvodních řádků, počínaje prvním
řádkem. Všechny řádky, které se do
textového objektu nevejdou, zůstanou
skryté. Z tohoto důvodu nemůže být text
delší než stránka.

Skrytý text zůstane zachován, pouze
nebude zobrazen na obrazovce. Po exportu
do formátu RTF bude v programu MS Word
dostupný celý text.

Více informací o textu naleznete na
stránce 121.
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Uložení zprávy
1. Stisknutím klávesy [F8] otevřete dialogové okno Preferences a potom zvolte kartu Report.

➤ V oblasti Directories je uvedena výchozí cesta pro ukládání zpráv a šablon.
➤ Program analySIS Vám jako výchozí složku pro ukládání zpráv navrhne složku Report, která je

vnořena do kořenové složky programu analySIS.

2. Do pole Reports zadejte cestu ke složce, do které chcete ukládat následující zprávy, například
C:\Reports\ProjectXYZ.

Pokud zvolená složka pro zprávy dosud neexistuje, klepněte na tlačítko ... vedle pole Reports.
Pokud chcete vytvořit složku, klepněte na tlačítko Create New Folder v dialogovém okně Select
Directory.

3. Klepnutím na tlačítko OK potvrïte zvolenou cestu.

4. Klepněte na tlačítko Save na standardním panelu nástrojů nebo panelu nástrojů Report.

➤ Pokud ukládáte zprávu poprvé, otevře se dialogové okno Save Report Document.
➤ Program analySIS navrhne v seznamu Save in složku pro uložení zpráv C:\Reports\ProjectXYZ.

5. Zadejte do pole File name název zprávy, který odpovídá jejímu obsahu.

6. Klepnutím na tlačítko Save zprávu uložte.

➤ Program analySIS bude ukládat soubory se zprávami s příponou *.srd do zvolené složky pro
zprávy.

➤ Zpráva se neuloží do jednoho souboru. Stejně jako databáze, která se skládá z několika souborů
a složek, i zpráva je vytvořena z několika souborů a složek. Všechny soubory, které jsou součást
zprávy, se umístí do vnořené složky nazvané podle zprávy. Nejsnazší, co můžete udělat při
vytváření záložních kopií, je zkopírovat celou složku se zprávou.

Export zpráv

ÚLOHA: Chcete odeslat zprávu, například elektronickou poštou, spolupracovníkovi, který nemá přístup
k programu analySIS (nebo k použitým obrázkům). Abyste ji mohli odeslat, potřebujete jeden úplný
soubor, který obsahuje všechna data nezbytná pro zprávu.

1. V nabídce File zvolte příkaz Report > Export RTF.

2. Klepněte na tlačítko ... u pole Destination file.

3. V dialogovém okně Save RTF zvolte složku pro uložení souboru RTF. Zadejte název souboru RTF
do pole File name. Klepněte na tlačítko Save, vrátíte se do dialogového okna Export RTF.

➤ V poli Destination file bude nyní uvedena úplná cesta včetně názvu souboru RTF. Všimněte si,
že soubor RTF nebyl dosud uložen.

4. V oblasti Reduce image data určete rozlišení pro obrázky v souboru RTF a tedy i velikost souboru
RTF. Pokud plánujete odeslání zprávy elektronickou poštou, pokuste se dosáhnout co nejmenší
velikosti souboru.
Zatrhněte předvolbu Use JPEG compression.

5. Zadejte hodnotu 60 do pole quality [%]. Nastavená kvalita určuje komprimaci obrázků (malá
procentuální hodnota znamená vysoký stupeň komprimace).

➤ Komprimace JPEG zmenšuje velikost souborů s obrázky, ale zároveň na obrázku způsobuje
typické artefakty. S rostoucím stupněm komprimace klesá kvalita obrázku.

6. Klepnutím na tlačítko OK spus�te export.

➤ Výsledný soubor RTF můžete nyní například načíst do programu MS Word nebo odeslat jiné osobě
elektronickou poštou. Rozvržení zprávy zůstane v programu MS Word zcela beze změn.
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Cílový soubor Do pole Destination file zadejte požadovaný název pro
soubor RTF. Můžete zvolit název souboru bez přípony nebo
s příponou RTF. Program analySIS přijme obojí. Soubor RTF
se uloží do naposledy zvolené složky.

... Po klepnutí na tlačítko ... můžete interaktivně zvolit složku
pro uložení souboru RTF.

Uložení
obrázků jako
náhledů

Pokud chcete nahradit všechny obrázky ve zprávě za
náhledy, zatrhněte před exportem souboru RTF předvolbu
Export Thumbnails. Výchozí velikost obrázku pro náhledy
je 256 × 256 obrazových bodů. Program analySIS
přizpůsobí velikost náhledu výchozí velikosti obrázku, což
znamená, že velikost náhledu se může v závislost na
poměru délka/šířka obrázku poněkud lišit. Kromě toho jsou
náhledy uloženy zkomprimované metodou JPEG
a převedené do barevného prostoru RGB. Výsledné náhledy
jsou velké přibližně 5–10 kB.

Použití Úprava zprávy a náhledy v programu MS Word bude
rychlejší než úprava zprávy s obrázky ve vysokém rozlišení,
jednoduše proto, že sestavení jednotlivých stránek při
procházení nebo zvětšování zabere méně času. Před tiskem
můžete náhledy automaticky nahradit obrázky ve vysokém
rozlišení.
Při exportu exportujte pouze náhledy, nebo� tím významně
zkrátíte čas, který program analySIS potřebujte pro export
do souboru RTF.

Obrázky Skupina Image obsahuje položky pro zmenšení velikosti
souboru RTF. Slouží také k urychlení úprav ve Wordu. Tímto
způsobem můžete také vytvořit malý dokument, které
odešlete přes Internet.

Nastavení
rozlišení
obrázků

Zatrhněte předvolbu Set image resolution. Předvolba
optimalizuje rozlišení grafiky v souboru RTF pro Vaši
tiskárnu. Pokud chcete tisknout obrázky, můžete tak zmenšit
velikost souboru RTF, aniž by došlo ke ztrátě kvality.

[DPI] Do pole DPI zadejte požadovanou hodnotu dpi. Obrázek se
pak při exportu zkonvertuje na zvolené dpi. Můžete
kombinovat komprimaci JPEG a nastavení dpi. V mnoha
případech je vhodné exportovat obrázky v rozlišení 100 až
300 dpi. Po vytištění tyto obrázky nerozpoznáte od obrázků
vytištěných ve vysokém rozlišení.

Použití
komprimace
JPEG:

Zatrhněte předvolbu Use JPEG compression. Předvolba
zajiš�uje zkomprimování všech obrázků metodou JPEG
a jejich vložení do zpráv jako obrázků formátu JPEG.

Použití Pokud si například přejete doplnit zprávu do elektronické
pošty a přenést ji elektronickou cestou, má smysl (a je často
nezbytné) zajistit co nejmenší velikost souborů. V takovém
případě zvolte pro původní obrázky komprimaci JPEG, která
významně zmenší velikost souborů. Při komprimaci do 60 %
zůstane kvalita tiskových výstupů přijatelná.

Kvalita [%] Do pole Quality zadejte kvalitu pro obrázky, které budou
komprimovány. Velikost vytvořeného souboru s obrázkem je
nepřímo úměrná kvalitě obrázku. Při zobrazení na monitoru
nerozpoznáte rozdíly mezi souborem formátu JPEG s 85%
komprimací a původním obrázkem, dokonce ani u fotografií.
Menší odlišnosti budou patrné při 75% komprimaci. Pokles
kvality bude viditelný od 50% komprimace.

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků
vytvoření nové zprávy

vložení obrázků
nastavení velikosti obrázků pro tisk
doplnění stránek/procházení zprávou
vložení textu/tisk zprávy
uložení zprávy/export

použití obrázků z databáze

Formát RTF (Rich Text Format): Formát
RTF Vám umožňuje přenášet textové
dokumenty mezi různými aplikacemi, které
mohou být spuštěny na různých platformách.
Zprávy vytvořené v programu analySIS
můžete uložit ve formátu RTF a potom načíst
a upravit například v programu MS Word.
l Zprávy ve formátu RTF jsou

optimalizovány pro MS Word (MS Word
verze 97 nebo novější), tzn. že po načtení
do programu MS Word zůstane rozvržení
stránek zprávy zachováno.

l Zprávy ve formátu RTF již nelze
importovat zpět do programu analySIS.

l Obrázky jsou do souborů RTF vždy
vkládány jako kopie, ne jako odkazy,
a to bez ohledu na to, jak byly obrázky
do zprávy původně vloženy.

l V programu MS Word mohou být
soubory RTF pouze zobrazeny
a upravovány při nastaveném normálním
zobrazení nebo normálním zobrazení
s rozvržením. Zprávy z programu
analySIS neobsahují žádný text,
kontextově závislý na Wordu.

Další informace o exportu do souboru RTF
naleznete na stránce 60.

Komprimace JPEG je procedura, která
zajiš�uje komprimaci a efektivnější uložení
obrazových dat. Nezahrnuje pouze
efektivnější uložení dat, ale také operace,
jimiž se smažou různé doplňkové informace
o obrázcích (měřítko, zvětšení, překryvné
vrstvy, poznámky, kalibrace apod.).
S rostoucí úrovní komprimace dochází
k větším ztrátám informace. U obrázků
s vysokou úrovní komprimace může dojít
ke vzniku artefaktů – na obrázcích se objeví
rušící pravoúhlé oblasti a další artefakty.
Stupeň komprese nastavujete sami.

DPI (dots per inch – bodů na palec) je
maximální počet bodů, které tiskárna
vytiskne na délkovou jednotku. Běžná
rozlišení pro tiskárny jsou 300, 600 nebo
1200 dpi. Při tisku barevných obrázků však
tiskárna obvykle vyžaduje k vytištění
jednoho barevného bodu více než jeden
tiskový bod. To znamená, že například pro
tisk v rozlišení 600 dpi není nutná tiskárna
s rozlišením 600 dpi.
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Doplnění obrázku z databáze obrázků programu analySIS
1. Vytvořte novou zprávu na základě šablony SoftTecTemplate.

➤ První stránka šablony SoftTecTemplate obsahuje tři objekty typu záznam pro vložení obrázků
z databáze obrázků programu analySIS (viz popis šablony SoftTecTemplate na stránce 114).
Objekty typu záznam v šabloně SoftTecTemplate jsou speciálně přizpůsobeny obrázkům
z demonstrační databáze programu analySIS.

2. Otevřete databázi obrázků Demobase programu analySIS, případně jakoukoliv jinou databázi
obrázků, kterou jste si již vytvořili v programu analySIS.

3. Uspořádejte okna se zprávou a databází tak, aby byla vedle sebe, ale navzájem se nepřekrývala.

Ostatní otevřená okna můžete minimalizovat, například okno Image, a potom zvolit příkaz Tile
Vertical v nabídce Window.

4. Zvolte nastavení, které zajistí vložení obrázku do zprávy se zachováním vazby na původní soubor
s obrázkem. To má smysl, protože demonstrační databáze je vždy dostupná na pevném disku
(klávesa [F8], karta Report, zrušit zatržení předvolby Create Copies).

5. Přetáhněte náhled, například Wafer, z okna databáze metodou drag&drop na první vyšrafovaný
objekt typu obrázek v okně zprávy.

➤ Obrázek Wafer se vloží do zprávy a zobrazí v okně zprávy.
➤ Pole zvýrazněná šedou barvou jsou databázová pole. Record Name a Image Comment jsou

předdefinovaná pole, která se objeví v každé databázi obrázků programu analySIS. Databázové
pole Application bylo speciálně vytvořeno v demonstrační databázi. Obsah uvedených polí se
automaticky zahrne do zprávy.
Pokud zvolený záznam nemá v některém poli vyplněné údaje, odpovídající databázové pole
zůstane prázdné.

Doplnění několika obrázků z jedné databáze obrázků programu analySIS
6. Nyní zvolte v databázi několik náhledů. Učiníte tak, když stisknete tlačítko [Ctrl], aniž byste je uvolnili,

a klepnete levým tlačítkem myši na požadované obrázky.

7. Přetáhněte náhledy na druhý objekt typu záznam na stránce zprávy.

➤ Pokud je počet zvolených záznamů větší než počet objektů typu záznam, program analySIS
automaticky doplní nezbytný počet stránek.

➤ Obrázky se vždy doplňují v pořadí, v kterém byly zobrazeny v okně databáze. Pořadí, v jakém jste
je zvolili není důležité.
Možná chybová hlášení: Pokud přeplníte stránku obrázky, program analySIS dokáže doplnit nové
stránky pouze na konec zprávy. Jestliže přetáhnete několik obrázků na jeden objekt typu záznam,
který není na poslední stránce zprávy, můžete vyvolat chybové hlášení.
Doplnění dokumentů: Databáze obrázků programu analySIS může obsahovat záznamy, ke
kterým jsou ještě připojeny dokumenty. Tyto záznamy jsou označeny symbolem spona na papír.
Při vložení záznamu do zprávy se připojené dokumenty ignorují.

8. Nyní uložte zprávu a zavřete okno zprávy a demonstrační databázi.

Opakované otevření zprávy s objekty typu záznam
9. Otevřete znovu zprávu a nahraïte náhledy ve zprávě za obrázky ve vysokém rozlišení (klávesa [F8],

karta Report, zrušit zatržení předvolby Use thumbnails).

➤ Program analySIS zkontroluje, zda může odpovídající databázi otevřít nebo nikoli. Pokud není
databáze přístupná, obdržíte chybové hlášení a nebudete moci otevřít zprávu nebo nahradit
náhledy.
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Databáze je strukturována jako tabulka:

Databázová pole odpovídají záhlavím sloupců. Označují
strukturální a organizační kritéria databáze.

Záznam odpovídá jednomu celému řádku v tabulce.
Záznam v databázi může obsahovat jedno nebo více
volných polí (buněk). Zpravidla jsou však ve všech
databázových polích údaje vyplněny. Soubory s obrázky
jsou obvykle zahrnuty ve všech záznamech databáze
obrázků.

Údaj v poli je hodnota, umístěná v odpovídající buňce
tabulky. Je to část právě jednoho záznamu a jednoho
databázového pole.

Obrázek znázorňuje, jak vložit záznam z databáze přímo
do zprávy v programu analySIS. Stiskněte a přidržte levé
tlačítko myši a přetáhněte zvolené obrázky na první objekt
typu záznam v okně zprávy. Záznamy na uvedeném
obrázku byly zvoleny jako náhledy.

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků
vytvoření nové zprávy
použití obrázků z databáze

vložení obrázků
popis šablony SoftTecTemplate
nastavení objektů typu záznam

Databáze obrázků je určena pro
strukturované uložení všech Vašich
obrázků. Poskytne Vám rychlý a snadný
přístup k velkému počtu obrázků.

Databázová pole určují strukturu databáze.
Definují kritéria týkající se všech informací,
které si přejete uložit s obrázky. Údaje
v databázových polích poskytují
jednoznačnou charakteristiku každého
obrázku, která Vám umožní vyhledat
libovolný obrázek z databáze.

Předdefinovaná pole jsou pole předepsaná
programem analySIS®. Obsahují informace
o obrázku, které může program analySIS
automaticky načíst, například kalibraci
obrázku. Pro všechny databáze obrázků
programu analySIS se vytvoří stejná
předdefinovaná pole. Pokud použijete ve
Vaší zprávě pouze předdefinovaná pole,
nemusíte přizpůsobovat objekty typu
záznam ve zprávě databázi.

Zvolte vlastní uživatelská pole pro každý
z obrázků databáze, například User, project,
comment nebo instrument. Tato pole jsou
zpravidla pro každou databázi odlišná.
Objekty typu záznam (které se odkazují na
uživatelská pole) mohou tedy odpovídat
pouze jedné databázi obrázků.

Náhledy (získané z databáze)

Vkládáte obrázky (dialogové okno
Preferences, karta Report, předvolba
Use thumbnails) jako náhledy a to přímo
z databáze. V této situaci se použijí náhledy
z původní databáze. Můžete nastavit (jedno
z několika dostupných) rozlišení pro
náhledy, platné pro celou databázi.
To znamená, že právě při nastavování
databáze určujete rozlišení náhledů pro
zprávu.

VÝSTRAHA: Nejmenší rozlišení pro náhledy
v databázi je mnohem menší než rozlišení
náhledů v Generátoru zpráv.
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Prvky zprávy v šabloně SoftTecTemplate

Typ Funkce Poznámky

1 Grafické
prvky

O
bj

ek
ty

na
po

za
dí

Čáry, značky pro
děrování

Základní rozvržení grafických prvků pro všechny
stránky šablony zprávy.

2 Text Standardní texty, které
se vytisknou na každé
stránce zprávy

Textové objekty mohou být také otočené o 90° za
účelem přizpůsobení rozvržení stránky zprávy,
například upozornění na dodržování autorských
práv.

3 Automatický
text

Datum
Číslo aktuální stránky

Formát data závisí na nastavení Windows.

4 Textová
proměnná

Tr
va

lé
um

ís
tě

ní Kód pole pro text, který
se objeví ve všech
zprávách na stejném
místě, ovšem s odlišným
obsahem.

Hranaté závorky označují textové proměnné.

5 Objekt typu
záznam

Kód pole pro záznamy
pocházející z databáze
obrázků programu
analySIS

Objekt typu záznam je úplný záznam, který se
skládá z několika samostatných objektů. Objekty
typu záznam musí být obvykle přizpůsobeny
příslušné databázi obrázků (viz str. 116).

Prvky objektů typu záznam

Typ Funkce Poznámky

1 Objekt typu obrázek Kód pole pro obrázky
z databáze

Všechny vlastnosti objektu typu obrázek popsané
dříve jsou použitelné i pro obrázky databáze,
tzn. že do objektu typu záznam vložíte obrázky
s různými koeficienty zvětšení, buï se zachováním
vazby na původní soubor nebo jako kopie.

2 Text Standardní texty, které se
vytisknou na každé
stránce zprávy

Textové objekty jsou obvykle použity v objektech
typu záznam jako doplněk ke standardnímu
automatickému textu, například pořadové číslo
může být doplněno slovem Obrázek.

3 Grafické objekty Rámečky

4 Automatický text Postupné číslování
obrázků

Tento typ automatického textu je dostupný pouze
v objektu typu záznam.

5 Objekty typu pole Automaticky se vytiskne
jeden řádek
s databázovými poli

Objekty typu pole jsou skládané objekty, které se
obecně zahrnují alespoň název pole a údaj v poli.

Automatický tisk
databázového pole
Memo (víceřádkového)
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První stránka nové zprávy, vycházející ze šablony
SoftTecTemplate. Na této stránce jsou tři objekty typu
záznam (označené číslicí 5) propojené s demonstrační
databází programu analySIS. Podrobnější popis různých
prvků šablony stránky naleznete na předcházející stránce,

Struktura objektu typu záznam (vypadá jako tabulka na
předcházející straně): objekty pole (5) mohou být použity
pouze v objektech typu záznam. Obvykle se skládají
z názvu pole a údaje v poli. V šablonách zpráv můžete
vytvořit různě formátované šablony pro objekty pole.

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků
vytvoření nové zprávy
použití obrázků z databáze

vložení obrázků
popis šablony SoftTecTemplate
nastavení objektů typu záznam

Do objektu typu záznam můžete vložit
obrázky přímo z databáze obrázků
programu analySIS. Všechny údaje
související s obrázkem v databázi se po
vložení obrázku do databáze automaticky
zahrnou do zprávy. Jestliže chcete při
vytváření zprávy vycházet z existující
databáze obrázků a vytváření co nejvíce
automatizovat, použijte objekty typu
záznam.

Vložení obrázků z databáze:
Vytvořte novou stránku zprávy s minimálně
jedním objektem typu záznam. Zvolte
záznamy v databázi obrázků a přetáhněte
je na první objekt typu záznam. Pokud je
počet zvolených záznamů větší než počet
objektů typu záznam na aktuální stránce,
program analySIS automaticky doplní
potřebné stránky. Přidané stránky budou
vycházet ze šablony stránky, použité pro
poslední stránku nebo stránku před místem
vložení nové stránky.

Co to jsou objekty typu záznam?
Objekty typu záznam jsou úplné záznamy,
které se skládají z několika samostatných
objektů. Obvykle obsahují alespoň jeden
objekt typu obrázek a několik objektů typu
pole. Můžete však použít všechny další typy
objektů v objektu záznam: text, automatický
text, obrázky a grafické prvky. Kódy pole
pro text a více obrázků nejsou přípustné.

Vlastnosti objektu typu záznam: Pro celý
objekt typu záznam mohou být upravovány
následující vlastnosti (aniž by jej bylo nutné
rozložit na jednotlivé části): písmo, velikost
písma a barva pro všechny texty v objektu
typu záznam, poloha a velikost objektu typu
záznam, barva a tlouš�ka čar, výplňová
barva. Pokud chcete změnit vlastnosti
obrázku v databázi, přesuňte kurzor myši na
obrázek a potom otevřete dialogové okno
Properties.

Více o vytvoření objektů typu záznam
naleznete na stránce 149.
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Přizpůsobení objektů typu záznam Vaší vlastní databázi

Vaše vlastní databáze obrázků bude obsahovat pole, odlišná od těch, která jsou uváděna ve vzorech
šablon. V databázi máte vytvořena například pole Material a Order number a chcete mít informace
o materiálu uvedeny u každého obrázku. V takovém případě musíte přizpůsobit objekt typu záznam Vaší
databázi obrázků.
Přizpůsobení objektů typu záznam databázi se zpravidla provádí prostřednictvím šablony zprávy. Jedná
se o jediný dostupný způsob zpřístupnění nových objektů typu záznam, vytvořených na základě použité
šablony.

1. Zvolte příkaz Report > New... v nabídce File.

2. Zvolte položku SoftTecTemplate na kartě General. Zvolte položku Template v oblasti Create new.

3. Klepnutím na tlačítko OK potvrïte zvolené hodnoty.

➤ Program analySIS zkopíruje šablonu SoftTecTemplate a zobrazí šablonu stránky v samostatném
okně šablony zpráv. V záhlaví okna se zobrazí název nové šablony zprávy – Template1 – a název
aktivní šablony stránky – 3 image page. Šablona stránky obsahuje tři objekty typu záznam.

4. Otevřete databázi obrázků, která obsahuje pole, jež si přejete použít v budoucích standardních
zprávách.

5. Zvolte první objekt typu záznam na stránce. Musíte zvolit celý objekt, nelze pouze zvolit samostatný
prvek objektu.

6. Klepnutím na tlačítko Edit Object Template na panelu nástrojů v okně Report aktivujte režim úpravy
objektu.

➤ V režimu úpravy objektu můžete zvolit a upravit jednotlivé prvky zvoleného objektu typu záznam.
Ostatní objekty definované na stránce jsou zobrazeny pouze pro informaci a jsou vyšrafované.

7. Zvolte všechny objekty typu pole, které si přejete nahradit svými vlastními objekty (zvolte je
a stiskněte klávesu [Delete]). Odstraňte například objekty Application a Image Comment.

8. Klepnutím na tlačítko Field na panelu nástrojů Report Objects doplňte do záznamu nový objekt typu
pole.

➤ Otevře se dialogové okno Select Field, v kterém naleznete všechna databázová pole, vytvořená
v databázi obrázků programu analySIS.

9. Zvolte požadované databázové pole a jeho výběr potvrïte klepnutím na tlačítko OK.

➤ Změní se tvar kurzoru myši. Klepněte přibližně na místo, na které si přejete objekt typu pole umístit.
Polohu objektu můžete po jeho vložení dále upřesnit.

➤ Otevře se dialogové okno Select Object Template, v kterém můžete zvolit model objektu typu
pole. Jestliže šablona zprávy má pouze jedno volné místo pro objekt typu pole nebo dokonce
žádné, objekt typu pole se automaticky vloží na volné místo ve standardním formátu.

10. Zvolte položku Standard Database Field a potvrïte ji klepnutím na tlačítko OK.

11. Opakujte kroky 8–10, dokud do šablony nedoplníte všechna požadovaná databázová pole.

12. Pokud chcete uložit upravený objekt typu záznam, klepněte na tlačítko Finish Object Template na
panelu nástrojů okna Report.

13. V dialogovém okně Finish Object Template zadejte název pro upravený objekt typu záznam
a klepnutím na tlačítko Save Object Template ukončete přizpůsobení objektu databázi.

14. Nyní odstraňte ze stránky oba zbývající objekty typu záznam, které jste neupravili.

15. Zvolte příkaz Report > Save Report Template v nabídce File, šablona zprávy se uloží pod jiným
názvem.

16. Pokud chcete vytvořit zprávu na základě nově upravené šablony, zvolte příkaz Report > New...
v nabídce File. Nově vytvořená šablona zprávy bude uvedena na kartě User Templates
v dialogovém okně New Report.

17. Nyní vložte obrázek z databáze do upraveného objektu typu záznam.

➤ Obrázek i údaje z požadovaných polí se zahrnou do zprávy.
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Tlačítko Edit Object Template

Tlačítko Insert Fields

Tlačítko Finish Object Editing

1. Vytvoření standardních zpráv
použití obrázků ze správce obrázků
vytvoření nové zprávy
použití obrázků z databáze

vložení obrázků
popis šablony SoftTecTemplate
nastavení objektů typu záznam

Objekty typu pole jsou textová pole
obsahově propojená s určitým polem
v databázi. Odkazují se do určité databáze
obrázků programu analySIS (která musí být
při vytváření zprávy otevřená). Objekty typu
pole se obvykle skládají z názvu
databázového pole a vlastního údaje v poli.
Mohou však zahrnovat také všechny další
typy objektů přípustných pro vytváření
zpráv, kromě kódů polí. Objekt typu pole
můžete vložit pouze do objektu typu
záznam.

Databáze přesně neodpovídá objektům
typu pole: pokud používáte databázi,
v které jsou nadefinována jiná pole, než jaká
jsou součástí objektu typu záznam, budou
příslušná pole po vložení záznamu do
takovéhoto objektu ignorována. Nezobrazí
se chybové hlášení a obsah objektů typu
pole se nezmění.

Více informací o objektech typu pole
naleznete na stránce 153.

Šablony objektů: můžete vytvořit vlastní
šablony pro objekty typu záznam a pole.
Tyto šablony určují vzhled objektů. Šablony
objektů se ukládají pod samostatnými názvy
s aktivním dokumentem. Můžete je potom
kdykoliv vložit do zprávy. Šablony objektů
obvykle vytváříte v šabloně zprávy, takže
je můžete použít pro všechny zprávy,
vycházející z této šablony. Není však
povoleno importovat šablony objektů
z jedné šablony zprávy do druhé.

Odstranění šablon objektů

Nyní upravujete šablonu objektu, ale jakmile
ji upravíte, ihned ukončete režim úprav.
V seznamu šablon objektů (v dialogovém
okně Finish Object Editing) zvolte šablonu
objektu, kterou chcete odstranit, a klepněte
na tlačítko Delete Object Template.

Poznámka: Pokud vymažete všechny
šablony objektů ze seznamu, program
analySIS Vám po vložení nového objektu
typu záznam nabídne standardní šablonu.

Více informací o šablonách objektů
naleznete na stránce 149.
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Doplnění zvětšených výřezů obrázků (zvětšených detailů)
1. Otevřete databázi obrázků DemoBase nebo jakoukoliv jinou databázi obrázků, kterou jste vytvořili

v programu analySIS.

2. Vytvořte novou zprávu, založenou na šabloně SoftTecTemplate.

3. Doplňte do zprávy stránku podle šablony stránky 1ImagePage.

➤ Nově vložená stránka se zobrazí v okně Report. Stránka obsahuje objekt typu záznam, ve kterém
je umístěn název záznamu a rozlišení obrázku v ose X nad obrázkem. Prostor v dolní polovině
stránky je připraven pro umístění zvětšeného výřezu snímku nebo pro grafy a tabulky.

4. Nastavte vysoké rozlišení pro zobrazení obrázku na monitoru.
(klávesa [F8], karta Report, nezatržená předvolba Use thumbnails instead of full images)

5. Přetáhněte co největší obrázek, například obrázek Large Image, z demonstrační databáze na objekt
typu záznam.

➤ Obrázek Large Image je obrázek MIA, složený z několika obrázků, které byly sesazeny
dohromady. Z tohoto důvodu je obtížné pozorovat detaily při zobrazení celého obrázku.

6. Zvolte objekt typu záznam a klepněte na tlačítko Detail Zoom na panelu nástrojů Report Objects.

➤ Nyní můžete přesouvat kurzor myši pouze v objektu typu záznam. Jakmile se kurzor myši přesune
na obrázek, změní se jeho tvar.

7. Nyní zvolte pravoúhlou část obrázku.

Postup: Stiskněte a přidržte levé tlačítko myši a nakreslete přes obrázek obdélník. Jakmile má
obdélník požadovanou velikost, tlačítko myši uvolněte.

➤ Co se stane: Program analySIS zvolí označenou část obrázku a automaticky ji doplní do jiného
objektu typu obrázek. Objekt bude obsahovat zvolený detail původního obrázku.

➤ Zobrazí se pomocné čáry, které spojují rohy výřezu obrázku s rohy výběrového rámečku na
původním obrázku, čímž vizuálně vyjadřují vztah mezi výřezem a vlastním obrázkem a usnadňují
Vám orientaci.

8. Změňte velikost a polohu výřezu obrázku.

Postup: Pokud chcete změnit polohu detailního obrázku, přesuňte na něj kurzor myši. Jakmile se
tvar myši změní na čtyřstrannou šipku, můžete stisknout levé tlačítko myši, uchopit detailní obrázek
a přesunout jej na požadované místo.
Jestliže chcete upravit velikost detailního obrázku, nejprve jej zvolte. Potom stiskněte a přidržte
levé tlačítko myši a tažením některé z výběrových značek změňte velikost obrázku.

➤ Co se stane: Koeficient zvětšení detailního obrázku se změní podle velikosti objektu typu obrázek.
Zobrazena zůstane stejná část původního obrázku. Pomocné čáry, které spojují rohy detailního
obrázku a výběrového rámečku na původním obrázku, se automaticky přizpůsobí.

9. Nyní můžete změnit velikost a polohu výběrového rámečku, vymezujícího zobrazený výřez obrázku.

Postup: Zvolte červený výběrový rámeček, který ohraničuje požadovanou část obrázku. Můžete
libovolně změnit jeho polohu nebo velikost.

➤ Co se stane: Po každé změně výběrového rámečku se příslušným způsobem upraví detailní
obrázek. Poloha detailního obrázku však zůstane zachovaná.

10. Nyní zformátujte zvětšený detail.

Zvolte detailní obrázek a klepněte na tlačítko Properties na panelu nástrojů Report Objects.
Na kartě Properties naleznete všechny vlastnosti objektů typu obrázek pro zobrazení detailů.
Dostupná jsou všechna možná zvětšení a automatické označování.

Zvolte požadovanou část obrázku a klepněte na tlačítko Properties. Nyní budete moci nastavit na
kartě Line barvu, typ a tlouš�ku čar.

Zvolte některou z pomocných čar a klepněte na tlačítko Properties. Nyní budete moci nastavit na
kartě Line barvu, typ a tlouš�ku čar.
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Zvětšený detail obrázku tvoří výběrový rámeček ohraničující
požadovanou část obrázku, detailní obrázek a dvě
pomocné čáry.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS
vložení grafických objektů
úprava šablon stránek

Vložení výřezů obrázku: Zvolte objekt typu
obrázek a klepněte na toto tlačítko na panelu
nástrojů Report Objects. Do zprávy se vloží
zvětšený detail zvolené části obrázku.

Vzhled: Zvětšený detail zvolené části
obrázku je tvořen výběrovým rámečkem
(který ohraničuje požadovanou oblast na
původním obrázku), detailním obrázkem
a dvěma pomocnými čarami, které spojují
výběrový rámeček se zvětšeným detailem
obrázku.

l Vlastnosti jednotlivých prvků můžete
měnit samostatně. Zvolte, například,
pomocné čáry, u nichž chcete změnit
šířku a barvu.

l Detailní obrázek je objekt typu obrázek,
tzn. že pro něj můžete použít všechny
dostupné úpravy jako pro ostatní objekty
typu obrázek. Můžete pro něj také
zobrazit rámeček, rozlišení a měřítko.

Velikost a poloha výběrového rámečku
l Velikost a polohu výběrového rámečku,

který ohraničuje požadovanou oblast,
můžete kdykoliv změnit. Detailní obrázek
se pak příslušným způsobem automaticky
upraví, aby vždy zobrazoval aktuálně
zvolenou část původního obrázku.

l Výběrový rámeček ohraničující
požadovanou část obrázku je trvale
propojen s objektem typu obrázek. Pokud
chcete například přesunout objekt typu
obrázek, v kterém je vytvořen výběrový
rámeček, rámeček se posune společně
s objektem. Poloha detailního obrázku se
nezmění, ovšem upraví se obě pomocné
čáry. Pokud odstraníte objekt typu
obrázek, odstraní se i všechny výběrové
rámečky, vytvořené v tomto objektu.

Více výřezů obrázku
l K jednomu obrázku můžete zobrazit více

detailních obrázků.
l Detailní obrázky můžete skládat, tzn.

že můžete vytvořit detailní obrázek
z detailního obrázku. Tímto způsobem
můžete zvětšit určitou část velkého
obrázku v několika úrovních. Pokud
změníte výběrový rámeček na původním
obrázku, odpovídajícím způsobem se
automaticky změní i oba detailní obrázky.
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Vložení textových objektů

Máte v úmyslu vložit doplňkový komentář k obrázku do standardní zprávy. Vytvořte zprávu, vycházející
například ze šablony SoftTecTemplate, a vložte do ní stránku podle šablony stránky 1ImagePage. Tato
stránka obsahuje prostor pro doplňkové informace, jako je komentář k obrázku.

1. Klepněte na tlačítko Text na panelu nástrojů Report Objects, budete moci vložit nový textový objekt
do zprávy.

➤ Tvar kurzoru myši se změní na čtyřstrannou šipku.

2. Nyní vytvořte pravoúhlou oblast, do které plánujete vložit text. Text musíte vložit do textové oblasti,
jinak se nezobrazí ani nevytiskne.

Postup: Stiskněte a přidržte levé tlačítko myši a pohybem myši nakreslete pravoúhlý rámeček.
Jakmile bude mít rámeček požadovanou velikost, tlačítko myši uvolněte. Velikost a polohu
textového objektu můžete kdykoliv změnit.

➤ Nový textový objekt zůstane zvolen a zobrazí se v něm slovo Text.

3. Jestliže chcete formátovat text v textovém objektu, klepněte na tlačítko Properties na panelu nástrojů
Report Objects.

4. Na kartě Font zvolte písmo a jeho velikost, například Arial 12, případně styl Italic (kurzíva). Můžete
také rozhodnout, jakou bude mít text barvu.

5. Chcete-li si vyzkoušet zvolený formát textu ve zprávě, klepněte na tlačítko Apply.

6. Určete na kartě Text, jaký druh textu použijete:

✔ Pokud má mít komentář k obrázku více než jeden řádek, zatrhněte předvolbu Multiple Lines.
Zpřístupní se předvolba Word Break.

✔ Jestliže chcete, aby program analySIS automaticky přesouval slova mezi řádky a vyplňoval šířku
textového objektu, zatrhněte předvolbu Word Break. Jedná se o jediný způsob, jak zajistit, aby
se text automaticky přizpůsobil libovolným změnám velikosti a polohy textového objektu.

❑ Pokud chcete například zachovat seznam tvořený jednotlivými slovy, umístěnými nad sebou,
předvolbu Word Break nezatrhávejte. Jestliže pak potřebujete zarovnat celé řádky, musíte to
provést explicitně s využitím klávesy [Enter]. Formát textu nebude nyní vůbec souviset s rozměry
textového objektu.

7. Na kartě Line zvolte rámeček, který bude textový objekt ohraničovat.

➤ Zrušte zatržení předvolby Transparent a určete šířku a barvu čáry. Dostupných je mnoho druhů
tenkých čar.

8. Pokud chcete komentář k obrázku barevně zvýraznit, zpřístupněte kartu Fill a zvolte barvu pro
zvýraznění.

➤ Zrušte zatržení předvolby Transparent Fill a tlačítkem Foreground Color určete barvu pro
zvýraznění textu.

9. Klepnutím na tlačítko OK zavřete dialogové okno.

10. Klepněte dvakrát za sebou na slovo Text, aktivujete režim úpravy textu. Zadejte požadovaný
komentář k obrázku. Můžete zadat text tak dlouhý, jak si budete přát.

➤ Jakmile je řádek delší než šířka textového objektu, program analySIS přemístí kurzor na nový
řádek.

➤ Když zadáte více řádků, než kolik může být zobrazeno v textovém objektu, program analySIS
začne posouvat text po řádcích nahoru.

11. Pokud chcete ukončit režim úpravy textu, klepněte na libovolný bod vně textového objektu.

➤ Poslední vložené řádky, které se nevejdou do textového objektu, nebudou viditelné.

12. Myší určete velikost textového rámečku.
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Dialogové okno Report Object Properties – Karta Text

Kartu použijte pro přidělení jedno nebo víceřádkového textu
textovému objektu a nastavení zarovnání textu vzhledem
k textovému objektu.

Položka Popis

Text V poli Text je umístěn text propojený
s textovým objektem. Aktuální text
můžete upravit nebo nahradit.

Jednořádkový
text

Jednořádkové texty je snazší zadávat
přímo do textového pole než pro ně
používat režim vkládání textu.

Text Jednořádkový text je umístěn v poli Text.
Manuální zarovnání slov na řádcích
prostřednictvím klávesy [Enter] je
zastoupeno dvěma svislými čarami.

Multiple Lines Po zatržení předvolby budete moci
vkládat text do textového objektu.

Pokud není předvolba zatržená, budete
moci vkládat pouze jednořádkové texty.

Word Break Po zatržení předvolby se budou slova na
koncích řádků automaticky přesouvat na
další řádky, aby se řádky zarovnaly podle
šířky textového objektu.

Pokud není předvolba zatržená, můžete
řádky zarovnávat manuálně. Manuálně se
zarovnává prostřednictvím klávesy
[Enter]. Pokud jsou řádky delší než šířka
objektu, oříznou se (tzn. že nebudou
vidět).

Dostupnost Tato předvolba je přístupná po zatržení
předvolby Multiple Lines.

Horizontal
Alignment

Oblast slouží k nastavení zarovnání textu
ve vodorovném směru vzhledem
k textovému rámečku. Textový rámeček
je vymezen velikostí textového objektu.

Vertical
Alignment

Oblast slouží k nastavení zarovnání textu
ve svislém směru vzhledem k textovému
rámečku. Textový rámeček je vymezen
velikostí textového objektu.

Dostupnost Tato oblast je dostupná pouze v případě,
že není zatržena předvolba Multiple
Lines. Text jinak vždy začíná u horního
okraje textového pole.

Textový objekt na obrázku má odlišnou barvu pro text,
pozadí a rámeček.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS
vložení grafických objektů
úprava šablon stránek

Více o základní informacích o textech
naleznete na stránce 108.

Vložení textových objektů

Pokud chcete vložit textový objekt, klepněte
na toto tlačítko na panelu nástrojů Report
Objects. Nově vytvořený textový objekt
bude automaticky obsahovat slovo Text.

Ovládání myší: Klepněte levým tlačítkem
myši na místo, na kterém se má nacházet
levý horní roh textového pole. Přidržte
stisknuté levé tlačítko a pohybem myši
nakreslete rámeček. Plocha rámečku
představuje prostor vymezený pro text
zprávy. Po uvolnění tlačítka myši se textový
objekt vloží do dokumentu.

Vlastnosti textu: Jestliže chcete nastavit
vlastnosti zvoleného textového objektu,
klepněte na tlačítko Properties na panelu
nástrojů Report Objects. Můžete také zvolit
několik textových objektů a upravit všechny
jejich vlastnosti současně.

l Barva textu je vlastnost písma. Můžete ji
nastavit na kartě Font.

l Barva pozadí se nastavuje na kartě Fill.
Pozadí je celá plocha definovaná
textovým objektem.

l Vlastnosti rámečku (šířka a barva čáry)
se nastavují na kartě Line.

VÝSTRAHA: Vždy určujete vlastnosti
pro celý text v textovém objektu. Z tohoto
důvodu nelze jednotlivá slova psát tučně
nebo kurzívou. Pokud to ovšem vyžadujete,
musíte sestavit výraz složený ze
samostatných textových objektů.

Seskupení textových objektů

Zvolte skupinu několika textových objektů,
u nichž chcete současně změnit vlastnosti
písma (druh, velikost a barvu), barvu pozadí
nebo vlastnosti rámečku kolem textu.

Jestliže změníte velikost skupiny textových
objektů, změníte tedy velikost textových
objektů, nikoli aktuálního textu. Velikost
a druh písma se nezmění.

Více informací o uspořádání textu naleznete
na stránce 133.
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Vložení grafů vytvořených programem analySIS

Provedli jste analýzu fází několika obrázků a přejete si zdokumentovat výsledky v tabulce výsledků
měření.

1. Proveïte měření, jehož výsledky budou uvedeny v tabulce a znázorněny v grafu.

Demonstrační databáze obsahuje záznam PhaseAnalysis. K tomuto záznamu je připojena tabulka
a graf výsledků (fázové analýzy). Chcete-li načíst obrázek do správce obrázků a otevřít připojené
soubory, zvolte příkaz Load with documents... v nabídce Database.

2. Vytvořte novou zprávu, vycházející ze šablony zpráv MeasurementTemplate. Tato šablona zprávy je
ukázkou, jak může být strukturován protokol pro dokumentaci měření.

Popis šablony zpráv MeasurementTemplate

Prvek šablony zpráv Určení

1 Záhlaví Záhlaví obsahuje všeobecné informace, například o měřeném vzorku.

Textové objekty Všechna textová pole v záhlaví mohou být rozšířena, proto jsou označena
tečkovanými čarami.

2 Prostor pro graf Prostor vyhrazený pro graf nebo pro tabulku výsledků měření je zastoupen
příslušnými textovými objekty (bílé písmo na šedém pozadí). Nejsou zde
žádné objekty, které mohou být specificky definovány jako kódy polí pro
tabulky nebo grafy. Grafy a tabulky se vždy vkládají přímo do zprávy.

3 Prostor pro tabulku

4 Objekt typu obrázek Do zprávy můžete vložit charakteristický obrázek, který bude dokládat
výsledky měření. Za účelem úspory místa může být obrázek otočen o 90°.

5 Zvětšení Pole zvětšení je v tomto případě objekt typu záznam, který byl vzhledem
k obsahu omezen na pole, tzn. že obsahuje hodnotu zvětšení. Přetáhněte
obrázek (se správným zvětšením) z databáze do tohoto pole, zvětšení se
automaticky načte. Toto pole můžete samozřejmě nahradit textovým
objektem.

3. Aktivujte okno Report a klepněte na tlačítko Diagram na panelu nástrojů Report Objects.

➤ Pokud přesunete kurzor myši na dokument, změní se jeho tvar.

4. Klepněte ve zprávě na místo, na které si přejete vložit graf, například na bod, u nějž je zobrazeno
slovo Diagram. Jakmile se graf vloží do zprávy, můžete jeho polohu upřesnit.

➤ Program analySIS vloží do zprávy naposledy aktivovaný graf. Graf bude mít standardní velikost
80 × 60 mm a vloží se jako metasoubor Windows. Místo, které zvolíte ve zprávě, bude odpovídat
středu grafu.

5. Pokud chcete změnit polohu grafu, stiskněte a přidržte levé tlačítko myši.

6. Nyní můžete změnit velikost grafu. Stiskněte klávesu [Shift], stiskněte a přidržte levé tlačítko myši
a přetáhněte roh grafu požadovaným směrem.

Když zvětšujete nebo zmenšujete graf, pokuste se zachovat jeho proporce (poměr délky a šířky),
aby se nezdeformovalo písmo v grafu.

7. Zvolte graf a klepněte na tlačítko Properties na panelu nástrojů Report Objects. Budete moci změnit
rámeček grafu a barvu pozadí.

Písmo a jeho velikost určuje program analySIS.
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Jestliže chcete vložit graf z programu analySIS do zprávy,
klepněte na tlačítko Diagram na panelu nástrojů Report
Objects. Tuto možnost použijte například v situaci, kdy
chcete výsledky měření zobrazit ve zprávě formou grafu.

MeasurementTemplate je ukázka protokolu měření
vytvořeného použitím Generátoru zpráv. Jednotlivé prvky
šablony stránky jsou vysvětleny v tabulce na předcházející
stránce.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS

vložení grafů
vložení tabulek

vložení grafických objektů
úprava šablon stránek

Grafy: Jestliže chcete vložit do zprávy graf,
klepněte na toto tlačítko na panelu nástrojů
Report Objects. „Grafem“ může být pouze
grafika vytvořená v programu analySIS.
Některé příkazy, například Histogram,
generují grafy automaticky, jinak musíte
grafické zobrazení hodnot z tabulky
výsledků měření zvolit příkazem Diagram >
New... v nabídce Edit.

l Volba grafu: Pokud je aktuálně načteno
více grafů, zvolte požadovaný graf ještě
před vložením do zprávy.

l Označení grafů: Při zvětšování grafů
se odpovídajícím způsobem zvětšuje
i písmo. To však neplatí pro tabulky
a textové objekty.

VÝSTRAHA: Při nastavování velikosti
grafu stiskněte a přidržte klávesu [Shift].
Tím zajistíte zachování proporcí grafu
(zachování poměru délka : šířka)
a zabráníte zdeformování písma.

l Otočení: Graf nelze otáčet. Tlačítka na
panelu nástrojů Rotate zůstanou
nepřístupná.

l Pokud chcete změnit barvu pozadí grafu,
zpřístupněte kartu Fill. Nastavení
neovlivní označení grafu, zůstane tak
napsáno černým písmem na bílém
pozadí.

l Na kartě Line určete barvu a šířku
rámečku kolem grafu. Šířka os je
přednastavená a nelze ji v programu
analySIS měnit.

Formát metasoubor: WMF je zkratka pro
Windows Metafile Format. Jedná se formát
pro výměnu dat mezi aplikacemi pro
Windows.

Grafy se vkládají jsou metasoubory
Windows. Metasoubory můžete po exportu
do formátu RTF upravovat v aplikaci
MS Word. Ve Wordu můžete také například
změnit písmo a jeho velikost v grafu.
Všimněte si, prosím, že písmo a jeho
velikost můžete změnit pouhým otevřením
metasouboru v grafickém editačním režimu
programu Word.
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Vložení tabulky vytvořené programem analySIS

Načetli jste tabulku výsledků měření vytvořenou programem analySIS a zprávu vycházející ze šablony
zpráv, nazvané MeasurementTemplate.

1. Maximalizujte okno s tabulkou (klepněte na prostřední tlačítko v pravém horním rohu okna s tabulkou
– za záhlavím). Umožníte tak vložení největšího možného počtu řádků tabulky do zprávy.

2. Aktivujte okno Report. Zvolte například název zprávy umístěný v seznamu souborů na konci nabídky
Windows.

3. Klepněte na tlačítko Sheet na panelu nástrojů Report Objects.

➤ Změní se tvar kurzoru myši.

4. Klepněte ve zprávě na místo, na které si přejete vložit tabulku, například na bod, u nějž začíná slovo
Sheet. Jakmile se tabulka vloží do zprávy, můžete upřesnit její polohu.

➤ Program analySIS vloží do zprávy všechny řádky a sloupce tabulky výsledků měření, které jsou
zobrazené v okně s tabulkou. Prázdné řádky se vynechají.

➤ Vložená tabulka přepíše slovo Sheet. Toto slovo však zůstane stále na pozadí.

5. Jestliže chcete umožnit úpravu tabulky ve zprávě, klepněte na tlačítko Ungroup na panelu nástrojů
Order and Group.

➤ Postup, pokud není panel nástrojů Order and Group dostupný:
Zvolte příkaz Edit Button Bars... v nabídce Special. Pokud chcete, aby se příslušný panel nástrojů
zobrazil, zatrhněte předvolbu u názvu panelu.

➤ Tabulka, která je vložená do zprávy, se skládá ze skupiny textových objektů. Seskupení, které
zajiš�uje, že jednotlivé čáry drží pohromadě, se zruší. Nyní tedy můžete vidět výběrové značky
kolem každého samostatného textového objektu.

➤ Nyní můžete například přejmenovat tabulku nebo sloupce, doplnit komentář k jednotlivým
naměřeným hodnotám nebo zvýraznit barevně některé položky v tabulce.

6. Podle potřeby můžete tabulku upravit. Poklepejte například na záhlaví tabulky a tabulku přejmenujte.

7. Když ukončíte úpravu, zvolte všechny prvky tabulky nakreslením výběrového rámečku kolem celé
tabulky. Levé tlačítko myši musí být stisknuté.

8. Jestliže chcete sestavit samostatné objekty tabulky do jednoho objektu, klepněte na tlačítko Group
na panelu nástrojů Order and Group.

9. Chcete-li změnit polohu tabulky, stiskněte a přidržte levé tlačítko myši a tabulku přesuňte. Pokud je
to nutné, upravte velikost tabulky. Stiskněte a přidržte levé tlačítko myši a posuňte některý z okrajů
tabulky požadovaným směrem.

10. Nyní změňte velikost tabulky. Stiskněte a přidržte klávesu [Ctrl], aby tabulka zůstala na svém místě.

➤ Při nastavení velikosti tabulky se písmo ani jeho velikost nezmění. Jednotlivé hodnoty tedy budou
navzájem blíže a v krajních případech se mohou překrývat.

11. Chcete-li tabulku formátovat, klepněte na tlačítko Properties na panelu nástrojů Report Objects.

➤ Na kartě Font můžete změnit písmo, jeho velikost a barvu pro všechny řádky tabulky.
➤ Na kartě Fill zvolte barvu pozadí tabulky. Pokud je celá tabulka seskupena, budou mít všechny

buňky, včetně záhlaví, stejnou barvu.
➤ Na kartě Line můžete změnit šířku a barvu všech rámečků.
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Úplný protokol měření, vycházející z šablony
MeasurementTemplate.

Obrázek vlevo: Zvětšený detail ukazuje část tabulky pro
stránku zprávy (zobrazeno nahoře). Bylo zrušeno
seskupení, a proto mají jednotlivé buňky kolem sebe
výběrové značky.

Obrázek vpravo: Provedení změn v tabulce: Text záhlaví
byl změněn a byly zvoleny odlišné barvy písma a pozadí.
Velikost písma se změní pro všechny buňky. Některé buňky
(například buňky obsahující pozoruhodné výsledky měření)
se zvýrazní šrafováním.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS

vložení grafů
vložení tabulek

vložení grafických objektů
úprava šablon stránek

Tabulky: Jestliže chcete vložit tabulku
výsledků měření, vytvořenou v programu
analySIS, přímo do zprávy, klepněte na toto
tlačítko na panelu nástrojů Report Objects.

l Volba tabulky: Pokud je aktuálně
načteno více tabulek, zvolte
požadovanou tabulku před vložením
do zprávy.

l Volba buněk: Program analySIS vloží
do zprávy přesně ty buňky, které jsou
zobrazené v okně s tabulkou. To
znamená, že změnou velikosti okna
s tabulkou můžete odříznout některé
řádky nebo sloupce. Prázdné buňky jsou
při vkládání ignorovány. Jestliže nechcete
zobrazovat určitá data, můžete použít
funkci Autofilter, dostupnou v nabídce
Edit. Libovolný zvolený filtr bude
ovlivňovat vložení dat do zprávy.

l Šablony tabulek: Pro tabulku nemůžete
vytvořit šablony nebo kódy polí. Každá
tabulka, kterou vložíte, musí být
formátována individuálně.

l Struktura objektu tabulka: Program
analySIS převádí tabulku výsledků měření
(před vložením do zprávy) do složeného
objektu, sestaveného z mnoha
samostatných textových objektů.
Každá jednoduchá buňka tabulky je ve
skutečnosti samostatný textový objekt.
Tabulku můžete za účelem úprav zcela
rozložit na jednotlivé části.

l Úpravy tabulek: Jestliže chcete umožnit
samostatnou úpravu jednotlivých buněk,
musíte zrušit seskupení tabulky. Po
provedení úprav každou tabulku vždy
opět seskupte. S tabulkou se mnohem
snáze pracuje, pokud je seskupená.
Tabulku, která byla seskupena, můžete
například umístit jako samostatný objekt.

l Tabulky z Excelu: Nelze přímo vložit
do zprávy v programu analySIS. Nejprve
musíte exportovat zprávu do formátu RTF
(str. 111) a potom ji znovu načíst do
programu MS Word. Tabulky v MS Excel
lze vložit do MS Wordu. Totéž platí i pro
grafy vytvořené v aplikaci MS Excel.
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Kreslení grafických objektů

Následující postup ukazuje vložení symbolu dvoustranná šipka, jenž můžete použít například k označení
délky.

1. Pokud není zobrazen panel nástrojů Report Objects, zobrazte jej.

Klepněte pravým tlačítkem kdekoliv v okně zprávy, otevře se místní nabídka. Pod položkou Button
Bars jsou uvedeny všechny panely nástrojů dostupné v Generátoru zpráv. Zvolte panel nástrojů
Report Objects.

2. Pokud chcete nakreslit nový grafický objekt, klepněte na odpovídající tlačítko na panelu nástrojů
Report Objects, například na tlačítko Polygon.

➤ Kurzor myši změní v okně Report svůj tvar na kříž, čímž signalizuje, že můžete vytvořit nový objekt.

3. Nyní nakreslete hrot šipky podle obrázku u dolního okraje této stránky. Klepněte postupně na čtyři
rohy vymezující hrot šipky.

4. Kreslení grafického objektu ukončíte klepnutím pravým tlačítkem myši.

➤ Nyní ještě můžete změnit velikost a polohu mnohoúhlého objektu, resp. pravoúhelníku. Šipku
můžete buï natáhnout nebo smrštit. Rohy mnohoúhelníku však již nelze doplňovat.

➤ Po vložení zůstane objekt stále zvolen, takže jej můžete ihned upravit nebo přesunout. Například
mnohoúhelný objekt odpovídá obdélníkové oblasti, která exaktně obsahuje mnohoúhelník
(obrázek u dolního okraje stránky).

5. Chcete-li objekt formátovat, klepněte pravým tlačítkem myši a zvolte příkaz Properties...

6. Na kartě Fill určete, že objekt bude jednobarevný – černý.

➤ Zrušte zatržení předvolby Transparent Fill.
➤ Zatrhněte předvolbu Transparent Background.
➤ Klepněte na tlačítko Foreground Color a v paletě zvolte černou barvu.

7. Klepnutím na tlačítko OK zavřete dialogové okno Report Object Properties.

8. Nyní můžete změnit velikost šipky. Stiskněte a přidržte levé tlačítko myši a posuňte některou
z výběrových značek požadovaným směrem.

9. Pokud chcete vytvořit kopii šipky, stiskněte při přesouvání šipky klávesu [Ctrl].

10. Zobrazte panel nástrojů Rotate.

11. Zvolte jednu ze dvou šipek a otočte ji dvakrát opakovaným klepnutím na tlačítko Rotate 90°
Clockwise.

12. Klepněte na tlačítko Line, abyste mohli šipky navzájem spojit. Stiskněte a přidržte levé tlačítko myši
a nakreslete spojovací čáru.

13. Zvolte všechny části dvoustranné šipky a klepněte na tlačítko Group na panelu nástrojů Order and
Group. Jednotlivé části dvoustranné šipky se vzájemně seskupí.

➤ Právě jste úspěšně vytvořili dvoustrannou šipku, kterou můžete stisknutím kláves [Ctrl]+[C]
zkopírovat do schránky a stisknutím kláves [Ctrl]+[V] vložit na místo, kde ji potřebujete použít.
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Panel nástrojů Report Objects

Příkaz Popis Str.
Select
Objects

Aktivuje režim rozvržení. Objekty lze zvolit
pouze v režimu rozvržení.

105

Move Image Umožňuje přesunout obrázek v rámci
objektu typu obrázek, pokud jsou jeho
rozměry větší než rozměry objektu.

8

Properties Zobrazuje vlastnosti zvolených objektů
a umožňuje provést jejich změnu.

121
145
147

Save
Properties
As Default

Ukládá vlastnosti zvoleného objektu jako
výchozí pro následně vložené objekty.

132

Graphics
Objects

Panel nástrojů obsahuje řadu tlačítek pro
vytváření grafických objektů. Pokud chcete
vložit grafický objekt, klepněte na příslušné
tlačítko.

128

Text Vkládá textové objekty. 109
121
123

Auto Text Vkládá textové objekty, jejichž obsah se
automaticky aktualizuje, například číslo
stránky.

151

Image Vkládá objekt typu obrázek. 103
145

Detail Zoom Vkládá objekt typu obrázek, který obsahuje
zvětšenývýřez zvoleného obrázku.

119

Fit frame to
image

Přizpůsobí velikost objektu typu obrázek
vlastnímu obrázku. Tuto funkci můžete
použít pouze v případě, že obrázek je
menší než objekt typu obrázek.

104

Clear Object Odstraní obrázek z objektu typu obrázek
nebo záznam. Tuto funkci použijte zejména
při vytváření šablon – umožní Vám
zkontrolovat, jak objekt typu obrázek
vypadá po vložení konkrétního obrázku.

144

Record Vkládá složené objekty. Vzhled záznamu
se volí prostřednictvím šablony objektu –
obvykle se skládá z obrázku a objektů typu
pole, propojených s databází obrázků
programu analySIS.

115
148

Field Vkládá objekt typu pole do objektu typu
záznam. Tato funkce je dostupná pouze při
úpravě objektu typu záznam.

117
153

Sheet Vkládá buňky naposledy vložené tabulky,
vytvořené v programu analySIS, které byly
zobrazeny v tabulkovém dokumentu.

125

Diagram Vkládá graf, který byl naposledy aktivní.
Grafy se vkládají jako metasoubory
Windows.

123

Graph Vkládá objekty jako kódy pole například
pro znázornění výsledků spektrální analýzy,
provedené programem analySIS.
Znázornění výsledků spektrální analýzy
se vkládá jako metasoubor Windows.

Panel nástrojů Report Objects obsahuje tlačítka pro
všechny objekty, které lze vložit do zprávy. Tento panel
nástrojů je součástí Generátoru zpráv a zobrazí se pouze,
pokud je aktivní okno Report.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS
vložení grafických objektů

kreslení grafických objektů
umístění objektů
uspořádání textových objektů

úprava šablon stránek

Velikost a polohu objektů ve zprávě
můžete měnit zvolením absolutních
číselných hodnot v dialogovém okně pro
nastavení vlastností objektů (str. 129) nebo
přímo myší. Pro umístění objektů můžete
využít pravítka na okrajích okna se zprávou
(str. 40).

Změna velikosti objektů myší

l Zvolte objekt – stiskněte a přidržte levé
tlačítko myši a posuňte některou
z výběrových značek požadovaným
směrem. Při jednoduché změně velikosti
se poloha výběrové značky na opačné
straně nezmění.

l Pokud chcete při změně velikosti
zachovat poměr stran objektu, stiskněte
před přesunutím některého z rohů
objektu klávesu [Shift].

l Chcete-li měnit velikost objektu tak,
aby se nezměnila poloha jeho středu,
stiskněte klávesu [Ctrl].

Zrcadlení: Objekt můžete zrcadlit
prostřednictvím nástroje pro změnu
velikosti. Uchopte například pravý dolní roh
textového objektu nebo objektu obrázek
a přesuňte jej přes levý horní roh. Obrázek
nebo text se převrátí.

Změna polohy objektu myší
l Zvolte objekt. Stiskněte a přidržte levé

tlačítko myši a objekt přesuňte.
l Současně můžete zvolit a přesunout více

objektů. To znamená, že vzájemná
poloha zvolených objektů se nezmění.

l Jestliže chcete přesunout kopii objektu
a nikoli vlastní objekt, stiskněte při
přesouvání klávesu [Ctrl].

Více informací o umístění objektů naleznete
na stránce 131.
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Vkládání a úprava grafických objektů

Název Vložení Úprava

Tlačítka používaná pro vkládání grafických
objektů se nacházejí na panelu nástrojů
Report Objects (str. 127).

Před úpravou musíte objekt nejprve zvolit.

Čára Klepněte na počáteční bod
čáry. Stiskněte a přidržte levé
tlačítko myši a klepněte na
koncový bod čáry.

Klávesové
zkratky pro
vytváření
objektů:
Jestliže
chcete vložit
další bod ve
vodorovném
nebo svislém
směru ve
vztahu
k předcházejí
címu bodu,
stiskněte
a přidržte
klávesu
[Shift].

Můžete přesunout počáteční nebo
koncový bod.

Lomená čára
(Polygon)

Klepnutím myší zvolte
postupně koncové body
jednotlivých úšeček, z nichž
je čára (polygon) tvořena.

Můžete přesunout každý uzlový bod
zvláš�. Pokud chcete zobrazit výběrové
značky, stiskněte klávesu [Ctrl] a levé
tlačítko myši.

Lomená čára nemůže být
uzavřená.

Křivka Klepnutím myši zvolte řídicí
body pro Beziérovy křivky.

Můžete přesunout každý řídicí bod zvláš�
a změnit tak tvar křivky.

Každý segment křivky musí
mít čtyři řídicí body.

Mnohoúhelník Klepnutím myši zvolte rohové
body.

Můžete zmenšit nebo
zvětšit celý objekt.
Mnohoúhelník tak
zmáčknete nebo
protáhnete.

Klávesové
zkratky pro
úpravu
objektů:
Po stisknutí
klávesy [Shift]
se zachová
poměr stran
objektu, po
stisknutí
klávesy [Ctrl]
zůstane
zachována
poloha středu
objektu.

Pokud se obrysové
čáry vyplněného
mnohoúhelníku protínají,
příslušná část zůstane
nevyplněná. Mohou tak
vzniknout díry v objektech.

Při vytvoření zůstane
mnohoúhelník uzavřený.

Objekt mnohoúhelník
je v podstatě obdélník,
do kterého je vepsán
mnohoúhelník.

Uzavřená
křivka

Klepnutím levým tlačítkem
myši zvolte všechny potřebné
body křivky. Po klepnutí
pravým tlačítkem myši se
křivka automaticky uzavře.

Zvětšení a zmenšení se
provedou s celým
objektem.

Objekt uzavřená křivka
je v podstatě obdélník,
do kterého je vepsána
uzavřená křivka.

Obdélník Klepněte levým tlačítkem myši
na levý horní roh obdélníku.
Přidržte levé tlačítko myši
a zvolte požadovanou velikost
obdélníku.

Můžete měnit velikost
a polohu obdélníku.

Chcete-li nakreslit čtverec,
stiskněte a přidržte tlačítko
[Shift].

Elipsa Elipsa je obklopena
pravoúhlým rámečkem.
Stiskněte a přidržte levé
tlačítko myši a vytvořte elipsu
požadované velikosti.

Můžete měnit velikost
a polohu výběrového
rámečku kolem elipsy.

Chcete-li nakreslit kruh,
stiskněte a přidržte tlačítko
[Shift].
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Beziérovy křivky – jsou patrně nejpopulárnější
aproximační křivky používané pro malování ve dvou
rozměrech, ale i pro definici 3D objektů pomocí tzv.
šablonování. Používají se často i při definici písma.

Chcete-li vytvořit křivku znázorněnou na obrázku, zvolte
čtyři řídicí body (v uvedeném pořadí, tzn. 1 až 4). Každá část
křivky vyžaduje čtyři řídicí body. Jestliže zvolíte pouze tři
body, řídicí body pro ukončení křivky se vzájemně překryjí.
Délka a úhel tečny udávají odchýlení křivky od přímky
procházející vrcholy 1 a 4.

Obrázky zachycují použití různých barevných výplní
a výplňových vzorů pro čtverec. Barva popředí je u všech
uvedených čtverců černá.

1. Barva pozadí je šedá.

2. Čtverec má průhledné pozadí, z tohoto důvodu je vidět
obrázek za čtvercem.

3. Čtverec se skládá ze čtyř dílčích čtverců, pro každý z nich
je použit odlišný výplňový vzor. Barva pozadí je bílá.
Pokud není zvolen výplňový vzor, barva popředí se
použije jako výplňová barva.

Obrázek znázorňuje použití grafického objektu k popisu
obrázku.

Graf průběhu intenzity je součástí obrázku jako překryvný
objekt. Body grafu průběhu intenzity, použité pro měření
vzdálenosti, jsou ve zprávě zvýrazněny kroužky. Naměřená
vzdálenost nebyla před vložením do aktuální zprávy
označená.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS
vložení grafických objektů

kreslení grafických objektů
umístění objektů
uspořádání textových objektů

úprava šablon stránek

Vlastnosti grafických objektů

Na kartě Line zvolíte šířku a barvu čáry
grafických objektů. Pokud jde o uzavřené
objekty, například mnohoúhelníky,
představuje čára jejich obrys.

Některé druhy čar, jako jsou tečkované
nebo čárkované, jsou dostupné pouze pro
nejmenší tlouš�ky.

Karta Fill je dostupná pouze pro uzavřené
objekty (mnohoúhelníky, obdélníky,
uzavřené křivky nebo elipsy). Můžete na ní
nastavit barvu výplně, a pokud potřebujete,
i výplňový vzor.

VÝSTRAHA: Nepoužívejte průhledné
pozadí, pokud plánujete exportovat zprávu
do souboru formátu RTF, aby ji bylo možné
později vytisknout v programu MS Word.

Na kartě Position and Size můžete
absolutními číselnými hodnotami zadat
polohu a velikost jednoho nebo více
zvolených objektů. Pole pro zadání těchto
hodnot jsou ve zprávě dostupná pouze
v případě, že objekt nebyl v šabloně
definován jako „fixed“. Polohu objektů
na pozadí můžete měnit pouze v šabloně
stránky.

l Jednotky: Jednotky použité pro určení
polohy a velikosti jsou určeny vlastnostmi
zprávy. Dostupné jsou následující
jednotky: cm, palce, mm a body.

l Kotvení: Polohu můžete udávat buï ve
vztahu k celé stránce, tzn. že se odkazuje
na aktuální roh stránky, nebo ve vztahu
k okrajům stránky. Okraje stránky se volí
jako vlastnost zprávy (str. 30). Pokud
později změníte okraj stránky, současně
se automaticky přesunou všechny
objekty, jejichž poloha je k okrajům
vztažena.
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Umístění objektů

Orientace souřadnicové sítě
1. Klepněte kdekoliv na pozadí zprávy.

➤ Nyní nejsou zvoleny žádné objekty.

2. Klepněte pravým tlačítkem myši a v místní nabídce zvolte položku Properties... Zrušte zatržení
předvolby Snap to grid, abyste mohli myší zvolit libovolnou polohu všech objektů podle svých
představ.

V dialogovém okně Report Properties zvolte v oblastech Border a Format formát stránky po
aktuální zprávu. Kromě toho v oblastech Grid a Ruler určete vlastnosti grafického uživatelského
rozhraní (GUI).

✔ Snap to Grid: Předvolbu zatrhněte, jestliže chcete, aby se kurzor myši při vytváření nebo úpravě
objektů automaticky přesunul z aktuální polohy na nejbližší průsečík souřadnicové sítě.
Existující objekty bude stále možné přesunout do libovolného požadovaného bodu, nezávisle
na poloze průsečíků souřadnicové sítě, například použitím tlačítek na panelu nástrojů Position.

3. Klepnutím na tlačítko OK zavřete dialogové okno Report Properties.

4. Vytvořte několik objektů, které si budete přát umístit. Jako model můžete například použít obrázek
na následující stránce. Vlastnosti objektů jsou uvedeny v tabulce na následující stránce.

Vyrovnání objektů podle jiného objektu
5. Umístěte objekt ve zprávě do požadované polohy. Tento objekt bude použit jako referenční pro

umístění dalších objektů.

6. Nyní zvolte první objekt, který si přejete vyrovnat s jiným objektem.

➤ Kolem zvoleného objektu se zobrazí šedé výběrové značky.

7. Stiskněte klávesu [Shift] a zvolte objekt, podle kterého se již zvolený objekt vyrovná.

➤ Kolem obou objektů se zobrazí výběrové značky. Kolem naposledy zvoleného objektu budou šedé
výběrové značky, kolem ostatních zvolených objektů bílé.

➤ Podle příslušného objektu můžete současně vyrovnat několik objektů, například obdélníky 1 a 2.
Nejprve zvolte oba obdélníky a potom vztažný objekt.

8. Prvním tlačítkem na panelu nástrojů Align vyrovnejte všechny objekty, kolem kterých jsou bílé
výběrové značky, podle objektu obklopeného šedými výběrovými značkami. Klepněte například na
tlačítko Center Horizontal, zvolené objekty se posunou doleva nebo doprava tak, aby středy všech
objektů byly vyrovnané, tzn. měly stejnou souřadnici ve vodorovném směru.

➤ Objekty se mohou posunout pouze k okraji stránky, nikoli dále.

Uspořádání překrývajících se objektů
9. Zvolte například kruhový objekt, který přesunete do popředí.

10. Klepněte na tlačítko Bring Forward na panelu nástrojů Order and Group, objekt se umístí před
obdélníky. Jestliže příslušný objekt překrývají ještě další objekty, musíte na tlačítko klepnout vícekrát.

➤ Pokud chcete umístit zvolený objekt nad všechny ostatní objekty, klepněte na tlačítko Bring to
Front. Šrafování objektu způsobí, že všechny čáry, které se objeví v jeho ploše, budou tečkované.

Přesné umístění objektů
11. Zvolte objekty, které si přejete umístit, například čáru (5) na ukázkovém obrázku.

12. Každým stisknutím příslušného kurzorového tlačítka na panelu nástrojů Position posuňte objekt ve
směru šipky na tlačítku o 0,1 mm.
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Obrázek vlevo: Obrázek se skládá z 13 samostatných
objektů. Vlastnosti použitých objektů jsou shrnuty v tabulce
ve spodní polovině stránky.

Obrázek vpravo: Obrázek znázorňuje vyrovnání dvou
obdélníků s kruhovým objektem. Na obrázku 2 jsou
všechny objekty vyrovnány na střed ve vodorovném směru.
Poloha objektů v ose Y se nezměnila. Na obrázku 3
je kruhový objekt, jenž byl na pozadí, přesunut před
obdélníky. Proto je viditelný výplňový vzor kruhového
objektu.

Vlastnosti objektů na předcházejícím obrázku

Druh Vlastnosti
Filtr Čára
Výplňový
vzor

Barva
pozadí

Barva
popředí

1 Obdélník Podle přání Černá 1 bod

2 Obdélník Žádný Podle přání Šedá Průhledná

3 Kruh Průhledná Bílá 1 bod

4 Čára 2 body

5 Čáry 1 bod

6 Texty Průhledná výplň Průhledná

7 Text Žádný Průhledná Průhledná

K současnému posunutí všech zvolených objekt
požadovaným směrem po 0,1 mm použijte tlačítka na
panelu nástrojů Position.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS
vložení grafických objektů

kreslení grafických objektů
umístění objektů
uspořádání textových objektů

úprava šablon stránek

Více k umístění objektů myší naleznete na
stránce 127.

Přibližné umístění objektů: Pro nastavení
výchozího a přibližného umístění objektů
použijte myš. Zvolte jeden nebo více
objektů. Objekty můžete uchopit stisknutím
a přidržením levého tlačítka myši a potom je
přesunout na požadované místo. Chcete-li
objekty umístit rychleji, použijte vyrovnání
podle souřadnicové sítě.

Jemné doladění polohy: Zvolte jeden nebo
více objektů a:

l K posunutí objektů požadovaným
směrem použijte kurzorové klávesy
(na klávesnici). Pokud chcete zvětšit
vzdálenost, o kterou se objekt každým
stisknutím kurzorové klávesy posune
z 0,1 do 0,5 mm, stiskněte klávesu [Shift].

l K posunutí objektů požadovaným
směrem použijte tlačítka na panelu
nástrojů Position. Každé klepnutí
odpovídá vzdálenosti 0,1 mm.

l Pokud chcete zadat přesnou polohu
absolutní číselnou hodnotou, použijte
kartu Position and Size (str. 129).

Překrývající se objekty: Objekty, které
se vzájemně překrývají, můžete přesunout
o úroveň výš nebo zcela do popředí.
Objekty, které jste vložili jako poslední
budou obvykle v popředí. Pořadí objektů
však můžete později změnit. Jednotlivé
objekty mohou být postupně nebo přímo
posunuty na pozadí.
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Uspořádání textových objektů

Textová pole se ve zprávách používají také jako pole formuláře, která je nutné vyplnit. Při rozvržení
stránky jsou pak velkým pomocníkem tlačítka na panelu nástrojů Align.

1. Vytvořte první textové pole a vložte do něj požadovaný text. Jako základní model můžete například
využít formulář (uvedený na následující stránce), který obsahuje výsledky měření tlouš�ky vrstvy.

2. Nyní zformátujte textový objekt. Zvolte textový objekt a klepněte na tlačítko Properties na panelu
nástrojů Report Objects.

Pokud chcete mít text orámovaný, zrušte zatržení předvolby Transparent na kartě Line.

➤ Textový rámeček pak bude přesně odpovídat velikosti textového objektu. Vyrovnání samotného
textu s textovým objektem může být různé.

3. Zvolte textový objekt a klepněte na tlačítko Save Properties as Default na panelu nástrojů Report
Objects. Vlastnosti nastavené pro aktuální textový objekt se uloží a automaticky použijí i pro následně
vytvářené textové objekty.

Save Properties as Default: Funkce je určena zvláště pro textové objekty a automatický text.
Standardní rozvržení grafických objektů je určeno programem analySIS a uživatel je nemůže
změnit.
Standardní vlastnosti textového objektu jsou určeny globálně, tzn. že jejich nastavení se projeví
u všech zpráv, které vytvoříte později, i když budou vycházet z jiné šablony.

4. Nyní vložte všechny textové objekty, které byly formátovány stejně jako první textový objekt.

➤ Vytvořené textové objekty mají shodné všechny vlastnosti, které můžete nastavit pro textové
objekty. Všimněte si také, že všechny texty jsou v textových objektech shodně vyrovnané.

5. Přesuňte kurzor myši tak, aby měl textový objekt, umístěný nejblíže hornímu okraji stránky,
požadovanou velikost. Tento objekt bude v následujících krocích použit jako referenční.

6. Posunujte objekt nejvíce vzdálený od objektu umístěného co nejblíže hornímu okraji, dokud mezi nimi
nebude správná vzdálenost.

7. Zvolte všechny objekty, které chcete přemístit. Naposledy zvolte referenční objekt.

8. K uspořádání textových objektů využijte tlačítka na panelu nástrojů Align.

Jestliže chcete sjednotit velikost všech objektů, klepněte na tlačítko Make Same Size.

Pokud chcete všechny objekty vyrovnat podle levého okraje, klepněte na tlačítko Align Left.
Všechny objekty, označené bílými výběrovými rámečky, budou stejně vzdálené od levého okraje
stránky jako zvolený referenční objekt, obklopený šedými výběrovými značkami.

Chcete-li všechny zvolené objekty rovnoměrně rozmístit mezi nejvýše a nejníže umístěné zvolené
textové objekty, klepněte na tlačítko Space Vertical.

9. Všechna provedená vyrovnání můžete po jednom zrušit. Použijte tlačítko Undo na panelu nástrojů
dialogového okna Report.

Tlačítko Undo: Většinu příkazů Generátoru zpráv můžete zrušit, dokud se nacházíte na stejné
stránce zprávy. Jakmile začnete zprávu procházet nebo doplníte novou stránku, zpráva se
automaticky uloží. Můžete samozřejmě pokračovat v úpravě existující stránky. Uvědomte si,
prosím, že následující operace nelze zrušit:

Všechny operace provedené metodou drag&drop, například vložení obrázku nebo zprávy,
nastavení nového výchozího písma prostřednictvím tlačítka Save Properties as Default a změny
textových proměnných. Pokud změníte obsah textové proměnné, změní se všechny odpovídající
textové proměnné v celé zprávě. Aktualizaci všech textových proměnných nelze rovněž zrušit.

Tlačítko Redo: Tlačítko použijte, pokud chcete znovu provést příkaz, který jste zrušili operací
Undo.
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Výsledky měření tlouš�ky vrstvy jsou uvedeny vedle obrázku
brusné kuličky. Požadováno je šest samostatných objektů.

Panel nástrojů Align

Co
vyrovnáte?

Tlačítka na panelu nástrojů jsou dostupná
pouze v případě, že jste zvolili několik
objektů.

Co to je
referenční
objekt?

Při vyrovnávání objektů je rozhodující
poloha referenčního objektu. Referenční
objekt je objekt, který jste zvolili naposledy.
Snadno jej poznáte podle šedých
výběrových značek (ostatní zvolené objekty
mají bílé výběrové značky). Provedením
operace se nezmění poloha ani velikost
referenčního objektu.

Lze vyrovnat
seskupené
objekty?

První tlačítka na panelu nástrojů můžete
použít také pro seskupené objekty. Se
seskupenými objekty se při vyrovnávání
pracuje stejně jako s jednoduchými
objekty. Můžete tak přesunout objekty
složené z více objektů (například tabulky),
jako kdyby se jednalo o jednoduchý objekt.

Poslední tlačítka na panelu nástrojů nejsou
dostupná, pokud je některý ze zvolených
objektů seskupený. Objekty typu záznam
a tabulky jsou zpravidla seskupené.
Předpokládají se pouze seskupené
grafické objekty.

Co se stane
u okrajů
stránky?

Objekty nemohou být vyrovnány za okraj
stránky. Pokud je referenční objekt umístěn
tak, že další objekty by se měly přesunout
za okraj tiskové plochy, tyto objekty se
posunou až k okraji stránky, nikoli za něj.

Mění se při
vyrovnávání
vzájemné
uspořádání
objektů?

Volba objektů pro provedení operace
vyrovnání neovlivní jejich vzájemné
uspořádání. Pořadí objektů odpovídá
pořadí, v jakém byly do zprávy vloženy.
Objekt, který byl vložen naposledy, bude
automaticky vložen na popředí. Objekt
vložený jako první bude na pozadí. Pokud
chcete provést libovolnou změnu pořadí
objektů, použijte tlačítko Order and Group.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS
vložení grafických objektů

kreslení grafických objektů
umístění objektů
uspořádání textových objektů

úprava šablon stránek

Usnadnění umístění objektů

l Po zvolení objektu se ve stavovém řádku
zobrazí přesná velikost a poloha.

l Jestliže měníte umístění nebo velikost
objektu, budou v okně Report zobrazeny
jeho rozměry a aktuální poloha ve vztahu
k pravítkům.

l Pravítka: Pokud potřebujete usnadnit
volbu umístění v okně Report, zobrazte
si vodorovné a svislé pravítko.

l Zobrazení pravítek: V dialogovém okně
Report Properties můžete pravítka
zobrazit nebo skrýt. Toto dialogové okno
otevřete klepnutím pravým tlačítkem po
zvolení pozadí zprávy, tzn. že nesmí být
zvolen žádný objekt.

l Jednotky pro zobrazení pravítek jsou
určeny vlastnostmi zprávy. Dostupné jsou
následující jednotky: cm, palce, mm
a body.

l Použití pravítek pro zjednodušení
umístění: Pokud měníte polohu nebo
velikosti objektů, jejich rozměry nebo
aktuální souřadnice se zobrazí podle
pravítek v okně Report.

Uspořádání textů: Pokud si přejete
vyrovnat textové objekty použitím funkce
Align na panelu nástrojů, měly by být
všechny textové objekty vyrovnány ve
svislém směru. Důvodem je skutečnost,
že všechny funkce jsou určeny pro textové
objekty, nikoli pro vlastní texty. Pokud
chcete zarovnat text v textovém poli,
zpřístupněte kartu Text s vlastnostmi textu.

Více informací o vlastnostech textu naleznete
na stránce 121.
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Úprava šablony stránky ve zprávě

V záhlaví šablon stránek SISTemplate se objeví jméno autora. Přejete si doplnit konkrétní jméno autora
pro jednotlivou zprávu.

1. Vytvořte novou zprávu vycházející ze šablony SISTemplate a vložte do ní libovolný obrázek podle
vlastního výběru.

2. Stisknutím klávesy [F8] otevřete dialogové okno Preferences a zpřístupněte kartu Report.

3. Zatržením předvolby Enable page template editing zpřístupněte tlačítka pro úpravu šablon stránek
ve zprávě.

➤ Panel nástrojů Report bude nyní obsahovat doplňková tlačítka: New Page Template, Edit Page
Template a Save Page Template.

4. Pokud chcete provést změny v šablonách stránky, klepněte na tlačítko Edit Page Template na
panelu nástrojů Report.

Pokud jste dosud neuložili aktuální stránku zprávy, zobrazí se hlášení. Nyní stránku uložte, abyste
zálohovali obrázky a texty, které jste již na stránku vložili. Pokud stránku neuložíte, ztratíte všechny
vložené obrázky a texty.

➤ V dialogovém okně Select Page Template jsou v seznamu uvedeny všechny šablony stránek,
které jsou součástí šablony zprávy. Musíte změnit záhlaví každé šablony stránky.

5. Zvolte v dialogovém okně Select Page Template například položku 2ImagePage a potvrïte ji
stisknutím tlačítka OK.

➤ Program analySIS nyní načte zvolenou šablonu stránky do okna zprávy. Šedé pozadí a text Edit
page ve stavovém řádku signalizují, že nyní upravujete šablonu stránky, nikoli stránku vlastní
zprávy.

6. Zvolte nejprve textový objekt, jenž obsahuje jméno autora. Potom na textový objekt klepněte znovu,
abyste se přepnuli do režimu pro úpravu textů.

7. Změňte text záhlaví podle svých požadavků. Můžete doplnit jiné jméno autora:
například Dr. J. Cleaver.

8. Klepnutím na tlačítko Save Page Template na panelu nástrojů Report uložte provedené změny. Nyní
můžete do šablony doplnit novou stránku nebo změnit stávající.

➤ V okně zprávy se zobrazí naposledy zobrazená stránka zprávy. Záhlaví nebude zatím změněno.
➤ Libovolným stránkám, které již byly vloženy, se pouze automaticky nastaví pozadí. Pokud například

doplníte čáru nebo rámeček jako objekt na pozadí stránky zprávy, zobrazí se na všech stránkách,
které vycházejí z upravené šablony stránky.

9. Opakujte uvedené kroky (počínaje krokem 4) pro všechny šablony stránek, které obsahují záhlaví
a zápatí, jež si přejete změnit.

10. Pokud chcete doplnit novou stránku zprávy s upraveným formátem, klepněte na tlačítko Add Page
na panelu nástrojů Report.

11. Nyní procházejte stránkami nazpět a odstraňte stránku se starým záhlavím.

12. Doplňte na obrázky a texty.

13. Klepnutím na tlačítko Save na standardním panelu nástrojů uložte zprávu.

➤ Upravili jste šablony stránek speciálně po tuto zprávu. Pokud vytvoříte novou zprávu na základě
nezměněné šablony SISTemplate, v hlavičce nebude uvedeno jméno autora Dr. J. Cleaver.

➤ Zprávu, kterou jste právě upravili, můžete samozřejmě použít jako základ pro vytvoření nové
zprávy. Jediné, co potřebujete udělat, je načíst zprávu, přepsat všechny obrázky a texty a uložit
zprávu pod jiným názvem.

➤ Pokud si přejete vytvořit několik zpráv, které používají stejně upravené šablony stránek, je rychlejší
vytvořit novou šablonu.
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Šablona určuje rozvržení stránky...

... a zpráva obsahuje text a obrázky.

Všechny zprávy vycházejí ze šablony zprávy, která
stanovuje rozvržení stránky.

Přehled stránek v šabloně SISTemplate

Šablona stránky Funkce

1 Basis Layout Stránka, která definuje základní
rozvržení stránky.

2 FirstPage Obálka, která obsahuje dvě textová
pole pro dlouhé texty.

3 MIAPage Stránka pro velké obrázky
a prostorem pro zvětšené detaily
obrázku.

4 1ImagePage Stránka, která zahrnuje objekt typu
obrázek a prostor pro graf nebo
tabulky.

5 2ImagePage Stránka, která zahrnuje dva objekty
typu obrázek.

6 Overview Stránka se šesti objekty typu
záznam; tato stránka může být
použita pouze ve spojení s obrázky
z databáze.

Reference Page Stránka zahrnující objekty komplexní
povahy určené pro kopírování.

2. Vytvoření zvláštních zpráv
vložení zvětšených výřezů obrázků
vložení textů
vložení dokumentů analySIS
vložení grafických objektů
úprava šablon stránek

Úprava šablon stránek ve zprávě: Když
upravíte šablony stránek ve zprávě, budou
tyto změny dostupné pouze pro specifickou
zprávu. Všechny další zprávy, které vytvoříte
na základě stejné šablony zpráv, vycházejí
z neupravené šablony zprávy.

Které šablony stránek lze měnit ve
zprávě? Zpráva vždy obsahuje všechny
šablony stránek, definované v šabloně
zprávy. Všechny tyto šablony zpráv budou
dostupné k úpravě přímo ve zprávě.
Obecně platí, že budou přístupné i šablony
stránek, které nebyly použity ve zprávě.

Co se stane s existujícími stránkami
zprávy? Pokud změníte šablonu stránky
ve zprávě, která má již několik stránek,
všechny objekty na pozadí existujících
stránek se aktualizují. Kódy polí – jako jsou
upravitelný textový objekt a objekt obrázek –
se nezmění. Pokud chcete zajistit, aby
zpráva měla jednotný vzhled, musíte smazat
staré stránky a následně vložit nové.

Kdy upravovat šablony ve zprávě? Změny
v šabloně ve zprávě proveïte pouze
v případě, že chcete provést specifické
úpravy pouze ve zvolené zprávě, jestliže
například do jednoduché zprávy musíte
vložit další pole do seznamu autorů.

Kdy upravovat šablony v šabloně zprávy?
Pokud je na upravené šabloně stránky
založeno několik zpráv, budete potřebovat
buï vytvořit novou šablonu zprávy nebo
upravit existující. Například úprava objektů
typu záznam tak, aby vyhovovaly Vaší
vlastní databází, se obvykle provádí
v šabloně zprávy. Pouze po provedení
uvedených kroků budou všechny nově
definované objekty typu záznam přístupné
pro všechny zprávy vycházející z této
šablony (str. 140).
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Vytváření standardních složek pro zprávy a šablony
1. Zvolte příkaz Preferences... v nabídce Special. Dialogové okno Preferences můžete také otevřít

stisknutím klávesy [F8].

2. Na kartě Report určete předvolby, které chcete použít při vytváření zprávy.

3. V oblasti Directories zvolte standardní složky pro ukládání a načítání zpráv a šablon zpráv.

3.1 Zadejte do pole Reports úplnou cestu pro uložení zpráv. Aktuální složku pro zprávy můžete
kdykoliv změnit. Můžete také pouze klepnout na tlačítko ... a zvolit cestu interaktivně.

Proč měnit složky pro zprávy?
Používejte složky pro zprávy tak, abyste mohli pohodlněji pravidelně ukládat Vaše zprávy
a měli je uložené na jednom místě, kde je znovu snadno naleznete. Můžete například každý
měsíc vytvořit novou složku pro zprávy a jednoduše ji pojmenovat podle názvu měsíce.
Uložte si záložní kopii této složky, abyste měli zabezpečené všechny zprávy z příslušného
měsíce.

3.2 Zadejte do pole User templates cestu uložení Vašich uživatelských šablon.

Při vytváření nové zprávy budou na kartě User Templates v dialogovém okně New Report
nabízeny pouze šablony, které jsou uloženy v této složce pro šablony.

3.3 Zadejte do pole Workgroup templates cestu pro uložení všech šablon, které mohou používat
ostatní uživatelé pro vytváření svých zpráv.

Při vytváření nové zprávy budou na kartě Workgroup Templates v dialogovém okně New
Report nabízeny pouze šablony, které jsou uloženy v této složce pro šablony.

Jak jsou standardní složky ovlivňovány

Složka pro šablony pro pracovní skupinu

Složka pro uživatelské šablony

Složka pro zprávy

Uložit Při prvním ukládání nové zprávy nebo nové šablony zprávy bude
v dialogovém okně Report Document nabídnuta aktuální složka pro
zprávy. Pro uložení aktivního dokumentu také můžete v dialogovém
okně Save Report Document zvolit odlišnou cestu.

X

Otevřít Pokud si přejete upravit existující zprávy nebo šablony zpráv, použijte
příkaz Report > Open... v nabídce File. Na kartě Report se zobrazí
pouze ty zprávy, které jsou uloženy v aktuální složce pro zprávy. Na
kartě User Templates naleznete pouze šablony, které byly uloženy do
aktuální složky pro uživatelské šablony.
Samozřejmě můžete také kdykoliv načíst zprávy, které jsou uložené
v jiné než právě aktivní složce. Pokud chcete vyhledat zprávu, klepněte
na tlačítko Browse..., otevře se standardní dialogové okno pro načítání
dokumentů.

X X

Vytvoření nové
zprávy

Při vytváření nové zprávy příkazem Report > New... z nabídky File
budou nabídnuty pouze šablony zpráv, které jsou uloženy v aktuální
složce pro uživatelské šablony nebo ve složce pro šablony pro pracovní
skupinu. Nemůžete vytvořit novou zprávu na základě šablony, která není
uložena v jedné z aktivních složek pro šablony.

X X
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Každá zpráva nebo šablona zprávy se skládá z několika
souborů, které jsou uloženy v definované struktuře složek
v aktuální složce pro zprávu.

Vysvětlení k zobrazené ukázce: Složka Report je aktuální
složka pro zprávy a současně i pro uživatelské šablony.
Do složky byla uložena zpráva nazvaná Report a šablona
zprávy ReportTemplate. Složka Report_srd_files, která
běžně obsahuje 4 vnořené složky, je součástí zprávy.

Program analySIS vytvoří tuto strukturu složek automaticky
při ukládání zprávy nebo šablony zpráv.

Soubory,
složky

Určení Str.

*.srd, *.srt Soubory s příponami SRD a SRT jsou
hlavními soubory zpráv (SRD) nebo šablon
zpráv (SRT) a slouží jako základní
organizační soubory. Soubory SRD a SRT
se ukládají přímo do složky pro zprávu nebo
šablonu zpráv.

global.bin Soubor global.bin obsahuje sadu
všeobecných nastavení grafického
uživatelského rozhraní, které se ukládá
společně se zprávou, resp. šablonou.Jedná
se o nastavení, která nemůžete nastavit
globálně, tedy pro všechny zprávy, tzn. že
se mohou pro jednotlivé zprávy lišit,
například nastavení, která souvisejí se
souřadnicovou sítí nebo vkládáním obrázků
(jako kopie nebo pouze formou odkazu na
původní soubor).

CompTpts Název složky CompTpts odpovídá
Component Templates (šablony
komponentů). Do této složky se ukládají
všechny šablony objektů, které byly
vytvořeny pro zprávu nebo šablonu zprávy.
Zpráva obsahuje šablony objektů pro
šablonu zprávy i šablony objektů vytvořené
přímo ve zprávě.

148

Images Složka Images obsahuje všechny obrázky,
které byly vloženy do zprávy nebo šablony
jako kopie.

103

Pages Složka Pages obsahuje různé stránky
zprávy, resp. šablony zpráv. Stránky se
ukládají do samostatných souborů, aby byla
zajištěna ochrana dat. Stránka zprávy se
vždy uloží automaticky, například když ji
opustíte za účelem vytvoření nebo úpravy
jiné stránky. Objekty na pozadí stránky se
ukládají samostatně. Pokud je více stránek
založeno na stejné šabloně, objekty na
pozadí se uloží pouze jednou.

Thumbnails Složka Thumbnails obsahuje náhledy všech
obrázků zprávy nebo šablony zpráv.
Náhledy nahrazují obrázky ve vysokém
rozlišení po zatržení předvolby Use
thumbnails instead of full images.

103

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon
vytvoření nových šablon objektů
návrh šablon

Složky pro zprávy/šablony zpráv:
Standardní složky pro zprávy a šablony
zpráv se nastavují na kartě Report
v dialogovém okně Preferences, které
otevřete stisknutím klávesy [F8].

Složka pro zprávy zahrnuje všechny
soubory a vnořené složky, patřící uložené
zprávě. Soubor zprávy s příponou *.srd se
uloží přímo do složky pro zprávu. Kromě
toho program analySIS vytvoří vnořenou
složku, pojmenovanou podle zprávy, která
zahrnuje všechny vnořené složky patřící
zprávě.

Uživatelské šablony jsou šablony, které
si každý uživatel může vytvořit pro sebe.
Složka pro uživatelské šablony je obvykle
umístěna na lokálním disku. Obsahuje
všechny soubory a složky patřící uloženým
šablonám zpráv.

Šablony pro pracovní skupiny: Složka se
šablonami pro pracovní skupinu je obvykle
umístěna na sí�ovém disku, přístupném
všem uživatelům. Šablony pro pracovní
skupiny by měly být chráněny proti přepsání
a možnost upravovat je by měly mít pouze
autorizované osoby.
Pokud chcete chránit šablonu zprávy proti
přepsání, zvolte odpovídající soubor
s příponou *.srt v aplikaci Windows
Průzkumník (Explorer). Klepněte pravým
tlačítkem myši na soubor a v místní nabídce
zvolte položku Properties. Zatrhněte
předvolbu Jen pro čtení v oblasti Atributy.

Struktura souborů: Zpráva nebo šablona
zprávy se neukládají jako jeden soubor.
Podobně jako u databáze zahrnují několik
souborů a složek. Pokud budete upravovat
zprávu v programu analySIS, nebude pro
Vás struktura souborů podstatná. Jestliže
si však přejete vytvořit záložní kopii nebo
doručit zprávu dalším osobám, potřebujete
věnovat pozornost struktuře souborů.
Pokud jsou všechny soubory
s komponentami a složky dostupné, stačí
pouze otevřít zprávu nebo šablonu zprávy.

POZNÁMKA: Pokud si přejete poslat zprávu
jako jeden kompletní soubor, proveïte
export do souboru formátu RTF.

Více informací o exportu do souboru RTF
naleznete na stránce 111.
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Vytvoření nové šablony zprávy

Novou šablonu zprávy můžete vytvořit pouze na základě už existující šablony zprávy. Pokud dosud
nemáte vytvořenou žádnou vlastní šablonu zprávy, zpřístupněte kartu General, na které naleznete
předdefinované šablony zpráv, které se doplní při instalaci programu analySIS a které můžete upravovat
pro vlastní účely.

1. Zvolte příkaz Report > New... v nabídce File.

➤ Dialogové okno New Report Vám nabídne všechny šablony zpráv, které jsou umístěny
v aktuálních složkách pro zprávy, uživatelské šablony a šablony pro pracovní skupiny.

2. Zvolte v dialogovém okně New Report šablonu zprávy, na jejímž základě chcete vytvořit novou
šablonu zpráv. Zvolte například šablonu nazvanou SISTemplate na kartě General.

3. Zvolte položku Template v oblasti Create New.

4. Klepnutím na tlačítko OK vytvořte novou šablonu zprávy.

➤ Vždy můžete upravovat pouze jednu zprávu nebo šablonu zprávy. To znamená, že pokud je ještě
otevřená jiná zpráva nebo šablona zprávy, budete dotázáni, zda chcete uložit provedené změny.

➤ Aktuálně otevřená zpráva se zavře a do okna Report se načte první stránka šablony SISTemplate.
➤ Grafické uživatelské rozhraní (GUI) pro úpravu šablon zpráv je poněkud odlišné od grafického

uživatelského rozhraní pro vytváření nebo úpravu zpráv. Podle šedého pozadí poznáte, že
upravujete šablonu zprávy a nikoli zprávu.

Uložení šablon zpráv
1. Stisknutím tlačítka [F8] otevřete dialogové okno Preferences a zvolte kartu Report.

➤ V oblasti Directories bude uvedena standardní cesta pro ukládání zpráv a šablon zpráv.
➤ Program analySIS Vám pro uložení šablon zpráv navrhne složku Report.

2. Zadejte do pole User templates cestu k složce, do které chcete ukládat své šablony.

Pokud požadovaná složka pro zprávy dosud neexistuje, klepněte na tlačítko ... u pole User
templates. V dialogovém okně Select Directory klepněte na tlačítko Create New Folder a zvolte
název složky.

3. Klepnutím na tlačítko OK potvrïte nově zvolenou složku.

4. Klepněte na tlačítko Save na panelu nástrojů Standard nebo Report.

➤ Když ukládáte šablonu zprávy poprvé, automaticky se otevře dialogové okno Save Report
Template. Přednastavena je cesta, kterou jste zvolili pro ukládání zpráv na kartě Report
v dialogovém okně Preferences.

5. Zadejte do pole File name název pro šablonu zprávy, který vystihuje obsah šablony.

6. V seznamu Save in zvolte složku pro šablony zpráv, kterou jste určili v dialogovém okně
Preferences.

Program analySIS vám poskytne v seznamu Save in aktuální složku. Ujistěte se, zda uložíte
šablonu zprávy do správné složky. Pokud uložíte šablonu zprávy do jiné složky, nebude Vám
nabízena v dialogovém okně New Report.

7. Klepnutím na tlačítko Save uložte šablonu zprávy.

➤ Program analySIS ukládá šablony zpráv do souborů s příponou .srt. Šablona zprávy je
strukturována stejně jako zpráva, tzn. že každá šablona zprávy má doplňkové soubory, které se
automaticky ukládají do vnořené složky, pojmenované podle šablony.

8. Pokud si po provedení libovolných změn přejete znovu uložit šablonu zprávy, klepněte na tlačítko
Save. Předcházející verze šablony zpráv se přepíše aktuálnější verzí.

138



Na obrázku vlevo je zobrazena šablona zprávy se třemi
odlišnými rozvrženími stránky, vycházejícími ze základního
rozvržení. Základní rozvržení obsahuje záhlaví s logem
společnosti a zápatí s číslem stránky. Logo společnosti se
uloží jednou pro celou šablonu. Zpráva na obrázku vpravo
se skládá ze čtyř po sobě následujících stránek. Ze všech
dostupných šablon stránek byla použita jako jediná
1ImagePage.

Rozdíly mezi úpravou zpráv a šablon zpráv

Zprávy Šablony zpráv
Struktura Zpráva se skládá z více

po sobě následujících
stránek. Všechny
stránky zprávy mohou,
ale nemusí, vycházet
z jednotného rozvržení
stránky. V uvedené
ukázce určuje vzhled
všech stránek zprávy
šablona stránky
1ImagePage.

Šablona zprávy se
skládá z více stránek
s odlišným vzhledem
a funkcemi, například
úvodní stránka a stránky
s 1, 2 nebo 4 obrázky.
Kromě těchto rozvržení
stránek může šablona
zprávy obsahovat také
šablony objektů typu
záznam nebo pole.

Pozadí Bílé Šedé

Panel
nástrojů
okna Report

Tlačítka pro procházení zprávou
Zahrnuta Nezahrnuta
Tlačítka, která jsou dostupná pouze pro zprávy
nebo pro šablony
Edit Page Template Select Page Template
Panely nástrojů jsou uvedeny v dialogovém okně
Edit Button Bars pod odlišnými názvy:
Report Report template

Stavový
řádek

První pole stavového
řádku udává číslo
aktuální
stránky/celkový počet
stránek zprávy.

První pole stavového
řádku je prázdné.

Záhlaví Záhlaví okna Report
obsahuje název zprávy.
Pokud zpráva nebyla
dosud uložena, bude jí
přiřazen výchozí název
(který je Report +
pořadové číslo
vytvořené zprávy).

Záhlaví okna se
šablonou zprávy
obsahuje název
šablony zprávy a název
aktivní šablony stránky.

Přípona
souboru

*.srd *.srt

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon

vytvoření/uložení nových šablon
úprava šablon stránek
doplnění nových šablon stránek
doplnění nových textových
proměnných

vytvoření nových šablon objektů
návrh šablon

Šablony zpráv jsou druhem souborů zpráv,
v kterých je určen vzhled Vašich budoucích
zpráv. Každá zpráva, kterou vytvoříte
v Generátoru zpráv programu analySIS
bude založena na šabloně zprávy.

l Části šablony zprávy
Šablona zprávy se skládá ze šablon
stránek (str. 143) a šablon objektů
(str. 148). Tyto dílčí šablony se vytvářejí
v jednotlivých šablonách zpráv a nejsou
dostupné pro použití v jiných šablonách
zpráv. Nemůžete importovat šablonu
stránky nebo objektu z jedné šablony
zprávy do druhé. Můžete samozřejmě
upravit existující šablony zpráv a uložit je
pod jiným názvem. Tento přístup můžete
použít pro vytvoření nových šablon zpráv
ze všech dříve definovaných šablon.

l K čemu jsou určeny šablony zpráv?
Šablony zpráv určují vzhled zpráv, které
z nich vycházejí. Vytvoření šablon zpráv
má tedy z hlediska vytváření Vašich
vlastních zpráv podstatnou význam.
Práce věnovaná na začátku vytvoření
dobře promyšlené šablony zprávy se
Vám vyplatí. Ušetříte čas věnovaný
přizpůsobení šablony aktuálně vytvářené
zprávě.

l Úprava existujících šablon zpráv:
Pokud upravíte šablonu zprávy,
provedené úpravy se projeví pouze na
následně vytvořených zprávách. Existující
zprávy, vycházející z této (nyní upravené)
šablony, nelze automaticky aktualizovat.

l Úpravy šablon ve zprávě: Šablony
stránek a objektů můžete také upravovat
přímo ve zprávě. Tyto šablony však
budou potom dostupné pouze v této
zprávě a nebude je možné použít pro
ostatní zprávy vytvořené na základě
stejné šablony zpráv (str. 134).
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Přizpůsobení aktuální šablony zprávy Vašim potřebám

Nejrychlejší způsob vytvoření vlastní šablony zprávy je použít existující šablonu zprávy s mnoha různými
prvky a přizpůsobit ji Vašim potřebám.

1. Jestliže chcete vytvořit novou šablonu zprávy z existující šablony, použijte příkaz Report > New...
v nabídce File. Jako existující šablonu zprávy zvolte například šablonu SISTemplate.

➤ Zvolte na kartě General šablonu zprávy, kterou chcete upravit.
➤ Pokud chcete vytvořit novou šablonu zprávy, zvolte položku Template v oblasti Create New.

2. Chcete-li zobrazit seznam dostupných šablon stránek, klepněte na tlačítko Select Page Template
na panelu nástrojů dialogového okna Report. Zvolte šablonu zprávy SISTemplate a šablonu stránky
Basis Layout a obojí potvrïte klepnutím na tlačítko OK.

Volba písem

Zvolte písmo pro všechny objekty na aktuální stránce, aby bylo shodné s přednastaveným základním
písmem.

3. Zobrazte na obrazovce celou stránku. Klepněte na tlačítko pro automatické zvětšení na panelu
nástrojů dialogového okna Report.

4. Stiskněte a přidržte levé tlačítko myši a vytvořte výběrový rámeček kolem všech objektů na stránce.
Není podstatné, zda všechny zvolené objekty obsahují text nebo nikoli.

5. Klepněte na tlačítko Properties na panelu nástrojů Report Objects.

6. Nyní můžete na kartě Font změnit aktuálně nastavené písmo na písmo, které obvykle používáte,
například Arial nebo Times New Roman. Zvolené písmo potvrïte klepnutím na tlačítko OK.

➤ Změní se písmo pro všechny aktuálně zvolené objekty na stránce.
➤ Grafické objekty nebudou změnou písma ovlivněny, protože grafickým objektům nelze přiřadit

písmo.
➤ Písmo pro šablony objektů, například objektů typu záznam, je nastaveno trvale a uvedeným

postupem je nelze změnit. Pokud chcete změnit písmo pro šablony objektů, musíte šablony
objektů předefinovat. Když později přidáte objekt typu záznam, aniž byste využili upravené šablony
objektů, použije se původní písmo.

Změna loga společnosti

Nahraïte logo společnosti vlastním logem.

7. Načtěte logo společnosti do pamě�ového pole obrázku v programu analySIS.

8. Uložte logo společnosti do složky, ke které mají přístup ostatní uživatelé. Logo společnosti můžete
například umístit do složky pro šablony, kterou jste vytvořili na kartě Report v dialogovém okně
Preferences.

9. Ujistěte se, zda je logo vloženo do šablony zprávy pouze jako odkaz na původní soubor s logem.
Jinak budete plýtvat pamětí, protože logo by se muselo ukládat s každou stránkou znovu.
Pokud chcete po vložení zachovat vazbu mezi logem a původním souborem, zrušte zatržení
předvolby Create copies na kartě Report.

10. Nahraïte dosavadní logo společnosti přetažením Vašeho loga ze správce obrázků na objekt typu
obrázek, jenž obsahuje dosavadní logo.

POZNÁMKA: Pokud odstraníte obrázek ze zprávy nebo jej nahradíte jiným a dosavadní obrázek byl
vložen do zprávy jako kopie, smažete také soubor s obrázkem. Jestliže však byl obrázek vložen do
zprávy se zachováním vazby na původní soubor s obrázkem, soubor se z disku neodstraní. (str. 103)

11. Zatrhněte předvolbu Background object na kartě Select and Move v dialogovém okně Report
Object Properties.
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Vytvořte nové šablony na základě existujících šablon. Druhá
šablona (na spodním obrázku) vychází z první šablony
(na horním obrázku) a byla upravena následovně:

1. změněno logo společnosti

2. nastaveno písmo a jeho velikost

3. změněna šířka rámečku

4. změněna výplňová barva pro pravoúhlý objekt

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon

vytvoření/uložení nových šablon
úprava šablon stránek
doplnění nových šablon stránek
doplnění nových textových
proměnných

vytvoření nových šablon objektů
návrh šablon

Šablona stránky může obsahovat objekty
na pozadí. Objekty na pozadí, definované
pro šablonu stránky, se objeví na každé
stránce zprávy, vytvořené na základě této
šablony stránky.

l Vytvoření objektů na pozadí
Zvolte jeden nebo více objektů na stránce
šablony a otevřete dialogové okno pro
nastavení vlastností objektů. Zvolené
objekty můžete změnit na objekty na
pozadí na kartě Select and Move.
Objekty na pozadí nemůžete upravovat
na stránce zprávy, proto je na ní
nemůžete ani zvolit.

l Které objekty by měly být na pozadí?
V podstatě můžete libovolný objekt
zprávy nastavit jako objekt na pozadí.
Nemá však smysl volit jako objekt na
pozadí prázdný objekt typu obrázek nebo
prázdný textový objekt, protože do nich
nebudete moci vložit obrázek, resp. text.

l Objekty typu obrázek na pozadí: Pokud
použijete na pozadí objekt typu obrázek,
měli byste jej vždy vkládat se zachováním
vazby na původní soubor s obrázkem.
V opačném případě by se obrázek
ukládal pro každou stránku znovu.

Úprava objektů na pozadí ve zprávě

Pokud chcete upravit šablonu stránky přímo
ve zprávě, klepněte na tlačítko Edit Page
Template (str. 134). Libovolné změny,
provedené u objektů na pozadí, se ihned
projeví na všech existujících stránkách
zprávy. Jakékoliv změny provedené
u objektů, které nejsou na pozadí, se projeví
pouze u nově vytvářených stránek zprávy.
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Úprava objektů typu záznam
12. Otevřete databázi obrázků programu analySIS s obrázky, které si přejete vložit do zprávy.

13. Pokud chcete upravovat objekt typu záznam, musíte jej nejprve vložit do šablony. Klepněte na tlačítko
Select Page Template na panelu nástrojů okna Report. Zvolte „prázdnou“ šablonu stránky
a potvrïte ji klepnutím na tlačítko OK.

➤ „Prázdná“ šablona stránky je standardní prvek každé šablony zprávy.
Upozornění: Uvědomte si, že na této „prázdné“ šabloně stránky nelze vytvořit objekt.
Program analySIS po uložení šablony zprávy tuto „prázdnou“ šablonu stránky smaže. Tuto stránku
však můžete výhodně použít pro úpravu objektů typu záznam, protože na ní nejsou žádné objekty
typu záznam, které by mohly vadit vašim úpravám.

14. Klepněte na tlačítko Record na panelu nástrojů Report Objects, abyste mohli vložit existující objekty
typu záznam.

➤ Tvar kurzoru myši se změní. Klepněte na přibližné místo ve zprávě, na které chcete umístit objekt.
Místo, na které klepnete, bude odpovídat středu objektu typu záznam. Po úpravě můžete polohu
objektu upravit.

➤ Otevře se seznam Select Object Template, v kterém naleznete všechny objekty typu záznam,
vytvořené v aktuální šabloně zprávy. Pokud je v šabloně dosud vytvořen pouze jeden objekt typu
záznam nebo není vytvořen vůbec žádný, automaticky se vloží objekt typu záznam ve výchozím
formátu.

15. Zvolte jeden z objektů typu záznam v seznamu a potvrïte jej klepnutím na tlačítko OK.

➤ Zvolený objekt typu záznam se vloží na místo, které jste zvolili, a po vložení zůstane zvolen
(tzn. jako kdybyste na něj klepnuli levým tlačítkem myši).

16. Klepnutím na tlačítko Edit Object Template na panelu nástrojů okna Report se přepněte z režimu
rozvržení do režimu úprav. V režimu úprav můžete změnit šablonu zvoleného objektu typy záznam.

17. Smažte všechny objekty typu pole, které chcete nahradit vlastními objekty téhož typu.

18. Klepněte na tlačítko Field na panelu nástrojů Report Objects a vložte požadované objekty typu pole
z aktivní databáze do záznamu.

19. Klepnutím na tlačítko Finish Object Editing na panelu nástrojů okna Report uložte upravený objekt
typu záznam.

➤ Nyní můžete odstranit upravený záznam typu objekt ze šablony stránky. Můžete jej kdykoliv vložit
na libovolnou požadovanou stránku. Vytvořený objekt typu záznam je nyní dostupný v každé
zprávě, kterou vytvoříte na základě této šablony zprávy.

20. Opakováním uvedených kroků upravte všechny objekty typu záznam, obsažené v šabloně zprávy.

Uložení šablon stránek
21. Klepněte na tlačítko Save Page Template.

➤ V dialogovém okně Save Page Template Vám bude nabídnut název aktuální stránky. Pokud
chcete uložit upravenou šablonu stránky pod stejným názvem, klepněte na tlačítko OK.
Předcházející šablona stránky se přepíše.

➤ Pokud chcete uložit upravenou šablonu stránky pod novým názvem, zadejte požadovaný název
do pole Page template name a klepněte na tlačítko OK.

22. Opakujte všechny pozměňovací kroky pro každou šablonu stránky v šabloně zprávy.

23. Klepnutím na tlačítko Save na panelu nástrojů okna Report uložte upravenou šablonu zprávy.

Uložení: Zprávy a šablony lze v programu ukládat různými způsoby.

1. Tlačítkem Save Report Document na panelu nástrojů okna Report

2. Tlačítkem Save na standardním panelu nástrojů

3. Příkazem Report > Save Report Document (nebo Save as...) z nabídky File

24. Příkazem Report > New...vytvořte zprávu, vycházející z upravené šablony zpráv.
Vaše vlastní šablony zpráv jsou dostupné na kartě User Templates v dialogovém okně New Report.
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Úprava objektů typu záznam

Pokud si přejete použít objekty typu záznam, musíte
v šabloně zprávy nastavit objekty typu záznam tak,
aby odpovídaly Vaší vlastní databázi.

Pokud chcete upravovat objekt typu záznam, musíte jej
nejprve vložit do šablony. Můžete to provést na libovolné
stránce.

Jestliže chcete upravit objekt typu záznam, zvolte jej
klepnutím levým tlačítkem myši. Potom se tlačítkem Edit
Object Template přepněte z režimu rozvržení do režimu
úprav. V režimu úprav můžete zvolit jednotlivé objekty
typu pole, a pokud je to potřebné, následně odstranit.

Pokud chcete vložit nový objekt typu pole z databáze,
klepněte na tlačítko Field na panelu nástrojů Report.
Můžete zvolit libovolná databázová pole, definovaná
v aktivní databázi.

Jestliže chcete uložit objekt typu záznam, vytvořený
v šabloně zprávy, pouze ukončete režim úprav objektu
klepnutím na tlačítko Finish Object Editing.

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon

vytvoření/uložení nových šablon
úprava šablon stránek
doplnění nových šablon stránek
doplnění nových textových
proměnných

vytvoření nových šablon objektů
návrh šablon

Šablony stránek: Jednotlivé stránky
šablony zprávy se nazývají šablony stránek.
Používají se k definici rozvržení stránek,
které se použijí ve zprávě. Každé rozvržení
stránky se v šabloně zprávy ukládá pod
vlastním názvem. Pokud postupně vytváříte
zprávu na základě této šablony zprávy,
můžete pro každou stránku zprávy zvolit
v seznamu příslušnou šablonu stránky.

Úprava šablon stránek: Libovolné úpravy,
které chcete provést s rozvržením stránek,
musíte provést pro každou stránky šablony
zprávy zvláš�. Po klepnutím na tlačítko
Select Page Template na panelu nástrojů
Report můžete upravovat jednotlivé šablony
stránek.

POZNÁMKA: V mnoha případech je rychlejší
upravit šablonu stránky Basis Layout a z této
jedné stránky potom znovu vytvořit všechny
ostatní stránky.

Určení první stránky zprávy: Otevřete
šablonu zprávy a klepněte na tlačítko Select
Page Template. Potom zvolte v seznamu
některou ze šablon stránek pro úvodní
stránku nebo obálku zprávy. Jakmile bude
aktivní úvodní stránka, resp. obálka zprávy,
uložte Vaši zprávu a zavřete okno Report.
Když pak budete vytvářet novou zprávu na
základě této šablony zprávy, jako první se
otevře stránka vytvořená na základě šablony
stránky, zvolené pro úvodní stránku.

Doplnění obálky do zprávy: První stránkou
zprávy může být, ale nemusí, obálka.
Obálku můžete také doplnit na úplný konec
ukončené zprávy. Zobrazte první stránku
nově vytvořené zprávy a klepněte na tlačítko
Add Page. Zvolte položku Insert Page
v dialogovém okně Add Page.
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Doplnění nové šablony stránky pro několik obrázků

Přejete si doplnit novou šablonu stránky, která obsahuje šest obrázků. Aktuální šablona zprávy obsahuje
stránku Basic Layout. Stránka Basic Layout odpovídá prázdnému formuláři, který již má všechny
standardní prvky, jako jsou logo společnosti, místo pro adresu a datum.

1. Klepnutím na tlačítko Select Page Template na panelu nástrojů okna Report otevřete seznam všech
šablon stránek, vytvořených v aktuální šabloně zprávy.

2. Zvolte šablonu stránky, z níž můžete vytvořit svou vlastní stránku, a potvrïte ji stisknutím tlačítka OK.
Šablona zprávy SISTemplate obsahuje například stránku nazvanou BasicPage.

➤ V okně Report bude nyní zobrazena zvolená šablona stránky.

3. Klepněte na tlačítko Image na panelu nástrojů Report Objects a vytvořte v šabloně stránky nový
objekt typu obrázek.

➤ Tvar kurzoru se změní na kříž.

4. Nyní nakreslete pravoúhlou oblast pro objekt typu obrázek. Přesnou velikost a polohu určete myší
nebo na kartě Position and Size.

5. Přetáhněte typický obrázek ze správce obrázků nebo databáze obrázků na některý z objektů typu
obrázek, abyste si mohli lépe představit, jak budou obrázky později vypadat ve zprávách. Načtěte
například obrázek Scale z demonstrační databáze.

6. Zvolte objekt typu obrázek a klepněte na tlačítko Properties na panelu nástrojů Report Objects,
abyste mohli určit vlastnosti objektu typu obrázek.

7. Zkontrolujte nastavení na kartě Select and Move.

❑ Background object: Pokud chcete zvolit objekt typu obrázek jako kód pole obrázku, ponechejte
předvolbu nezatrženou. Objekty, které nastavíte jako objekty na pozadí, nebudete moci později ve
zprávě upravovat.

✔ Fixed Position: Pokud chcete nastavit trvalou velikost a polohu objektu typu obrázek pro všechny
zprávy, předvolbu zatrhněte. Nastavení předvolby nemůžete později ve zprávě změnit.

8. Klepnutím na tlačítko Clear Object na panelu nástrojů Report Objects odstraňte zkušební obrázek
ze zprávy.

➤ Písmo pro měřítko (délkové) a hodnota automatického zvětšení se nahradí symboly číslic #.

9. Vždy, když přesouváte „nový“ objekt typu obrázek do požadované polohy, vytvořte stisknutím
klávesy [Ctrl] jeho kopii.

➤ Celkový pohled na dokončenou stránku obsahuje například 6 objektů uspořádaných do matice 2
× 3.

10. Klepněte na tlačítko Save Page Template a do vstupního pole zadejte nový název, například
ImageGallery.

11. Klepnutím na tlačítko OK zajistěte doplnění nové šablony stránky do šablony zprávy.

➤ Nová šablona stránky, nazvaná ImageGallery, bude nyní dostupná při vytváření nových zpráv,
vycházejících z aktuální šablony zprávy.
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Dialogové okno Report Object Properties

Všechny vlastnosti zvolené v dialogovém okně se uplatní
u všech zvolených objektů typu obrázek na aktuální stránce
zprávy nebo šabloně stránky.

Ovládací
prvky

Význam

Magnification Zvolte jednu ze čtyř dostupných možností
pro nastavení velikosti obrázku pro tisk.
Jednotlivé položky jsou podrobněji
popsány na stránce 104.

Poznámka: Přepínače Use fixed magnification a Use
image magnification použijte pouze
v šabloně zprávy, pokud používáte
obrázky, které mají všechny stejné
rozměry. V opačném případě se vložené
obrázky mohou ve zprávě objevit buï
příliš zvětšené nebo naopak příliš malé.

Labels V této oblasti se aktivuje nebo ruší
automatické označování objektů typu
obrázek.

Vlastnosti: Poloha pro automatické označení je
přednastavena a nelze ji změnit. Pokud je
označení delší než objekt typu obrázek,
vůbec se nezobrazí. Pokud je rámeček
obrázku příliš úzký pro oba údaje, zobrazí
se jako první zvětšení.

Určete na kartě Font písmo, jeho velikost
a barvu pro označení, tzn. pro zvětšení
a měřítko (délkové).

Frame Předvolbu zatrhněte, pokud chcete
zobrazit rámeček kolem objektu typu
obrázek. Všimněte si, že rámeček je
nakreslený kolem objektu typu obrázek,
nikoli kolem vlastního obrázku. Obrázek
může být menší nebo větší než objekt
typu obrázek (v závislosti na zvolené
velikosti pro tisk).

Vlastnosti Na kartě Line můžete určit šířku a barvu
čar rámečku.
Na kartě Fill zvolte barvu výplně rámečku.
Obrázek a jeho označení budou vždy na
popředí. Obrázek můžete barevně
zvýraznit, pouze pokud bude zobrazen
rámeček. Jestliže rámeček nezvolíte,
pozadí zůstane průhledné bez ohledu
na nastavení na této kartě.

Magnification Předvolbu zatrhněte, pokud chcete vlevo
pod obrázkem tisknout zvětšení (M).
Zvětšení se zobrazuje ve tvaru M:1.

Scale Předvolbu zatrhněte, pokud chcete
vpravo pod obrázkem zobrazit měřítko.
Vzhled měřítka i jeho relativní délku určuje
program analySIS a nelze je změnit.

Více informací o objektech typu obrázek naleznete na
stránce 103.

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon

vytvoření/uložení nových šablon
úprava šablon stránek
doplnění nových šablon stránek
doplnění nových textových
proměnných

vytvoření nových šablon objektů
návrh šablon

Vložení nových šablon stránek: Existují
dva způsoby vložení nových šablon stránek
do šablon zpráv.

Klepněte na tlačítko New Page Template,
do šablony zpráv se vloží prázdná šablona.
Nové šabloně stránky se automaticky přiřadí
název Page template + pořadové číslo
vytvořené šablony stránky. Jestliže chcete
přiřazený název změnit, klepněte na tlačítko
Save Page Template.

Novou šablonu můžete vytvořit z jiné
existující šablony. Nejprve klepněte na
tlačítko Select Page Template a uložte
šablonu stránky pomocí tlačítka Save Page
Template pod jiným názvem.

Mazání šablon stránek

Chcete-li odstranit šablonu stránky ze
šablony zprávy, otevřete šablonu zprávy
a zpřístupněte seznam vytvořených šablon
stránek. Tlačítko Delete se nachází
v dialogovém okně Select Page Template.

Úprava šablon stránek ve zprávě (str. 134)
Šablony stránek se vytváří v šablonách
zpráv. Novou šablonu stránky však můžete
vytvořit také přímo ve zprávě. Ve zprávě
můžete také upravovat existující šablony
stránek. Stačí pouze klepnout na
odpovídající tlačítka na panelu nástrojů
Report.

VÝSTRAHA: Uvědomte si, že jakékoliv
změny provedené na stránce šablony přímo
ve zprávě se projeví pouze v této zprávě.
Šablona zprávy, z níž příslušná zpráva
vychází, se nezmění. Když budete příště
vytvářet zprávu na základě této šablony
zprávy, budete mít k dispozici stejné,
nezměněné šablony stránek.
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Vytváření nových textových proměnných

Úloha: Záhlaví šablony SISTemplate obsahuje na pozadí textový objekt udávající oddělení. Přejete si
použít tuto šablonu pro více oddělení, a tedy potřebujete zaměnit název oddělení za textovou proměnnou.

1. Klepněte na tlačítko Select Page Template na panelu nástrojů okna Report, budete moci vytvořit
novou textovou proměnnou v šabloně stránky Basis Layout.

2. Zvolte v záhlaví textový objekt, jenž obsahuje označení oddělení.

3. a) Klepněte pravým tlačítkem myši na příkaz Properties...
b) Klepněte na tlačítko Properties na panelu nástrojů Report Objects.
c) Poklepejte na textový objekt.

➤ Na kartě General se nachází pole Name. Aktuální název textového objektu je standardní pro
všechny textové objekty: Text.

4. Změňte název textového objektu z Text na @Address.

➤ Pokud název textového objektu začíná symbolem @, program analySIS s ním bude zacházet jako
s textovou proměnnou. Pokud upravíte text v textové proměnné, automaticky se změní obsah
všech textových objektů stejného názvu v celé zprávě.

5. Zrušte zatržení předvolby Background object na kartě Select and Move a zatrhněte předvolbu
Fixed Position.

6. Klepnutím na tlačítko OK zavřete dialogové okno Report Object Properties.

POZNÁMKA: Při pouhém pohledu na textový objekt nemůžete určit, zda se jedná o automatický
text, text na pozadí, textovou proměnnou nebo upravitelný text. Proto je rozumné se rozhodnout
pro některý ze způsobů označení, aby se ještě více urychlilo rozpoznávání odlišných typů textů.
Pokud několik uživatelů používá stejné šablony, všichni z nich by měli být schopni určit, které
textové objekty musí být vyplněny a které nikoli.
K odlišení textových proměnných v šabloně zprávy byste měli používat hranaté závorky.
Upravitelný text by měl být označen třemi tečkami nebo můžete aktuálně zapsat prázdnou žádost
v textovém objektu Enter image comment here.

7. Přepněte se do režimu úprav textu. Zvolte textový objekt, který obsahuje označení oddělení, a potom
klepněte levým tlačítkem myši na textový objekt ještě jednou.

➤ Standardní text byl zvolen a bude přepsán jakmile zadáte vlastní text.

8. Nahraïte přesnou adresu a například obecné označení oddělení:
například Department/Employee/Dept #:...

9. Klepnutím kdekoliv na stránce ukončete režim úprav textu.

10. Uložte upravenou šablonu stránky.

11. Opakujte uvedené kroky pro každou šablonu stránky.

Vyplnění textových proměnných
1. Vytvořte novou zprávu na základě upravené šablony SISTemplate.

2. Poklepejte na adresu a zadejte oddělení, zaměstnance, přesný název oddělení a telefonní číslo.

3. Klepněte na tlačítko Add Page na panelu nástrojů zprávy, do zprávy se doplní nová stránka. Nová
stránka nemusí vycházet ze stejné šablony jako první stránka zprávy.

➤ Záhlaví nové stránky bude automaticky aktualizováno, aniž byste museli změnit šablonu stránky.
➤ Textové proměnné existujících stránek se automaticky aktualizují.
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Zpráva na obrázku obsahuje několik druhů textu. Jednotlivé
druhy jsou popsány v následující tabulce. Textové
proměnné jsou uvedeny v hranatých závorkách. Texty, které
lze upravovat. jsou označeny tečkovanými čarami.
Tečkované čáry vyznačují místo, na které můžete vložit text.
Objekty typu pole, které se automaticky vyplní při vložení
záznamu, jsou programem analySIS vloženy do špičatých
závorek.

Druh textu

Vlastnosti Vložení

Str.Dialogové okno
Report Object
Properties

Panel nástrojů
Report Objects

1 Text na
pozadí

Na kartě Select and
Move byla zatržena
předvolba
Background Object.

Pouze v šabloně
zprávy

141

2 Textová
proměnná

Název textové
proměnné začíná
na kartě General
znakem @.

147

3 Automatický
text

Textový objekt
nastavíte na
automatický text na
kartě General.
Dialogové okno
Report Object
Properties bude nyní
obsahovat
doplňkovou kartu –
Auto-Text.

151

4 Upravitelný
textový
objekt

Na kartě Select and
Move nebyla zatržena
předvolba
Background Object.

Nelze v objektu
typu záznam
nebo pole

108

5 Objekt typu
pole

Textový objekt
změníte na objekt
typu pole na kartě
General.

Dostupné pouze
v režimu úprava
objektu

117
153

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon

vytvoření/uložení nových šablon
úprava šablon stránek
doplnění nových šablon stránek
doplnění nových textových
proměnných

vytvoření nových šablon objektů
návrh šablon

Vytvoření textových proměnných: Jestliže
chcete změnit textový objekt na textovou
proměnnou, musíte změnit na kartě General
jeho název. Tato karta se nachází v okně
Properties pro textové objekty. Název
textové proměnné musí začínat znakem @.

Co to je textová proměnná? Kdykoliv
změníte obsah textového objektu, program
analySIS automaticky aktualizuje všechny
textové proměnné ve zprávě se stejným
názvem. Obsah textové proměnné můžete
měnit tak často, jak potřebujete, například
při opravě pravopisných chyb.

Použití: Textové proměnné se obvykle
vytváří v šabloně zprávy a umožňují
strukturovat záhlaví a zápatí stránek.
To znamená, že záhlaví, které se má objevit
na všech stránkách zprávy, stačí zadat
pouze jednou.
Můžete však také vytvořit textovou
proměnnou na stránce přímo ve zprávě.

Několik textových proměnných: V šabloně
zprávy můžete vytvořit tolik textových
proměnných, kolik potřebujete, například
pro záhlaví, autora zprávy, název projektu,
oddělení atd.

Odlišné šablony stránek: Pokud změníte
ve zprávě obsah textové proměnné, tato
změna se projeví na všech stránkách,
na nichž se textová proměnná vyskytuje.
Nezáleží na tom, zda byly jednotlivé stránky
vytvořeny ze stejné nebo různých šablon.
Jedna textová proměnná se také může
vyskytnout na jedné stránce vícekrát.

Formátování textových proměnných:
Textové proměnné jsou propojené z hlediska
obsahu, nikoli pokud se týká formátu. To
znamená, že když změníte formát textové
proměnné nemusí to automaticky znamenat
aktualizaci jiné proměnné stejného typu ve
zprávě.
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Vytvoření nových šablon pro objekty typu záznam
1. Otevřete demonstrační databázi programu analySIS nebo databázi s poli, která si přejete použít

v budoucí standardní zprávě.

2. Vytvořte novou šablonu zprávy, založenou na šabloně zprávy Normal, která je dostupná na kartě
General v dialogovém okně New Report.
➤ Šablona Normal je „prázdná“ šablona, tzn. že nemá předdefinované žádné šablony stránek.

3. Klepnutím na tlačítko Report na panelu nástrojů Report Objects vložte standardní objekt typu
záznam. Vytvořte novou šablonu objektu, vycházející z tohoto objektu typu záznam.

➤ Objekt typu záznam se vloží do šablony a zůstane zvolen. Po zvolení objektu typu záznam zůstane
přístupné pouze tlačítko Edit Object Template.

4. Klepněte na tlačítko Edit Object Template na panelu nástrojů okna Report, přepnete se do režimu
úprav šablon objektů.

➤ V režimu úprav můžete zvolit a upravovat jednotlivé objekty zvoleného objektu typy záznam.

POZNÁMKA: Pokud nemůžete v režimu úprav zvolit některé objekty, jedná se pravděpodobně
o objekty na pozadí. Chcete-li upravené objekty umístit na pozadí, použijte tlačítko Send to Back
na panelu nástrojů Order and Group.

5. Odstraňte všechny prvky standardního objektu typu záznam kromě objektu typu obrázek.

➤ Objekt typu záznam musí obsahovat alespoň jeden prvek, proto nemůžete smazat všechny prvky
a pak pokračovat vkládáním nových.

6. Jestliže chcete formátovat objekt typu obrázek, zvolte jej a klepněte na tlačítko Properties na panelu
nástrojů Report Objects.

➤ Zvolte položku Fit image into frame na kartě Image Properties. Zrušte zatržení všech předvoleb
v Labels.

Popis šablon pro objekt PhotoPanel1 typu záznam

Typ Funkce Poznámka

1 Objekt typu
obrázek

Kód pole pro obrázek
z databáze

Objekt typu záznam může obsahovat pouze „prázdný“ objekt
typu obrázek. Do tohoto objektu můžete později vložit
obrázek z databáze programu analySIS. Obrázky ze správce
obrázků nelze přetáhnout na objekt typu záznam.
Objekt typu obrázek má stejné vlastnosti (jak již bylo
uvedeno), tzn. že můžete vložit obrázky do objektu typu
záznam buï se zachováním vazby na původní soubor
s obrázkem, nebo jako kopii, a to s různými koeficienty
zvětšení.

2 Ikony zastupující panel
fotoaparátu

Ikony byly vloženy do šablony jako objekty na pozadí.

Vždy se přesvědčte, zda jsou obrázky v šabloně objektu
vloženy se zachováním vazby na původní soubor s obrázkem.

3 Text Standardní text, který
se objeví u každého
obrázku

Texty se obvykle v objektech typu záznam používají jako
doplněk ke standardním automatickým textům, například
slova photo panel jsou vložena tak, aby se zobrazila vedle
pořadového čísla.

4 Grafické
objekty

Vyplněný pravoúhlý
rámeček

V šabloně objektu můžete použít libovolný požadovaný
grafický prvek.

5 Automatický
text

Pořadové číslo obrázku Tento druh automatického textu je dostupný pouze u objektů
typu záznam.

6 Objekty typu
pole

Údaje z databázových
polí

Objekty typu pole jsou složené objekty, které obvykle tvoří
alespoň název pole a vlastní údaj.

7 Udává zvětšení
v uživatelském
rozvržení
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Na obrázku je uvedena ukázka objektu typu záznam.
Jeho vzhled je definován šablonou objektu PhotoMount1.
Jednotlivé prvky objektu typu záznam jsou popsány
v tabulce na předcházející stránce. Šablona objektu
PhotoMount 1 je součástí šablony zprávy SISTemplate.

Režim úpravy objektu

Vysvětlení Režim úpravy objektu je určen pro výběr
a úpravy jednotlivých prvků zvoleného
objektu typu záznam. Všechny ostatní
prvky na stránce zprávy nelze upravovat
a jsou na obrazovce zobrazeny pouze
z orientačních důvodů.

Edit Object
Template

Klepnutím na tlačítko Edit Object
Template spustíte režim úpravy objektu.
V tomto režimu je pozadí stránky
vyšrafováno.

Finish Object
Editing

Klepnutím na tlačítko Finish Object Editing
ukončíte režim úpravy objektu.

Objekty typu záznam vložte v režimu rozvržení. V režimu
rozvržení se také objekty typu záznam volí a upravují jako
celek, což Vám například umožňuje současně změnit
vlastnosti všech textových objektů.

Pokud chcete upravit jednotlivé složky objektu typu
záznam, musíte se přepnout do režimu úprav objektu.

V režimu úprav objektu můžete zvolit a upravit kteroukoliv
ze složek zvoleného objektu typu záznam.

Aktivní režim úpravy objektu poznáte podle záhlaví okna
zprávy a stavového řádku.

Pozadí – všechny objekty na aktuální stránce, které nejsou
součástí objektu záznam, se zobrazí vyšrafované pouze
z orientačních důvodů a nebude je možné upravovat.

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon
vytvoření nových šablon objektů

šablony pro objekty typu záznam
šablony pro objekty typu pole

návrh šablon

Více informací o objektech typu záznam
naleznete na stránce 115

Vytvoření nových šablon objektů

Pravidlo pro všechny šablony vytvořené
Generátorem zpráv programu analySIS:
Nové šablony můžete vytvářet pouze
úpravou existujících šablon. Pokud chcete
vytvořit novou šablonu pro objekt typu
záznam, nejprve vložte objekt typu záznam,
upravte jej a uložte šablonu pod jiným
názvem.

POZNÁMKA: Šablony objektů jsou seřazeny
podle abecedy. Využijte tuto informaci
a zvolte pro šablony objektů, které často
používáte, název, který začíná písmenem
ze začátku abecedy.

Textové objekty v šablonách objektů:
Šablony objektů nemohou obsahovat
upravitelné textové objekty. Pokud si přejete
dodatečně vložit do zprávy objekt typu
záznam, můžete upravit texty v textových
objektech pouze v režimu úprav objektu.

Dostupnost: Šablony objektů musí být
vytvořeny v šabloně zprávy. Budou pak
dostupné pro všechny zprávy, vycházející
z této šablony. Šablony objektů nelze
přenášet z jedné šablony zprávy do druhé.

Pro úpravy jednotlivých objektů typu
záznam je při práci se zprávou dostupný
režim úpravy objektu.

Standardní šablony objektů: Pokud
šablona zprávy neobsahuje žádné
předefinované šablony objektů, program
analySIS po klepnutí na tlačítko Record vloží
standardní záznam. Po vytvoření vlastní
šablony objektu typu záznam již nebude
standardní záznam dostupný. Jestliže si
přejete zachovat možnost použít standardní
záznam později, uložte jej.
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Nyní postupně vložte všechny požadované objekty

POZNÁMKA: Při vytváření šablony objektu nebo rozvržení stránky začněte vkládáním prvků, které se
zobrazí na pozadí, například rámečku. Každý objekt, který dodatečně vložíte, se tedy automaticky objeví
v popředí.

7. Vložte obdélník. Umístěte obdélník vedle objektu typu obrázek a přiřaïte mu následující vlastnosti:

Zvolte barvu výplně na kartě Fill a zrušte zatržení předvolby Transparent Fill.

Zpřístupněte kartu Line a zatrhněte na ní předvolbu Transparent.

8. Vložte slova photo panel. Umístěte text do levého horního rohu obdélníku a přidělte mu následující
vlastnosti:

Zatrhněte předvolby Transparent na kartách Fill a Line.

Zrušte zatržení předvolby Multiple Lines a zvolte položku Center pro vyrovnání textu ve
vodorovném a svislém směru.

9. Klepněte na tlačítko Save Properties As Default na panelu nástrojů Report Objects. Nastavené
vlastnosti textu se uloží a použijí pro příští automatické texty.

10. Klepněte na tlačítko AutoText na panelu nástrojů Report Objects, abyste mohli doplnit pořadové
číslo.

➤ Otevře se dialogové okno Select AutoText. V seznamu Type jsou uvedena všechna dostupná
textová pole.

11. Zvolte položku Continuous Number v seznamu Type a klepnutím na tlačítko OK ji potvrïte.

Počitadlo je celé číslo, které můžete použít například k očíslování všech obrázků ve zprávě.
Počítadlo začíná číslovat od hodnoty 1 a při každém výskytu automatického textu Continuous
Number se hodnota počitadla zvětší o 1. Počitadla můžete také definovat v různých šablonách
objektů.

12. Použitím tlačítek na panelu nástrojů Align umístěte počitadlo napravo od textu photo panel.

13. Jediné objekty, které Vám stále chybí, jsou objekty typu pole (str. 152). Během úprav a před vložením
objektů typu pole uložte objekt typu záznam klepnutím na tlačítko Finish Object Editing.

14. V dialogovém okně Finish Object Editing přiřaïte objektu typu záznam odpovídající název,
například standard photo panel, a klepněte na tlačítko Save Object Template.

Dialogové okno Finish Object Editing

Dialogové okno použijte k ukončení režimu úprav objektu.

Save Object Template Zadejte do pole název pro novou šablonu objektu a klepnutím na tlačítko vytvořte
nový záznam.
Zvolte šablonu objektu ze seznamu a klepnutím na toto tlačítko přepište existující
záznam.

Exit without Save Klepnutím na tlačítko ukončíte režim úprav objektu bez uložení úprav do šablony
objektu typu záznam. Tlačítko použijte, pokud si přejete upravit pouze jeden
záznam bez vytvoření šablony.

Exit All Klepněte na tlačítko, pokud chcete ukončit režim úprav objektu po ukončení
úprav objektu typu pole. Tímto způsobem zajistíte, že nebudete muset zavírat
každou vrstvu šablony zvláš�. Existující šablony objektů se nezmění.

Delete Object
Template

Zvolte šablonu objektu ze seznamu a klepnutím na tlačítko ji odstraňte.
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Přehled dostupných automatických textů

Page
Number

První stránka: V dialogovém okně Report
Properties rozhodněte, od jakého čísla se začnou
stránky číslovat.
Klepnutím pravým tlačítkem myši na pozadí zprávy
zobrazte místní nabídku a v ní zvolte příkaz
Properties... Potom zvolte vlastnosti zprávy.

Page Count
= celkový
počet
stránek

Aktualizace: Automatické texty, které souvisejí
s číslováním stránek, se aktualizují vždy při vložené
nové stránky. Seznam Update v dialogovém okně
Select AutoText není dostupný.
Číslování stránek v šabloně: Vzhledem k tomu,
že z šablony zprávy se nevyvolává funkce pro
číslování stránek, program analySIS prostě vloží na
místo, kde se na stránce zobrazí číslo stránky
nebo počet stránek, hodnotu 0.

Current
Date

Formát data: Formát zápisu data odpovídá,
v případě „krátké“ formy, nastavení v operačním
systému Windows.
Změna formátu data: Klepněte na tlačítko Start na
hlavním panelu Windows. Postupně zvolte položky
Nastavení a Ovládací panely. Poklepejte na
zástupce Místní nastavení. Na kartě Datum se
nachází oblast Krátké datum.
Jakékoliv změny v nastavení formátu data se
projeví v automatickém textu, proto se po
opakovaném otevření existující zprávy po změně
formátu data může změnit datum ve zprávě.
Kdykoliv budete měnit formát data v operačním
systému, uvědomte si, že můžete ovlivnit další
aplikace.

Current
Time

Čas se vkládá v následujícím formátu: HH:MM
(H – hodiny, M – minuty). Čas se průběžně
aktualizuje během úpravy zprávy. Tento
automatický text použijte například pro rozlišení
starší a novější verze stejné zprávy.

Company Název společnosti a jméno uživatele odpovídají
údajům, zadaným při registraci programu
analySIS. Tyto informace se zadávají při instalaci
programu. Pokud chcete zjistit, jaké údaje se
použijí, zvolte příkaz About... v nabídce ?.
Příslušné informace zjistíte v poli Program
Information.

User Při práci v síti si všimněte, že údaj v automatickém
textu User nemusí odpovídat jménu uživatele,
kterým se přihlašuje do sítě.

Continuous
Number

Automatický text Continuous Number je dostupný
pouze v režimu úprav objektu. Toto počitadlo
použijte pro objekty typu záznam, například
k číslování obrázků v záznamech.
Co znamená Continuous Number ve zprávě:
Po každém vložení objektu typu záznam
(opatřeném pořadovým číslem) do zprávy
se všechna pořadová čísla v aktuální zprávě
aktualizují, tzn. chronologicky se přečíslují.
V dialogovém okně Report Properties můžete
změnit počáteční hodnotu pořadového čísla.
Přípustná jsou celá čísla v rozsahu od –1000 do
1000.
Co znamená Continuous Number v šabloně
zprávy: Na šabloně stránky se všechna plynule se
měnící čísla postupně zvyšují. Počáteční hodnota
je 1.

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon
vytvoření nových šablon objektů

šablony pro objekty typu záznam
šablony pro objekty typu pole

návrh šablon

Automatické texty jsou zvláštní druhy textů,
jejichž obsah je nezávislý na programu
analySIS. Automatické texty můžete použít
ve zprávách i šablonách zpráv.

PŘÍKLAD: Vložte automatický text nazvaný
Page Number za účelem číslování stránek
zprávy. Program analySIS automaticky
doplní správné číslo stránky, když například
smažete stránku, která se nacházela před
aktuální stránkou.

Aktualizace: V dialogovém okně Select
AutoText můžete zvolit, jak často bude
program analySIS aktualizovat některé
automatické texty, například datum a čas:

l Continuous: Automatické texty se budou
aktualizovat průběžně. Datum vložené při
nastavení této položky bude vždy
aktuální. Dokonce když otevřete existující
zprávu, nahradí se libovolné datum,
obsažené ve zprávě, za aktuální.

Automatické texty mohou být
aktualizovány také v případě, že je vložíte
do šablony zprávy jako objekty na
pozadí.

l Never: Obsah automatického textu bude
vždy určen pouze okamžikem vložení.
Jestliže vložíte datum po nastavení této
položky, bude trvale odpovídat datu
vložení. Pokud otevřete zprávu později,
datum zůstane zachováno.

Properties: Vlastnosti automatických textů
můžete měnit v dialogovém okně Report
Object Properties, podobně jako vlastnosti
jakýchkoliv jiných objektů. Kromě vlastností
přidělených textovým objektům máte také
k dispozici kartu AutoText, na které můžete
zvolit typ a způsob aktualizace
automatických textů.

Více informací k vlastnostem textů naleznete
na stránce 121

151



Vytvoření nových šablon pro objekty typu pole

Šablona objektu by měla zahrnovat dva objekty typu pole různých formátů. Jeden objekt udává zvětšení
pro každý obrázek, druhý objekt typu pole (odlišně formátovaný) obsahuje informaci o databázi obrázků,
z níž obrázek pochází.

1. Načtěte databázi obrázků programu analySIS, která obsahuje obrázky, jež chcete použít ve zprávě.

2. Zvolte záznam a klepněte na tlačítko Edit Object Template na panelu nástrojů dialogového okna
Report, přepnete se do režimu úprav šablony objektů.

3. Klepnutím na tlačítko Field na panelu nástrojů Report Objects vložte standardní objekt typu pole do
záznamu. Vytvoříte novou šablonu objektu pro objekty typu pole, založenou na tomto objektu typu
pole.

➤ VÝSTRAHA: Objekty typu pole nemůžete vkládat bez otevření existující databáze. To je způsobeno
tím, že bez databáze nejsou dostupné žádné informace o polích. Jestliže není při provádění
uvedených úkonů otevřená databáze, obdržíte proto chybové hlášení.

➤ Otevře se dialogové okno Select Field, v němž naleznete všechna databázová pole, která jsou
definována v aktivní databázi obrázků programu analySIS.

4. Zvolte libovolná databázová pole a výběr potvrïte klepnutím na tlačítko OK.

Uvědomte si, prosím, že při vytváření šablony objektu se nemusíte starat o výběr jednotlivých
databázových polí. Jediné, co nyní uděláte, je návrh rozvržení. Později můžete toto rozvržení použít
pro libovolné požadované databázové pole.

➤ V šabloně zprávy Normal nejsou vytvořeny žádné šablony objektů. To znamená, že se automaticky
vloží standardní objekt typu pole. Pokud jste již vytvořili šablony objektů typu pole, otevře se
dialogové okno Select Field.

➤ Objekt typu pole se vloží a zůstane zvolen, můžete jej tedy ihned umístit.

5. Klepnutím na tlačítko Edit Object Mode na panelu nástrojů okna Report se přepněte do režimu
úprav šablon objektů (v tomto případě objektů typu pole).

Uvědomte si, prosím, že jste již v režimu úpravy šablon objektů. Šablony objektů můžete upravovat
v několika víceúrovňových krocích. V režimu úprav šablon objektu typu záznam můžete vytvořit
šablonu objektu typu pole.

➤ Nyní můžete zvolit jednotlivé prvky objektu typu pole a následně je upravit.
➤ Všechny ostatní objekty, dokonce i jednotlivé objekty aktivního objektu záznam, budou zobrazeny

pouze pro orientační účely a budou vyšrafované. Nebude je již možné zvolit.

6. Nyní upravte objekt typu pole. Na následující stránce jsou zobrazené ukázky objektů typu pole.

Uvědomte si, prosím, že název pole je nezbytná součást objektu typu pole. Můžete zadat libovolný
text, který si přejete použít jako název pole. Jestliže však vložíte objekt typu pole do objektu typu
záznam, tento text se automaticky nahradí názvem zvoleného databázového pole.

7. Klepnutím na tlačítko Finish Object Editing uložte šablonu objektu typu pole.

8. Zadejte v dialogovém okně Finish Object Editing odpovídající název pro aktuální objekt typu pole
a klepněte na tlačítko Save Object Template.

➤ Znovu se vrátíte do režimu úpravy objektů typu záznam.

9. Klepnutím na tlačítko Field na panelu nástrojů Report Objects vložte objekty typu pole, založené na
šabloně objektu, kterou jste právě vytvořili.

10. Klepnutím na tlačítko Finish Object Editing uložte nový dokončený objekt typu záznam.

11. Klepnutím na tlačítko Record na panelu nástrojů Report Objects vložte nově definovaný objekt typu
záznam do šablony stránky.
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Tři odlišně formátované objekty typu pole dokumentují
rozmanitost, v níž se mohou objekty typu pole objevit
ve zprávě.

Horní objekt typu pole je například určen pro údaje
databázových polí (které mohou zahrnovat dosti dlouhé
texty.

Dolní objekt typu pole je již vyplněn, tzn. že obrázek byl
přetažen z databáze na objekt typu záznam ve zprávě.
Objekt typu pole Image Height (vlevo) byl použit a vložen
místo údajů pro tento obrázek

Dostupné složky objektu typu pole

Objekt Funkce Poznámka
1 Textová

proměnná
Kód pole pro název
databázového pole

Název pole je určen definicí pole
v databázi. Když vložíte objekt
typu pole, obsah tohoto objektu
se automaticky nahradí názvem
zvoleného pole.

2 Textová
proměnná

Kód pole pro obsah
příslušného
databázového pole, tzn.
údaje v poli. Tato textová
proměnná se objeví ve
špičatých závorkách. Po
vložení objektu typu pole
se zde zobrazí název
pole.

Obsah databázového pole je
odlišný pro každý obrázek
a automaticky se vyplní vždy,
když do zprávy vložíte objekt
typu záznam z databáze
obrázků. Údaj v poli Calibration
Unit se nahradí například
hodnotou mm, pokud byl
obrázek kalibrován
v mm/obrazový bod.
Tento textový objekt můžete
formátovat jako každý jiný.
Důležitá je skutečnost, že můžete
povolit text, tedy umožnit
vyhrazení prostoru pro
databázová pole, jako jsou pole
typu memo.

3 Grafický
objekt

Funkce pro úpravu rozvržení, jako jsou rámečky a obdélníky,
pro barevné zvýraznění textu

4 Objekt
typu
obrázek

Funkce pro úpravu
rozvržení, například
symboly zastupující různá
databázová pole

Objekt typu obrázek, definovaný
v objektu typu pole, nemůže být
později použit jako kód pole pro
obrázky. Nemůžete vložit nový
obrázek do tohoto objektu typu
obrázek v této zprávě.
Jestliže chcete ušetřit místo,
přesvědčte se, zda jste všechny
obrázky vložili jako odkazy na
původní soubory. Pokud ne,
obrázky se zkopírují pokaždé,
když vložíte do zprávy objekt
typu pole.

5 Objekt
typu pole

Šablona pro objekt typu pole může obsahovat objekt typu
pole, který se však musí odkazovat na konkrétní databázové
pole, například Calibration Unit. Potom můžete vložit několik
databázových polí, například Height a Width, které pak
budou vždy zahrnovat kalibraci jednotek pro objekt typu
záznam.

6 Text Standardní text, který se vytiskne s každým databázovým
polem.

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon
vytvoření nových šablon objektů

šablony pro objekty typu záznam
šablony pro objekty typu pole

návrh šablon

Více informací o objektech typu pole
naleznete na stránce 117

Objekty typu pole v režimu úprav objektu
(str. 149):

l Vložení objektů typu pole: Pokud chcete
vytvořit nový objekt typu pole, musíte
upravit některý existující. Aktivujte režim
úprav objektu. Objekty typu pole lze
vkládat pouze v režimu úprav objektu.
V tomto režimu však musíte zvolit celý
objekt typu pole, nelze formátovat jeho
jednotlivé části nebo doplňovat nové.

l Údaje v polích se v režimu úprav při
přetažení obrázku z databáze do objektu
typu obrázek nevyplní. Tím je zajištěno,
že při vkládání nového objektu typu
záznam zůstane označení polí obecné.

l Otevření databáze: Uvědomte si,
že objekty typu pole můžete vkládat
pouze v případě, že je otevřená databáze.

Úprava objektů typu pole: Po klepnutí na
tlačítko Edit Object Template v režimu úprav
objektů můžete pouze začít s úpravu
objektů typu pole snížením úrovně v rámci
režimu úprav objektu.

l Složky: Objekty typu pole mohou
v podstatě obsahovat všechny druhy
objektů pro zprávy. Normálně objekt typu
pole obsahuje alespoň název a obsah
databázového pole.

l Délka textového objektu: Program
analySIS nenastavuje automaticky délku
textového objektu tak, aby odpovídala
údajům v polích nebo databázovým
polím. Pokud je údaj v poli delší než
textový objekt, údaj se na pravé straně
ořízne. Měli byste tedy mít odhadnutu
délku textových objektů. Rozhodněte,
zda jejich délka bude záviset na délce
nejdelšího údaje v poli nebo na
maximální délce databázového pole.

153



Nastavení databází obrázků programu analySIS pro vytváření zpráv

Při vytváření databáze obrázků pamatujte na zprávy, které budete chtít vytvořit použitím obrázků z této
databáze.

1. Připojené dokumenty: Obrázky můžete vložit do zprávy přímo z databáze, pouze pokud byly
vloženy do databáze jako záznamy. Z tohoto důvodu byste neměli obrázky, které chcete vkládat
z databáze do zprávy, k záznamu připojovat jako „dokumenty“.

2. Rozlišení náhledů: Pokud vložíte obrázky jako náhledy (Dialogové okno Preferences, karta Report,
zatržená předvolba Use thumbnails instead of full images) přímo z databáze, použijí se v databázi
náhledy. Při vytváření struktury databáze můžete vybírat z několik rozlišení pro náhledy. To znamená,
že již při vytváření databáze určíte rozlišení pro náhledy ve zprávě!

Uvědomte si, prosím, že čím větší bude rozlišení pro náhledy, tím větší budou soubory v databázi
obrázků. Pokud chcete zajistit největší rozlišení pro náhledy, zvolte příkaz Preferences... z nabídky
Special. Potom zvolte velkou fyzickou velikost náhledů na kartě Database. Narozdíl od rozlišení pro
náhledy však velikost zobrazení náhledů neovlivní, jak se náhledy zobrazí později ve zprávě.

3. Zvolte odpovídající název: Ujistěte se, že jste zvolili název pole, který odpovídá jeho obsahu.
Nezapomeňte, názvy a hodnoty polí se automaticky zahrnou do zprávy.

4. Prázdná pole: Pokud si nepřejete, aby byla některá pole zprávy prázdná, vytvořte závazný údaj pro
všechna databázová pole. Můžete například doplnit následující údaj do seznamu – <not applicable>,
jenž označuje záznam, v kterém není toto pole dostupné, a tudíž nelze zadat žádný údaj.

5. Znovupoužitelné textové „stavební bloky“: Když zařadíte obrázek do zprávy, obvykle k němu
zapíšete komentář do textového objektu. Ve zprávě však můžete také použít texty, které jste již zadali
při vložení obrázku do databáze.

Vytvořte databázové pole pro komentář k obrázku použitím souboru typu memo nebo použitím
předdefinovaného databázového pole, nazvaného Image Comment. Tímto způsobem se vytváří
stavební textové boky, které lze použít v libovolné zprávě s obrázky. Texty, které jste zapsali přímo
do zprávy, mohou být použity pouze pro tuto zprávu.

6. Výtažky z databáze: Může být velmi vhodné vytvořit databázové pole, které obsahuje název zprávy.
To Vám dovolí prostřednictvím jednoduchého dotazu fronty všechny obrázky z databáze, které patří
do stejné zprávy. Potom můžete rychle vytvořit vlastní databázi, která bude obsahovat pouze obrázky
ze zprávy. Zjednoduší se tak odeslání zprávy jiné osobě.

Před vytvořením šablony objektu typu záznam
1. Určení formátu stránky: Generátor zpráv programu analySIS je program pro vytváření rozvržení

stránek. To znamená, že je velmi obtížené upravit formát stránky existující zprávy, protože všechny
objekty byly již definitivně umístěny na stránce. Proto byste měli před vytvořením nové šablony zprávy
určit formát a okraje stránky.
Formát stránky zvolte v dialogovém okně Report Properties. Otevřete dialogové okno Report,
klepněte pravým tlačítkem myši kdekoliv na pozadí stránky tak, abyste nezvolili žádný objekt. Zvolte
položku Properties... v místní nabídce.

2. Použití existujících šablon: Pokud je možné použít existující šablonu zprávy, použijte ji. Prázdné
stránky znamenají mnoho práce, právě tak jako skutečnost, že vytváření takového množství prvků
objektu typu záznam je nadbytečné.

3. Vytvoření základních rozvržení: Vzhledem k tomu, že je to možné, vytvořte předem všechny objekty
na pozadí zprávy.

Sestavte základní rozvržení včetně rámečků, loga společnosti, místa pro vložení adresy
a všeobecných informací, jako jsou název společnosti nebo pořadové číslo. Pokud budete muset
později provést úpravy, musíte upravit každou šablonu stránky zvláš�. Existující zprávy již nelze
automaticky přizpůsobit novému rozvržením stránek. Z tohoto důvodu Vám jakékoliv nevyhnutelné
změny, které musíte později provést (tzn. po vytvoření šablony), zaberou určitý čas.
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Vytvoření šablony zprávy zahrnuje...
1. Zvolení odpovídajícího názvu: Každé šabloně stránky

přidělte název, který odpovídá jejímu obsahu. Zajistíte
tak, že žádný uživatel nebude mít potíže s rozeznáním
jednotlivých šablon stránek při vkládání nových
stránek do zprávy.

2. Označení kódů textových polí: Uživatel by měl být
ihned schopen rozpoznat, aniž by musel zkoušet
jednotlivá prázdná místa, která šablona objektu
textové pole bude vyplněna a která je na pozadí. Při
vytváření šablony zprávy byste tedy měli postupně
označovat každý textový objekt, který bude vyplňovat
uživatel. Textové proměnné můžete například umístit
do hranatých závorek a do kódů textových polí zapsat
žádost.
Nevytvářejte ve Vašich šablonách žádná textová pole,
která neobsahují text. Uživatel by měl potíže s jejich
vyhledáváním v šablonách.

3. Nastavte grafické uživatelské rozhraní (GUI): Při
práci s Generátorem zpráv věnujte čas optimálnímu
přizpůsobení grafického uživatelského rozhraní
programu analySIS Vašim potřebám. Zvolte šířku
okna Report a okna s databází tak, aby se obě okna
mohla zobrazit současně, a umístěte je tak, aby se
nepřekrývala. Umístěte panely nástrojů Generátoru
zpráv v grafickém uživatelském rozhraní vpravo nebo
vlevo, nikoli pod standardní panel nástrojů u horního
okraje okna. Pokud jsou ostatní panely nástrojů
umístěny pod standardním panelem nástrojů,
zobrazení celého grafického uživatelského rozhraní
při přepínání mezi dokumenty Vám zbytečně zabere
čas.

Pokud vkládáte obrázky pouze z jedné databáze,
můžete při úpravách zprávy značně zvětšit prostor
pro Generátor zpráv minimalizováním správce
obrázků a správce výřezů. Obě okna můžete
postupně minimalizovat stisknutím kombinací kláves
[Alt]+[1] a [Alt]+[2].

4. Základní rozvržení: Pro základní rozvržení vytvořte
v šabloně zprávy zvláštní šablonu stránky. Na základě
této šabloně stránky potom můžete snadno založit
rozvržení všech dalších šablon stránek. Na šablonu
stránky se základním rozvržením můžete ve zprávě
například rychle vložit objekt typu obrázek a tabulku
s výsledky měření.

5. Referenční stránky: Vytvořte referenční stránky pro
všechny prvky, které budete často používat ve Vaší
šabloně zprávy, například pro seskupený objekt,
tvořený objektem typu obrázek, textovým objektem
a čarami. Textové objekty, které lze upravovat,
nemůžete vytvořit jako součást objektu typu záznam,
proto na referenční stránce vytvořte objekt typu
záznam společně s textovým objektem.

Vytvořte všechny prvky tak, abyste je mohli kopírovat
rychleji, než znovu vytvářet: například grafické prvky
vytvořené podle Vašich představ.

3. Vytváření šablon zpráv
vytvoření složek pro zprávy
úprava existujících šablon
vytvoření nových šablon objektů
návrh šablon
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